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About Creating and Managing Industrial
Graphics

Industrial Graphics are graphics you can create to visualize data in an HMI/SCADA system.

You use the Industrial Graphic Editor to create Industrial Graphics from basic elements, such as rectangles, lines,
and text elements. You can also use the Industrial Graphic Editor to embed and configure an Industrial Graphic
from the Graphic Toolbox library of graphics. 

After you create an Industrial Graphic, you can embed it into another graphic or an HMI system window and use
it at run time.

You can embed an Industrial Graphic in a template or instance of an object providing several ways to visualize
object-specific information quickly and easily. Embedding a graphic in a template means that you can update one
graphic and cascade the changes throughout your application.

Depending on your development requirements, you can select where and how to store industrial graphics.

• Create and store graphics as a standard set that you can re-use, such as a generic valve graphic.•

• Store graphics as templates if you want to use the graphics in multiple instances at run time.•

• Store graphics for use in a specific application.•

Embedding Graphics
You can embed graphics into other graphics. Embedding graphics enables you to rapidly develop more complex
graphics with common components.

For example, you can create a single tank graphic, then embed it multiple times in another graphic to create a
graphic representing a collection of tanks.

There is no limit to the number of levels of embedding.

Embedded graphics appear in the Elements List. The default name is the same as the source graphic, followed by
a numeric sequence.

Changing Embedded Graphics
After you embed a graphic, you can change its size, orientation or transparency. You can add a limited set of
animations to the graphic, such as:

• Visibility•
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• Blink•

• Horizontal and vertical location•

• Width and height•

• Orientation•

• Disable•

• Touch Pushbuttons (Discrete Value, Action, Show Window, and Hide Window)•

You can configure its public custom properties, if any exist.

You cannot:

• Change the graphic definition of the embedded graphic from within the hosting graphic.•

• Embed a graphic contained in an object created in your HMI/SCADA software into a graphic that is contained•
in the Industrial Graphic Editor.

• Create circular references. A circular reference occurs when one graphic (Graphic A) has embedded within it•
another graphic (Graphic B) that has embedded within it a graphic that directly or indirect references back to
the first graphic (Graphic A).

You can, however, change the embedded graphic by changing its source graphic. The changes you make
propagate to the embedded graphic.

Size Propagation and Anchor Points
An anchor point controls how changes in graphic size are propagated to embedded instances. By default, the
anchor point of the graphic is the center point of all elements on the canvas.

This can be done graphically on the canvas, or by setting anchor position properties in the Properties Editor.

There are two types of anchors:

• Use the AbsoluteAnchor property to specify its position as absolute coordinates.•

• Use the RelativeAnchor property to specify its position as coordinates relative to the graphic center.•

When you embed a graphic, the embedded graphic inherits the anchor point in relation to its own center point.

You can also set the AnchorFixedTo property. When you make changes to the graphic that affects its size, the
AnchorFixedTo property determines if the absolute position or relative position of the anchor point is
recalculated. This property can have following values:

• Absolute: The absolute anchor point position is unchanged, and the relative anchor point position is•
recalculated.

• Relative: The absolute anchor point position is recalculated, and the relative anchor point position is•
unchanged.

When you change the AbsoluteAnchor property, the AnchorFixedTo property is set to the value Absolute. When
you change the RelativeAnchor property, the AnchorFixedTo property is set to the value Relative.

You can change the position of the anchor point of the graphic. This affects the position of the embedded
instances. The anchor points of the embedded instances, however, remain unchanged.
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Embedded SymbolSource Symbol

Anchor Point embedded at: 110,220Anchor Point set to: 64,80

Embedding

Embedded SymbolSource Symbol

Anchor Point remains at: 110,220Added Element and moved 
Anchor Point to: 64,80

Propagation

You can change the anchor point of an embedded graphic. This moves the embedded graphic. It does not change
the anchor point position in relation to the graphic. You can resize or rotate the embedded graphic. The anchor
point moves in relation to the embedded graphic. You can also use the AnchorPoint property in the Properties
Editor to change the position.

Showing Quality and Status
To show a specified status or quality at run time, you can:

• Use a Status element that shows you an icon. It indicates the status or quality of specified attributes or tags•
directly or those used indirectly in elements.

• Change the appearance of animated elements based on the status and quality of attributes or tags they use.•

Showing Quality and Status with the Status Element
The Status element cannot monitor attributes of:

• Elements that are not in the same hierarchy level in the Elements List.•

• Elements that use the attributes in scripts.•

• Elements that are invisible at run time.•

For more information on how to configure status on an element, see Configuring Animation for a Status Element.
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For more information on how to configure the appearance of a status element, see Setting the Appearance of a
Status Element.

Showing Quality and Status by Overriding
You can override the appearance of an animation depending on its configured attributes by:

• Overriding the animation or changing the appearance of the element.•

• Drawing an outline around the element.•

Overriding the appearance of animations also applies to:

• Elements contained in groups.•

• Elements in graphics embedded in other graphics.•

Overriding the appearance of animations does not apply to:

• Elements that use the monitored attribute in scripts.•

• Elements that are invisible at run time.•

For more information, see Overriding Element Appearance Depending on Quality and Status of its Attributes.
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Working with Industrial Graphic Editor

Managing Industrial Graphics
Creating a New Graphic

You can create a new graphic:

• In your HMI graphics repository, such as the Graphic Toolbox, for generic graphics that you frequently use in•
different situations. For example, a valve graphic.

• From a template, if object and application templates are supported by your HMI/SCADA software. Do this if•
you want to re-use the graphic in combination with the object functionality. An example is a graphic
representing a specific tank and your production facility has multiple tanks.

• From an object if instantiation is supported by your HMI/SCADA software. Do this if you are unlikely to re-use•
the graphic in any other situation.

Creating a new graphic using your HMI/SCADA software will add it to your graphics library. You can then manage
and use your graphics.

• Rename•

• Copy•

• Move•

• Edit the graphic•

• Create toolsets - groups of graphics for use in a particular visualization application or to represent a group of•
related devices

• Move graphics between toolsets•

• Rename toolsets•

Opening Graphics for Editing
Organizing Graphics

Use the library available to your HMI/SCADA software to organize your graphics by creating a folder hierarchy as
you would with files and folders in Windows Explorer. You can move graphics around within the folder hierarchy.
These folders are called Graphic Toolsets.
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Importing and Exporting Graphics
You can import and export graphics to the graphic libraries associated with your HMI/SCADA software. Consult
the corresponding user guide for specific information and procedures.

Deleting a Graphic
You can delete a graphic that you no longer need. Deleting a graphic removes it completely from the Industrial
Graphic Editor.

• When you delete a graphic, you are shown where the graphic is used. This allows you to understand the•
impact of deleting the graphic before you actually delete it.

• You cannot delete a graphic that someone else has open for editing or left checked out.•

• If you delete a graphic that is embedded in another graphic, it shows a Not Found message.•

To delete a graphic
1. Select the graphic you want to delete and click Delete. The Delete dialog box appears.1.

2. Review the places the graphic is being used, and then click Yes.2.

Creating Multiple Configurations of a Graphic
The Symbol Wizard Editor is a feature of the Industrial Graphic Editor to create multiple configurations of a
graphic. A graphic configuration represents different visual or functional variations of a graphic.

Graphic configurations are created using layers containing associated graphic elements, custom properties, and
named scripts. Based on graphic properties and possible values of these properties, rules are applied that specify
when a layer is part of a graphic configuration.

Understanding Visual and Functional Graphic Configurations
Standard Industrial Graphics show reasonably realistic views of process objects. These graphics can be modified
with the Symbol Wizard to incorporate multiple visual configurations in a graphic.

Situational Awareness Library graphics are a special set of Industrial Graphics that are available for use in your
HMI/SCADA software, and are designed using the Symbol Wizard Editor. Their design cannot be changed.
However, you can select Wizard Options from the Symbol Wizard Editor to select the configurations that are
incorporated into each graphic’s design.

Visual Graphic Configurations
Using an example of a centrifugal pump with separate inlet and outlet pipes, there are four practical visual
configurations. The pump’s blade housing is common and appears in all possible configurations. But, the pump’s
inlet and outlet pipes can be placed at the left or right in a horizontal direction or at the top or bottom when the
pump is oriented vertically.
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Orientation is the visual property that identifies the different configurations of a pump graphic. The attributes
associated with the Orientation property are left, right, top, and bottom.

Functional Graphic Configurations
Situational Awareness Library symbols include functional properties in addition to visual properties. For example,
a multi-stage pump symbol includes a Wizard Option to select either a five-stage, three-stage, or single stage
pump in addition to a visual Orientation property to select left or right pump configurations.

  

Embedding Graphics
You can embed graphics into other graphics. Embedding graphics enables you to rapidly develop more complex
graphics with common components.

For example, you can create a single tank graphic, then embed it multiple times in another graphic to create a
graphic representing a collection of tanks.

There is no limit to the number of levels of embedding.

Embedded graphics appear in the Elements List. The default name is the same as the source graphic, followed by
a numeric sequence.

Appearance of Embedded Graphics
Embedded graphics appear in the Elements List. The default name is the same as the source graphic, followed by
a numeric sequence.

Changing Embedded Graphics
After you embed a graphic, you can change its size, orientation or transparency. You can add a limited set of
animations to the graphic, such as:

• Visibility•

• Blink•

• Horizontal and vertical location•

• Width and height•

• Orientation•
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• Disable•

• Touch Pushbuttons (Discrete Value, Action, Show Window, and Hide Window)•

You can configure its public custom properties, if any exist.

You cannot:

• Change the graphic definition of the embedded graphic from within the hosting graphic.•

• Embed a graphic contained in an object created in your HMI/SCADA software into a graphic that is contained•
in the Industrial Graphic Editor.

• Create circular references. A circular reference occurs when one graphic (Graphic A) has embedded within it•
another graphic (Graphic B) that has embedded within it a graphic that directly or indirect references back to
the first graphic (Graphic A).

You can, however, change the embedded graphic by changing its source graphic. The changes you make
propagate to the embedded graphic.

Viewing a Graphic in Read-Only Mode
You can view a graphic in read-only mode if you don’t want to edit it, or if it is checked out by somebody else.

If you open a graphic in read-only mode, you have access to all functions in the Industrial Graphic Editor that
don't change the graphic.

To view a graphic in read-only mode
1. Select the graphic that you want to view in read-only mode.1.

2. Click Open Read-Only. The selected graphic opens in the Industrial Graphic Editor.2.

Using the Industrial Graphic Editor
Showing, Hiding and Adjusting Panels

You can edit graphics using the Industrial Graphic Editor. Depending on where the graphic is contained, you can
start the Industrial Graphic Editor from your HMI/SCADA software:

You can:

• Show and hide Industrial Graphic Editor panels to allocate more space on the canvas.•

• Pan and zoom the canvas to make finer or more granular adjustments to elements.•

• Place a grid on the canvas surface to align elements more precisely.•

You can hide the Properties Editor and Animation Summary to allocate more space on the canvas.

To show or hide the Properties Editor and Animation Summary panels
• Do either of the following:•

• Press ALT + ENTER.•

• On the View menu, click Properties.•

You can also adjust the size of the Elements List and Properties Editor.
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To adjust the size of panels
1. Drag the dividing line between the panels to specify the new panel size.1.

2. Release the mouse button and the panels are resized.2.

Panning and Zooming the Canvas
You can pan and zoom the canvas to make finer visual adjustments to the elements or to get a better overview of
a large graphic.

Use the Pan and Zoom toolbar to pan and zoom.

Panning
You can use the Pan functions of the Pan and Zoom toolbar to do the following:

• Use the Pan and Zoom window to select which part of the canvas appears on the screen.•

• Grab the canvas with the Hand tool and move it (Pan).•

You can also use the scroll wheel of the mouse to pan up and down in the current canvas display.

Using the Pan and Zoom Window to Pan
Use the Pan and Zoom window to pan the canvas area.

To use the Pan and Zoom window for panning
1. On the Pan and Zoom toolbar, click the Pan and Zoom window icon. The Pan and Zoom window appears.1.

2. In the Pan and Zoom window, move the mouse within the red rectangle. The pointer hand icon appears.2.

3. Click and hold the left mouse button down.3.

4. Drag the mouse. The red rectangle moves with the mouse.4.

5. Release the mouse button. The area shown in the canvas is changed accordingly.5.

Using the Hand Tool to Pan
Use the Hand tool to pan the canvas area. This is equivalent to picking up the canvas and moving it so that the
visible canvas area changes.

To use the Hand tool to pan

1. On the Pan and Zoom toolbar, click the Pan icon.1.

2. Move the mouse over the canvas. The Hand tool pointer appears.2.

3. Click the canvas to grab the canvas and keep the mouse button down.3.

4. Move the mouse to change the area of canvas that is shown.4.

5. Release the mouse button.5.
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Using the Mouse Scroll Wheel to Pan
You can use the mouse scroll wheel to:

• Pan up or down.•

• Pan 360 degrees.•

To use the mouse scroll wheel to pan up or down
1. Click the canvas so that no elements are selected.1.

2. Move the mouse scroll wheel:2.

• Forward to pan up.•

• Backward to pan down.•

To use the mouse scroll wheel to pan in any direction
1. Click the canvas so that no elements are selected.1.

2. Click the mouse scroll wheel. The pointer appears in 360 degrees scroll mode.2.

3. Move the mouse. The visible area of the canvas is panned accordingly.3.

4. When you are done, click the canvas.4.

Zooming
Use the Pan and Zoom toolbar to:

• Zoom in on a specified point to magnify the current elements.•

• Zoom out from a specified point.•

• Zoom to the default zoom factor (100 percent).•

• Zoom so that the currently selected element is shown across the available canvas area or zoomed to the•
maximum value of 500 percent.

• Zoom in on an area of the canvas using a "rubber band" selection with your mouse.•

• Specify or select a zoom factor.•

You can also use the CTRL key and the scroll wheel of the mouse to zoom in and zoom out the current canvas
view.

Zooming In to a Specified Point
You can zoom in by 25 percent of the default scale to any specified point on the canvas.

To zoom in to a specified point

1. Click the Zoom In icon in the toolbar.1.

2. Move the mouse over the canvas. The Zoom In pointer appears.2.

3. Click the canvas to where you want to zoom in. The canvas is zoomed in at the specified point.3.
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Zooming Out from a Specified Point
You can zoom out by 25 percent of the default scale from any specified point on the canvas.

To zoom out to a specified point
1. Click the Zoom Out icon in the toolbar.1.

2. Move the mouse over the canvas. The Zoom Out pointer appears.2.

3. Click the canvas from where you want to zoom out. The canvas is zoomed out from the specified point.3.

Zooming to the Default Zoom Value
You can reset the zoom to the default zoom value 100 percent.

To reset the zoom to the default zoom value

• Click the Zoom to Normal icon in the toolbar. The canvas zoom is reset to its default.•

Zooming a Selected Element
You can zoom one or more selected elements so that they appear as large as possible in the allocated canvas
area. This is useful when you want to make fine adjustments to one or more elements.

To zoom a selected element
1. Select the elements you want to zoom.1.

2. Click the Zoom To Selection icon in the toolbar. The visible canvas is zoomed so that the selected elements2.
appear as large as possible.

Zooming a Specified Area
You can zoom a specified area by using the "rubber band" selection method.

To zoom a specified area
1. Click the Rubber Band Zoom icon.1.

2. Move the mouse over the canvas. The Rubber Band pointer appears.2.

3. Move the mouse to the top left corner of the area you want to zoom.3.

4. Hold the left mouse button down and then drag the mouse to the bottom right corner of the area you want4.
to zoom.

5. Release the mouse button. The area is zoomed to the entire canvas area.5.

Selecting or Specifying a Zoom Value
You can select a defined zoom value or type a zoom value. Valid values are 25 percent to 500 percent.

To select or specify a zoom value
• On the Zoom and Pan toolbar, do one of the following:•

• Click the zoom value list and select a zoom value.•

• Click the zoom value in the zoom value list, type a valid value, and then click Enter.•
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Using the Pan and Zoom Window to Change the Zoom
Use the Pan and Zoom window to change the zoom of the canvas.

You can also use the Pan and Zoom window to "scroll" to a different part of the canvas. This is called panning.
For more information, see Panning.

To use the Pan and Zoom window for zooming
1. On the Zoom and Pan toolbar, click the Pan and Zoom window icon. The Pan and Zoom window appears.1.

2. In the Pan and Zoom window, move the mouse over a corner or an edge of the red rectangle.2.

3. Click and hold the left mouse button down. The corresponding resize pointer appears.3.

4. Drag the mouse. The red rectangle changes size proportionally.4.

5. Release the mouse button. The zoom of the canvas is changed accordingly.5.

Using the Mouse Scroll Wheel for Zooming
You can use the mouse scroll wheel to zoom the canvas area. The canvas is then zoomed on the midpoint of all
selected elements or, if none are selected, on the midpoint of the canvas.

To use the mouse scroll wheel for zooming
• Press and hold the CTRL key and move the scroll wheel:•

• Forward to zoom in by a factor of 25 percent of the default zoom value.•

• Backward to zoom out by a factor of 25 percent of the default zoom value.•

Configuring Designer Preferences
Use the Designer Preferences dialog box to set Industrial Graphic Editor preferences. Preferences can be
configured for the following:

• Grid Settings - The grid helps you precisely place and move elements on the canvas.•

• Canvas Settings - The settings for the appearance of the graphic on the canvas can also be configured.•

• Graphics Performance Index Warning window visibility•

• Image Editor selection•

To open the Designer Preferences dialog window
1. Open the Industrial Graphic Editor.1.

2. On the View menu, click Preferences. The Designer Preferences dialog box appears.2.

To configure Grid Settings
1. Click the box next to the Grid color label. The Select Grid Color dialog box appears. For more information,1.

see Setting a Solid Color.

2. In the Grid size box, type a value from 1 to 100 to specify the distance in pixels between each line in the grid.2.

3. In the Major subdivisions box, type a value from 1 to 10 to specify the number of major subdivisions of the3.
grid. Major subdivisions are emphasized lines that visually create larger grid cell blocks.

4. Clear or select the Grid visible check box to hide or show the grid.4.
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5. Clear or select the Snap to grid check box. With the snap-to-grid option set, when you move elements or5.
groups on the canvas they are moved to the closest grid intersection. If this option is not set, you can move
the elements freely to any location on the canvas.

To configure Canvas Settings and graphic appearance
1. Click the box next to the Background Color label. The Select Canvas Color dialog box appears. For more1.

information, see Setting a Solid Color.

2. Clear or select the Symbol Smoothing check box. If this option is not set, lines drawn on the canvas may2.
show jagged edges. With this option set, lines drawn on the canvas show smooth edges.

3. Clear or select the Show Anchor check box. With this option selected, the graphic displays anchor icons, if3.
anchors were created in the graphic.

To configure Graphic Performance Index Settings
• Clear or select the Show the Graphic Performance Index warning on save check box. If this option is•

disabled, the Graphic Performance Index Warning window will not appear when saving a graphic with a GPI
rating calculated to be less than 5.0. For more information about the Graphics Performance Index, see
Estimating Graphic Performance."

To select an Image Editor
• Choose the graphic editing tool from the Image Editor menu. If you select Choose Custom Editor, the Select•

Image Editing Application window appears so you can make a selection.

To save your settings as default settings
1. Click Save as Default.1.

2. Click Apply.2.

3. Click OK.3.

Using the Symbol Wizard Editor
The Symbol Wizard Editor in the Industrial Graphic Editor allows you to create graphics with multiple
configurations called Symbol Wizards. They create Symbol Wizards with the Symbol Wizard Editor. You can
embed Symbol Wizards and use the Symbol Wizard Editor to select the configuration needed for an application.

Start creating a multi-configuration graphic by opening a graphic element or graphic in the Industrial Graphic
Editor. Show the Symbol Wizard Editor by clicking the Symbol Wizard icon from the Industrial Graphic Editor’s
menu bar, selecting it as an option of the View menu, or pressing the Alt+W key combination.

The Industrial Graphic Editor window updates to show tabbed Symbol Wizard panes at the left of the window.
The top pane shows the graphic elements, named scripts, and custom properties of the graphic in separate
views.

The bottom pane shows tabbed Options and Layers panes. The Options pane shows a hierarchical list of Choice
Groups, Choices, and Options that define graphic properties and the possible values associated with each
property. The Layers pane includes a list of defined graphic layers. Beneath each layer, separate folders contain
the graphic's elements, custom properties, and named scripts associated with each layer. You can add, edit, or
delete items associated with the Options and Layers panes.

Symbol Wizard Option Properties or Layer Properties panes appear to the right of the canvas area in the
Industrial Graphic Editor window after selecting items from the Options or Layers panes.
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Both properties pane shows the name of the selected item and any rule associated with the item. If a Choice
Group is selected from the Options pane, the Options Properties pane also shows the default value of the
Choice Group and a Description field.

After creating the configurations of a graphic with the Symbol Wizard Editor, use the Symbol Wizard Preview to
verify that all configurations are correct. The Symbol Wizard Preview can be opened by clicking it from the menu
bar, selecting it as an option of the View menu, or pressing the Alt+P key combination.

After opening Symbol Wizard Preview, the Properties pane shows Wizard Options, which includes drop-down
menus to select options to show the different configurations created for the graphic. As options are selected, the
graphic is updated to show the selected configuration.

The Validation pane shows any script or custom property errors within the graphic. Selecting a listed error from
the Validation pane shows the Custom Properties or Scripts dialog box to identify and correct an error within
the graphic.

After verifying that all graphic configurations are correct, save the graphic into the Graphic Toolbox. For more
information about the Symbol Wizard tasks completed by a user, see Designing a Symbol Wizard.

To create an application containing Symbol Wizards, add a graphic to an automation object or create a new
graphic from the Graphic Toolbox. Then, embed a Symbol Wizard. The graphic appears with the default
configuration selected.
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The Wizard Options pane shows a set of drop-down lists with configuration options. Select options from the
drop-down lists to change the graphic’s configuration to meet the needs of an application. Finally, edit and
update the custom properties and named scripts that are associated with the multi-configuration graphic. For
more information about the Symbol Wizard tasks, see Using Symbol Wizards in an Application.
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Graphic Elements

About Graphic Elements
This section explains how to work with the common features of graphic elements. For information about
features specific to certain elements such as element properties, see Editing Graphic-Specific and Element-
Specific Properties.

Graphic elements are basic shapes and controls you can use to create a graphic to your specifications. You can:

• Draw an element by selecting an element from the Tools panel, placing it on the canvas, and then•
configuring its properties.

Select one or more elements on the canvas with the mouse or from the Element list.

• Edit certain elements in a special way called inline editing.•

• Copy, cut, paste, and duplicate elements.•

• Move elements around on the canvas.•

• Align elements to each other.•

• Change the spacing between elements.•

• Resize elements.•

• Change the z-order of elements to change which elements appear on top of others when they overlap.•

• Rotate elements.•

• Change the origin of elements to specify around which point the elements are rotated.•

• Flip elements on their horizontal or vertical axis.•

• Lock elements to stop them being moved or changed.•

• Undo and redo any number of changes made previously to the graphic.•

• Create groups of elements to bind them together.•

• Create a path graphic from multiple open line elements.•

Drawing and Dragging Elements
You can create elements such as lines, curves, circles, squares, and so on. You can combine these elements to
create complex drawings of all the equipment in your manufacturing environment.
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After you draw an element, you can modify its properties. For more information about modifying properties, see
Editing Element Properties.

Regardless of the kind of element you are drawing, drawing each kind of element is very similar.

After you draw an element, the pointer tool is selected again by default. To draw multiple elements of the same
type, double-click the element in the Tools panel. It remains selected after you draw your first element of that
type. You can press the ESC key to return to the pointer tool again.

If you draw or drag an element outside of the visible canvas area to the right or bottom, horizontal and/or
vertical scroll bars appear but the visible area does not follow the mouse. You can later use the scroll bars to
scroll the canvas and see the element you drew or moved.

Drawing Rectangles, Rounded Rectangles, Ellipses, and Lines
You can draw rectangles, rounded rectangles, ellipses, and lines on the canvas.

To draw a rectangle, rounded rectangle, ellipse, or line
1. Click the appropriate icon in the Tools panel.1.

2. Click the canvas and drag the shape of the element on the canvas.2.

Note: To make your rectangle a square or your circle an ellipse, hold down the Shift key while you are
drawing the shape.

3. When you are done, release the mouse button.3.

Drawing Polylines, Polygons, Curves, and Closed Curves
You can draw polylines, polygons, curves, and closed curves on the canvas.

If you are drawing a closed element, the element automatically closes when you are done drawing.

To draw a polyline, polygon, curve, or closed curve
1. Click the appropriate icon in the Tools panel.1.

2. Click the canvas where you want to start the element.2.

3. Click the next point for the element.3.

4. Continue clicking until you have all the points you require.4.

5. When you are done, right-click.5.

6. You can change the shape of these elements anytime by editing their control points. For more information,6.
see Editing Control Points.

Drawing 2-Point Arcs, 2-Point Pies and 2-Point Chords
You can draw 2-point arcs, 2-point pies, and 2-point chords on the canvas.

If you are drawing a closed element, the element automatically closes when you are done drawing.

To draw a 2-point arc, 2-point pie, or 2-point chord
1. Click the appropriate icon in the Tools panel.1.

2. Click the canvas where you want to start the element and hold the mouse button.2.
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3. Drag the mouse to where you want the element to end.3.

4. When you are done, release the mouse button.4.

5. You can change the shape of these elements anytime by editing their control points. For more information,5.
see Editing Control Points.

Drawing 3-Point Arcs, 3-Point Pies, and 3-Point Chords
You can draw 3-point arcs, 3-point pies and 3-point chords on the canvas.

If you are drawing a closed element, the element automatically closes when you are done drawing.

To draw a 3-point arc, 3-point pie, or 3-point chord
1. Click the appropriate icon in the Tools panel.1.

2. Click the canvas where you want to start the element.2.

3. Click the canvas in two other places to define the element.3.

4. You can change the shape of these elements anytime by editing their control points. For more information,4.
see Editing Control Points.

Placing and Importing Images
You can place an image element on the canvas and import an image into it.

To draw an image
1. Click the image icon in the Tools panel.1.

2. Click the canvas and drag the shape of the image element.2.

3. Release the mouse button. The Open dialog box appears.3.

4. Browse to the image file, select it, and then click Open. The image file is loaded into the image element.4.

Drawing Buttons
You can draw a button on the canvas. You can configure a button with a text label or an image.

For more information on how to configure a button with an image after drawing it on the canvas, see Configuring
Buttons with Images.

To draw a button
1. Click the button icon in the Tools panel.1.

2. Click the canvas and drag the shape of the button element.2.

3. Release the mouse button. The button text appears in edit mode.3.

4. Type a text label for the button and click Enter.4.

Placing Text
You can place text on the canvas.
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The text element has no border and no background fill. The text does not wrap. When you type the text, the size
of the Text element expands.

You can also drag the handles of the Text element to resize it.

To place text
1. Click the text icon in the Tools panel.1.

2. Click the canvas where you want to place the text.2.

3. Type the single line of text you want.3.

4. When you are done, do one of the following:4.

• Click Enter to type a new line of text. This new line is a new element.•

• Click the canvas outside the text element.•

Drawing Text Boxes
You can draw text boxes on the canvas. Text boxes can have borders and background fill.

You can also configure the text to wrap in the text box. For more information, see Wrapping Text in Buttons.

To draw a text box
1. Click the text box icon in the Tools panel.1.

2. Click the canvas where you want to place the text box.2.

3. Drag a rectangle on the canvas.3.

4. Release the mouse button. The text appears in edit mode.4.

5. Type a text label for the text box, and then click Enter.5.

Drawing Status Elements
Use the status element to indicate specific quality and status conditions of attributes.

To draw status elements
1. Click the status icon in the Tools panel.1.

2. Click the canvas where you want to place the status element.2.

3. Drag a rectangle on the canvas.3.

4. Release the mouse button.4.

Drawing User Interface Common Controls
Draw user interface common controls on the canvas to add additional functionality to your graphic. Each of the
controls has specific behavior when it is drawn. For example, you can change the width of a combo box, but not
the height.

To draw a windows control
1. Click the appropriate common interface control icon in the Tools panel.1.
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2. Click the canvas where you want to place the control.2.

3. Drag a rectangle on the canvas.3.

4. Release the mouse button.4.

Dragging Elements
After you draw elements on the canvas, you can drag them to a new position.

To drag elements on the canvas
1. Select one or more elements.1.

2. Click one of them and hold the mouse button down.2.

3. Drag the mouse to the new position.3.

4. Release the mouse button.4.

Editing Element Properties
You can control the appearance of an element, a group of elements, or multiple elements with functions on the
toolbar and properties shown in the Properties Editor of the Industrial Graphic Editor.
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Often you can edit an element by changing the values of its properties instead of using the mouse to perform the
same function. This is useful when you want very exact editing, such as when you want to resize an element to a
specific width.

The Properties Editor shows the properties common to all selected elements.

• Read-only properties appear in grey.•

• Non-default values appear in bold.•

The Properties Editor not only supports values, but also allows input of color, font, and file information in the
respective dialog boxes.

Properties are organized in categories so you can find them more easily. The following table shows the
categories:

Property Category Purpose

Graphic Element name or other describing identifiers

Appearance Element style, location, size, orientation, offset, transparency and locked
status

Fill Style Any parameters related to the fill appearance of the element

Line Style Any parameters related to the appearance of element lines

Text Style Any parameters related to the appearance of element text

Runtime Behavior Element visibility, tab order and any other element behavior at run time

Custom Properties Additional user-defined properties you can associate with any element

Selecting Elements
You can select one or more graphic elements from the Industrial Graphic Editor canvas by:

• Clicking on them with the mouse.•

• Dragging a lasso around them with your mouse.•

• Selecting them with a menu option or with a shortcut key.•

• Selecting them by name from the Elements list.•

When you select an element, handles appear around the border of the element that can be moved to control
the size of the element. You can change the orientation of a graphic element by moving the handle connected to
the top center border handle.
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When you select multiple elements, the last selected element is the primary element. All other
previously selected elements are secondary elements.

Selected Element Description

Primary Element Appears with color-filled handles.

Behaves as an active selected element.

Is the point of reference for all operations, such
as aligning or spacing multiple selected
elements.

Secondary Elements Appear with white handles.

Behave as inactive selected elements.

Follow the edits made to the primary element.

To select a group, click one of the elements contained in the group.

Selecting Elements by Mouse Click
You can select one or more elements by pressing Shift + clicking. This is particularly useful for selecting multiple
elements that are not necessarily all included in a specified rectangular area on the canvas.

To select an element or multiple elements by mouse click
1. On the canvas, click an element. It becomes selected.1.

2. To select further elements, press Shift+ click. The other elements become selected.2.

You can see in the Elements List which elements are selected.

Selecting Elements by Lasso
You can select one or more elements by lassoing them with your mouse. This is useful for selecting multiple
elements within a specified rectangular area on the canvas.
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To select elements by lasso
1. On the canvas, click outside any element and hold the mouse button down.1.

2. Drag the mouse so that the lasso wraps around all elements that you want to select.2.

3. When you are done, release the mouse button. The elements that are fully enclosed within the lasso are3.
selected.

Selecting All Elements
You can select all elements using the Select All function.

To select all elements
• On the Edit menu, click Select All. All elements on the canvas are selected.•

You can also press the F2 key to select all elements.

Selecting Elements Using the Elements List
You can use the Elements List to select any elements on the canvas. The Elements List is particularly useful for
selecting elements behind other elements.

The Elements List shows which elements are currently selected. The primary selected element appears by
default in dark blue, the secondary selected elements appear by default in light blue.

The color setting of the Elements List depends on the setting for the Selected Items option in the operating
system’s Display Properties Appearance panel.

To select elements using the Elements List
1. In the Elements List, select the element name.1.

2. To select multiple elements, Ctrl + click the other elements.2.

Unselecting Elements
You can unselect one or more selected elements. You can do this by clicking on them individually on the canvas
or in the Elements List.

If you want to remove the selected elements in a specified rectangular area, you can use the lasso.

To unselect elements individually
1. Do one of the following:1.

• Shift + click the selected element on the canvas.•

• Ctrl + click the selected element name in the Elements List.•

2. Repeat the previous step for all elements you want to unselect.2.

To unselect elements from a specified rectangular area
1. Shift + click the canvas outside of any element.1.

2. Drag the mouse so that the lasso surrounds the elements that you want to unselect.2.
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3. Release the mouse button. The selected elements within the lasso are unselected, and the selected3.
elements outside the lasso remain selected.

Inline Editing
After you place graphic elements on the Industrial Graphic Editor canvas, you can edit them by selecting them
and clicking on them again. This is called inline editing. The following elements support inline editing.:

Element Use inline editing to

Button, text, text box Edit the text.

Polyline, polygon, curve, closed
curve

Edit the control points.

2-point arc, 2-point pie, 2-point
chord, 3-point arc, 3-point pie,
3-point chord

Edit the start and sweep angles.

Group Edit the individual elements and groups contained in the group.

Path Edit the control points.

To edit elements with inline editing
1. Select an element by clicking on it or selecting it from the Elements list. Element handles appear around the1.

border of the element.

2. Click the element again to begin inline editing.2.

• For buttons, text, and text boxes, the text is selected and you can type new text.•

• For polylines, polygons, curves, and closed curves, the control points of the element appear. Move a•
control point to change the shape of the element.

You can also add and delete control points. For more information, see Adding and Removing Control
Points.

• For arcs, pies, and chords, the handles for the start angle and sweep angle appear. Move a handle to•
change the start angle and sweep angle.

• For groups, the group handle is replaced with a shaded outline. You can select individual elements and•
groups within the group to edit and move them.

3. Click the canvas outside the element to exit from inline editing.3.

© 2022 AVEVA Group plc and its subsidiaries. All rights reserved.
  

Page 38

AVEVA™ Industrial Graphic Editor User Guide 
Chapter 3 – Graphic Elements



Copying, Cutting, and Pasting Elements
After you draw elements, you have the same cut, copy, and paste options available to you as in any other
Windows application. However, some of these options behave differently in the Industrial Graphic Editor.

You can also duplicate elements. Duplicating elements lets you quickly make copies of existing selected elements
without first copying or cutting. You can duplicate one or more selected elements at the same time.

When you copy or duplicate elements, all of its properties are copied with the element. If you don't want the
properties to be identical, change the properties after you copy.

Locked grouped elements and the path element behave differently when you copy or duplicate them.

If you copy or duplicate:

• A set of elements that are locked, the copy is not locked.•

• Grouped elements, the copy is still grouped.•

• A path element, the copy is also a path.•

Copying Elements
After you select an element, you can copy it by using menu options or you can Ctrl + click.

To copy one or more elements
Do any of the following:

• Select one or more elements to be copied on the canvas. On the Edit menu, click Copy. On the Edit menu,•
click Paste. The paste pointer appears. Click the canvas where you want to place the copy.

• Ctrl + click an element.•

• Select one or more elements to be copied on the canvas. Press Ctrl + C. Press Ctrl + V. The paste pointer•
appears. Click the canvas where you want to place the copy.

Cutting or Deleting Elements
You can cut elements or groups or you can delete them. Cutting lets you select elements or groups and remove
them from the canvas. You can paste the removed elements or groups.

Deleting elements or groups deletes them from the canvas. You cannot paste deleted elements or groups.

To cut one or more elements
• Select one or more elements, and then do one of the following:•

• On the Edit menu, click Cut.•

• Press Ctrl + X.•

To cut and paste elements on the canvas
1. Select the element or group.1.

2. On the Edit menu, click Cut.2.

3. Do one of the following:3.

• Click Paste on the Edit menu.•
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• Press Ctrl + V.•

4. Click the canvas location where you want the element or group to be placed.4.

To delete an element or a group
1. To remove the element or group and not use it in the future, select the element or group.1.

2. Do one of the following:2.

• Click Delete on the Edit menu.•

• Press Delete on your keyboard.•

Duplicating Elements
Duplicating elements enables you to select an element or elements and quickly make copies of them.

You can also specify the amount of overlap when you duplicate.

To duplicate elements
1. Select one or more elements.1.

2. Do one of the following:2.

a. Click Duplicate on the Edit menu. The selected element is duplicated and appears offset to the originala.
element.

b. Press Ctrl + D. The selected element is duplicated and appears offset to the original element.b.

c. Ctrl + click one of the selected elements to duplicate all selected elements. You can keep the mousec.
button down and drag them to the new position on the canvas.

To set the overlap when you duplicate
1. Duplicate an element or elements. The element is copied overlapping the original.1.

2. Move the duplicated element to the location relative to the original. For example, move the duplicated2.
element five grid spaces above the original element.

3. Duplicate the element again. The new duplicate is placed in the same offset you specified in the preceding3.
step. For example, five grid spaces above the original element.

Moving Elements
After you create elements, you can move them to the location you want on the canvas.

You can move elements or groups by dragging them to the new location or you can open the properties for the
element or group and change the X and Y properties.

If you turned on snap to grid, moving an element or group with the mouse snaps the element or group to the
grid.

If you move an element or group by specifying X and Y coordinates, it does not snap to the grid.

You can move an element or group vertically or horizontally using the keyboard.

To move an element or group using the mouse
1. Select the element or group you want to move.1.
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2. Drag the elements or group to the new location.2.

To move an element or group by specifying the X and Y properties
1. Select the element or group you want to move.1.

2. In the Properties Editor, expand Appearance.2.

3. Do the following:3.

• In the X box, type the new X location.•

• In the Y box, type the new Y location.•

4. Click in the canvas or click ENTER.4.

To move an element or group vertically or horizontally using the mouse
1. Shift + click to select the element or group you want to move.1.

2. Drag the elements or group to the new location.2.

To move an element or group vertically or horizontally using the keyboard
1. Select the element or group you want to move.1.

2. Do one of the following:2.

• Press the Up or Down arrow keys to move the element or group vertically by one unit in the grid.•

• Press the Left or Right arrow keys to move the element or group horizontally by one unit in the grid.•

You can move the element or group by two units in the grid by additionally pressing the Shift key, by four units by
additionally pressing the Ctrl key, and by 10 units by additionally pressing both keys.

To move multiple elements or groups
1. Select the elements and/or groups.1.

2. Move them as you would with one single element. The elements are moved together and maintain their2.
spatial relationship when moving.

Aligning Elements
After you draw elements, you can align them:

• Horizontally so that their top or bottom sides or their center points are horizontally aligned.•

• Vertically so that their left, right, or center points are vertically aligned.•

• So that their center points are on top of each other.•

• So that their points of origin are on top of each other.•

When you align elements, the secondary elements are moved so that they align with the primary element. For
more information about primary and secondary elements, see Selecting Elements.

Aligning Elements Horizontally
You can align multiple elements by their top or bottom sides or horizontally on their middle points.
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To align elements by their top sides
1. Select all elements that you want to align. The element you want to align all other elements to, has to be the1.

primary element.

2. On the Arrange menu, point to Align, and then click Align Top. The secondary elements are moved so that2.
their top sides are aligned with the top side of the primary element.

To align elements by their bottom sides
1. Select all elements that you want to align. The element you want to align all other elements to, has to be the1.

primary element.

2. On the Arrange menu, point to Align, and then click Align Bottom. The secondary elements are moved so2.
that their bottom sides are aligned with the bottom side of the primary element.

To align elements horizontally by their center points
1. Select all elements that you want to align. The element you want to align all other elements to, has to be the1.

primary element.

2. On the Arrange menu, point to Align, and then click Align Middle. The secondary elements are moved2.
vertically so that their center points are aligned with the center point of the primary element.
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Aligning Elements Vertically
You can vertically align multiple elements on the left, right, or their center points.

To align elements by their left sides
1. Select all elements that you want to align. The element you want to align all other elements to, has to be the1.

primary element.

2. On the Arrange menu, point to Align, and then click Align Left. The secondary elements are moved so that2.
their left sides are aligned with the left side of the primary element.

To align elements by their right sides
1. Select all elements that you want to align. The element you want to align all other elements to, has to be the1.

primary element.

2. On the Arrange menu, point to Align, and then click Align Right. The secondary elements are moved so that2.
their right sides are aligned with the right side of the primary element.

To align elements vertically by their centers
1. Select all elements that you want to align. The element you want to align all other elements to, has to be the1.

primary element.

2. On the Arrange menu, point to Align, and then click Align Center. The secondary elements are moved2.
horizontally so that their center points are aligned with the center point of the primary element.
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Aligning Elements by their Center Points
You can align elements by their center points. The center point of one or more elements is the point halfway
between the horizontal and vertical boundaries.

To align elements on their center points
1. Select all elements that you want to align. The element you want to align all other elements to, has to be the1.

primary element.

2. On the Arrange menu, point to Align, and then click Align Centers. The secondary elements are moved so2.
that their center points are placed on top of the center point of the primary element.

Aligning Elements by their Points of Origin
You can align elements by their points of origin. By default, the element’s center point if the point of origin. But,
an element’s center point can be changed. The center point is the anchor point of an element to the canvas.

To align elements on their points of origin
1. Select all elements that you want to align. The element you want to align all other elements to, has to be the1.

primary element.

2. On the Arrange menu, point to Align, and then click Align Origins. The secondary elements are moved so2.
that their points of origins are placed on top of the point of origin of the primary element.

Adjusting the Spacing between Elements
You can adjust the space between elements according to specific rules.

You can adjust the spacing between elements in the following ways:

• Horizontally - moves the selected elements left or right without changing the vertical positions.•
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• Vertically - moves the selected elements up or down without changing the horizontal positions.•

• Distribution - moves the selected elements so that their center points are distributed in equal distance to•
each other.

• Equal spacing - moves the selected elements so that the distance between their edges is equal.•

• Increase spacing - moves all selected elements one pixel further away from each other. The primary element•
does not move.

• Decrease spacing - moves all selected elements one pixel closer toward each other. The primary element•
does not move.

• Remove spacing - removes all space between selected elements so that their edges touch.•

Distributing Elements
You can distribute elements so that their center points are distributed in equal distance to each other.

To distribute elements horizontally
1. Select at least three elements.1.

2. On the Arrange menu, point to Space, and then click Distribute Horizontal. The selected elements are2.
distributed horizontally.

To distribute elements vertically
1. Select at least three elements.1.

2. On the Arrange menu, point to Space, and then click Distribute Vertical. The selected elements are2.
distributed vertically.

Making Space between Elements Equal
You can space elements so that the distances between their boundaries are equal.

The difference between making space between elements equal and distributing them is that making space equal
uses the boundaries of the elements, whereas distributing uses the center points. Both don't necessarily lead to
the same result.

To make the horizontal space between elements equal
1. Select at least three elements.1.

2. On the Arrange menu, point to Space, and then click Make Horizontal Space Equal. The selected elements2.
are moved so that the horizontal spaces between their boundaries are equal.

To make the vertical space between elements equal
1. Select at least three elements.1.

2. On the Arrange menu, point to Space, and then click Make Vertical Space Equal. The selected elements are2.
moved so that the vertical spaces between their boundaries are equal.

Increasing Space between Elements
You can increase space between elements equally.
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The primary element does not move. All secondary elements are moved away from the primary element.

To increase the horizontal space between elements
1. Select at least two elements.1.

2. On the Arrange menu, point to Space, and then click Increase Horizontal Spacing. The selected elements are2.
moved so that the horizontal space between them is increased by one pixel.

3. Repeat the previous step to move the selected elements further away from each other.3.

To increase the vertical space between elements
1. Select at least two elements.1.

2. On the Arrange menu, point to Space, and then click Increase Vertical Spacing. The selected elements are2.
moved so that the vertical space between them is increased by one pixel.

3. Repeat the previous step to move the selected elements further away from each other.3.

Decreasing Space between Elements
You can decrease space between elements equally.

The primary element does not move. All secondary elements move toward the primary element. You can move
them until the left sides of all elements are aligned.

To decrease the horizontal space between elements
1. Select at least two elements.1.

2. On the Arrange menu, point to Space, and then click Decrease Horizontal Spacing. The selected elements2.
are moved so that the horizontal space between them is decreased by one pixel.

3. Repeat the previous step to move the selected elements closer toward each other.3.

To decrease the vertical space between elements
1. Select at least two elements.1.

2. On the Arrange menu, point to Space, and then click Decrease Vertical Spacing. The selected elements are2.
moved so that the vertical space between them is decreased by one pixel.

3. Repeat the previous step to move the selected elements closer toward each other.3.

Removing All Space between Elements
You can remove all space between selected elements so that their boundaries touch.

The primary element does not move. All secondary elements move toward the primary element. You can move
them until the left and right sides of all secondary elements are aligned.

To remove all horizontal space between elements
1. Select all elements between which you want to remove the space.1.

2. On the Arrange menu, point to Space, and then click Remove Horizontal Spacing. The horizontal space2.
between all selected elements is removed, so that their boundaries touch.

© 2022 AVEVA Group plc and its subsidiaries. All rights reserved.
  

Page 46

AVEVA™ Industrial Graphic Editor User Guide 
Chapter 3 – Graphic Elements



To remove all vertical space between elements
1. Select all elements between which you want to remove the space.1.

2. On the Arrange menu, point to Space, and then click Remove Vertical Spacing. The vertical space between2.
all selected elements is removed, so that their boundaries touch.

Resizing Elements
You can resize selected elements by:

• Dragging the handles of a single element to increase or decrease its horizontal or vertical size.•

• Changing the Width and Height properties of one or more elements using the Properties Editor.•

• Proportionally resizing multiple elements.•

• Making multiple objects the same width and/or height.•

Some elements cannot be resized or can only be resized in certain directions, such as the Calendar control or
DateTime Picker. If the primary element has such restrictions, then any secondary elements resize proportional
to the change in primary element's size and don't resize independently.

Resizing a Single Element with the Mouse
You can resize a single selected element with the mouse.

You can resize most elements to any given width and height, or to a fixed width to height ratio.

To resize a single selected element with the mouse
1. Select an element. The handles of the selected element appear.1.

2. Drag one of the handles. The object is resized while you drag.2.

3. Release the mouse button.3.

To resize a single selected element with the mouse and keeping a fixed width/height ratio
1. Select an element. The handles of the selected element appear.1.

2. Press and hold the Shift key.2.

3. Drag one of the handles. The object is resized while you drag, the width/height ratio stays unchanged.3.

4. Release the mouse button and Shift key.4.

Resizing Elements by Changing Size Properties
You can resize one or more elements by changing the width and/or height property of the selected elements.

To resize elements by changing their size properties
1. Select one or more elements.1.

2. In the Properties Editor, type a value for Width and for Height. The selected elements are resized2.
accordingly.
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Resizing Elements Proportionally
You can resize multiple elements proportionally on the canvas. One element is the primary element you can use
to resize. The secondary elements resize proportionally to the change of the primary element.

To resize elements proportionally
1. Select multiple elements.1.

2. Drag one of the handles of the primary element. The secondary elements are resized accordingly by the2.
same percentage.

3. Release the mouse button.3.

For example, assume the primary element is 100 pixels wide and 50 pixels high. A secondary element is 200
pixels wide and 20 pixels high.

You drag the handle of the primary element so that it is 120 pixels wide (20 percent increase) and 100 pixels high
(100 percent increase).

Then the secondary element is resized to 240 pixels wide (20 percent increase of the original width of 200 pixels)
and 40 pixels high (100 percent increase of the original width of 20 pixels).

Making Elements the Same Width, Height, or Size
You can make elements the same width, height, or size.

To make elements the same width
1. Select at least two elements. The primary element is the element with the target width for all elements.1.

2. On the Arrange menu, point to Size, and then click Make Same Width. The width of the secondary elements2.
are resized to the same width as the primary element.

To make elements the same height
1. Select at least two elements. The primary element is the element with the target height for all elements.1.

2. On the Arrange menu, point to Size, and then click Make Same Height. The height of the secondary2.
elements are resized to the same height as the primary element.

To make elements the same size
1. Select at least two elements. The primary element is the element with the target size for all elements.1.

2. On the Arrange menu, point to Size, and then click Make Same Size. The size of the secondary elements are2.
resized to the same size as the primary element.

Adjusting the z-Order of Elements
The z-order of elements specifies which element appears on top of other elements when the elements overlap
on the canvas. The z-order also determines how the elements of a path graphic connect.

When you place new elements on the canvas, they are placed at the top and can cover all other elements.

However, you might want to bring certain elements forward so that they are always visible or overlap certain
other elements. Or you may want to use a large background element behind all other elements. You can:
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• Bring one or more elements to the very front.•

• Send one or more elements to the very back.•

• Bring one or more elements one level forward.•

• Send one or more elements one level backward.•

You can use the Elements List to see or change the z-order of the elements.

To bring selected elements to the front
• On the Arrange menu, point to Order, and then click Bring To Front. The selected elements are brought to•

the front. They don't change their relative z-order.

To send selected elements to the back
• On the Arrange menu, point to Order, and then click Send To Back. The selected elements are sent to the•

back. They don't change their relative z-order.

To bring selected elements one level forward
• On the Arrange menu, point to Order, and then click Bring Forward.•

To send selected elements one level backward
• On the Arrange menu, point to Order, and then click Bring Backward.•
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Rotating Elements
You can rotate elements to any orientation (0 - 359 degrees):

• Graphically with the rotation handle.•

• Numerically by typing the orientation angle in the Properties Editor.•

• By rotating in 90 degree increments in a clockwise or counter-clockwise direction.•

The element rotates around its point of origin. By default, the point of origin is in the center of the element. You
can move the point of origin to any other location, even outside of the object itself. To change the point of origin,
see Moving the Origin of an Element.

Rotating Elements with the Mouse
You can rotate one or more elements with the mouse. If you select multiple elements, you can rotate the
primary element. The secondary elements rotate in unison with the primary element.

You can rotate elements:

• Freely in the range 0 to 359 in integer degrees.•

• In multiples of 15 degrees.•

• In multiples of 45 degrees.•

You can rotate an element with the rotation handle. The rotation handle is a light-blue circle at the top of a
selected element.

To rotate elements freely with the mouse
1. Select one or more elements.1.

2. Grab the rotation handle of the primary element.2.

3. Drag the mouse across the screen. All selected elements are rotated around their own points of origin as you3.
move the mouse.

4. Release the mouse button.4.

To rotate elements by multiple of 15 degrees with the mouse
1. Select one or more elements.1.

2. Grab the rotation handle of the primary element.2.

3. Press and hold the Shift key.3.
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4. Drag the mouse across the screen. All selected elements are rotated in multiples of 15 degrees around their4.
own points or origin as you move the mouse.

5. Release the mouse button and Shift key.5.

To rotate elements by multiple of 45 degrees with the mouse
1. Select one or more elements.1.

2. Grab the rotation handle of the primary element.2.

3. Press and hold the Ctrl key.3.

4. Drag the mouse across the screen. All selected elements are rotated in multiples of 45 degrees around their4.
own points or origin as you move the mouse.

5. Release the mouse button and Ctrl key.5.

Rotating Elements by Changing the Angle Property
You can change the angle property of one or more selected elements.

To rotate elements by changing the angle property
1. Select one or more elements.1.

2. In the Properties Editor, type a value in the Angle box.2.

3. Click Enter. The selected elements rotate to the specified angle.3.

Rotating Elements by 90 Degrees
You can rotate elements in 90 degrees clockwise or counter-clockwise increments.

To rotate elements by multiples of 15 and 45 degrees, see Rotating Elements with the Mouse.

To rotate elements by 90 degrees clockwise
1. Select one or more elements.1.

2. On the Arrange menu, point to Transform, and then click Rotate Clockwise. The selected elements rotate by2.
90 degrees clockwise.

To rotate elements by 90 degrees counter-clockwise
1. Select one or more elements.1.

2. On the Arrange menu, point to Transform, and then click Rotate Counter Clockwise. The selected elements2.
rotate by 90 degrees counter-clockwise.

Moving the Origin of an Element
You can change the point of origin of any element. The point of origin specifies around which point the element
rotates or flips. By default the point of origin is in the center of the element.

You can change the point of origin:

• With the mouse on the canvas.•

• By specifying the absolute origin in the Properties Editor.•
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• By specifying the relative origin in the Properties Editor.•

Changing Points of Origin with the Mouse
You can change the point of origin for an element with the mouse.

To change the point of origin for an element with the mouse
1. Select an element on the canvas.1.

2. Move the mouse over the rotation handle of the element. The point of origin icon for the element appears.2.

3. Drag the Point of Origin icon to where you want to place the new point of origin for the element.3.

4. Release the mouse button.4.

Changing Points of Origin in the Properties Editor
You can change the absolute or relative point of origin in the Properties Editor.

The absolute point of origin shows the position of the point of origin in relation to the canvas. The absolute point
of origin changes when the element moves.

The relative point of origin shows the position of the point of origin in relation to the center of the element. The
relative point of origin does not change when the element moves.

To change the point of origin in the Properties Editor
1. Select one or more elements on the canvas.1.

2. In the Properties Editor, do one of the following:2.

• Type the absolute coordinates in the x, y format for the point of origin.•

• Type the relative coordinates in the x, y format for the point of origin.•

3. Click Enter. The points of origin move to the specified absolute position or to the specified position in3.
relation to the center points of the selected elements.

For example, if you have two elements, you can set the relative point of origin to 10, 10 to place the points of
origin for both elements 10 pixels to the right and 10 pixels below the corresponding center points of each
element.

Add Connectors Between Graphic Elements
A connector is a line drawn between graphic elements. A connector starts at a connection point on one graphic
element and ends at a connection point on another element. Connectors are particularly useful for complex
graphics like flow diagrams, industrial piping, or electrical wiring diagrams that incorporate many lines between
graphic elements.
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Connectors change length or orientation in response to changes to connected graphic elements during design
time or run time. Graphic elements within a graphic can be moved, resized, or rotated and still maintain the
connector between elements.

Connection points are the locations on a graphic element to attach a connector. A default set of eight connection
points appear on the bounding rectangle around a graphic element or an embedded graphic.

You can also add custom connection points to graphic elements or embedded graphics if you want to place a
connector at a different position than on a bounding rectangle.

One or more control points appear on an Angled connector based on the number of angles in the connector
path. Using your mouse, you can move a control point horizontally or vertically to change the shape of a
connector between the fixed connection points on both graphic elements. By default, a control point is placed at
the intersection point of each right angle in a connector.

Connector lines don't maintain their horizontal and vertical orientation with 90 degree angles when placed in a
graphic whose dimensions exceed 1280 by 1280 pixels. Instead, the connector will revert to a straight line
between connection points.

You can also add control points to a connector if you want to change the shape of its path. For more information
about adding control points to a connector, see Change the Shape of a Connector.

Draw a Connector
Use the Connector tool to draw a connector between graphic elements. The Connector tool initially attempts to
draw a connector with a minimum number of angles. You can change the shape of the initial connector path
using control points to redraw the path if necessary.
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A connector supports Symbol Wizards like any other graphic element. You can associate a connector with a
Symbol Wizard layer by dragging the connector element to the layer during design time. You can also remove the
connector from a layer by removing the connector from the association list. If a connector is hidden based on the
Symbol Wizard’s Wizard Option configuration, the connector does not appear during run time.

Press the Esc key to cancel drawing a connector. Also, clicking on the Industrial Graphic Editor’s canvas takes you
out of connector drawing mode.

To draw a connector
1. Open a graphic in Industrial Graphic Editor that you want to add a connector.1.

2. Click once on the Connector icon within the Tools pane to draw a single connector.2.

If you want to draw multiple connectors, double click on the Connector icon.

3. Move your mouse over the first graphic element that you want to add a connector.3.

The default connection points appear when you move your mouse over a graphic element.

4. Place the mouse over the connection point where you want to place the connector on the graphic element.4.

A green rectangle appears around the connection point when it is selected.

A start connection point has an automatic offset, which is a perpendicular straight line segment from the
start connection point to the first angle in the connector path. An automatic offset prevents the connector
from following the border of the originating graphic element. No automatic offset is applied to the
terminating connection point on the connected graphic element.

5. Press and hold your left mouse key and drag the mouse to the second graphic element.5.

Connection points appear when you move the mouse over the second graphic element.

6. Release the mouse button when you are over a selected connection point on the second graphic element.6.

The connector appears as a line between both graphic elements.

7. If necessary, use connector control points to change the shape of the connector between the connected7.
graphic elements.
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Adding Connection Points
Use the Connection Point tool to place additional connection points at other locations on a graphic element than
the bounding rectangle. Also, you can place custom connection points on an embedded graphic and connect to
them.

Custom connection points are part of the parent graphic element and cannot be grouped. Also, custom
connection points added to a graphic element that is part of a Symbol Wizard layer are shown when the graphic
element is part of the Symbol Wizard’s current configuration.

Press the Esc key to cancel adding a connection point. Also, clicking on the Industrial Graphic Editor’s canvas
takes you out of connection point addition mode.

To add connection points
1. Open a graphic that you want to add one or more connection points.1.

2. Click once on the Connection Point icon from the Tools pane to draw a single connection point on a graphic2.
element.

If you want to draw multiple connection points, double click on the Connection Point icon.

3. Move your mouse to a location within a graphic element that you want to place a new connection point.3.

Connection points can be added within the bounding rectangle of a hosting element of an embedded
graphic.

4. Click once.4.

The new connection point appears as a green rectangle at the location you selected.

To change the position of a connection point
You can change the position of a connection point that you added to a graphic element or a graphic.

1. Click on the connection point you want to move to select it.1.

2. Keep the left mouse key pressed.2.

3. Drag the connection point to a new location and release the mouse key.3.

The X and Y properties show the coordinate position of the connection point.

You can also change the location of a connection point you added by changing the X and Y coordinate values
assigned to the connection point’s X and Y properties.

Change Connector Properties
A connector includes a set of Appearance, Line Style, and Runtime Behavior properties. These properties can be
modified during design time.

During run time, you can use animation to change property values that affect the appearance or
behavior of a connector. For Angled or Straight connectors, you can use Line Style or Element Style
animation. A connection point does not support any type of animation.

Property Description

Appearance Properties
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Property Description

ConnectionType Type of connector (Angled or Straight). Angled is the default, which contains a set
of connector line segments with 90 degree angles between them.

ElementStyle Element style applied to a connector to change the line color, fill, and pattern.
Line styles can be applied to Angled and Straight types of connectors. None is the
default.

X Horizontal coordinate of the left most border of a selected graphic element or
graphic that has an attached connector.The X coordinate value is the number of
pixels between the left vertical border of the Industrial Graphic Editor's canvas
area to the left most border position of the selected graphic element or graphic.

Y Vertical coordinate of the top border of a selected graphic element or graphic that
has an attached connector.The Y coordinate value is the number of pixels between
the top horizontal border of the Industrial Graphic Editor's canvas area to the top
of the selected graphic element or graphic.

Start Read-only X and Y coordinates of a connector’s start point with respect to the
origin at the top left corner of the Industrial Graphic Editor’s canvas.

End Read-only X and Y coordinates of a connector’s end point with respect to the
origin at the top left corner of the Industrial Graphic Editor’s canvas.

Line Style Properties

LineWeight Line weight of an Angled or Straight type of connector. 1 is the default.

LinePattern Line pattern of an Angled or Straight type of connector. Solid is the default.

StartCap Shape of the line start point of an Angled or Straight type of connector. Flat is the
default.

EndCap Shape of line end point of an Angled or Straight type of connector. Flat is the
default.

LineColor Line color of an Angled or Straight type of connector. Black is the default.

Runtime Behavior Properties

Enabled Connector animation is enabled or disabled during run time. Enabled is the
default.

Visible Connector is visible or hidden during run time. Visible is the default.

Change the Type of Connector
You can select the type of connector by setting an option for the ConnectionType property in the Appearance
pane of the Industrial Graphic Editor.
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The default connector type is Angled, which consists of horizontal and vertical lines with a 90 degree angle
between them. A Straight connector is a straight line between the connection points on different graphic
elements.

To change the type of connector
1. Click on a connector to select it.1.

The Connection Type property appears in the Appearance pane of the Industrial Graphic Editor.

2. Select a connector type from the drop-down list of the Connection property.2.

The appearance of the selected connector changes to the type you selected.

Change the Length of a Connector
You can change the length of a connector to move it to another connection point on a graphic element or detach
it from a graphic element.

A connector is not required to start or end at a connection point on a graphic element. Connectors can be drawn
on the canvas detached from any graphic elements.

To change the length of a connector
1. Click on a connector to select it.1.

The start point of a connector appears as a green circle. A halo appears around the end point.

2. Select either the start or end point of the connector and keep your left mouse key pressed.2.

3. Drag the start or end point of a connector to a new location and release the mouse key.3.

The length of the connector changes until you release your mouse key. The Start or End properties show a
new coordinate position based on whether you moved the connector’s start or end point.

You can also change the location of a connector’s start or end points by changing the X and Y coordinate
values assigned to the connector’s Start or End properties.

Change the Shape of a Connector
An Angled connector includes one or more control points that can be moved to change the shape of a connector.
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The movement of control points is restricted to changing the shape of the connector without changing the fixed
position of the connection points on graphic elements. For example, the two control points shown in the figure
below are part of an Angled connector. Both control points can be moved horizontally to the same X coordinate
position to change the position of the vertical line segment of the connector.

But, the line segments from the connection points of the graphic elements to their adjacent control points
cannot be moved. In the following example, the control points cannot be moved vertically. To maintain the
required right angles between line segments of an Angled connector would require the locations of the fixed
connection points to be moved.

To change the shape of a connector
1. Click on a connector to select it.1.

A control point appears at the intersection point of each right angle in an Angled connector.

2. Click a control point and keep your mouse key pressed.2.

The mouse cursor changes to a double arrow to indicate the control point can be moved.

3. Move the control point to change the shape of the connector and release the mouse key.3.

Delete a Control Point
If you want to remove a control point to change the shape of your connector, first reposition a line segment so
that the resulting connector path contains only right angles before deleting a control point.

In the following example, a line segment needs to be repositioned vertically or horizontally so that the connector
contains only right angles. After a line segment is repositioned, a control point can be deleted.
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To delete a control point
1. Click on a connector to select it.1.

2. Move a line segment within the connector; so the connector path contains only right angles between its line2.
segments.

3. With your Ctrl key pressed, place your cursor over the control point on the connector you want to delete.3.

The appearance of the cursor changes to a pen tip with a minus sign to indicate that a control point can be
deleted from a connector.

Control points at the right angles of a connector cannot be deleted. You can only remove control points on
straight line segments.

4. Left click with your mouse to delete the control point.4.

The small blue circle on the connector disappears indicating the control point is deleted from the connector.

Flipping Elements
You can flip elements on their horizontal or vertical axes. The axis for each element is determined by its point of
origin. For more information on how to change the point of origin, see Moving the Origin of an Element.

To flip elements vertically
1. Select one or more elements.1.

2. On the Arrange menu, point to Transform, and then click Flip Vertical. The selected elements are flipped2.
vertically on their horizontal axis.

To flip elements horizontally
1. Select one or more elements.1.

2. On the Arrange menu, point to Transform, and then click Flip Horizontal. The selected elements are flipped2.
horizontally on their vertical axis.
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Locking and Unlocking Elements
When you lock elements, they cannot be:

• Moved.•

• Resized.•

• Rotated.•

• Aligned.•

• Flipped.•

You also cannot change the point of origin in locked elements. To enable these functions again, unlock the
elements.

To lock elements
1. Select all elements that you want to lock.1.

2. Do one of the following:2.

• On the Arrange menu, click Lock.•

• In the Properties Editor, set the Locked property to True.•

The selected elements appear with lock icons at their handles.

To unlock elements
1. Select all elements that you want to unlock.1.

2. Do one of the following:2.

• On the Arrange menu, click Unlock.•

• In the Properties Editor, set the Locked property to False.•

The lock icons disappear from the handles of the selected elements.

Making Changes Using Undo and Redo
Use the Undo function to reverse an editing change you made to a graphic element in the Industrial Graphic
Editor. After you undo a change, you can also restore the change by using the Redo function. The Undo and Redo
functions appear as icons on the Industrial Graphic Editor's Edit menu.

You can undo one single change, or any number of changes that you have previously made. You can also redo
any number of changes. These can be selected from a list.

To undo a single change
• Do one of the following:•

▪ Press Ctrl + Z.▪

▪ On the Edit menu, click Undo.▪
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To redo a single change
• Do one of the following:•

▪ Press Ctrl + Y.▪

▪ On the Edit menu, click Redo.▪

To undo a specified number of previous changes
1. On the toolbar, click the Undo icon. The Undo list appears with one or more descriptions of what changes1.

were made.

2. Select a change from the list or click the bottom list entry to undo all changes. The changes up to and2.
including the selected item are undone.

To redo a specified number of previously undone changes
1. On the toolbar, click the Redo icon. The Redo list appears with a description of the undone changes.1.

2. Select a the change from the list or click the bottom list entry to redo all changes. The changes down to and2.
including the selected item are redone.

Working with Groups of Elements
You can group together multiple elements. This is useful to bind certain element together so that they are not
inadvertently moved. The group is treated as a new element.

You can:

• Create a group from one or more elements.•

• Ungroup the elements without losing their original configuration information.•

• Add more elements to an existing group.•

• Remove elements from a group.•

• Edit the elements of a group without having to ungroup them.•

Creating a Group of Elements
After you create elements, you can group them. Grouping elements lets you manage the elements as one unit.

Groups are assigned default names when you create them, such as Group1, Group2, and so on. After you create
a group, you can rename it.

Groups can have properties that are different than the properties of the elements.
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To create a group
1. Select the elements you want as part of the new group.1.

2. On the Arrange menu, point to Grouping, and then click Group. The elements are combined into a group.2.
The group is listed in the Elements List.

3. Rename the group as required. To do this:3.

a. In the Elements List, click the group name and click again. The group name is in edit mode.a.

b. Type a new name and click Enter. The group is renamed.b.

c. You can also rename a group or elements by changing the Name property in the Properties Editor.c.

Ungrouping
After you create a group, you can ungroup it if you no longer want it.

If the group included elements and other groups, when you ungroup, the original elements and groups again
exist as independent items. To ungroup any subgroups, select each one and ungroup it separately.

If you ungroup a set of elements and elements already exist with the names of the grouped elements, then the
newly ungrouped elements are renamed.

To ungroup
1. Select the groups you want to ungroup.1.

2. On the Arrange menu, point to Grouping, and then click Ungroup. The groups is converted to the original2.
elements. The group name is removed from the Elements List and the element names appear.

Adding Elements to Existing Groups
After you create a group, you can add elements or other groups to an existing group.

For example, you can combine a group that represents a valve with another group that represents a tank to
create a new group that can be called a tank unit.

You can add:

• Elements to groups.•

• Groups to the primary selected group.•

To add elements to an existing group
• On the canvas, select the group and also elements and groups that you want to add.•

• Right-click a selected element or on the group, point to Grouping, and then click Add to Group. The selected•
elements are added to the group.

You can also add elements to existing groups by using the Elements List in similar way.

Removing Elements from Groups
After you create a group, you can remove elements from the group. This lets you remove one or more elements
you no longer want in that group.
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Removing elements from the group removes them from the canvas. It also removes any scripts or animations
you added to the element.

To remove an element from a group
1. On the canvas, select the group with the elements that you want to remove.1.

2. Click the group again to enter inline editing mode.2.

3. Select the elements that you want to remove from the group.3.

4. Right-click a selected elements, point to Grouping, and then click Remove from Group. The selected4.
elements are removed from the group.

You can also remove elements from existing groups by using the Elements List in similar way.

Editing Components within a Group
You can edit components within a group without having to dissolve the group. Do this by:

• Selecting the element in Elements List.•

• Using the Edit Group command on the shortcut menu.•

• Slowly double-clicking to enter inline editing mode.•

To edit components within a group by using the Elements List
1. In the Elements List, expand the group that contains the element that you want to edit.1.

2. Select the element that you want to edit. The element appears selected in the group and the group is2.
outlined with a diagonal pattern.

3. Edit the element with the Properties Editor, by mouse or by menu according to your requirements.3.

4. Click outside the group.4.

To edit components within a group by using the Edit Group command
1. On the canvas, select the group that you want to edit.1.

2. On the menu Edit, click Edit Group ‘GroupName’. The group is outlined with a diagonal pattern.2.

3. Select the element that you want to edit.3.

4. Edit the element with the Properties Editor, by mouse, by menu or pop-up menu according to your4.
requirements.

5. Click outside the group.5.

If you move the position of an element in a group outside the group, the group size is automatically changed to
incorporate the new position of the element.

Using Path Graphics
You can join a set of open elements, such as lines, to create a new closed element. The new closed element is
called a path graphic.

You can:

• Create a path graphic by joining open elements.•
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• Break the path graphic into its elements.•

• Edit the path graphic in its entirety or by editing its elements.•

• Add new elements to the path graphic.•

• Remove elements from the path graphic.•

You can view a path graphic in two modes:

• Element mode shows you the individual elements contained in the path graphic and determine its shape.•
Elements that make up the path graphic are shown as blue lines. The points where the elements are
connected are shown as grey lines.

• Path mode shows you the path graphic in its final rendering, including fill styles and lines styles.•

When you are in inline editing mode, you can switch between both modes by pressing the space bar. This lets
you preview the path graphic without leaving the inline editing mode.

Creating a Path Graphic
You can create a path graphic from one or more open elements such as lines, polylines, curves, and arcs.

The path graphic is created according to the start and end points and the z-order of the open elements that
create it.

For example, if you draw a line from point A to point B, then an arc from point C to point D, and then join these
elements in a path graphic, the path graphic is described by a straight edge from points A to B, a straight edge
from points B to C, a curved edge from points C to D, and closed by a straight edge from points D to A.

If the Path Graphic doesn’t appear as you expected after you create it, then you can swap the end points or
change the z-order of one or more elements. For more information, see Swapping the End Points of an Element
in a Path Graphic and Changing the Z-order of an Element in a Path Graphic.
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To create a path graphic
1. Select one or more open elements.1.

2. On the Arrange menu, point to Path, and then click Combine. A new path graphic is created from the2.
selected open elements.

Breaking the Path of a Path Graphic
You can break the path of a path graphic so that it is broken into its individual open elements. When you do so,
the path graphic loses its unique properties such as fill style and line style.

To break the path of a path graphic
1. Select one or more path graphics.1.

2. On the Arrange menu, point to Path, and then click Break.2.

Changing a Path Graphic
You can edit an existing path graphic on the canvas by accessing the individual elements of which it consists. For
each individual element, you can:

• Move.•

• Rotate.•

• Change size.•

• Change start and sweep angles if the elements are arcs.•

• Change control points if the elements are curves or polylines.•

• Swap the end points of an element in a path graphic.•

• Change the z-order or the elements in a path graphic.•

The path graphic is updated while you edit the individual elements.

Moving Elements in a Path Graphic
You can move elements in a path graphic. If you move an element outside of the path graphic boundary, the
boundary is redrawn to include the moved element.

To move an element within a path graphic
1. Select the path graphic you want to edit.1.

2. Do one of the following:2.

a. On the Edit menu, click Edit Path.a.

b. Slowly double-click the path graphic.b.

The path graphic appears in element mode.

3. Select the individual element within the path graphic you want to move. You can also do this by selecting the3.
element in the Elements List.

4. Click a solid part of the element and drag it to the new position. The element is moved.4.
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5. Click outside the path graphic on the canvas. The path graphic is shown in path mode.5.

Resizing Elements in a Path Graphic
You can resize elements in a path graphics. If you resize an element outside of the path graphic boundary, the
boundary is redrawn to include the resized element.

To resize an element within a path graphic
1. Select the path graphic you want to edit.1.

2. Do one of the following:2.

a. On the Edit menu, click Edit Path.a.

b. Slowly double-click the path graphic.b.

The path graphic appears in element mode.

3. Select the individual element within the path graphic you want to resize. You can also do this by selecting the3.
element in the Elements List.

4. Click and drag any of the resize handles of the selected element. The element is resized.4.

5. Click outside the path graphic on the canvas. The path graphic is shown in path mode.5.

Editing Start and Sweep Angles of Elements in a Path Graphic
If your path graphic contains arcs, you can edit the start and sweep angles of these elements. If changing the
angle of an element causes it to overlap the path graphic boundary, the boundary is redrawn to include the
changed element.

To edit start or sweep angle of an element within a path graphic
1. Select the path graphic you want to edit.1.

2. Do one of the following:2.

a. On the Edit menu, click Edit Path.a.

b. Slowly double-click the path graphic.b.

The path graphic appears in element mode.

3. Select the individual element within the path graphic for which you want to change the start or sweep angle.3.
You can also do this by selecting the element in the Elements List.

4. Click the element again. The element appears in edit mode with its start angle and sweep angle.4.

5. Click outside the path graphic on the canvas. The path graphic is shown in path mode.5.

Editing Element Control Points in a Path Graphic
If your path graphic contains curves or polylines, you can edit the control points of these elements. If changing
the control points of the element causes it to overlap the path graphic boundary, the boundary is redrawn to
include the changed element.

To edit control points of an element within a path graphic
1. Select the path graphic you want to edit.1.
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2. Do one of the following:2.

a. On the Edit menu, click Edit Path.a.

b. Slowly double-click the path graphic.b.

The path graphic appears in element mode.

3. Select the curve or polyline element within the path graphic for which you want to change the control3.
points. You can also do this by selecting the element in the Elements List.

4. Click the element again. The element appears in edit mode with its control points.4.

5. Drag any of the control points to shape the curve or polyline.5.

6. Click outside the path graphic on the canvas. The path graphic is shown in path mode.6.

Swapping the End Points of an Element in a Path Graphic
The path graphic is created by following the direction in which you draw its elements.

If a path graphic does not appear as expected, this can be caused by drawing an element in a different direction
as intended. You can see this if one of the path graphic edges appears crossed over when connecting to the
previous and next element.

You can fix this by swapping the end points of the element where this appears.

To swap the end points of an element within a path graphic
1. Select the path graphic you want to edit.1.

2. Do one of the following:2.

a. On the Edit menu, click Edit Path.a.

b. Slowly double-click the path graphic.b.

The path graphic appears in element mode.

3. Select the individual element within the path graphic for which you want to swap the end points. You can3.
also do this by selecting the element in the Elements List.

4. Right-click that element and select Path, Swap End Points on the context menu. The end points of the4.
selected element are swapped and the path graphic is updated accordingly.
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5. Click outside the path graphic on the canvas. The path graphic is shown in path mode.5.

Changing the Z-order of an Element in a Path Graphic
If a path graphic does not appear as expected, this can be caused by drawing an element in a different z-order as
intended. You can see this if one of the path graphic edges jumps across the path graphic area.

You can fix this by changing the z-order of the element where this appears.

The z-order of elements in a path graphic is only applicable within the path graphic.

To change the z-order of an element within a path graphic
1. Select the path graphic you want to edit.1.

2. Do one of the following:2.

a. On the Edit menu, click Edit Path.a.

b. Slowly double-click the path graphic.b.

The path graphic appears in element mode.

3. Select the individual element within the path graphic for which you want to change the z-order. You can also3.
do this by selecting the element in the Elements List.

You can see the elements in their z-order in the Elements List. Alternatively, you can select one from the
Elements List and change its z-order.

4. On the Arrange menu, point to Order, and then click:4.

• Send To Back to send the element to the back of the set of elements of the path graphic.•

• Send Backward to send the element one order backward.•

• Sent To Front to send the element to the front of the set of elements of the path graphic.•

• Send Forward to send the element one order forward.•

5. Click outside the path graphic on the canvas. The path graphic is shown in path mode.5.

Adding Elements to an Existing Path Graphic
You can easily add elements to an existing path graphic. You can add:
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• New elements, which you draw while the path graphic is in edit mode.•

• Existing elements, which are already on the canvas.•

You can only add open elements such as lines, polylines, curves, and arcs to an existing path graphic.

You can only set the origin of a new element within the frame of the existing path graphic. If you click anywhere
outside the path graphic, the edit mode is exited and the element you are drawing is a new element.

To add new elements to an existing path graphic
1. Select the path graphic to which you want to add a new element.1.

2. On the Edit menu, click Edit Path. The path graphic appears in element mode.2.

3. Select the new element you want to add from the Tools panel.3.

4. Draw the element as you would normally. While you are drawing the element, the path graphic is updated.4.

To add existing elements to an existing path graphic
1. Select the path graphic and all elements that you want to add to the path graphic.1.

2. Right-click a solid part of a selected element, point to Path, and then click Add To Path. The selected2.
elements are added to the selected path graphic.

Removing Elements from a Path Graphic
You can remove individual elements from a path graphic. The elements are not deleted, but appear outside the
path graphic.

You cannot remove the last element of a path graphic.

To remove elements from a path graphic
1. Select the path graphic from which you want to delete individual elements.1.

2. On the Edit menu, click Edit Path. The path graphic appears in element mode.2.

3. Shift + click one or more elements to remove.3.
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You can also select the elements to remove from the Elements List by holding CTRL key during the selection.

4. Right-click any selected element, point to Path, and then click Remove From Path. The selected element is4.
removed from the path graphic and the path graphic is updated accordingly.

Animating Graphic Elements
About Animations

You can use animations to change the appearance of graphic elements at run time. Animations are driven by
data that comes from attribute or tag values and expressions as well as element properties.

You can use:

• Visualization animations such as visibility, fill style, line style, text style, blinking, percent fill horizontal,•
percent fill vertical, horizontal location, vertical location, width, height, orientation, value display or tooltip.

• Interaction animations such as disable, user input, horizontal slider, vertical slider, pushbutton, action script,•
show graphic or hide graphic.

• Element-specific animations for the Status element and Windows common control elements.•

Each element in your Industrial graphic can have one or more animations. You can disable and enable individual
animations. You can also cut, copy and paste animations between elements. Only animations supported by the
target element are pasted.

You can also substitute references and strings in animations.

Not all animations are available for all element types. Some animations don't make logical sense, such as line
style with a text element. You cannot select or copy these invalid combinations.

Adding an Animation to an Element
You can add one or more animations to a single element in your Industrial graphic.

To add an animation to an element
1. Select the element to which you want to add an animation.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

You can also add an animation from the Animation Summary in the lower right corner of the Industrial
Graphic Editor.

3. Click the Add icon. The list of animations appears.3.

4. Select an animation from the list. The animation is added to the Animation list. You can configure the4.
selected animation from the Edit Animations dialog box.

Depending on the animation type, you may get an animation state selection panel instead. For more
information, see Reviewing which Animations are Assigned to an Element.

Reviewing which Animations are Assigned to an Element
You can review which animations are assigned to an element and change the number of animations or their
configuration at the same time.
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To review which animations are assigned to an element
1. Select the element. The assigned animations appear in the Animation Summary in the lower right of the1.

Industrial Graphic Editor.

You can also review which animations are assigned to an element by double-clicking it.

2. Select an animation to view further information on how the element is configured with that animation.2.

Showing and Hiding the Animation List
You can show or hide the Animation list. If you hide the Animation list, the configuration space expands, giving
you more space to configure the animations.

To hide the Animation list
• In the Edit Animations dialog box, click the Hide icon. The Animation list hides and the configuration space•

expands.

To show the Animation list
• In the Edit Animations dialog box, click the Show icon. The Animation list appears and the configuration•

space reduces to its default width.

Removing Animations from an Element
You can remove an animation from an element by using the Edit Animations dialog box. You can remove
animations from an element for:

• Individual animations•

• All animations at the same time•

To remove an animation from an element
1. Select the element in which you want to remove an animation.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

You can also remove an animation from the Animation Summary in the lower right of the Industrial Graphic
Editor.

3. Select the animation you want to remove from the Animation list.3.

4. Click the Remove icon. A message appears.4.

5. Click Yes. The animation is removed from the list and no longer associated with the element.5.

To remove all animations from an element
1. Select one or more elements from which you want to remove all animations.1.

2. Do one of the following:2.

• Right-click, point to Animations and then click Clear.•

• On the Edit menu, point to Animations, and then click Clear.•

All animations are removed from the selected elements.
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Enabling and Disabling Animations
You can enable or disable animations for an element. When you disable an animation, its configuration is not
lost. This lets you see, for example, each animation independently from each other.

To disable an animation
1. Select the element with the animation you want to disable.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

You can also disable animations from the Animation Summary in the lower right corner of the Industrial
Graphic Editor.

3. Locate the animation you want to disable from the Animation list on the left of the dialog box.3.

4. Select Disabled from the list of that row.4.

5. Repeat for any other animations you want to disable and click OK when you are done.5.

To enable an animation
1. Select the element with the animation you want to enable.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

You can also enable animations from the Animation Summary of the Industrial Graphic Editor.

3. Locate the animation you want to enable from the Animation list.3.

4. Select Enabled from the list of that row.4.

5. Repeat for any other animations you want to enable and click OK when you are done.5.

Validating the Configuration of an Animation
You can validate the configuration of an animation. If the configuration contains an error, an exclamation mark
appears next to the Animation icon.

Examples of animation configuration errors include:

• Animation is disabled•

• Syntax errors such as data mismatches•

• Required values not specified•

• Specified values out of valid range•

To validate the configuration of an animation
1. Select the element that contains the animations you want to validate.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Select the animation you want to validate.3.

4. Click the Validate icon. The currently selected animation is validated. Possible errors are highlighted.4.

Clearing the Configuration from an Animation
You can clear all data from the configuration boxes of an animation and reset the settings to their defaults.
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To clear all data from the configuration boxes of an animation
1. In the Edit Animations dialog box, select the animation.1.

2. In the configuration panel, click the Clear icon. All data from the configuration boxes is cleared and the2.
settings are reset to their defaults.

Managing Animations
You can easily manage animations in the Edit Animations dialog box. You can:

• Change the way the list of animations appears.•

• Switch easily between multiple animations of an element.•

You can also do this for the Animation Summary in the lower right corner of the Industrial Graphic Editor.

Organizing the Animation List
You can organize the list of animations alphabetically or by category.

To organize the Animation list
• In the Edit Animations dialog box, click the:•

▪ Alphabetic sort icon to sort alphabetically.▪

▪ Category icon to sort by category.▪

Switching between Animations
If you configure more than one animation for an element, you can easily switch between their configuration
panels without having to use the Animation list. This is particularly useful when the Animation list is hidden.

To switch between animations
• In the Edit Animations dialog box, on the configuration panel click the left or right arrow icon.•

The configuration panel changes to the configuration panel of the previous or next animation.

Configuring Bit State Animations
The following sections will describe the basic working of the bit state animation. For information on individual
animations, refer to the corresponding animation sections of this document. Bit state animation is only available
for the following animations:

• Fill Style•

• Line Style•

• Text Style•

• Element Style•

• Visibility•

• Blink•

• Value Display•
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• Tooltip•

• Disable•

Note: AVEVA OMI ViewApps do not support Bit State animations. Bit State animations have not been tested
on a non-English language Operating System. Web Client does not support Bit State animations.

About Bit State Animation
Bit State animation allows you to add conditions to an animation based on bit values. You can add multiple
conditions and for each condition you can select individual bits in any pattern up to 32 bits. You select the bit
pattern using the Bit Pattern Selector dialog. The conditions are verified against an integer expression or
reference (tag, object attribute, custom property) and if true, the corresponding animation is performed.

You can also customize your bit configuration using Bit Labels.

Configuring a Bit State Animation
Configuring a bit state animation is similar to adding a truth table animation to an element. After adding a bit
state animation to an element, you use the Bit Pattern Selector dialog to configure a condition using a bit
pattern. For more information, see Using the Bit Pattern Selector Dialog.

To configure a bit state animation
1. In the Graphic Editor, insert a symbol.1.

2. Select the element.2.

3. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.3.

4. Click the Add icon and select one of the animations that support bit animation. For example: Blink. The blink4.
animation is added to the Animation list and the Blink configuration panel appears.

5. Click the Bit State button. The Bit State configuration panel appears.5.

6. In the Expression Or Reference area, type a value, attribute reference or expression in the text box.6.

7. In the Bit State area, you will observe the following columns:7.

a. Blink: Select the Blink speed.a.

b. Attributes: Click the field to display the Edit Blink Attributes dialog box.b.

c. Operator: Select the operatorc.

d. Bitmask and Bitmatch: Click the field to launch the Bit Pattern Selector Dialog. For more information,d.
see Using the Bit Pattern Selector Dialog.

Note: Except for the 3 columns (Operator, Bitmask and Bitmatch), the type and number of columns will
differ for each animation. For more information, see About the Bit State Area.

8. To add/remove other conditions:8.

a. Click the Add icon. An additional condition is added to the table.a.

b. Click the Remove icon. The selected condition is removed from the table.b.

9. To reorder the condition use the up and down arrows.9.

10. After adding all the bit state conditions, click OK.10.
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About the Bit State Area
You use the Bit state table to configure bit state condition for animations. Each bit state condition has 3 common
columns:

• Operator•

• Bitmask•

• Bitmatch•

Operator
Each Bit State has the following options in the Operator dropdown list:

Options Effects

All All the bits in the state must match the Bitmatch value to trigger the animation.

Any Any bit in the state matched with the Bitmatch value will trigger the animation.

Bitmask and Bitmatch
The Bitmask and Bitmatch values in the bit state animation editors are determined by the bit selection in the Bit
Pattern Selector dialog. For each bit selection, the bit in the Bitmask and Bitmatch is calculated as follows:

Bit Selection Bitmask Bit Bitmatch Bit

0 1 0

1 1 1

X 0 0

For example, if B31=B30=B29=B28 = 1 and B27=B26=B25=B24 = 0 and all other 32 bits are not set with default
value ‘X’, then
Bit State = 11110000XXXXXXXXXXXXXXXXXXXXXXXX
Bitmask   = 11111111000000000000000000000000 = 0XFF000000
Bitmatch  = 11110000000000000000000000000000 = 0XF0000000
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Ignored Bit
When a bit is set to "X" in the Bit Pattern, it will be ignored in the state comparison. Only bits with bit value 1 in
the Bitmask will be used for the comparison.

The Bitmask and Bitmatch values of an ignored bit are both "0". The ignored bit will be skipped in the state
comparison and will not trigger the animation.

For example, on a Bit Pattern configuration like below. That means any bit in the input value is "0" will trigger the
bit state.
BitMask     = 0xFFFFFFFD = 11111111111111111111111111111101 
Bitmatch    = 0x00000000 = 00000000000000000000000000000000 
Bit operator = Any

For a reference with below input value will not trigger the bit state:
Input value = 0xFFFFFFFD = 11111111111111111111111111111101 

In this example, all the bits in the input value are "1" and different from the Bitmatch, except the bit 2. However,
the bit 2 in the Bitmask is "0", which means this bit will be ignored. In this case, this bit state will not be
triggered.

Accelerator Keys used in the Bit Pattern Selector Dialog
The Bit Pattern Selector dialog contains below accelerator keys:

Control Accelerator Functionality

Button “0” 0 All bits are set to ‘0’.

Button “1” 1 All bits are set to ‘1’

Button “X (Ignore)” X All bits are set to ‘X’ (Ignored).
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Button “OK” O Accept the Bit Pattern Selector configuration

Button “Cancel” C Cancel the Bit Pattern Selector configuration

About the Bit Pattern Selection Dialog
The Bit Pattern Selector dialog consists of 32-bit selection controls.

Each bit is represented by a rectangle in the Bit Pattern Selector dialog. For example, Bit 1 of the Standard Bit
Labels:

• Each rectangle will be labeled with the bit ID on the top-left corner; like "B1". Each rectangle has a small•
rectangle on the top-right corner.

• Click on the rectangle to toggle the bit state value in below order: "X" > "0" > "1" > "X" > "0" > "1" >……•

• Each bit state value change will change the rectangle color in the below order:•

The current Bitmask and Bitmatch values are displayed in the hexadecimal format on top of the Bit Pattern
Selector dialog.
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Using the Bit Pattern Selector Dialog
You use the Bit Pattern Selector dialog to configure a condition using a bit pattern. This pattern will be verified
against the integer reference and will trigger an animation when the condition is true. You can configure multiple
conditions, each with a bit pattern.

1. Click the Bitmask or Bitmatch field, to launch the Bit Pattern Selector dialog.1.

2. To set one bit:2.

a. For each bit selection control, click the small button to change the value: X, 0, 1 or use tab key with up/a.
down arrow keys.

The white background color indicates bit value 1 and gray background color indicates the bit value ‘0’.
The Ignore bit ‘X’ will be displayed by using the dialog background color.

3. To set all the 32-bit controls, use the 3 "Set All" buttons:3.

a. Button "0": Set all 32 bit values to "0"a.
Bitmask = 0xFFFFFFFF; Bitmatch = 0x00000000;

b. Button "1": Set all 32 bit values to "1"b.
Bitmask = 0xFFFFFFFF; Bitmatch = 0xFFFFFFFF;

c. Button "X(Ignore)": Set all 32 bit values to "X"c.
Bitmask = 0x00000000; Bitmatch = 0x00000000;

Bit Labels
Bit labels provide a preconfigured pattern of bits, with customized names and bit combinations. By default, the
Bit Label Standard is selected on a new configured bit state. The selected bit labels are available in the Bit State
animation editor and in the Bit Pattern Selector dialog.
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The Bit Labels drop down list is only available if the pre-configured BitLabels.xml and aaBitLabelsSchema.xsd files
are available under IDE root folder: <Install_root>\ArchestrA\Framework\Bin.

Selecting a Bit Label from the drop down list in the Bit Pattern Selector dialog, will display the corresponding
label name for each bit, as specified in the XML file. For example, select Bit Labels "ALMSTA", the Bit Pattern
Selector dialog will look as follows:

If the schema or XML file is not available in the specified folder, the Bit Labels drop-down list will be greyed out
in the animation panel and the Bit Pattern Selector dialog. You will not be able to change the Bit Label.

Changing Bit Labels
You can change the Bit Labels used in the Bit Pattern Selector during design time.

1. Launch the Bit Pattern Selector Dialog.1.
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2. Select a bit label from the drop-down list.2.

The bit pattern selector will reflect the new Bit configuration specified in the bit label file.

While switching the bit labels name within the Bit Pattern Selector, the following rules will be applied:

• The bits selected will remain the same after the bit labels are changed. For example, ‘xx0’ in Standard B7 –•
B5 bits will be transferred to CRIT ‘0’ in ALMSTA after switching Standard label to ALMSTA label. The Bitmask
value has changed from ‘001’ to ‘111’ on B7 – B5 bits. But the Bitmask and Bitmatch in the preview will
remain the same as in the Standard label.

• The Bitmask and Bitmatch change preview will only take effective if the user has edited the bit selection or•
clicking OK on the Bit Pattern Selector to accept the bit selection.

• The enabled bit value ‘0’, ‘1’, or ‘x’ in the previous bit labels will be transferred to the corresponding bit value•
of the switched bit labels. If the switched bit label is disabled, the top right corner will still show the
transferred bit value.

Configuring the BitLabels.xml and aaBitLabelsSchema.xsd files
The Bit Labels information is defined in the BitLabels.xml file and validated by using aaBitLabelsSchema.xsd file.
These files are not available by default.

BitLabels.xml
The BitLabels.xml file defines the labels of each supported Bit Labels. For example, the Bit Labels "Standard".

To define a Bit Labels, we need a Name and a Type. For example: <Labels Name="Standard" Type="Default">.

1. Name: The name specified here is listed in the Bit Labels dropdown combo.1.
The bit labels Name must contain at least one letter. Valid characters are alphanumeric and special
characters ($, #, _). The maximum length of the bit labels name is 32.

2. Type: ‘Default’ or the ‘Name’ of the Label.2.

Each XML can contain multiple <Labels>. Each <Labels> consists one or more <Label>. Each label has the Name
and Range info. For example:
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<Labels Name="Standard" Type="Default">
<Label Name="B31" Range="0X80000000"/>
<Label Name="B30" Range="0X40000000"/>
<Label Name="B29" Range="0X20000000"/>

Each <Label> will have two fields:

1. Name: The label name and bit labels name are case insensitive and the maximum length of the label name is1.
4. In the Bit Pattern Selector dialog, when the ‘Standard’ Bit Labels is selected, the label name "B31" is
displayed on the first top left corner.

2. Range: Is an Integer in hexadecimal format specifying which bit will be applied to the Name. The Range has2.
32 bits and can have only one bit set to '1'. All the other bits should be '0'. There is exception on the label
"CRIT" and label "PRI" of the Label "ALMSTA".

For example:

In the Label ‘Standard’, the bit "B31" is assigned to "0x80000000". Converting the hexadecimal number to a
binary, it will be "1000 0000 0000 0000 0000 0000 0000 0000". That means the label "B31" is the highest bit.

<Label Name="B31" Range="0x80000000"/>

In the Label ‘Standard’, the bit "B5" in assigned to "0x20". Converting the hexadecimal number to a binary, it is
"0000 0000 0000 0000 0000 0000 0010 0000". Since the lead twenty-six digits are zeros, we can ignore these
zeros in the Range value.

<Label Name="B5" Range="0x20"/>

The following rules will be applied when validating the bit labels XML and displaying the Bit Pattern Selector
Dialog:

• The label name and bit labels name must contain at least one letter. Valid characters are alphanumeric and•
special characters ($, #, _).
<Label Name="B31" Range="0x80000000"/>

• Label name must be unique for each label type. One label name cannot be used more than one places in a•
label type.

• Bit Label name can start with "," to reserve the label space. For example: <Label Name=",PNT2"•
Range="0x4000"/>.

• Two different label names cannot point to the same bit, although a bit can have multiple labels. The labels•
can be assigned in a Name and separated by comma ','. It can have comma separated values up to 4 groups.
For example, the bit "0x2000000" in the Label "ALMSTA", The entry in the BitLabels.xml will be <Label
Name="HHA,TARG" Range="0x2000000"/> and in the Bit Pattern Selection dialog, it will be displayed like:
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• Bit Pattern Selector supports label name alias. For example, the selector will apply all the label of label type•
"ALMOPT" for the label name selection "INHSTA" if the following labels type is defined in the xml:
<Labels Name="ALMOPT" Type="ALMOPT" SameAs="INHSTA"/>

• If no label name is defined for the bit, the corresponding bit configuration will be disabled in the selector•
dialog. The label from the Standard Bit Labels will be associated to the bit.

• Each label name except "CRIT" and "PRI" only can specify one bit in the range. For more information, see•
CRIT and PRI in the Label ALMSTA.

aaBitLabelsSchema.xsd
The aaBitLabelsSchema.xsd contains the schema to validate the BitLabels.xml file. The Bit Labels drop down list
will be disabled if:

• The XML and XSD files are not available in the <installpath>\ArchestrA\Bin location.•

• The XML is not well formed•

• An invalid label is detected when loading the BitLabels.xml; In this case a warning message will be logged•
and the default Standard label type will be used.

If the Bit Labels is disabled, the "Standard" bit labels will be applied to each bit in the Bit Pattern Selector dialog.

Unassigned bit
If a bit is not assigned to a label, the bit will be greyed out in the Bit Pattern Selector dialog.

For example, the "B15" to "B8" are greyed out in the Label "ALMSTA".

A greyed-out bit cannot be changed and the bit value will be displayed as "X" (Ignore).

CRIT and PRI in the Label ALMSTA
The CRIT and PRI in the Label ALMSTA are the only labels set with multiple bits.

The CRIT is set as "0xe0", which is "0000 0000 0000 0000 0000 0000 1110 0000" in binary format.
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The PRI is set as "0x1f", which is "0000 0000 0000 0000 0000 0000 0001 1111" in binary format.

Since multiple bits are set in the Range of both labels, the rectangles will be merged. Only CRIT and PRI are
allowed a label set with multiple bits in the Range.

Label Name Bits Range Integer Range

CRIT Bit 6 to bit 8 0xe0 0 to 7

PRI Bit 1 to bit 5 0x1f 0 to 31

Entering an invalid number will set the CRIT or PRI to -1. An error message will be displayed if an invalid value is
entered.

Configuring Common Types of Animations
Every animation type has its own set of configuration parameters. This section shows you how to configure each
type of animation and what references it can use.

You can configure:

• Visualization animations such as:•

• Visibility animations•

• Fill style, line style or text style animations•

• Blink animations•

• Alarm Border animations•

• Horizontal or vertical percent fill animations•

• Horizontal or vertical location animations•

• Width or height animations•

• Point animations•
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• Orientation animations•

• Value display animations•

• Tooltip animations•

• Interaction animations such as:•

• Disable animation•

• User input animation•

• Horizontal and vertical slider animations•

• Pushbutton animations•

• Action script animations•

• Show or hide animations•

Configuring a Visibility Animation
You can configure an element with a visibility animation with a:

• Boolean visibility animation.•

• Truth table visibility animation.•

• Bit State visibility animation.•

Configuring a Boolean Visibility Animation
To configure an element with a boolean visibility animation
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select Visibility. The visibility animation is added to the Animation list and the3.
Visibility configuration panel appears.

4. In the Boolean box, type a Boolean numeric value, attribute reference or expression.4.

5. Select True, 1, On if you want the element to show, when the expression is true, otherwise select False, 0,5.
Off.

6. Click OK.6.

Configuring a Truth Table Visibility Animation
Note: AVEVA OMI ViewApps do not support Truth Table Visibility animations. The Truth Table Visibility animation
has not been tested on a non-English language Operating System. Web Client does not support Truth Table
Visibility animations.

To configure an element with a truth table visibility animation
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select Visibility. The Visibility animation is added to the Animation list and the3.
Visibility configuration panel appears.
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4. Click the Truth Table button. The Truth Table configuration panel appears.4.

5. In the Expression Or Reference area:5.

a. Select the data type of the expression from the list.a.

b. Type a value, attribute reference or expression in the text box.b.

6. If the data type of the expression is string, you can specify to ignore the case by selecting Ignore Case.6.

7. In the Truth Table area, for the Visible column, select True or False. Select True if you want to display the7.
element, when the expression is true, else select False.

8. In the Operator column, select the comparison operator ('=', '<', '>', '<=', '>='). If the data type selected in8.
step 5, is boolean then only the '=' operator is available.

9. In the Value or Expression column, type a value, attribute reference, or expression.9.

10. To add/remove other conditions:10.

a. Click the Add icon. An additional condition is added to the truth table.a.

b. Click the Remove icon. The selected condition is removed from the table.b.

11. To reorder the condition use the up and down arrows.11.

12. After adding all truth table conditions, click OK.12.

Configuring a Bit State Visibility Animation
To configure an element with a bit state visibility animation
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select Visibility. The Visibility animation is added to the Animation list and the3.
Visibility state selection panel appears.

4. Click the Bit State button. The Bit State Visibility configuration panel appears.4.

5. In the Expression Or Reference area, type a value, attribute reference or expression in the text box. Only5.
integer values are allowed.

6. In the Bit State area, select the:6.

a. Visible: Select True or False.a.

b. Operator: Any or All.b.

c. Bitmask/Bitmatch: For more information, see Using the Bit Pattern Selector Dialog.c.

7. To add/remove other conditions:7.

a. Click the Add icon. An additional condition is added to the table.a.

b. Click the Remove icon. The selected condition is removed from the table.b.

8. To reorder the condition use the up and down arrows.8.

9. After adding all the bit state conditions, click OK.9.
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Configuring a Fill Style Animation
You can configure an element with a:

• Boolean fill style animation.•

• Truth table fill style animation.•

• Bit State fill style animation.•

The truth table fill style animation lets you:

• Associate expressions of any data type supported by the HMI with a fill style.•

• Define as many fill styles as you require and associate each one with a condition.•

You can define the conditions by specifying an comparison operator (=, >, >=, <, <=) and a breakpoint, which
itself can be a value, an attribute reference, or an expression.

You can add conditions, delete conditions, and also change the order in which the conditions are processed.

Configuring a Boolean Fill Style Animation
You can configure an element with a discrete fill style animation.

To configure an element with a Boolean fill style animation
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select Fill Style. The fill style animation is added to the Animation list and the Fill Style3.
state selection panel appears.

4. Click the Boolean button. The Boolean Fill Style configuration panel appears.4.

5. In the Boolean box, type a Boolean numeric value, attribute reference or expression.5.

6. Clear Color in the True, 1, On area or False, 0, Off area if you do not want a different fill style for the true or6.
false condition than the default fill style.

7. In the True, 1, On area, click the color box to configure the fill color when the expression is true. The Select7.
FillColor dialog box appears. For more information, see Setting Style.

8. In the False, 0, Off area, click the color box to configure the fill color when the expression is false. The Select8.
FillColor dialog box appears. For more information, see Setting Style.

9. Click OK.9.

To set default fill style in a Boolean fill style animation
1. Open the Edit Animations dialog box, Boolean Fill Style panel.1.

2. In the Element Fill Style area, click the color box to select a style from the Select FillColor dialog box.2.

To use default fill style in a Boolean fill style animation
1. Open the Edit Animations dialog box, Boolean Fill Style panel.1.

2. Clear Color to use the corresponding default fill style.2.

Configuring a Truth Table Fill Style Animation
You can configure an element with a fill style animation based on a truth table.
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To configure an element with a truth table fill style animation
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select Fill Style. The fill style animation is added to the Animation list and the Fill Style3.
state selection panel appears.

4. Click the Truth Table button. The Truth Table Fill Style configuration panel appears.4.

5. In the Expression Or Reference area:5.

• Select the data type of the expression from the list.•

• Type a value, attribute reference or expression in the text box.•

6. If the data type of the expression is string or internationalized string, you can specify to ignore the case by6.
selecting Ignore Case.

7. In the Truth Table, click the color box in the Color column. The Select FillColor dialog box appears. For more7.
information, see Setting Style.

8. In the Operator column, select the comparison operator.8.

9. In the Value or Expression column, type a value, attribute reference, or expression.9.

10. To add further conditions, see .10.

11. Click OK.11.

To set the default fill style for a truth table fill style animation
1. Open the Edit Animations dialog box, Truth Table Fill Style panel.1.

2. In the Element Fill Style area, click the color box. The Select FillColor dialog box appears. For more2.
information, see Setting Style.

To use the default fill style in a truth table fill style animation
1. Open the Edit Animations dialog box, Truth Table Fill Style panel.1.

2. Locate the condition for which you want to set the style to default style.2.

3. Clear the mark for that condition in the Color column of the truth table. The associated style is the same as3.
the style for the Element Fill Style.

To add a condition to a truth table fill style animation
1. Open the Edit Animations dialog box, Truth Table Fill Style panel.1.

2. Click the Add icon. An additional condition is added to the truth table.2.

3. Configure color, operator and breakpoint value according to your requirements.3.

To delete a condition from an analog fill style animation
1. Open the Edit Animations dialog box, Truth Table Fill Style panel.1.

2. Select the condition you want to delete.2.

3. Click the Remove icon. The condition is removed.3.
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To change the processing order of fill style conditions
1. Open the Edit Animations dialog box, Truth Table Fill Style panel.1.

2. Select the condition you want to move up or down the condition list in order for it to be processed sooner or2.
later.

3. Click the:3.

• Arrow up icon to move the condition up in the truth table.•

• Arrow down icon to move the condition down in the truth table.•

For example, you want to model an analog fill color animation that describes the following conditions:

• When the attribute TankLevel_001.PV is 0 then the fill style is solid black.•

• When the attribute TankLevel_001.PV is smaller than 20, then the fill style is solid red.•

• When the attribute TankLevel_001.PV is greater than the attribute Standards.TankMax then the fill style•
is red with a diagonal pattern.

• In all other cases, the fill style is solid blue.•

Configuring a Bit State Fill Style Animation
You can configure an element with a Bit State animation .

To configure an element with a Bit State fill style animation
1. Open the symbol or graphic in the Graphic editor.1.

2. Select the element.2.

3. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.3.

4. Click the Add icon and select Fill Style. The Fill Style animation is added to the Animation list and the Fill4.
Style state selection panel appears.

5. Click the Bit State button. The Bit State configuration panel appears.5.

6. In the Expression Or Reference area, type a value, attribute reference or expression in the text box. Only6.
integer values are allowed.

7. In the Bit State area, select the :7.

a. Color: Click the color box in the Color column. The Select FillColor dialog box appears. For morea.
information, see Setting Style.

b. Operator: Any or All.b.

c. Bitmask/Bitmatch: For more information, see Using the Bit Pattern Selector Dialog.c.

8. You can also select the color for the Element Fill Style.8.

9. To add/remove other conditions:9.

a. Click the Add icon. An additional condition is added to the table.a.

b. Click the Remove icon. The selected condition is removed from the table.b.

10. To reorder the condition use the up and down arrows.10.

11. After adding all the bit state conditions, click OK.11.
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Configuring a Line Style Animation
You can configure an element with a:

• Boolean line style animation.•

• Truth table line style animation.•

• Bit State line style animation.•

The truth table line style animation lets you:

• Associate expressions of any data type supported by your HMI/SCADA software with a line style.•

• Define as many line styles as you want and associate each one with a condition.•

You can define the conditions by specifying an comparison operator (=, >, >=, <, <=) and a breakpoint, which
itself can be a value, an attribute reference or an expression.

You can add conditions, delete conditions and also change the order in which the conditions are processed.

Configuring a Boolean Line Style Animation
You can configure an element with a Boolean line style animation. You can use a new style or use all or parts of
the default appearance of a line for:

• Line style.•

• Line thickness.•

• Line pattern.•

To configure an element with a Boolean line style animation
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select Line Style. The line style animation is added to the Animation list and the Line3.
Style state selection panel appears.

4. Click the Boolean button. The Boolean Line Style configuration panel appears.4.

5. In the Boolean box, type a Boolean numeric value, attribute reference or expression.5.

6. In the True, 1, On area, click the Color box to configure the line style when the expression is true. The Select6.
FillColor dialog box appears. For more information, see Setting Style.

7. In the Weight box, type a value for the line thickness when the expression is true.7.

8. From the Pattern list, select a line pattern for the line when the expression is true.8.

9. Repeat the above steps for the false condition in the False, 0, Off area.9.

10. Click OK.10.

To set default line style, thickness and/or pattern in a Boolean line style animation
1. Open the Edit Animations dialog box, Boolean Line Style panel.1.

2. In the Element Line Style area, select a style, type a value for the width and select a pattern for the default2.
Boolean line style.
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To use default line style, thickness and/or pattern in a Boolean line style animation
1. Open the Edit Animations dialog box, Boolean Line Style panel.1.

2. In the True, 1, On or False, 0, Off areas, clear Color, Weight and/or Pattern to use the corresponding default2.
style, weight and/or pattern.

Configuring a Truth Table Line Style Animation
You can configure an element with a truth table line style animation.

To configure an element with a truth table line style animation
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select Line Style. The line style animation is added to the Animation list and the Line3.
Style state selection panel appears.

4. Click the Truth Table button. The Truth Table Line Style configuration panel appears.4.

5. In the Expression or Reference box:5.

• Select the data type of the expression from the list.•

• Type a value, attribute reference or expression in the text box.•

6. If the data type of the expression is string or internationalized string, you can specify to ignore the case by6.
selecting Ignore Case.

7. In the Truth Table, click the color box in the Color column. The Select FillColor dialog box appears. For more7.
information, see Setting Style.

8. Select the truth options. Do one of more of the following:8.

• In the Weight column, type a value for the line weight.•

• In the Pattern column, select a line pattern.•

• In the Operator column, select the comparison operator.•

• In the Value or Expression column, type a value, attribute reference or expression.•

• To add further conditions, see .•

9. Click OK.9.

To set the default line style, width or pattern for a truth table line style animation
1. Open the Edit Animations dialog box, Truth Table Line Style panel.1.

2. In the Element Line Style area, select a style, type a value for the width and select a pattern for the default2.
truth table line style.

To use the default line style, width or pattern in a truth table line style animation
1. Open the Edit Animations dialog box, Truth Table Line Style panel.1.

2. Locate the condition for which you want to change the line style, width or pattern.2.

3. To use the default line style for the condition, clear the mark in the Color column of the truth table.3.

4. To use the default line width for the condition, clear the mark in the Width column of the truth table.4.
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5. To use the default line pattern for the condition, clear the mark in the Pattern column of the truth table.5.

To add a condition to a truth table line style animation
1. In the Edit Animations dialog box, Truth Table Line Style panel, click the Add icon. An additional condition is1.

added to the truth table.

2. Configure color, weight, pattern, operator and breakpoint value according to your requirements.2.

To delete a condition from an analog line color animation
1. In the Edit Animations dialog box, Truth Table Line Style panel, select the condition you want to delete.1.

2. Click the Remove button. The condition is removed.2.

To change the processing order of line style conditions
1. Open the Edit Animations dialog box, Truth Table Line Style panel1.

2. Select the condition you want to move up or down the condition list in order for it to be processed sooner or2.
later.

3. Click the:3.

• Arrow up icon to move the condition up in the truth table.•

• Arrow down icon to move the condition down in the truth table.•

Configuring a Bit State Line Style Animation
You can configure an element with a Bit State animation

To configure an element with a bit state line style animation
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select Line Style. The line style animation is added to the Animation list and the Line3.
Style state selection panel appears.

4. Click the Bit State button. The Bit State Line Style configuration panel appears.4.

5. In the Expression Or Reference area, type a value, attribute reference or expression in the text box. Only5.
integer values are allowed.

6. In the Bit State area, select the:6.

a. Color: Click the color box in the Color column. The Select FillColor dialog box appears. For morea.
information, see Setting Style.

b. Weight: Type a value for the line weight.b.

c. Pattern: Select a line pattern.c.

d. Operator: Any or Alld.

e. Bitmask/Bitmatch: For more information, see Using the Bit Pattern Selector Dialog.e.

7. You can also set the Element Fill Style, with Color, Weight and Pattern.7.

8. To add/remove other conditions:8.

a. Click the Add icon. An additional condition is added to the table.a.
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b. Click the Remove icon. The selected condition is removed from the table.b.

9. To reorder the condition use the up and down arrows.9.

10. After adding all the bit state conditions, click OK.10.

Configuring a Text Style Animation
You can configure an element with a:

• Boolean text style animation.•

• Truth table text style animation.•

• Bit State text style animation.•

The truth table text style animation lets you:

• Associate expressions of any data type supported by your HMI/SCADA software with a text style.•

• Define as many text styles as you want and associate each one with a condition.•

You can define the conditions by specifying an comparison operator (=, >, >=, <, <=) and a breakpoint, which
itself can be a value, an attribute reference or an expression.

You can add conditions, delete conditions and also change the order in which the conditions are processed.

Configuring a Boolean Text Style Animation
You can configure an element with a Boolean text style animation.

To configure an element with a Boolean text style animation
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select Text Style. The text style animation is added to the Animation list and the Text3.
Style state selection panel appears.

4. Click the Boolean button. The Boolean Text Style configuration panel appears.4.

5. In the Boolean box, type a Boolean numeric value, attribute reference or expression.5.

6. In the True, 1, On area, click the Color box to configure the text style when the expression is true. The Select6.
FillColor dialog box appears. For more information, see Setting Style.

7. Click the browse button for the Font box, to select a font, font style and size for the text when the expression7.
is true.

8. Repeat the above steps for the false condition in the False, 0, Off area.8.

9. Click OK.9.

To set default text style and/or font in a Boolean text style animation
1. Open the Edit Animations dialog box, Boolean Text Style panel.1.

2. In the Element Text Style area, select a style and/or a font for the default Boolean text style.2.

To use default text style and/or font in a Boolean text style animation
1. Open the Edit Animations dialog box, Boolean Text Style panel.1.
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2. In the True, 1, On or False, 0, Off areas, clear Color and/or Font to use the corresponding default style2.
and/or font.

Configuring a Truth Table Text Style Animation
You can configure an element with a truth table text style animation.

To configure an element with a truth table text style animation
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select Text Style. The text style animation is added to the Animation list. The Text3.
Style information page appears.

4. Click the Truth Table button. The Truth Table Text Style configuration panel appears.4.

• Select the data type of the expression from the list.•

• Type a value, attribute reference or expression in the text box.•

5. If the data type of the expression is string or internationalized string, you can specify to ignore the case by5.
selecting Ignore Case.

6. In the Truth Table, click the color box in the Color column. The Select FillColor dialog box appears. For more6.
information, see Setting Style.

7. Select the truth options. Do one of more of the following:7.

• Click on the cell in the Font column to select a font.•

• In the Operator column, select the comparison operator.•

• In the Value or Expression column, type a value, attribute reference or expression.•

• To add further conditions, see .•

8. Click OK.8.

To set the default text style or font for a truth table text style animation
1. Open the Edit Animations dialog box, Truth Table Text Style panel.1.

2. In the Element Text Style area, select a style and a font for the default truth table text style.2.

To use the default text style or font in a truth table text style animation
1. Open the Edit Animations dialog box, Truth Table Text Style panel.1.

2. Locate the condition for which you want to change the text style or font.2.

3. To use the default text style for the condition, clear the mark in the Color column of the truth table.3.

4. To use the default font for the condition, clear the mark in the Font column of the truth table.4.

To add a condition to a truth table text style animation
1. In the Edit Animations dialog box, Truth Table Text Style panel, click the Add icon. An additional condition is1.

added to the truth table.

2. Configure style, font, operator and breakpoint value according to your requirements.2.
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To delete a condition from a truth table text style animation
1. In the Edit Animations dialog box, Truth Table Text Style panel, select the condition you want to delete.1.

2. Click the Remove button.2.

To change the processing order of text style conditions
1. Open the Edit Animations dialog box, Truth Table Text Style panel1.

2. Select the condition you want to move up or down the condition list in order for it to be processed sooner or2.
later.

3. Click the:3.

• Arrow up icon to move the condition up in the truth table.•

• Arrow down icon to move the condition down in the truth table.•

Configuring a Bit State Text Style Animation
You can configure an element with a Bit State animation

To configure an element with a bit state text style animation
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select Text Style. The Text Style animation is added to the Animation list and the Text3.
Style state selection panel appears.

4. Click the Bit State button. The Bit State Text Style configuration panel appears.4.

5. In the Expression Or Reference area, type a value, attribute reference or expression in the text box. Only5.
integer values are allowed.

6. In the Bit State area, select the:6.

a. Color: Click the color box in the Color column. The Select FillColor dialog box appears. For morea.
information, see Setting Style.

b. Font: Click on the cell in the Font column to select a font.b.

c. Operator: Any or Allc.

d. Bitmask/Bitmatch: For more information, see Using the Bit Pattern Selector Dialog.d.

7. You can also set the Element Text Style, with Color and Font settings.7.

8. To add/remove other conditions:8.

a. Click the Add icon. An additional condition is added to the table.a.

b. Click the Remove icon. The selected condition is removed from the table.b.

9. To reorder the condition use the up and down arrows.9.

10. After adding all the bit state conditions, click OK.10.

Configuring a Blink Animation
You can configure an element with a blink animation. You can specify:
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• The blinking speed: slow, medium or fast.•

• If the element should blink invisibly or if it should blink with specified colors.•

You can configure an element with a:

• Boolean blink animation•

• Truth Table blink animation•

• Bit State blink animation•

Configuring a Boolean Blink Animation
You can configure an element with a blink animation based on a boolean value.

To configure an element with a boolean blink animation
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select Blink. The blink animation is added to the Animation list and the Blink3.
configuration panel appears.

4. In the Boolean box, type a Boolean numeric value, attribute reference or expression.4.

5. Click the Boolean button. The Boolean Blink configuration panel appears.5.

6. In the Expression or Reference area, type a Boolean numeric value, attribute reference or expression.6.

7. In the Blink When Expression Is area, select:7.

• True, 1, On to enable blinking when the expression is true.•

• False, 0, Off to enable blinking when the expression is false.•

8. In the Blink Speed area, select Slow, Medium or Fast for the blinking speed.8.

9. In the Blink Attributes area, select Blink Visible With These Attributes or Blink Invisible.9.

10. If you select Blink Visible With These Attributes, you can configure the styles used at run time for the text,10.
line and fill component of the element. Click on the corresponding color box, and the Select FillColor dialog
box appears. For more information, see Setting Style.

11. Click OK.11.

Configuring a Truth Table Blink Animation
You can configure an element with a blink animation based on truth table conditions.

Note: AVEVA OMI ViewApps do not support Truth Table Blink animations. The Truth Table Blink animation has
not been tested on a non-English language Operating System. Web Client does not support Truth Table Blink
animations.

To configure an element with a truth table blink animation
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select Blink. The blink animation is added to the Animation list and the Blink3.
configuration panel appears.
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4. Click the Truth Table button. The Truth Table configuration panel appears.4.

5. In the Expression Or Reference area:5.

• Select the data type of the expression from the list.•

• Type a value, attribute reference or expression in the text box.•

6. If the data type of the expression is string or internationalized string, you can specify to ignore the case by6.
selecting Ignore Case.

7. In the truth table area, under the Blink column, select the type of Blink (Slow, Medium, Fast).7.

8. Under the Attributes column, click the field to display the Edit Blink Attributes dialog box.8.

9. If you select Blink Visible With These Attributes, you can configure the styles used at run time for the text,9.
line and fill component of the element. Click on the corresponding color box, and the Select FillColor dialog
box appears. For more information, see Setting Style.

10. If you select Blink Invisible, no animation will be displayed. Click Ok.10.

11. In the Operator column, select a comparison operator. (<, <=, >, >=,=)11.

12. In the Value or Expression column, type a value, attribute reference, or expression.12.

13. To add/remove other conditions:13.

a. Click the Add icon. An additional condition is added to the truth table.a.

b. Click the Remove icon. The selected condition is removed from the table.b.

14. To reorder the condition use the up and down arrows.14.

15. After adding all truth table conditions, click OK.15.

Configuring a Bit State Blink Animation
You can configure an element with a blink animation based on a bit state.

To configure an element with a bit state blink animation
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select Blink. The blink animation is added to the Animation list and the Blink3.
configuration panel appears.

4. Click the Bit State button. The Bit State configuration panel appears.4.

5. In the Expression Or Reference area, type a value, attribute reference or expression in the text box. Only5.
integer values are allowed.

6. In the Bit State area, select the:6.

a. Blink: Select the type of Blink (Slow, Medium, Fast).a.

b. Attributes: Under the Attributes column, click the field to display the Edit Blink Attributes dialog box.b.

If you select Blink Visible With These Attributes, you can configure the styles used at run time for the
text, line and fill component of the element. Click on the corresponding color box, and the Select
FillColor dialog box appears. For more information, see Setting Style.

c. If you select Blink Invisible, no animation will be displayed. Click Ok.c.
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d. Operator: Any or Alld.

e. Bitmask/Bitmatch: For more information, see Using the Bit Pattern Selector Dialog.e.

7. To add/remove other conditions:7.

a. Click the Add icon. An additional condition is added to the truth table.a.

b. Click the Remove icon. The selected condition is removed from the table.b.

8. To reorder the condition use the up and down arrows.8.

9. After adding all the bit state conditions, click OK.9.

Configuring an Alarm Border Animation
Alarm Border animation shows a highly visible border around a graphic or graphic element when an
alarm occurs. The color and fill pattern of the border indicates the severity and current state of the
alarm, if supported by your HMI/SCADA software. Plant operators can quickly recognize alarm
conditions when Alarm Border animation is used

Alarm Border animation also shows an indicator icon at the top left corner of the border around a closed graphic
element. For open pie or arc graphic elements, the indicator icon is placed at the top-left most location of the
start and end points.

Alarm severity (1-4) or the current alarm mode (Shelved, Silenced, Disabled) appear as part of the indicator icon.
The indicator icon can be shown or hidden as a configurable option of Alarm Border animation.

Alarm Border animation adheres to the following precedence rules with other functions that can change the
appearance of a graphic:

1. Quality status1.

2. Alarm Border animation2.

3. Element Style animation3.

4. Style animations4.

5. Element Style on canvas5.

Understanding Requirements of Alarm Border Animations
Alarm border animation can be applied to all types of graphics except embedded graphics and nested groups.
Alarm border animation can also be applied to graphic elements and group elements.
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Understanding the Behavior of Alarm Border Animations
Alarm Border animation appears around a graphic element based on the current state of the object’s aggregated
alarm attributes, or other configured alarm inputs supported by your HMI/SCADA software. The appearance of
the alarm border itself reflects the current alarm state and the user’s interaction with the alarm.

• A graphic's process value transition into an alarm state.•

Alarm Border animation appears around the graphic based on alarm severity with blinking.

 

• The user acknowledges an alarm with the process value still in an alarm state.•

Alarm Border animation appears around the graphic without blinking.

• The alarm value returns to normal without the user acknowledging the alarm.•

Alarm Border animation remains around the graphic in a defined Return to Normal visual style without
blinking.

• The alarm value returns to normal and the user acknowledges the alarm.•
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Alarm Border animation no longer appears around a graphic.

• The user suppresses an alarm.•

Alarm Border animation remains around the graphic in a defined suppressed/disabled visual style without
blinking. The indicator shows the suppressed/disabled alarm mode icon.

• The user silences an alarm•

Alarm Border animation remains around the graphic in a defined silenced visual style without blinking. The
indicator shows the silenced alarm mode icon.

A silenced alarm mode takes precedence over an alarm in shelved mode.

• The user shelves an alarm•

Alarm Border animation remains around the graphic in a defined shelved visual style without blinking. The
indicator shows the shelved alarm mode icon.
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If a new alarm condition occurs when Alarm Border animation appears around a graphic, the animation updates
to show the new alarm state. In the case of aggregation alarms, Alarm Border animation shows the highest
current alarm state.

Configuring Alarm Border Animation
Alarm Border animation can be configured by selecting Alarm Border from the list of Visualization animations.
For Situational Awareness Library symbols, Alarm Border animation can be selected as a Wizard Option of the
graphic.

The Alarm Border animation dialog box contains mutually exclusive fields to set the referenced attributes for
aggregate or individual alarms.

If your HMI/SCADA software supports aggregating alarms from different plant or functional areas, you can
specify Alarm Border animation by entering an attribute, object, or tag name in the Use Standard Alarm-
Urgency References field of the Alarm Border dialog box.

The selected object attributes or tags typically map to the following aggregation alarm attributes:

• AlarmMostUrgentAcked•

• AlarmMostUrgentInAlarm•

• AlarmMostUrgentMode•

• AlarmMostUrgentSeverity•

• AlarmMostUrgenShelved•

For individual alarms, you can specify Alarm Border animation by entering attribute or object names in the Use
Custom Alarm-Urgency References fields of the Alarm Border dialog box.

• InAlarm Source•

Indicates the InAlarm status (True/False) of the most urgent alarm that is in the InAlarm state or waiting to
be Acked. If no alarms are in the InAlarm state or waiting to be Acked, the value is False.

• Acked Source•

Indicates the acknowledgement status (True/False) of the most urgent alarm that is in the InAlarm state or
waiting to be Acked. If no alarms are in an InAlarm state or waiting to be Acked, the value is True, which
means no acknowledgement is needed.

• Mode Source•
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Indicates the alarm mode (Enable/Silence/Disable/Shelved) of the most urgent alarm that is in the InAlarm
state or waiting to be Acked. If alarms are configured for an attribute, but no alarms are in the InAlarm state
or waiting to be Acked, the value is the same

as the AlarmMode of the object.

• Severity Source•

Indicates the severity as an integer (1-4) of the most urgent alarm current in an InAlarm state. If no alarms
are in an InAlarm state or waiting to be acknowledged, the value is 0.

• Shelved Source•

Indicates the current Shelved status (True/False) of the most urgent alarm that is in the InAlarm state or
waiting to be Acked. If no alarms are in the InAlarm state or waiting to be Acked, the value is False.

To set Alarm Border animation for individual alarms, specify references to the following alarm attributes or tags:

• InAlarm attribute•

• Acked attribute•

• Mode attribute•

• Severity attribute•

• Shelved attribute•

Alarm Border animation subscribes to these attributes or tags. Based on the alarm state of these attributes or
tags, Alarm Border animation is applied to the graphic element in run time.

To configure Alarm Border animation
1. Open a graphic in the Industrial Graphic Editor.1.

2. Select the graphic to show the graphic elements listed in the Elements pane of the Industrial Graphic Editor.2.

3. Select a graphic element from the Elements list to apply Alarm Border animation.3.

4. Click Add Animation to show the list of animation types.4.

5. Select Alarm Border from the list of Visualization animations.5.

The Alarm Border dialog box appears with a set of configuration options.

6. Select either Use Standard Alarm-Urgency References or Use Customized Alarm-Urgency References.6.

▪ To use Standard Alarm-Urgency References▪
Click Browse and select an attribute, tag, or object name, then Click OK.

Both direct and relative references to an object or tag are supported. An expression cannot be used to
reference the object.

▪ To use Customized Alarm-Urgency References▪
Click Browse and select an attribute, a graphic element, or a tag name for all Source fields shown
beneath Use Customized Alarm Urgency References, then click OK.

Fields cannot be left blank. Expressions, external references, and custom properties can be entered
in all fields.

7. Enter a custom property, a constant (True/False), an external reference, or an expression in the Show Alarm7.
Indicator field to set the condition when an alarm indicator icon is shown or hidden.
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Configuring Optional Alarm Border Animation Characteristics
You can complete a set of optional tasks to customize the appearance of Alarm Border animation.

Changing Alarm Border Indicator Icons

Alarm border animation shows an indicator icon at the top left corner of the border with alarm severity as a
number from 1 to 4 if your HMI/SCADA software supports it. Other indicator images represent alarm suppressed,
silenced and shelved modes.

A default Alarm Border indicator image is assigned to each alarm mode and severity level. The default images
appear in the Image fields of the Alarm and Event Priority Mapping and Historization dialog box. The images
are saved in an XML file. For details about the location of the file, refer to your HMI/SCADA software
documentation.

The default Alarm Border indicator images can be replaced by custom images. Supported image file types
include .bmp, .gif, .jpg, .jpeg, .tif, .tiff, .png, .ico and .emf.

To replace Alarm Border indicator images
1. Create Alarm Border indicator images that will replace the default indicator images.1.

2. Navigate to the Alarm Priority Mapping configuration dialog. The Alarm and Event Priority Mapping and2.
Historization dialog box appears.

The navigation path will differ according to your HMI/SCADA software. Typically, the path will be through
menu items to configure your project or application components.

3. Click the Search button next to the Alarm Border indicator or mode image to be replaced. The Open dialog3.
box appears to locate the replacement Alarm Border indicator images.
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4. Go to the folder containing the replacement images.4.

5. Select an image file and click Open.5.

6. Verify the new Alarm Border indicator image replaced the original image in the Alarm and Event Priority6.
Mapping and Historization dialog box.

At run time, Alarm Border animation reads the XML file from the location where it is stored. If images are not
available from the XML file, an Alarm Indicator does not appear during Alarm Border animation.

Modify Alarm Border Animation Element Styles

The color and fill pattern of alarm borders are set by the Outline properties of a set of AlarmBorder Element
Styles. The following table shows the Element Styles applied to Alarm Border animations by alarm severity and
alarm state.

The assignment of these Element Styles to alarm conditions cannot be changed. Only the assigned
Element Style’s Outline properties can be changed to modify the line pattern, line weight, and line color
of alarm borders.

Alarm
Severity Alarm State Element Style

1 UnAcknowledged AlarmBorder_Critical_UNACK

1 Acknowledged AlarmBorder_Critical_ACK

1 Return To Normal AlarmBorder_Critical_RTN

2 UnAcknowledged AlarmBorder_High_UNACK

2 Acknowledged AlarmBorder_High_ACK

2 Return To Normal AlarmBorder_High_RTN

3 UnAcknowledged AlarmBorder_Medium_UNACK

3 Acknowledged AlarmBorder_Medium_ACK

3 Return To Normal AlarmBorder_Medium_RTN

4 UnAcknowledged AlarmBorder_Low_UNACK

4 Acknowledged AlarmBorder_Low_ACK

4 Return To Normal AlarmBorder_Low_RTN

All Suppressed AlarmBorder_Suppressed

All Shelved AlarmBorder_Shelved

All Silenced AlarmBorder_Silenced

Configuring a Percent Fill Horizontal Animation
You can configure an element with a percent fill horizontal animation.
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Besides specifying the expressions that determine how much of the element is filled at run time, you can also
specify:

• Fill direction: from left to right or right to left.•

• Unfill color: the style of the background when the element has 0 percent filling.•

• Fill orientation: if the filling is in relation to the element or to the screen. This affects how the fill appears if•
the orientation of the element changes. If the fill is in relation to the screen and the element or graphic are
rotated, the fill remains in relation to the screen.

The fill orientation is a common setting to the percent fill horizontal and percent fill vertical animations.

You can also preview how the percent fill horizontal animation appears at run time.

To configure an element with a percent fill horizontal animation
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select % Fill Horizontal. The percent fill horizontal animation is added to the3.
Animation list and the % Fill Horizontal configuration panel appears.

4. Specify the settings. Do one or more of the following:4.

• In the Analog box, type an analog value, attribute reference or expression.•

• In the Value - At Min Fill box, type an analog value, attribute reference or expression that causes the•
minimum percent of filling at run time.

• In the Value - At Max Fill box, type an analog value, attribute reference or expression that causes the•
maximum percent of filling at run time.

• In the Fill - Min% box, type an analog value, attribute reference or expression to specify the minimum•
percent of filling.

• In the Fill - Max% box, type an analog value, attribute reference or expression to specify the maximum•
percent of filling.

• In the Colors area, click the:•
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Fill Color box to select a style from the Select FillColor dialog box. This is the fill style of the element.

Unfilled Color box to select a style from the Select FillColor dialog box. This is the unfilled fill style of the
element.

For more information, see Setting Style.

5. In the Direction area, select:5.

• Right - to fill from left to right.•

• Left - to fill from right to left.•

6. In the Orientation area, select:6.

• Relative to Graphic - so that the filling is in relation to the element and the filling rotates with the•
element.

• Relative to Screen - so that the filling is in relation to the screen and the filling does not rotate with the•
element.

7. You can preview your configuration by using the slider in the Preview area. Drag the slider to see how7.
different values affect the appearance at run time.

8. Click OK.8.

Configuring a Percent Fill Vertical Animation
You can configure an element with a percent fill vertical animation.

Besides specifying the expressions that determine how much of the element is filled at run time, you can also
specify:

• Fill direction: from lower to top or top to lower.•

• Unfill color: the style of the background when the element has 0 percent filling.•

• Fill orientation: if the filling is in relation to the element or to the screen. This affects how the fill appears if•
the orientation of the element changes. If the fill is in relation to the screen and the element or graphic are
rotated, the fill remains in relation to the screen.

The fill orientation is a common setting to the percent fill horizontal and percent fill vertical animations.
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To configure an element with a percent fill vertical animation
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select % Fill Vertical. The percent fill vertical animation is added to the Animation list3.
and the % Fill Vertical configuration panel appears.

4. In the Analog box, type an analog value, attribute reference or expression.4.

5. In the Value-At Min Fill box, type an analog value, attribute reference or expression that causes the5.
minimum percent of filling at run time.

6. In the Value-At Max Fill box, type an analog value, attribute reference or expression that causes the6.
maximum percent of filling at run time.

7. In the Fill-Min% box, type an analog value, attribute reference or expression to specify the minimum percent7.
of filling.

8. In the Fill-Max% box, type an analog value, attribute reference or expression to specify the maximum8.
percent of filling.

9. In the Colors area, click the:9.

• Fill Color box to select a style from the Select FillColor dialog box. This is the fill style of the element.•

• Unfilled Color box to select a style from the Select FillColor dialog box. This is the unfilled fill style of the•
element.

For more information, see Setting Style.

10. In the Direction area, select:10.

• Up - to fill from lower to top.•

• Down - to fill from top to lower.•

11. In the Orientation area, select:11.

• Relative to Graphic - so that the filling is in relation to the element and the filling rotates with the•
element.

• Relative to Screen - so that the filling is in relation to the screen and the filling does not rotate with the•
element.

12. You can preview your configuration by using the slider in the Preview area. Drag the slider to see how12.
different values affect the appearance at run time.

13. Click OK.13.

Configuring a Horizontal Location Animation
You can configure an element with a horizontal location animation.

To configure an element with a horizontal location animation
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.
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3. Click the Add icon and select Location Horizontal. The horizontal location animation is added to the3.
Animation list and the Location Horizontal configuration panel appears.

4. In the Analog box, type an analog value, attribute reference or expression.4.

5. In the Value-At Left End box, type an analog value, attribute reference or expression that corresponds to the5.
offset specified by the Movement-To Left value.

6. In the Value-At Right End box, type an analog value, attribute reference or expression that corresponds to6.
the offset specified by the Movement-To Right value.

7. In the Movement-To Left box, type an analog value, attribute reference or expression for the maximum7.
offset to the left.

8. In the Movement-To Right box, type an analog value, attribute reference or expression for the maximum8.
offset to the right.

9. Click OK.9.

Configuring a Vertical Location Animation
You can configure an element with a vertical location animation.

To configure an element with a vertical location animation
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select Location Vertical. The vertical location animation is added to the Animation list3.
and the Location Vertical configuration panel appears.

4. In the Analog box, type an analog value, attribute reference or expression.4.

5. In the Value - At Top box, type an analog value, attribute reference or expression that corresponds to the5.
offset specified by the Movement - Up value.

6. In the Value - At lower box, type an analog value, attribute reference or expression that corresponds to the6.
offset specified by the Movement - Down value.

7. In the Movement - Up box, type an analog value, attribute reference or expression for the maximum offset7.
upwards.

8. In the Movement - Down box, type an analog value, attribute reference or expression for the maximum8.
offset downwards.

9. Click OK.9.

Configuring a Width Animation
You can configure an element with a width animation. You can also specify if the element is to be anchored to its
left, center, right side or origin.

To configure an element with a width animation
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.
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3. Click the Add icon and select Width. The width animation is added to the Animation list and the Width3.
configuration panel appears.

4. In the Analog box, type an analog value, attribute reference or expression.4.

5. In the Value-At Min Size box, type an analog value, attribute reference or expression that corresponds to the5.
minimum width specified by the Width-Min% value.

6. In the Value-At Max Size box, type an analog value, attribute reference or expression that corresponds to the6.
maximum width specified by the Width-Max% value.

7. In the Width-Min% box, type an analog value, attribute reference or expression for the minimum width in7.
percent of the original element.

8. In the Width-Max% box, type an analog value, attribute reference or expression for the maximum width in8.
percent of the original element.

9. In the Anchor area, select:9.

• Left - to specify that the left of the element is anchored.•

• Center - to specify that the horizontal center of the element is anchored.•

• Right - to specify that the right side of the element is anchored.•

• Origin - to specify that the origin of the element is anchored.•

10. Click OK.10.

Configuring a Height Animation
You can configure an element with a height animation. You can also specify if the element is to be anchored to its
top side, middle, lower side or origin.

To configure an element with a height animation
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select Height. The height animation is added to the Animation list and the Height3.
configuration panel appears.

4. In the Analog box, type an analog value, attribute reference or expression.4.

5. In the Value-At Min Size box, type an analog value, attribute reference or expression that corresponds to the5.
minimum height specified by the Height-Min% value.

6. In the Value-At Max Size box, type an analog value, attribute reference or expression that corresponds to the6.
maximum height specified by the Height-Max% value.

7. In the Height-Min% box, type an analog value, attribute reference or expression for the minimum height in7.
percent of the original element.

8. In the Height-Max% box, type an analog value, attribute reference or expression for the maximum height in8.
percent of the original element.

9. In the Anchor area, select:9.

• Top - to specify that the top side of the element is anchored.•
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• Middle - to specify that the vertical center of the element is anchored.•

• Lower - to specify that the lower side of the element is anchored.•

• Origin - to specify that the origin of the element is anchored.•

10. Click OK.10.

Configuring a Point Animation
Point animation changes the X and Y coordinate values of one or more selected points on a graphic or graphic
element. During run time, the X and the Y coordinates of a selected point are set to an expression or reference
that evaluates to a calculated real floating point value.

Point animation supports negative floating point values, which may cause the animation to go out of scope of
the visualization window. In the case when a point’s expression evaluates to a null value or causes an exception,
animation stops and the point retains its original value.

The X and Y coordinates of a point can be configured as a pair or individually. If only the X coordinate of a point is
configured, then the Y coordinate value is kept constant. The animation shows the point of the graphic element
traversing the X axis. Likewise, if only the Y coordinate of a point is configured, then the animation shows the
point traversing the Y axis with the point’s X axis value held constant.

After selecting point animation, a list of configurable points is retrieved from the graphic element based on the
following conditions.

• If the graphic element is a multi-point graphic type (Line, HV/Line, Polyline, Curve, Polygon, Closed curve),•
animation control points appear on the graphic element in preview mode.

• If the graphic element is not a supported multi-point graphic, then the top left X and Y coordinate of the•
graphic element is selected as the animation point.

In the case of an element group consisting of several graphic elements, the animation point is the top left
corner of the rectangle around all grouped elements.

To configure point animation
1. Open the graphic in Industrial Graphic Editor.1.

2. Select a graphic element.2.

3. On the Special menu, click Edit Animations.3.

The Edit Animations dialog box appears.

4. Click the Add Animation button to show a list of Visualization and Interaction animations.4.

5. Select Point from the Visualization animation list.5.

The Point dialog box appears with a list of points and a preview of the points on the graphic. The list shows
each point as a pair of X and Y fields to enter an expression or a reference that evaluates to a floating point
value.

6. Select a point from the list of points.6.

The selected point changes to orange in the preview of the graphic.

7. Enter an expression, constant, or reference in the Point field.7.

8. Repeat steps 6-7 to animate other points in the graphic.8.
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9. Save your changes.9.

Configuring an Orientation Animation
You can configure an element with an orientation animation. You can also:

• Specify a different orientation origin.•

• Ignore or accept the design-time orientation of the element on the canvas.•

• Preview the orientation at run time with a slider.•

To configure an element with an orientation animation
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select Orientation. The orientation animation is added to the Animation list and the3.
Orientation configuration panel appears.

4. In the Analog box, type an analog value, attribute reference or expression.4.

5. In the Value-At CCW End box, type an analog value, attribute reference or expression that corresponds to5.
the maximum angle in degrees for the counter-clockwise orientation as specified by the Orientation-CCW
value.

6. In the Value-At CW End box, type an analog value, attribute reference or expression that corresponds to the6.
maximum angle in degrees for the counter-clockwise orientation as specified by the Orientation-CW value.

7. In the Orientation-CCW box, type an analog value, attribute reference or expression for the maximum7.
orientation in counter-clockwise direction in degrees.

8. In the Orientation-CW box, type an analog value, attribute reference or expression for the maximum8.
orientation in clockwise direction in degrees.

9. In the Orientation Offset area, select:9.

• Replace Current to ignore the design-time orientation of the element as it appears on the canvas and to•
use absolute orientation.

• Use Current as Offset Orientation to orientate the element at run time in relation to its design-time•
orientation on the canvas.
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10. If you use current as offset orientation, you can type an offset value in the text box next to Use Current as10.
Offset Orientation. This affects the orientation of the element on the canvas.

11. In the Current Relative Origin area, type values in the dX and dY boxes to specify the rotation origin as offset11.
from the element center point. This affects the point of origin of the element on the canvas.

12. You can preview the orientation and how run-time values affect the appearance of the element, by dragging12.
the slider in the Preview area.

13. Click OK.13.

Configuring a Value Display Animation
You can configure an element with a value display animation. You can show:

• A Boolean value as a Message.•

• An Analog value.•

• A string value.•

• A time or date value.•

• The tag name, hierarchical name or contained name of the hosting object.•

• A value based on Truth Table conditions.•

• A value based on Bit State conditions.•

Configuring an Analog Value Display Animation
You can configure a text element, TextBox, or button to show an analog value. You can also configure an analog
value display animation for a grouped element when the TreatAsIcon property is True.

© 2022 AVEVA Group plc and its subsidiaries. All rights reserved.
  

Page 111

AVEVA™ Industrial Graphic Editor User Guide 
Chapter 3 – Graphic Elements



To configure an element with an analog value display animation
1. Select the text element, TextBox, Button, or grouped element that you want to configure Analog Value1.

Display animation.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select Value Display. The value display animation is added to the Animation list and3.
the Value Display state selection panel appears.

4. Click the Analog button. The Analog Value Display configuration panel appears.4.

5. In the Analog box, type an analog value, attribute reference or expression.5.

6. Click the Text Format drop-down list and select a global number style.6.

• Format String is the default numeric format, which includes a text field to enter characters that specify a•
number format. For more information about assigning a number format using typed characters, see
Enter Input Numbers in U.S. Format.

• Selecting custom from the Text Format list shows another drop-down list to select a number format.•

• Fixed Width: Appears on the Analog Value Display dialog box for every Custom number format.•
When selected, the run-time number value will not exceed the text length specified for Value Display
animation.

• Precision: Appears on the Analog Value Display dialog box for the Fixed Decimal and Exponential•
Custom number formats. Precision sets the precision of the fractional part of a number to the right
of the decimal point.

• Bits From and To: Appear on the Analog Value Display dialog box for the Hex and Binary number•
formats. Bits From sets the starting bit position of a hex or binary number shown during run time. To
sets the ending bit position of a hex or binary number shown during run time.

7. Click OK.7.

Except for the Format String and Custom text styles, all other text styles are global number styles that don't
need further configuration.

For more information about the listed global number formats, see Setting Global Number Styles.

Configuring Value Display Animation with the FormatStyle Property

When Value Display or User Input animation have a text format configured with a number style from your HMI/
SCADA software, numeric data shown during run time is formatted in accordance to the number style selected
for the animation.

Changes to a number style are not propagated during run time. Any changes to global number styles become
effective only after the HMI/SCADA software is restarted.

A number style can be changed during run time using the FormatStyle property. FormatStyle is a text element
run-time property that displays the name of the current applied global number style. The value of the
FormatStyle property can be set as the active number style of Value Display and User Input animation during run
time .

• If the name applied to the FormatStyle property during run time is the name of a global number style, the•
text element is reformatted using the new applied number style for Value Display or User Input animation.
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• If the FormatStyle property is assigned a value that does not match any global number style, the value of•
FormatStyle remains unchanged and a warning message is logged to SMC logger.

• If FormatStyle is set to an empty string, the text format of User Input and Value Display animation reverts to•
the value specified for Text Format during design time.

• If a text element is inside a group in which the TreatAsIcon property is set to True, then the group's text•
format overrides the first text child element for Value Display or User Input animation.

• If a text element’s FormatStyle property changes in run time, the new number style is used to format the•
text element. Because a graphic group does not have TextFormat and FormatStyle properties, using the
FormatStyle property is the only way to change the format of text in run time.

Configuring a Boolean Value Display Animation
You can configure an element to show a Boolean value as a message.

To configure an element with a Boolean value display animation
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select Value Display. The value display animation is added to the Animation list and3.
the Value Display state selection panel appears.

4. Click the Boolean button. The Boolean Value Display configuration panel appears.4.

5. In the Boolean box, type a Boolean value, attribute reference or expression.5.

6. In the True Message box, type a value, attribute reference or expression for the text display when the6.
expression is true.

7. In the False Message box, type a value, attribute reference or expression for the text display when the7.
expression is false.

8. Click OK.8.

Configuring a Truth Table Value Display Animation
You can configure an element to display a value, based on Truth Table conditions.

Note: AVEVA OMI ViewApps do not support Truth Table Value Display animations. The Truth Table Value Display
animation has not been tested on a non-English language Operating System. Web Client does not support Truth
Table Value Display animations.

To configure an element with a Truth Table value display animation
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select Value Display. The value display animation is added to the Animation list and3.
the Value Display configuration panel appears.

4. Click the Truth Table button. The Truth Table configuration panel appears.4.

5. In the Expression Or Reference area:5.

a. Select the data type of the expression from the list.a.

b. Type a value, attribute reference or expression in the text box.b.
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6. If the data type of the expression is string, you can specify to ignore the case by selecting Ignore Case.6.

7. In the truth table area, under the Text column, click the Input Mode icon to set a static value or an attribute7.
reference or expression. The Galaxy Browser will only be available for the Reference or expression mode. For
more information, see Setting the Input Mode.

8. In the Operator column, select a comparison operator. (<, <=, >, >=,=). If the data type selected is Boolean,8.
"=" is the only available option for the Operator column.

9. In the Value or Expression column, type a value, attribute reference, or expression.9.

10. To add/remove other conditions:10.

a. Click the Add icon. An additional condition is added to the truth table.a.

b. Click the Remove icon. The selected condition is removed from the table.b.

11. To reorder the condition use the up and down arrows.11.

12. After adding all truth table conditions, click OK.12.

Configuring a String Value Display Animation
You can configure an element to show a string value.

To configure an element with a string value display animation
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select Value Display. The value display animation is added to the Animation list and3.
the Value Display state selection panel appears.

4. Click the String button. The String Value Display configuration panel appears.4.

5. In the String box, type a string value, attribute reference or expression.5.

6. Click OK.6.

Configuring a Time Value Display Animation
You can configure an element to show a time value.

Use the following letters to set the time format:

h The one or two-digit hour in 12-hour format.

hh The two-digit hour in 12-hour format. Single digit values are
preceded by a zero.

H The one or two-digit hour in 24-hour format.

HH The two-digit hour in 24-hour format. Single digit values are
preceded by a zero.

t The one-letter AM/PM abbreviation ("AM" appears as "A").

tt The two-letter AM/PM abbreviation ("AM" appears as "AM").
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m The one or two-digit minute.

mm The two-digit minute. Single digit values are preceded by a zero.

s The one or two-digit seconds.

ss The two-digit seconds. Single digit values are preceded by a
zero.

d The one or two-digit day.

dd The two-digit day. Single digit day values are preceded by a
zero.

ddd The three-character day-of-week abbreviation.

dddd The full day-of-week name.

M The one or two-digit month number.

MM The two-digit month number. Single digit values are preceded
by a zero.

MMM The three-character month abbreviation.

MMMM The full month name.

y The one-digit year (2001 appears as "1").

yy The last two digits of the year (2001 appears as "01").

yyyy The full year (2001 appears as "2001").

The format for elapsed time is:

[–][DDDDDD] [HH:MM:]SS[.fffffff]

Use the following letters to set the elapsed time format:

DDDDDD The number of days. Valid values are 0 to 999999.

HH The two-digit hour in 24-hour format. Single digit values are
preceded by a zero. Valid values are 00 to 23.

MM The two-digit month number. Single digit values are preceded
by a zero. Valid values are 00 to 59.

SS The two-digit seconds. Single digit values are preceded by a
zero. Valid values are 00 to 59.

fffffff Optional fractional seconds to right of decimal, and can be one
through seven digits.

You can use any other characters, except "g" in the property. These characters then appear at design time and
run time in the control.

To configure an element with a time value display animation
1. Select the element.1.
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2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select Value Display. The value display animation is added to the Animation list and3.
the Value Display state selection panel appears.

4. Click the Time button. The Time Value Display configuration panel appears.4.

5. In the Time or Elapsed Time box, type a time or elapsed time value, attribute reference or expression.5.

6. In the Text Format box, type a format for the value output. If you change this value, the TextFormat property6.
of the element also changes.

7. Click OK.7.

Configuring a Name Display Animation
You can configure an element to show the tag name, hierarchical name or contained name of the
AutomationObject that is hosting it.

For example if the AutomationObject hosting the graphic is named Valve_001 and Valve_001 is contained in
Pump_001 and has a contained name of InletValve, then configuring an element with the value display
animation with:

• Tag Name shows Valve_001 at run time•

• Hierarchical Name shows Pump_001.InletValve at run time•

• Contained Name shows InletValve at run time•

To configure an element with a name display animation
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select Value Display. The value display animation is added to the Animation list and3.
the Value Display state selection panel appears.

4. Click the Name button. The Name Display configuration panel appears.4.

5. Select:5.

• Tag Name to show the tag name of the hosting AutomationObject.•

• Hierarchical Name to show the hierarchical name of the hosting AutomationObject.•

• Contained Name to show the contained name of the hosting AutomationObject.•

6. Click OK.6.

Configuring a Bit State Value Display Animation
You can configure an element with a Bit State animation.

To configure an element with a bit state value display animation
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select Value Display. The Value Display animation is added to the Animation list and3.
the Value Display state selection panel appears.

4. Click the Bit State button. The Bit State Value Display configuration panel appears.4.
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5. In the Expression Or Reference area, type a value, attribute reference or expression in the text box. Only5.
integer values are allowed.

6. In the Bit State area, select the:6.

a. Text: Under the Text column, click the Input Mode icon to set a static value or an attribute reference ora.
expression.

b. Operator: Any or Allb.

c. Bitmask/Bitmatch: For more information, see Using the Bit Pattern Selector Dialog.c.

7. To add/remove other conditions:7.

a. Click the Add icon. An additional condition is added to the table.a.

b. Click the Remove icon. The selected condition is removed from the table.b.

8. To reorder the condition use the up and down arrows.8.

9. After adding all the bit state conditions, click OK.9.

Configuring a Tooltip Animation
You can configure an element with a:

• String Tooltip animation•

• Bit State Tooltip animation•

Configuring a String Tooltip Animation
You can configure an element with a string animation.

To configure an element with a tooltip animation
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select Tooltip. The tooltip animation is added to the Animation list and the Tooltip3.
configuration panel appears.

4. Click the String button. The String Tooltip configuration panel appears.4.

5. In the Expression box, type:5.

a. A static value and make sure the Input Mode icon is set to static.a.

b. An attribute reference or expression and make sure the Input Mode icon is set to attribute or reference.b.

6. Click OK.6.

Configuring a Bit State Tooltip Animation
You can configure an element with a bit state animation.

To configure an element with a bit state tooltip animation
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.
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3. Click the Add icon and select Tooltip. The tooltip animation is added to the Animation list and the Tooltip3.
state selection panel appears.

4. Click the Bit State button. The Bit State Tooltip configuration panel appears.4.

5. In the Expression Or Reference area, type a value, attribute reference or expression in the text box. Only5.
integer values are allowed.

6. In the Bit State area, select the:6.

a. Tooltip: Click the Input Mode icon to set a static value or an attribute reference or expression.a.

b. Operator: Any or All.b.

c. Bitmask/Bitmatch: For more information, see Using the Bit Pattern Selector Dialog.c.

7. To add/remove other conditions:7.

a. Click the Add icon. An additional condition is added to the table.a.

b. Click the Remove icon. The selected condition is removed from the table.b.

8. To reorder the condition use the up and down arrows.8.

9. After adding all the bit state conditions, click OK.9.

Configuring a Disable Animation
You can configure an element with a disable animation. This lets you disable user interaction with an element
depending on a run-time value or expression.

You can configure an element with a:

• A boolean disable animation•

• A truth table disable animation•

• A bit state disable animation•

Configuring a Boolean Disable Animation
You can configure an element with a boolean disable animation.

To configure an element with a boolean disable animation
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select Disable. The disable animation is added to the Animation list and the Disable3.
configuration panel appears.

4. Click the Boolean button. The Boolean Disable configuration panel appears.4.

5. In the Boolean box, type a Boolean numeric value, attribute reference or expression.5.

6. In the Disabled When Expression is area, select:6.

a. True,1, On in which case the element is disabled at run time whenever the expression is true, anda.
enabled whenever the expression is false.

b. False, 0, Off in which case the element is disabled at run time whenever the expression is false, andb.
enabled whenever the expression is true.
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7. Click OK.7.

Configuring a Truth Table Disable Animation
You can configure an element with a truth table animation.

Note: AVEVA OMI ViewApps do not support Truth Table Disable animations. The Truth Table Disable animation
has not been tested on a non-English language Operating System. Web Client does not support Truth Table
Disable animations.

To configure an element with a truth table disable animation
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select Disable. The disable animation is added to the Animation list and the Disable3.
selection panel appears.

4. Click the Truth Table button. The Truth Table configuration panel appears.4.

5. In the Expression Or Reference area:5.

a. Select the data type of the expression from the list.a.

b. Type a value, attribute reference or expression in the text box.b.

6. If the data type of the expression is string, you can specify to ignore the case by selecting Ignore Case.6.

7. In the Truth Table area, under Disable, select true to disable the element or false to enable it.7.

8. In the Operator column, select the comparison operator ('=', '<', '>', '<=', '>='). If the data type selected in8.
step 5, is boolean then only the '=' operator is available.

9. In the Value or Expression column, type a value, attribute reference, or expression.9.

10. To add/remove other conditions:10.

a. Click the Add icon. An additional condition is added to the truth table.a.

b. Click the Remove icon. The selected condition is removed from the table.b.

11. To reorder the conditions click the up and down arrows.11.

12. After adding all truth table conditions, click OK.12.

Configuring a Bit State Disable Animation
You can configure an element with a bit state disable animation.

To configure an element with a bit state disable animation
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select Disable. The disable animation is added to the Animation list and the Disable3.
state selection panel appears.

4. Click the Bit State button. The Bit State Disable configuration panel appears.4.

5. In the Expression Or Reference area, type a value, attribute reference or expression in the text box. Only5.
integer values are allowed.
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6. In the Bit State area, select the:6.

a. Disable: Select true to disable the element or false to enable.a.

b. Operator: Any or All.b.

c. Bitmask/Bitmatch: For more information, see Using the Bit Pattern Selector Dialog.c.

7. To add/remove other conditions:7.

a. Click the Add icon. An additional condition is added to the table.a.

b. Click the Remove icon. The selected condition is removed from the table.b.

8. To reorder the condition use the up and down arrows.8.

9. After adding all the bit state conditions, click OK.9.

Configuring a User Input Animation
You can configure an element with a user input animation for the following data types:

• Boolean•

• Analog (integer, float, double)•

• String•

• Time•

• Elapsed time•

Configuring a User Input Animation for a Discrete Value
You can configure an element with a user input animation for a Boolean value.

To configure an element with a user input animation
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select User Input. The user input animation is added to the Animation list and the3.
User Input state selection panel appears.

4. Click the Boolean button. The Boolean Value User Input configuration panel appears.4.

5. Specify the options. Do one or more of the following:5.

• In the Boolean box, type an attribute reference or browse for one by using the browse button.•

• In the Message to User box, type a value, attribute reference or expression. This is the text that appears•
as prompt on the Boolean value input dialog box at run time.

• In the Prompt - True Message box, type a value, attribute reference or expression. This is the text that•
appears on the button that causes the attribute to be set to true.

• In the Prompt - False Message box, type a value, attribute reference or expression. This is the text that•
appears on the button that causes the attribute to be set to false.

• Specify that the input dialog box appears by pressing a key or key combination. In the Shortcut area.•
Select a shortcut key in the Key list. Select CTRL and/or SHIFT to combine the shortcut key with the CTRL
key and/or SHIFT key.
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• If you don’t want the discrete value display element to show the True Message and False Message, select•
Input Only.

• In the Display Value - True Message box, type a value, attribute reference or expression. This is the text•
that appears on the canvas when the associated attribute is true.

• In the Display Value - False Message box, type a value, attribute reference or expression. This is the text•
that appears on the canvas when the associated attribute is false.

• Verify that the input modes of all boxes are set correctly. Click the Input Mode icon to set a static value•
or an attribute reference or expression.

6. Click OK.6.

Configuring a User Input Animation for an Analog Value
You can configure an element with a user input animation for an analog value.

To configure an element with a user input animation for an analog value
1. Select the text element, TextBox, Button, or grouped element that you want to configure for User Input1.

animation.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon from the Animations pane and select User Input.3.

User Input is added to the Interaction list and User Input state selection panel appears.

4. Click the Analog button. The Analog Value User Input configuration panel appears.4.

5. In the Analog box, type an attribute reference or browse for one by using the browse button.5.

6. In the Message to User box, type a value, attribute reference, or expression. This text appears to prompt for6.
the analog value input dialog box at run time.

7. Verify that the input mode of the Message to User box is set correctly. Click the Input Mode icon to set a7.
static value or an attribute reference or expression.

8. If you want to restrict the range of input values, you can do so in the Value Limits area by:8.

• First selecting Restrict Values.•

• Enter values, attribute references, or expressions in the Minimum and Maximum boxes.•

9. In the Shortcut area, specify that an Input dialog box appears by pressing a key or key combination. Select a9.
shortcut key from the Key list. Select CTRL and/or SHIFT to combine the shortcut key with the Ctrl key and/or
Shift key.

10. Select Input Only to restrict the text of a graphic from showing the current value of the reference attribute.10.

If unchecked, the text of a graphic shows the current value of the reference attribute.

11. Select Use Keypad to show a keypad during run time for the user to type a data value.11.

12. Click the Text Format drop-down list and select a global number format.12.

For more information about the listed global number styles, see Setting Global Number Styles.

Format String is the default numeric format, which includes a text entry field to assign a number format
using four characters:
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Numeric Format Character Description

Zero, (0) Represents a digit at each specified position of a real number.
Forces leading zeros to the integer part of a number and trailing
zeros to the fractional part of a number.

Pound sign, (#) Represents a digit at that position within a number.

Comma, (,) Inserts a comma at the specifed position of a real number.

Decimal point, (.) Inserts a decimal point at the specified position of a real number.

Except for the Format String and Custom text styles, all other text styles are global number styles that don't
need further configuration.

13. Click OK.13.

Configuring a User Input Animation for a String Value
You can configure an element with a user input animation for a string value.

To configure an element with a user input animation for a string value
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select User Input. The user input animation is added to the Animation list and the3.
User Input state selection panel appears.

4. Click the String button. The String Value User Input configuration panel appears.4.

5. In the String box, type an attribute reference or browse for one by using the browse button.5.

6. In the Message to User box, type a value, attribute reference or expression. This is the text that appears as6.
prompt on the string value input dialog box at run time.

7. Verify that the input mode of the Message to User box is set correctly. Click the Input Mode icon to set a7.
static value or an attribute reference or expression.

8. You can specify that the Input dialog box appears by pressing a key or key combination. In the Shortcut area.8.
Select a shortcut key in the Key list. Select CTRL and/or SHIFT to combine the shortcut key with the CTRL key
and/or SHIFT key.

9. If you don’t want the string value display element to show the string input result on the canvas, select Input9.
Only.

10. If you want to use the keypad to type the string value, select Use Keypad.10.

11. If you select Input Only and want to see placeholders during the input at run time, select Echo Characters.11.

12. If you are configuring a password input:12.

• Select Password.•

• Type in the replacement character in the adjacent box.•

• Select Encrypt if you want to encrypt the string that holds the password.•
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Password encryption only works within the context of HMI/SCADA software applications that support
password encryption. Do not encrypt the string if you want to pass it to an external security system, such
as the operating system or a SQL Server database. The external security system cannot read the
encrypted password string and access will fail.

13. Click OK.13.

Configuring a User Input Animation for a Time Value
You can configure an element with a user input animation for a time value.

To configure an element with a user input animation for a time value
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select User Input. The user input animation is added to the Animation list and the3.
User Input state selection panel appears.

4. Click the Time button. The Time Value User Input configuration panel appears.4.

5. In the Time box, type an attribute reference or browse for one by using the browse button.5.

6. In the Message to User box, type a value, attribute reference or expression. This is the text that appears as6.
prompt on the time value input dialog box at run time.

7. Verify that the input mode of the Message to User box is set correctly. Click the Input Mode icon to set a7.
static value or an attribute reference or expression.

8. Specify that the Input dialog box appears by pressing a key or key combination. In the Shortcut area. Select a8.
shortcut key in the Key list. Select CTRL and/or SHIFT to combine the shortcut key with the Ctrl key and/or
Shift key.

9. If you don’t want the time value display element to show the time input result on the canvas, select Input9.
Only.

10. To use the current date and time as default, select Use Current Date/Time as Default.10.

11. Select:11.

• Use Input Dialog to use the Time User Input dialog box at run time to type date and time values in•
individual boxes.

• Use Calendar to use the Time User Input dialog box at run time to type a date with the calendar control.•

12. If you select Use Input Dialog to type the time value, you can select:12.

• Date and Time to type date and time.•

• Date to only type a date.•

• Time to only type a time.•

Select Show Seconds if you also want to input seconds.

13. If you want to format your text after input, type a valid text format in the Text Format box. Use the following13.
letters to set the time format:

h The one or two-digit hour in 12-hour format.
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hh The two-digit hour in 12-hour format. Single digit values are
preceded by a zero.

H The one or two-digit hour in 24-hour format.

HH The two-digit hour in 24-hour format. Single digit values are
preceded by a zero.

t The one-letter AM/PM abbreviation ("AM" appears as "A").

tt The two-letter AM/PM abbreviation ("AM" appears as "AM").

m The one or two-digit minute.

mm The two-digit minute. Single digit values are preceded by a
zero.

s The one or two-digit seconds.

ss The two-digit seconds. Single digit values are preceded by a
zero.

d The one or two-digit day.

dd The two-digit day. Single digit day values are preceded by a
zero.

ddd The three-character day-of-week abbreviation.

dddd The full day-of-week name.

M The one or two-digit month number.

MM The two-digit month number. Single digit values are preceded
by a zero.

MMM The three-character month abbreviation.

MMMM The full month name.

y The one-digit year (2001 appears as "1").

yy The last two digits of the year (2001 appears as "01").

yyyy The full year (2001 appears as "2001").

You can use any other characters, except "g" in the property. These characters then appear at design time and
run time in the control.

1. Click OK.1.

Configuring a User Input Animation for an Elapsed Time Value
You can configure an element with a user input animation for an elapsed time value.

To configure an element with a user input animation for an elapsed time value
1. Select the element.1.
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2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select User Input. The user input animation is added to the Animation list and the3.
User Input state selection panel appears.

4. Click the Elapsed Time button. The Elapsed Time Value User Input configuration panel appears.4.

5. In the Elapsed Time box, type an attribute reference or browse for one by using the browse button.5.

6. In the Message to User box, type a value, attribute reference or expression. This is the text that appears as6.
prompt on the elapsed time value input dialog box at run time.

7. Verify that the input mode of the Message to User box is set correctly. Click the Input Mode icon to set a7.
static value or an attribute reference or expression.

8. Specify that the Input dialog box appears by pressing a key or key combination. In the Shortcut area. Select a8.
shortcut key in the Key list. Select CTRL and/or SHIFT to combine the shortcut key with the CTRL key and/or
SHIFT key.

9. If you don’t want the elapsed time value display element to show the time elapsed input result on the9.
canvas, select Input Only.

10. Select Use Dialog to use the Elapsed Time User Input dialog box to type the elapsed time value at run time.10.

11. If you select Use Dialog to type the elapsed time value, you can optionally select:11.

Show Days if you also want to input days.

Show Milliseconds if you also want to input milliseconds.

12. Click OK.12.

Configuring a Horizontal Slider Animation
You can configure an element with a horizontal slider animation. This lets you drag an element at run time in
horizontal direction and write a corresponding value back to an attribute.

To configure an element with a horizontal slider animation
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select Slider Horizontal. The horizontal slider animation is added to the Animation list3.
and the Slider Horizontal configuration panel appears.

4. In the Analog box, type an attribute reference or browse for one by using the browse button.4.

5. In the Value - Left Position box, type an analog value, attribute reference or expression that corresponds to5.
the offset specified by the Movement - To Left value.

6. In the Value - Right Position box, type an analog value, attribute reference or expression that corresponds to6.
the offset specified by the Movement - To Right value.

7. In the Movement - To Left box, type an analog value, attribute reference or expression for the maximum7.
offset to the left in pixels.

8. In the Movement - To Right box, type an analog value, attribute reference or expression for the maximum8.
offset to the right in pixels.
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9. You can select where the cursor is anchored to the element when it is dragged at run time. In the Cursor9.
Anchor area, select:

• Left to anchor the element at its left.•

• Center to anchor the element at its center point.•

• Right to anchor the element at its right side.•

• Origin to anchor the element at its point of origin.•

10. You can select if position data from the slider is written continuously to the attribute, or only one time when10.
the mouse button is released. In the Write Data area, select Continuously or On mouse release.

11. If you want a tooltip to appear on the element showing the current value during dragging, select Show11.
Tooltip.

12. Preview the movement as it appears in run time by dragging the slider in the Preview area.12.

13. Click OK.13.

Configuring a Vertical Slider Animation
You can configure an element with a vertical slider animation.

To configure an element with a vertical slider animation
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select Slider Vertical. The vertical slider animation is added to the Animation list and3.
the Slider Vertical configuration panel appears.

4. In the Analog box, type an attribute reference or browse for one by using the browse button.4.

5. In the Value - Top Position box, type an analog value, attribute reference or expression that corresponds to5.
the offset specified by the Movement - Up value.

6. In the Value - lower Position box, type an analog value, attribute reference or expression that corresponds to6.
the offset specified by the Movement - Down value.

7. In the Movement - Up box, type an analog value, attribute reference or expression for the maximum offset7.
upwards in pixels.

8. In the Movement - Down box, type an analog value, attribute reference or expression for the maximum8.
offset downwards in pixels.

9. You can select where the cursor is anchored to the element when it is dragged at run time. In the Cursor9.
Anchor area, select:

• Top to anchor the element at its top side.•

• Middle to anchor the element at its middle point.•

• Lower to anchor the element at its lower side.•

• Origin to anchor the element at its point of origin.•

10. You can select if position data from the slider is written continuously to the attribute, or only one time when10.
the mouse button is released. In the Write Data area, select Continuously or On mouse release.
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11. If you want a tooltip to appear on the element showing the current value during dragging, select Show11.
Tooltip.

12. Preview the movement as it appears in run time by dragging the slider in the Preview area.12.

13. Click OK.13.

Configuring a Pushbutton Animation
You can configure an element with a pushbutton animation to change Boolean, analog or string references.

Configuring a Pushbutton Animation for a Boolean Value
You can configure an element with a pushbutton to change a Boolean value.

To configure an element with a pushbutton animation to change a Boolean value
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select Pushbutton. The pushbutton animation is added to the Animation list and the3.
Pushbutton state selection panel appears.

4. Click the Boolean button. The Boolean Pushbutton configuration panel appears.4.

5. In the Boolean box, type a Boolean attribute reference or browse for one by using the browse button.5.

6. In the Action list, select:6.

• Direct so the value becomes true when the element is clicked and the mouse button held. The value•
returns to false when the mouse button is released.

• Reverse so the value becomes false when the element is clicked and the mouse button held. The value•
returns to true when the mouse button is released.

• Toggle so the value becomes true if it is false and false if it is true when the element is clicked.•

• Set so the value is set to true when the element is clicked.•

• Reset so the value is set to false when the element is clicked.•

• Momentary Contact to configure a time-period to hold the set value. (The Momentary Contact action•
has not been tested on a non-English language Operating System. AVEVA OMI ViewApps and Web Client
do not support this action.)

7. If you select Toggle, Set, Reset or Momentary Contact as action, you can configure the action to be7.
performed when the mouse button is released instead of pressed down. To do this, select On button
release.

8. If you select Direct, Reverse, Reset or Set as action, you can configure the value to be written:8.

• Continuously by selecting Continuously while button is pressed. Also specify the frequency the value is•
to be sent, by typing a value in the Delay between value send box.

• One time by clearing Continuously while button is pressed.•

9. If you select Momentary Contact then you can configure:9.

• Pulse Type: From the drop down list, you can select True (default), false or Toggle.•
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• Time Period: Enter an integer value between 500 and 5000 milliseconds to set the time the momentary•
contact animation will be held. Default will be 500 milliseconds.

10. The Momentary Contact does not have preview and only displays "No Preview". However, a short10.
description is displayed below the Preview area, while changing the Pulse Type.

• For True (Default): TRUE on mouse action. FALSE after time period.•

• For False: FALSE on mouse action. TRUE after time period.•

• Toggle: On mouse action set to opposite of starting state. Set back to starting state after time period.•

11. Specify that the pushbutton action is executed by pressing a key or key combination. In the Shortcut area.11.
Select a shortcut key in the Key list. Select CTRL and/or SHIFT to combine the shortcut key with the Ctrl key
and/or Shift key.

12. Preview the pushbutton run-time behavior by clicking Button in the Preview area.12.

13. Click OK.13.

Configuring a PushButton Animation for an Analog Value
You can configure an element with a pushbutton to set an analog value.

To configure an element with a pushbutton animation to set an analog value
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select Pushbutton. The pushbutton animation is added to the Animation list and the3.
Pushbutton state selection panel appears.

4. Click the Analog button. The Analog Pushbutton configuration panel appears.4.

5. In the Analog box, type an attribute reference or browse for one by using the browse button.5.

6. From the Action list, select:6.

• Direct so the value becomes Value1 when the element is clicked and the mouse button held. The value•
returns to Value2 when the mouse button is released.

• Toggle so the value becomes Value1 if it is Value2 and Value2 if it is Value1 when the element is clicked.•

• Set so the value is set to Value1 when the element is clicked•

7. In the boxes Value1 and, if applicable, Value2, type analog values, attribute references or references.7.

8. From the Action list, select8.

• Increment so the value is increased by Value1.•

• Decrement so the value is decreased by Value1.•

• Multiply so the value is multiplied with Value1.•

• Divide so the value is divided by Value1.•

(The Increment, Decrement, Multiply and Divide actions have not been tested on a non-English
language Operating System. AVEVA OMI ViewApps and Web Client do not support these actions.)

On selecting any of the above four options; you are presented with the following options:

a. Percentagea.
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If Checked If Unchecked

Value1 will be the ramp percentage of the
range (Maximum – Minimum).

Value1 will be the ramp value

For example, when Increment action is
selected where Value = 100, Value1 = 5,
Minimum = 0, Maximum = 200.

If Percentage is checked, it will ramp up the
reference value by 5% x (200-0) = 10 and
updated reference value = 100 + 10 = 110.

For example, when Increment action is selected
where Value = 100, Value1 = 5, Minimum = 0,
Maximum = 200.

If Percentage is not checked, it will ramp up the
reference value by 5 and updated reference
value = 100 + 5 = 105.

b. Value1: Value1 > 0 to ramp up the existing value; Value1 < 0 to ramp down the existing value.b.

c. Restrict Values: Select the Restrict Values checkbox if you want to provide minimum and maximumc.
values. If the Percentage option is selected, this option will be enabled and greyed out. You must provide
Minimum and Maximum values.
Percentage Restrict Values Reference Value (+,-,*,/)

Unchecked Unchecked CurrentValue (operator) Value1

Unchecked Checked CurrentValue (operator) Value1

(with restriction between minimum and
maximum values)

Checked Unchecked N/A

Checked Checked CurrentValue (operator) [(Value1/100) *
(Maximum-Minimum)]

d. Minimum and Maximum:d.

• During design time only constant values will be validated•

• The Minimum value must be less than the Maximum value•

• If you provide references they will be validated in runtime.•

9. You can configure the value to be written when the mouse button is released instead. Select On button9.
release. This does not apply if you select Direct as action.

10. You can configure the value to be written:10.

• Continuously by selecting the Continuously while button is pressed. Also specify the frequency the•
value is to be sent, by typing a value in the Delay between value send box.

• One time by clearing the Continuously while button is pressed.•

This does not apply if you select Toggle as action. If you select Toggle as action, the Continuously while
button is pressed checkbox will be grayed out and disabled.

11. Specify that the pushbutton action is run by pressing a key or key combination. In the Shortcut area. Select a11.
shortcut key in the Key list. Select CTRL and/or SHIFT to combine the shortcut key with the CTRL key and/or
SHIFT key.
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12. Preview the pushbutton run-time behavior by clicking Button in the Preview area. Click the button multiple12.
times to preview the value changes over a period of time.

13. If the following actions are selected; Increment, Decrement, Multiply or Divide then the Preview area will13.
behave as follows:

• Value will start from 100 and will be updated only if Value1, Minimum, and Maximum are constant•
values, else it will display No Preview.

• Only mouse action with On button release option will update the preview value. Continuously while•
button is pressed option and Shortcut key will not update the preview value.

• If Increment is selected with the Percentage option, the preview message will be Set to existing value•
plus Value1 %x (Max-Min) on mouse action, else the preview message will be Set to existing value plus
Value1 on mouse action.

• The preview message will differ for the action selected; Decrement (minus), Multiply (multiplied) and•
Divide (divided).

14. Click OK.14.

Configuring a PushButton Animation for a String Value
You can configure an element with a pushbutton to set a string value.

To configure an element with a pushbutton animation to set a string value
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select Pushbutton. The pushbutton animation is added to the Animation list and the3.
Pushbutton state selection panel appears.

4. Click the Analog button. The String Pushbutton configuration panel appears.4.

5. In the String box, type an attribute reference or browse for one by using the browse button.5.

6. From the Action list, select:6.

• Direct so the value becomes Value1 when the element is clicked and the mouse button held. The value•
returns to Value2 when the mouse button is released.

• Toggle so the value becomes Value1 if it is Value2 and Value2 if it is Value1 when the element is clicked•

• Set so the value is set to Value1 when the element is clicked.•

7. In the boxes Value1 and, if applicable, Value2, type string values, attribute references or references.7.

8. Verify that the input modes of the Value1 and Value2 boxes are set correctly. Click the Input mode icons to8.
set a static values or an attribute references or expressions.

9. You can configure the value to be written when the mouse button is released instead. Select On button9.
release. This does not apply if you select Direct as action.

10. You can configure the value to be written:10.

• Continuously by selecting the Continuously while button is pressed. Also specify the frequency the•
value is to be sent, by typing a value in the Delay between value send box.

• One time by clearing the Continuously while button is pressed.•
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This does not apply if you select Toggle as action.

11. Specify that the pushbutton action is executed by pressing a key or key combination. In the Shortcut area.11.
Select a shortcut key in the Key list. Select CTRL and/or SHIFT to combine the shortcut key with the Ctrl key
and/or Shift key.

12. Preview the pushbutton run-time behavior by clicking Button in the Preview area.12.

13. Click OK.13.

Configuring an Action Script Animation
You can configure an element with an action script animation.

You can assign multiple action scripts to one element that are activated in different ways such as:

Use this... To activate the action script when the...

On Left Click/Key/Touch Down left mouse button or a specific key is pressed or a
tap on a touch display.

While Left Click/Key/Touch Down left mouse button or a specific key is pressed and
held or the touch display is tapped and held.

On Left/Key/Touch Up (default) left mouse button or a specific key is released or the
tap is released from a touch display.

On Left Double Click/Double Tap left mouse button is double-clicked or the touch
display is tapped twice in quick succession.

On Right Click/Long Press right mouse button is pressed or a long press on the
touch display.

While Right Down right mouse button is pressed and held.

On Right Up right button is released.

On Right Double Click right mouse button is double-clicked.

On Center Click center mouse button is pressed.

While Center Click center mouse button is pressed and held.

On Center Up center mouse button is released.

On Center Double Click center mouse button is double-clicked.

On Mouse Over pointer is moved over the element.

On Mouse Leave pointer is moved out of the element.

On Startup element is first shown in the HMI/SCADA run time
display.

While Mouse Over pointer is over the element.
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To expand the available space for your script, you can use the Expansion buttons to hide the script header
and/or the Animation list.

To configure an element with an action script animation
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select Action Scripts. The action scripts animation is added to the Animation list and3.
the Action Scripts configuration panel appears.

4. From the Trigger type list, select the trigger that activates the action script at run time.4.

5. If you select a trigger type that starts with "While", type how frequently the action script is executed at run5.
time in the Every box.

6. If you select the trigger types On Mouse Over or On Mouse Leave, the Every box label shows After instead.6.
Type a value in the After box. This value specifies after what delay the action script is executed at run time.

7. Specify a trigger type that involves pressing a key is run by typing a key or key combination. In the Shortcut7.
area. Select a shortcut key in the Key list. Select Ctrl and/or Shift to combine the shortcut key with the Ctrl
key and/or Shift key.

8. Create your script in the action script window.8.

9. Click OK.9.

Configuring an Action Script Animation with a "Mouse-Down" Event Trigger
Action scripts that are activated with a "mouse-down" event (for example, On Left Click/Key/Touch Down) trigger
two separate events:

• A mouse-down event, when the button is pressed.•

• A mouse-up event, when the button is released.•

As a result, timing issues can occur in if the user holds the button, even momentarily, before releasing it. These
timing issues can affect how a pushbutton graphic is displayed. The pushbutton image may continue to show as
depressed (active state), even after the user has released the button.

You can avoid this potential timing issue by using a "mouse-up" trigger instead of the "mouse down." A "mouse-
up" trigger only sends one event (when the button is released), thus eliminating any timing issues that could
result from a delay in the user releasing the button.

Configuring a Show Symbol Animation
You can configure an element with a show symbol animation. A Show symbol animation shows a specified
graphic in a new dialog box, when the element is clicked on.

You can configure:

• Which graphic appears in the new window.•

• If the window has a title bar, and if so if it has a caption.•

• If the window is modal or modeless.•

• If the window has a close button.•

• If the window can be resized.•
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• The initial window position.•

• The size of the window.•

You can configure the position to be in relation of the:

• Desktop, such as at edges, corners, or at center.•

Desktop

Top Left Corner 
of Desktop

Top of Desktop Top Right Corner 
of Desktop

Left Side of 
Desktop

Bottom Left Corner 
of Desktop

Center Desktop

Bottom of Desktop

Right Side of 
Desktop

Bottom Right 
Corner of Desktop

Positioning Related to Desktop Edges and Center

• Window, such as at one of its edges, its corners, its center or above, below, to the left or right. The window•
area includes the title bar if it appears.
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Window

Left Side of 
Window

Bottom Left Corner 
of Window

Center Window

Bottom of Window

Right Side of 
Window

Bottom Right 
Corner of Window

Positioning Related to Window

Left of
Window

Right of
Window

Above

Application Below

Top Right Corner 
of Window

Top of WindowTop Left Corner 
of Window

• Client Area of your HMI/SCADA software.•
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• Source Symbol, in which case the Show Symbol window is positioned in relation to the entire source symbol•
that contains the element that called the window.

Top Left Corner 
of Parent 
Symbol

Top of Parent 
Symbol Top Right Corner 

of Parent Symbol

Left Side of 
Parent Symbol

Bottom Left Corner 
of Parent Symbol

Bottom of Parent 
Symbol

Right Side of 
Parent Symbol

Bottom Right Corner 
of Parent Symbol

Positioning Related to Parent Symbol

Left of
Parent Symbol

Right of
Parent 
Symbol

Above

Parent Symbol

BelowCenter Parent 
Symbol

• Parent Element, in which case the Show Symbol window is positioned in relation just to the element that•
called the Show Symbol window.
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Positioning Related to Parent Element

Parent Symbol

Parent Element

• Mouse, in which case the Show Symbol window is positioned in relation to the pointer coordinates.•

Top Left Mouse 
Position

Selected Positionings Related to Mouse Pointer

Top Right 
Mouse Position

Bottom Left 
Mouse Position

Bottom Right 
Mouse Position

Center Mouse 
Position

• Desktop coordinates. The graphic is placed in the vicinity of coordinates that relate to the desktop.•

Desktop

X, Y Positioning Related to Desktop

X

Y

Vicinity in which the symbol 
is shown (depending on the 

Position setting)
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• Window coordinates. The graphic is placed in the vicinity of coordinates that relate to the window, including•
the title bar if shown.

Desktop

X, Y Positioning Related to Window

X

Y

Window

0

0

Vicinity in which 
the symbol is 

shown (depending 
on the Position 

setting)

• Client Area coordinates. The graphic is placed in the vicinity of coordinates that relate to the client area.•

Desktop

X, Y Positioning Related to Client Area

X

Y

Client Area

0

0

Vicinity in which 
the symbol is 

shown (depending 
on the Position 

setting)

To configure an element with a show symbol animation
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select Show Symbol. The Show Symbol animation is added to the Animation list.3.

4. Configure the graphic. Do one or more of the following:4.

a. In the Reference box, type a graphic name or browse for one by using the browse button.a.

b. To add a title bar to the graphic, select Has Title Bar.b.

c. To use the graphic name as window title, select Use Symbol Name for Window Title.c.

d. Select the window type, Modal or Modeless.d.
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e. To add a Close button, select Has Close Button.e.

f. To add resize controls, select Resizable.f.

5. Select where you want the window to appear by selecting a position in the Position lists. The first list5.
contains positions that are in relation to the item of the second list. Select one of the following:

▪ Center▪

▪ Top Left Corner▪

▪ Top Right Corner▪

▪ Left▪

▪ Right of▪

▪ Lower▪

▪ Below▪

▪ Above▪

▪ Top▪

▪ Left of▪

▪ Right Side▪

▪ Lower Left Corner▪

▪ Lower Right Corner▪

From the second list, select the item the position is referring to:

▪ Desktop: relative to the entire desktop▪

▪ Window: relative to the window.▪

▪ Client Area: relative to the client area.▪

▪ Parent Symbol: relative to the entire graphic that calls it.▪

▪ Parent Element: relative to the element or element group that calls it.▪

▪ Mouse: relative to the pointer.▪

▪ Desktop X,Y: relative to a specified coordinate on the desktop.▪

▪ Window X,Y: relative to a specified coordinate of the window.▪

▪ Client Area X,Y: relative to a specified coordinate of the client area.▪

6. If you select Desktop X,Y or Window X,Y or Client Area X,Y as position, type the new coordinates in the X6.
and Y value boxes.

7. Select how large you want the window to be in the Size list. You can select:7.

▪ Relative to Symbol to make the window size the same as the size of the graphic.▪

▪ Custom Width and Height to specify a width and height.▪

Depending on your selection of the item the graphic is referring to, you can select:

▪ Relative to Desktop to adjust the window size relative to the size of the desktop.▪
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▪ Relative to Window to adjust the window size relative to window that contains the graphic that calls it.▪

▪ Relative to Client Area to adjust the window size relative to the client area.▪

▪ Relative to Parent Symbol to adjust the window size relative to the size of the graphic that calls it.▪

▪ Relative to Parent Element to adjust the window size relative to the size of the element that calls it.▪

8. Continue specifying position information.8.

a. If you select Relative... as size, enter a scaling percentage in the Scale Symbol box.a.

b. If you select Custom Width and Height as size, type the new width and height in the W and H boxes.b.

c. If you select Desktop, Window, Client Area, Parent Symbol or Parent Element as referred item, you canc.
configure the object to be stretched horizontally or vertically. Do one or both of the following:

• Select Stretch symbol to fit ... width and enter a height in the H box.•

• Select Stretch symbol to fit ... height and enter a width in the W box.•

9. You can specify that the graphic window appears by pressing a key or key combination. In the Shortcut area:9.

a. Select a shortcut key in the Key list.a.

b. Select Ctrl and/or Shift to combine the shortcut key with the CTRL key and/or SHIFT key.b.

10. Click OK.10.

Configuring a Hide Symbol Animation
You can configure an element with a Hide Symbol animation. The Hide Symbol animation lets you close:

• The current graphic•

• A graphic that is shown by a specified element.•

To configure an element with a Hide Symbol animation
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select Hide Symbol. The Hide Symbol animation is added to the Animation list and3.
the Symbol Hide configuration panel appears.

4. Select:4.

• Current Symbol if you want to close the currently shown graphic.•

• Symbol shown by an element if you want to close a graphic that appears by that element. Type the•
element name in the adjacent box.

5. You can specify that the graphic window closes by pressing a key or key combination. In the Shortcut area:5.

a. Select a shortcut key in the Key list.a.

b. Select Ctrl and/or Shift to combine the shortcut key with the Ctrl key and/or Shift key.b.

6. Click OK.6.
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Configuring a Hyperlink Animation
You can configure an element with a hyperlink animation, i.e. a link when clicked will launch the default browser
with a customizable URL. The animation will allow you to construct a URL animation using static text, reference
or a compound expression.

To configure an element with a hyperlink animation
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animation dialog box appears.2.

3. Click the Add icon and select Hyperlink. The hyperlink animation is added to the Animation list and the3.
Hyperlink configuration panel appears.

4. The hyperlink can be specified as static text, an expression, or a reference.4.

• Select the T icon to indicate that it is a static value.•

• Select the tag icon to indicate that it is a reference to a value.•

5. For a static value type the complete URL. For example: www.google.com5.

6. For a reference or expression value, open your HMI's attribute/tag browser and select a data source.6.

7. You can also form expression that will use tag values in runtime to generate a URL. For example:7.
"www.google.com/search?q=" + CPSearchText

8. Select the Protocol; http or https.8.

9. You can specify a shortcut by pressing a key or key combination. In the Shortcut area:9.

• Select a shortcut key in the Key list.•

• Select Ctrl and/or Shift to combine the shortcut key with the Ctrl key and/or Shift key.•

10. If the value is set as static text, then you can click the Preview button and test the link.10.

11. Click OK.11.

Configuring Element-Specific Animations
Some elements have their own unique animation type that can only be used for that element type. You cannot
remove their unique animation, but depending on the element you can add and remove other common
animations.

The elements with specific animations are:

• Status element•

• Windows common controls•

Configuring Animation for a Status Element
You can configure the Status element with a DataStatus animation to indicate quality and status from:

• Attributes and tags used in elements with animation.•

• Attributes and tags directly.•
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The appearance of the Status element depends on the settings in the Configure Quality and Status Display
dialog box. For more information, see Configuring Animation for a Status Element.

The DataStatus animation is only used by the Status element and cannot be removed from the Status element.

To configure a DataStatus animation
1. Select the Status element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears, showing the2.
DataStatus configuration panel.

3. In the Available Graphic Elements list, select all elements for which you want to monitor their attribute3.
quality and status.

4. Click the >> button to add them to the Selected Graphic Elements list.4.

5. Click the Expression tab. The Expression panel appears.5.

6. In the Value or Expression list, type a value or expression that can be a literal, or a reference or element6.
property.

Tip: You can also browse for the reference by clicking the browse button.

7. To add more values or expressions, click the Add button. An additional row is added for data input.7.

8. Click OK.8.

Restrictions of the Status Element
Keep the Status element in the same hierarchical level as the animated elements with the attributes you want to
monitor.

If you move elements out of their hierarchical level after you associate them with a Status element, for example,
by grouping them, their attributes are no longer monitored.

To avoid this problem, move a new Status element in the hierarchical level you want to monitor, or associate it
directly with the attributes you want to monitor.

Configuring a Radio Button Group Animation
The Radio Button Group animation is only used by the Radio Button Group element.

You can create a:

• Static radio button group - uses static captions and values that you define in the configuration panel.•

• Array radio button group - uses captions and values contained in an AutomationObject array.•
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• Enum radio button group - uses captions and values contained in an enum data type of an•
AutomationObject.

Configuring a Static Radio Button Group Animation
You can configure a radio button group with static values and captions.

To configure a static radio button group animation
1. Select the radio button group element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears and the Static Radio2.
Button Group configuration panel appears on the right side.

3. In the Reference box, type an attribute reference that is to be tied to the selected value at run time.3.

You can select when to submit the value changes. For more information, see Submitting the Value Changes.

4. In the Static Values and Captions list, configure the captions of the radio button group and also the values4.
that correspond to them to:

• Add an option - click the Add icon.•

• Delete an option - select it in the list and click the Remove icon.•

• Move an option up the list - select it in the list and click the Arrow up icon.•

• Move an option down the list - select it in the list and click the Arrow down icon.•

5. To use the values themselves as captions, select Use Values as Captions.5.

6. Orientate the radio button group in vertical or horizontal direction. Select Vertical or Horizontal.6.

7. Click OK.7.

Configuring an Array Radio Button Group Animation
You can configure a radio button group with values from an array and captions.

To configure an array radio button group animation
1. Select the radio button group element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Array button. The Array Radio Button Group configuration panel appears on the right side.3.

4. In the Reference box, type an attribute reference that is to be tied to the selected value at run time.4.

You can select when to submit the value changes. For more information, see Submitting the Value Changes.

5. In the Array Reference box, type or browse for an array attribute. The Array Values and Captions list shows5.
the values from the array reference.

6. To define your own captions, clear Use Values as Captions and type them in the list.6.

7. To format the value before it appears as a caption, type a text format string in the Format box, for example7.
#.###. Preceding zeroes are ignored if the array data type is numeric.

8. Set Items Sorting to:8.

• None to show the items in the order they are in the array attribute.•

• Ascending to show the items sorted in ascending order.•
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• Descending to show the items sorted in descending order.•

9. Orientate the radio button group in vertical or horizontal direction. Select Vertical or Horizontal.9.

10. Click OK.10.

For example, you want to create a Radio Button Group in your symbol with the following options. The values to
be written to the target attribute are contained in the user-defined attribute array called Options of an
AutomationObject called UD.

Option Value to be written

Open 1

Close 2

Hold 3

Report Error 4

Unknown 99

Configuring an Enum Radio Button Group Animation
You can configure a radio button group with values from an enum attribute and captions.

To configure an enum radio button group animation
1. Select the radio button group element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Enum button. The Enum Radio Button Group configuration panel appears on the right side.3.

4. In the Enum Reference box, type an enum attribute reference. The Enum Values and Captions list shows the4.
values from the enum reference.

You can select when to submit the value changes. For more information, see Submitting the Value Changes.

5. To define your own captions, clear Use Values as Captions and type them in the list.5.

6. Set Items Sorting to:6.

• None to show the items in the order they are in the enum attribute.•

• Ascending to show the items sorted in ascending order.•

• Descending to show the items sorted in descending order.•

7. Orientate the radio button group in vertical or horizontal direction. Select Vertical or Horizontal.7.

8. Click OK.8.

Configuring a Check Box Animation
The Check Box animation is only used by the Check Box element.

To configure a Check Box animation
1. Select the Check Box element.1.
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2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears and the Check Box2.
configuration panel appears on the right side.

3. In the Checked value - Boolean box, type an attribute reference. The attribute reference is tied to the3.
selected state of the check box control at run time.

You can select when to submit the value changes. For more information, see Submitting the Value Changes.

4. To set the caption of the check box at run-time, select Override caption at Runtime with the following4.
expression and type a string value or attribute reference or expression in the String Expression box.

5. Click OK.5.

Configuring an Edit Box Animation
The Edit Box animation is only used by the Edit Box element. You cannot remove this animation from the Edit
Box element, but you can add certain common animations.

You can also use Edit Box-specific methods in scripting to get and set the text at run time. You can browse these
methods in your HMI's attribute/tag browser with the Edit Box selected. For more information on these
methods, see Configuring Edit Box Methods.

To configure an Edit Box animation
1. Select the Edit Box element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears and the Edit Box2.
configuration panel appears on the right side.

3. In the String Reference box, type an string attribute reference. The string attribute reference is tied to the3.
text in the edit box at run time.

You can select when to submit the value changes. For more information, see Submitting the Value Changes.

Tip: Use the On Trigger Condition option to set when the Edit Box element writes the run-time value to the
reference. This avoids a conflict between the run-time value of the Edit Box and run-time value of the
reference.

4. In the Configuration area, select:4.

• Multiline to wrap the text into multiple lines in the edit box.•

• Read-Only to use the edit box to only show text and not allow text input.•

• Maximum Length to limit the maximum numbers of characters you can type in the edit box control. You•
can specify the maximum number in the Characters box.

5. Enter a default text in the Text box.5.

Configuring a Combo Box Animation
The Combo Box animation is only used by the Combo Box element.

You can create a:

• Static combo box - uses static captions and values that you define in the configuration panel.•

• Array combo box - uses captions and values contained in an array if supported by your HMI/SCADA software.•
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• Enum combo box - uses captions and values contained in an enum data type if supported by your HMI/•
SCADA software.

You can also use Combo Box-specific methods in scripting to perform various functions at run time. You can
browse these methods in your HMI's attribute/tag browser with the Combo Box selected.

For more information on these methods, see Configuring Combo Box and List Box Methods.

Configuring a Static Combo Box Animation
You can configure a combo box with static values and captions.

To configure a static combo box animation
1. Select the combo box element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears and the Static Combo2.
Box configuration panel appears on the right side.

3. In the Reference box, type an attribute reference that is to be tied to the selected value at run time.3.

You can select when to submit the value changes. For more information, see Submitting the Value Changes.

4. In the Static Values and Captions list, configure the captions of the combo box and also the values that4.
correspond to them:

▪ Add an option - click the Add icon.▪

▪ Delete an option - select it in the list and click the Remove icon.▪

▪ Move an option up the list - select it in the list and click the Arrow up icon.▪

▪ Move an option down the list - select it in the list and click the Arrow down icon.▪

5. Specify how you want to use captions. Do one of more of the following:5.

▪ To use the values themselves as captions, select Use Values as Captions.▪

▪ To alphabetically sort the captions, select Sorted.▪

▪ To enable duplicate captions, select Allow Duplicates.▪

If you clear Allow Duplicates and click OK, all duplicate captions are removed from combo box on the
canvas. The captions are case-insensitive, so that for example "item1" is considered a duplicate of
"Item1". The removal of the duplicate items is reflected when you re-open the Edit Animations dialog
box.

6. Select the type of combo box from the Type list. Select:6.

▪ Simple - at run time you can type a value, or select one by using arrow up and arrow down buttons.▪
However, you cannot see the list of values.

▪ DropDown - at run time you can type a value, or select one from the list.▪

▪ DropDownList - at run time you can only select a value from the list, but not type one.▪

7. Click OK.7.

Configuring an Array Combo Box Animation
You can configure a combo box with values from an array and captions.
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To configure an array combo box animation
1. Select the combo box element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Array button. The Array Combo Box configuration panel appears on the right side.3.

4. In the Reference box, type an attribute reference that is to be tied to the selected value at run time. The4.
Array Values and Captions list shows the values from the array reference.

You can select when to submit the value changes. For more information, see Submitting the Value Changes.

5. To define your own captions, clear Use Values as Captions and type them in the list.5.

6. If you want to format the value before it appears as a caption, type a text format string in the Format box, for6.
example #.###. Preceding zeroes are ignored if the array data type is numeric.

7. Set Items Sorting to:7.

• None to show the items in the order they are in the array attribute.•

• Ascending to show the items sorted in ascending order.•

• Descending to show the items sorted in descending order.•

8. Click OK.8.

Configuring an Enum Combo Box Animation
You can configure a combo box with values from an enum attribute and captions.

To configure an enum combo box animation
1. Select the combo box element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Enum button. The Enum Combo Box configuration panel appears on the right side.3.

4. In the Enum Reference box, type an enum attribute reference. The Enum Values and Captions list shows the4.
values from the enum reference.

You can select when to submit the value changes. For more information, see Submitting the Value Changes.

5. To define your own captions, clear Use Values as Captions and type them in the list.5.

6. Set Items Sorting to:6.

• None to show the items in the order they are in the enum attribute.•

• Ascending to show the items sorted in ascending order.•

• Descending to show the items sorted in descending order.•

7. Click OK.7.

Configuring a Calendar Control Animation
The Calendar Control animation is only used by the Calendar Control element. The Calendar Control date format
depends on the regional settings of the operating system.
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To configure a Calendar control animation
1. Select the Calendar control element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears and the Calendar2.
configuration panel appears on the right side.

3. In the Date Reference box, type a Time attribute reference that is to be tied to the selected value at run3.
time.

You can select when to submit the value changes. For more information, see Submitting the Value Changes.

4. To restrict the date the user can select at run time, specify limits as follows:4.

• In the MinDate box, type a lower limit for the date.•

• In the MaxDate box, type an upper limit for date.•

5. To show some dates as bold, in the Bolded Dates box, type a reference that points to an attribute array with5.
time data type.

6. To show today’s date on the calendar control, select Show Today.6.

7. To change the colors of the calendar control, click in the Calendar Colors area the following color boxes:7.

• Month Background•

• Month Trailing Forecolor•

• Title Background•

• Title Foreground•

The Select FillColor dialog box appears and you can select a solid color.

8. Click OK.8.

Configuring a DateTime Picker Animation
The DateTime Picker animation is only used by the DateTime Picker element.

To configure a DateTime Picker animation
1. Select the DateTime Picker control element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears and the DateTime2.
Picker configuration panel appears.

3. In the Time Reference box, type a Time attribute reference that is to be tied to the selected value at run3.
time.

You can select when to submit the value changes. For more information, see Submitting the Value Changes.

4. To set the datetime format, select one of the following from the Format list:4.

▪ Long to show the date and time in the long format of the operating system, for example: Thursday,▪
August 03 2006.

▪ Short to show the date and time in the short format of the operating system, for example: 8/3/2006.▪

▪ Time to show just the time in the time format of the operating system, for example: 3:46:09 PM.▪

▪ Custom to specify your own time format. Use the following letters to set the time format:▪
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h One or two-digit hour in 12-hour format.

hh Two-digit hour in 12-hour format. Single digit values are
preceded by a zero.

H One or two-digit hour in 24-hour format.

HH Two-digit hour in 24-hour format. Single digit values are
preceded by a zero.

t One-letter AM/PM abbreviation ("AM" appears as "A").

tt Two-letter AM/PM abbreviation ("AM" appears as "AM").

m One or two-digit minute.

mm Two-digit minute. Single digit values are preceded by a zero.

s One or two-digit seconds.

ss Two-digit seconds. Single digit values are preceded by a zero.

d One or two-digit day.

dd Two-digit day. Single digit day values are preceded by a zero.

ddd Three-character day-of-week abbreviation.

dddd Full day-of-week name.

M One or two-digit month number.

MM Two-digit month number. Single digit values are preceded by a
zero.

MMM Three-character month abbreviation.

MMMM Full month name.

y One-digit year (2001 appears as "1").

yy Last two digits of the year (2001 appears as "01").

yyyy Full year (2001 appears as "2001").

You can use any other characters, except "g" in the property. These characters then appear at design
time and run time in the control.

5. To restrict the date the user can select at run time, you can specify limits in the:5.

▪ MinDate box - type a lower limit for the date.▪

▪ MaxDate box - type an upper limit for date.▪

6. To change the colors of the calendar control that drops down, click in the Calendar Colors area the following6.
color boxes:
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▪ Month Background▪

▪ Month Trailing Forecolor▪

▪ Title Background▪

▪ Title Foreground▪

The Select FillColor dialog box appears and you can select a solid color.

Configuring a List Box Animation
The List Box animation is only used by the List Box element.

You can create a:

• Static list box - uses static captions and values that you define in the configuration panel.•

• Array list box - uses captions and values contained in an array if supported by your HMI/SCADA software.•

• Enum list box - uses captions and values contained in an enum data type if supported by your HMI/SCADA•
software.

You can also use List Box-specific methods in scripting to perform various functions at run time. You can browse
these methods in your HMI's attribute/tag browser with the List Box selected.

For more information on these methods, see Configuring Combo Box and List Box Methods.

Configuring a Static List Box Animation
You can configure a list box with static values and captions.

To configure a static list box animation
1. Select the list box element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears and the Static List Box2.
configuration panel appears on the right side.

3. In the Reference box, type an attribute reference that is to be tied to the selected value at run time.3.

You can select when to submit the value changes. For more information, see Submitting the Value Changes.

4. In the Static Values and Captions list, configure the captions of the list box and also the values that4.
correspond to them. To:

• Add an option - click the Add icon.•

• Delete an option - select it in the list and click the Remove icon.•

• Move an option up the list - select it in the list and click the Arrow up icon.•

• Move an option down the list - select it in the list and click the Arrow down icon.•

5. Specify how you want to use captions. Do one of more of the following:5.

• If you want to use the values themselves as captions, select Use Values as Captions.•

• If you want to alphabetically sort the captions, select Sorted.•

• If you want to allow duplicate captions, select Allow Duplicates.•

6. Click OK.6.
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Configuring an Array List Box Animation
You can configure a list box with values from an array and captions.

To configure an array list box animation
1. Select the list box element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Array button. The Array List Box configuration panel appears on the right side.3.

4. In the Reference box, type an attribute reference that is to be tied to the selected value at run time.4.

You can select when to submit the value changes. For more information, see Submitting the Value Changes.

5. In the Array Reference box, type or browse for an array attribute. The Array Values and Captions list shows5.
the values from the array reference.

6. To define your own captions, clear Use Values as Captions and type them in the list.6.

7. To format the value before it appears as a caption, type a text format string in the Format box, for example7.
#.###. Preceding zeroes are ignored if the array data type is numeric.

8. Set Items Sorting to:8.

• None to show the items in the order they are in the array attribute.•

• Ascending to show the items sorted in ascending order.•

• Descending to show the items sorted in descending order.•

9. Click OK.9.

Configuring an Enum List Box Animation
You can configure a list box with values from an enum attribute and captions.

To configure an enum list box animation
1. Select the radio button group element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Enum button. The Enum List Box configuration panel appears on the right side.3.

4. In the Enum Reference box, type an enum attribute reference. The Enum Values and Captions list shows the4.
values from the enum reference.

5. You can select when to submit the value changes. For more information, see Submitting the Value Changes.5.

6. To define your own captions, clear Use Values as Captions and type them in the list.6.

7. Set Items Sorting to:7.

• None to show the items in the order they are in the enum attribute.•

• Ascending to show the items sorted in ascending order.•

• Descending to show the items sorted in descending order.•

8. Click OK.8.
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Configuring a Trend Pen
A Trend Pen shows a succession of process values as a trend line consisting of current and historical data
updated at a minimum of one second intervals. A trend line gives operators a quick visual snapshot of a process
value over a defined period.

Understanding the Types of Trend Plots
You can configure two types of Trend Pen plots. A Line plot draws a line between each successive data point
during the trend period.

A Step Line plot draws a horizontal line from a trend data point to the time of the next point on the trend’s X-
axis, and then draws a vertical line to the data point. A Step Line plot is the default for a Trend Pen.

Understanding the Types of Trend Pen Periods
A trend time period is the interval of process values shown on the X-axis of the trend during run time, which
consists of a start time, end time, and a duration.

• The StartTime and duration properties are read/write.•

• The EndTime property is a read-only value that the system calculates by adding the duration to the start•
time.

You can configure two types of Trend Pen periods.

• Moving time period•

In a Moving trend period, the start time of a trend period is the current time, and the end time is the
duration of the time period from the start time. When the period ends, the next period begins. The start
time for the next period is set to the end time of the previous trend period.
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• Fixed time period•

In a Fixed trend period, the start time is initially the current time. The start time of a trend period does not
change automatically, but can be specified by a script using the StartTime property.

The end time of a Fixed trend period is set by the duration of the trend from the specified start time of the
period.

End Time = Start Time + Duration

Configuring a Multi Pens Trend
A Multi Pens Trend is like a trend pen and displays a succession of process values but with multiple trend lines.
See the sections under Configuring a Trend Pen () for more information on the types of pen trends.

Note:
- Multi Pens Trend has not been tested on a non-English Language Operating System.
- Performance Index calculation for Multi Pens Trend is not included in the GPI.
- AVEVA OMI ViewApps do not support Multi Pens Trend.
- Web Client does not support Multi Pens Trend.

To configure a Multi Pens Trend:
1. Select the Multi Pens Trend element.1.

2. Click over the Graphic Editor canvas.2.

3. The Edit Animations dialog box appears. For each pen, configure the following sections in the Trend Pens3.
tab:

• Pen Name and Reference•

• Pen Details•

• Pen Options•

• Source•
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Configuring the Pen Name and Reference
In the Trend Pens tab, for each pen:

1. Enter a name of the pen in the Pen Name field.1.

The pen name field must meet the following rules:

• Only static text strings are allowed.•

• Must contain one letter.•

• The maximum number of characters is 32.•

• Valid characters are alphanumeric and special characters ($, #, _).•

• Two trend pens cannot have the same name.•

• The pen name is case-insensitive.•

A tooltip will show the configured Pen name.

2. Enter a reference in the Reference field. Use the Ellipsis button next to the field to select the reference.2.
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The reference is the data source that appears as the value shown by the trend, which can be an external
reference like an object’s attribute, an InTouch analog tag value, or a custom property. Constants and
expressions are not allowed. For more information, see Setting the Input Mode.

3. By default, two empty rows will be created in the grid, and you can create a maximum of 8 pens.3.

4. Use the  icon to add more trend pens. Use the  icon to remove any trend pens. Use the  and  arrows4.
to change the order in which the pens are displayed. Use the  icon to duplicate an existing pen
configuration.

Configuring the Pen Details
Under the Pen Details section, you can configure the range and units of each individual pens.

1. Select Auto Range for the scaling method to place process values on a trend line.1.

If you select Auto Range, the Min and Max fields are disabled. The Y-axis of the trend line is automatically
adjusted to show the full range of trend values within the upper and lower boundaries of the trend.

a. Specify the Margin percentage value. In runtime a margin for the trend area will be dynamicallya.
displayed based on the trend values and the margin% specified. This is only for display purposes and
does not affect the values of the axis.

For example: If the minimum value is 10 and the maximum value is 20. The range is 10 (20-10).
If you specify a margin of 20%, then the margin will be calculated as Range*Margin%; 10*20%=2.
The maximum value of the Y-axis will be Maximum Value + Margin; 20+2=22. The minimum value of the
Y-axis will be Minimum Value - Margin; 10-2=8.

2. If Auto Range is not selected, specify the Min and Max values for the Y-axis of the selected pen.2.

You can specify the values directly, or click ... . The Galaxy Browser is displayed.

If the Min value is greater than the Max value then in runtime the trend pen will be rendered differently and
the scale will be opposite to when the Max value is greater than Min value.
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3. Browse and select an attribute or tag.3.

4. Enter the Units. Use the Toggle button to enter a static text or select a reference value from the Galaxy4.
Browser. For example: Degrees.

5. Click OK.5.

Configuring the Pen Options
Under the Pen Options, you can configure the style of each individual pen.

1. Color: Select the color in which the pen will be displayed.1.

a. You can use the Color Picker to select a color from an part of the screen.a.

b. You can also use Load Custom Palette, by clicking Load Palette…b.

c. You can also add colors to the Custom Palette by pressing the + and remove colors by pressing the deletec.
button.

d. After developing the custom palette you can save it for future use. Click Save Palette.d.

2. Weight: Enter the weight of the pen. The weight determines the thickness of the trend pen line.2.

3. Pattern: Select the display pattern for the trend pen line from a list of predefined options.3.

4. Style: You can select from a list of predefined Style options. The Styles are configured under Element Styles4.
in the IDE. See Change the Visual Properties of an Element Style () for more information.

5. Plot: This is the type of trend line to be displayed. Select between a Step Line and Line.5.

6. Click OK.6.

Configuring the Source
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You can select to override the Historical source of data configured in the Options tab. See Customizing the Multi
Pens Trends for more information.

• Click Override Default Source to change the source of Historical data.•

Customizing the Multi Pens Trend
You can customize the display of the Multi Pens Trend in runtime using the Options tab.

1. The Formatting options are disabled.1.

2. The Fixed Time setting can toggle between the Fixed Time Mode (when selected) and Moving Mode (when2.
not selected). When the Fixed Time checkbox is selected the trend area will display trend data for a specific
duration, and will not move.

3. Select the Time Interval from the list of predefined options in the drop down list. The time interval selected3.
here will be set as the initial value in runtime.

4. Select where in the Trend Area the Scale Label should be displayed; On the left, right, on both sides or4.
display no scale label.
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5. Click Trend Data Shown on Click to customize the behavior of the cursor readout dialog in runtime.5.

By default, the Cursor Readout dialog will be displayed when cursor hovers over the Trend Area. When this
option is selected, you can show and hide the Cursor Readout dialog by clicking in the Trend Area.

6. To hide the top header, select Hide Top Header. Only the trend area and toolbar will be displayed.6.

7. Select the required color for grid lines using the Grid Line Color option.7.

8. Select a pre-defined style from the Element Style drop down list.8.

9. You can also choose a color for the background using the Background Color option.9.

10. Under the Default Trend Source, select Historian or InTouch Log History/LGH for the Source field.10.

By default, Historian source and Auto Detect options will be selected. When Auto Detect is checked, the
Server Name will be disabled.

When an expression or reference is entered in the Server Name field, the Multi Pens Trend connects to the
specified Historian Server. The button to the left of the Server Name field toggles input to the field as an
expression or Static Text mode.

The Historian server is automatically detected from the AppEngine on which the reference attribute is
running. For example, if the Reference field is set to UDO.UDA1, Auto Detect is set to the Historian server
name configured for the AppEngine on which UDO is running. Auto Detect is only valid for Application Server
References. A Trend Pen only shows live data if the Server Name field is left blank in Expression mode.

11. If you select InTouch Log History/LGH, use the button next to the UNC Path field to toggle input to the field11.
as an Expression or Static text.

a. If you select the Expression mode, you can click the ellipsis button to launch your HMI's attribute/taga.
browser and select a Custom property, attribute or tag.

b. If you select the Static Text mode, you can click the ellipsis button to launch the file browser where youb.
can specify the LGH file location.

Submitting the Value Changes
You can configure a Windows common control to write the data:

• Immediately when it is selected in the control at run time.•

• When a specified Boolean expression becomes true.•

The Boolean expression is a trigger that determines when the value is written from the control to the tag or
attribute. If the value changes in the tag or attribute, then the value is written to the control, regardless of the
trigger setting or condition.

To submit value changes immediately
1. Open the Windows common control in the Edit Animations dialog box.1.

2. In the Submit Value Changes area, select Immediately.2.

To submit value changes after a Boolean expression becomes true
1. Open the Windows common control in the Edit Animations dialog box.1.

2. In the Submit Value Changes area, select On Trigger Condition.2.

3. In the Boolean Expression box, type a Boolean expression or browse for a Boolean attribute.3.
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Format Strings in Element-Specific Animations
Some element-specific animations support format strings that specify the format of data during run time when a
graphic is displayed. Element specific-animations enable you to change the style of the displayed data without
changing the graphic in the editor, either interactively through the use of static text or by referencing strings
within data items, thereby making the format dynamic. A format string consists of one or more identifiers that
define the output.

Numbers
The following table lists the basic number formatting.

Identifier Type Format
Example Output
for "1.42"

Example Output for
"-12400"

c Currency {0:c} $1.42 -$12,400

d Decimal (whole number) {0:d} Error -12400

e Scientific {0:e} 1.420000e+000 -1.240000e+004

f Fixed point {0:f} 1.42 -12400.00

g General {0:g} 1.42 -12400

n Number with commas for
thousands

{0:n} 1.42 -12,400

r Round trip {0:r} 1.42 Error

x Hexadecimal {0:x4} Error cf90

The following table lists the custom number formatting.

Identifier Type Format
Example Output
for "1500.42" Notes

0 Zero placeholder {0:00.0000} 1500.4200 Pads with zeroes.

# Digit placeholder {0:(#).##} (1500).42

. Decimal point {0:0.0} 1500.4

, Thousand separator {0:0,0} 1,500 between two zeroes.

,. Number scaling {0:0,.} 2 Comma adjacent to Period
scales by 1000.

% Percent {0:0%} 150042% Multiplies by 100, adds %
sign.

e Exponent placeholder {0:00e+0} 15e+2 Many exponent formats
available.
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Identifier Type Format
Example Output
for "1500.42" Notes

; Group separator Used to separate multiple
formats in one string format
(for example, including
parentheses around a string
if the value is negative; see
Format String Examples).

Dates
Date formatting is dependent on the system’s regional settings; the example strings here are for the U.S.

The following table lists the basic date formatting.

Identifier Type Example

d Short date 10/12/2002

D Long date December 10, 2002

t Short time 10:11 PM

T Long time 10:11:29 PM

f Full date and time December 10, 2002 10:11 PM

F Full date and time
(long)

December 10, 2002 10:11:29 PM

g Default date and time 10/12/2002 10:11 PM

G Default date and time
(long)

10/12/2002 10:11:29 PM

M Month day pattern December 10

r RFC1123 date string Tue, 10 Dec 2002 22:11:29 GMT

s Sortable date string 2002-12-10T22:11:29

u Universal sortable, local
time

2002-12-10 22:13:50Z

U Universal sortable, GMT December 11, 2002 3:13:50 AM

Y Year month pattern December, 2002

The following table lists the custom date formatting.
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Identifier Type Format
Example
Output

dd Day {0:dd} 10

ddd Day name {0:ddd} Tue

dddd Full day name {0:dddd} Tuesday

f, ff, … Second fractions {0:fff} 932

gg, … Era {0:gg} A.D.

hh 2-digit hour {0:hh} 10

HH 2-digit hour, 24-
hr format

{0:HH} 22

mm Minute 00-59 {0:mm} 38

MM Month 01-12 {0:MM} 12

MMM Month abbreviation {0:MMM} Dec

MMMM Full month name {0:MMMM} December

ss Seconds 00-59 {0:ss} 46

tt AM or PM {0:tt} PM

yy Year, 2 digits {0:yy} 02

yyyy Year {0:yyyy} 2002

zz Time zone offset,
2 digits

{0:zz} -05

zzz Full time zone offset {0:zzz} -05:00

: Separator {0:hh:mm:ss} 10:43:20

/ Separator {0:dd/MM/yyyy} 10/12/2002

Enumerations
Identifier Type

g Default (flag names if available, otherwise decimal)

f Flags always

d Integer always

x Eight-digit hex

Format String Examples
The following string is an example of a currency string:
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String.Format("{0:$#,##0.00;($#,##0.00);Zero}", value);

This string example will output values as follows:

• $1,240.00 if passed 1243.50.•

• ($1,240.00) if passed -1243.50.•

• The string Zero if passed the number zero.•

The following string is an example of a phone number string:
String.Format("{0:(###) ###-####}", 8005551212);

This string example will output (800) 555-1212.

Cutting, Copying and Pasting Animations
You can cut, copy and paste animations and their configuration between different elements. This is useful when
you want to duplicate the animations of one element such as a line, to a different type of element such as a
polyline.

If you try to paste an animation to an element that is already configured with that animation, or does not
support this animation, a message appears informing you why you cannot paste the animation.

To copy and paste animations between elements
1. Select the element from which you want to copy the animations.1.

2. On the Edit menu, point to Animations, and then click Copy.2.

3. Select one or more elements to which you want to paste the animations.3.

4. On the Edit menu, point to Animations, and then click Paste. The animation links are copied from the source4.
element to the target elements.

To cut and paste animations between elements
1. Select the element from which you want to cut the animations.1.

2. On the Edit menu, point to Animations, and then click Cut.2.

3. Select one or more elements to which you want to paste the animations.3.

4. On the Edit menu, point to Animations, and then click Paste. The animation links are removed from the4.
source element and copied to the target elements.

Substituting References in Elements
You can search and replace references used by any element on your canvas. You can use:

• basic mode by replacing strings in a list.•

• advanced functions such as find and replace, ignore or respect case-sensitivity and wildcards.•

To substitute references in a graphic by using the list
1. Select one or more elements.1.

2. Do one of the following:2.

• Press Ctrl + E.•
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3. On the Special menu, click Substitute References.3.

The Substitute References dialog box appears.

4. In the New column, type the reference to be replaced.4.

5. Click OK. All references are substituted accordingly in the elements.5.

To substitute references in a graphic by using find and replace functions
1. Select one or more elements.1.

2. Do one of the following:2.

• Press Ctrl + E.•

• On the Special menu, click Substitute References.•

The Substitute References dialog box appears.

3. Click Find & Replace. The dialog box expands and shows find and replace parameters.3.

4. Specify your find and replace options. Do one of more of the following:4.

• To find specific references in the list, type a string in the Find What box and click Find Next to find the•
next string.

• To replace a selected found string with another string, type a wstring in the Replace with box and click•
Replace.

• To replace multiple references, type values in the Find What and Replace with boxes and click Replace•
all.

• To specify the search is case-sensitive, select Match Case.•

• To find only entire words that match your search string, select Match Whole Word Only.•

• To use wildcards, select Use Wildcards. Valid wildcards are "*" (asterisk) and "?" (question mark).•

"*" indicates any number of variable characters. For example. "s*" to search for all strings starting with
"s".

"?" indicates one single variable character. For example, "M_7?t" to search for all strings that start with
"M_7" and end with "t" and have exactly 5 characters.

5. Click OK. All text strings are substituted accordingly in the elements.5.

Embedding Graphics within Graphics
Embedding Graphics

You can embed graphics into other graphics. This lets you split your visualization into modules and re-use already
defined graphics. For example, you can create a valve graphic and embed it multiple times into a tank graphic.

When you embed a graphic into another graphic, you are creating a link to the original graphic. Any changes to
the original graphic are propagated to all embedded instances.

You can:

• Embed a graphic within another graphic.•
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• Edit an embedded graphic.•

• Restore an embedded graphic to the original size of its source graphic.•

• Convert the embedded graphic to a graphic.•

• Detect the source of an embedded graphic.•

• Edit the source of an embedded graphic.•

• Override the custom properties of the source graphic.•

• Control the size propagation of an embedded graphic.•

• Select an alternate or same graphic of an alternate object instance as source.•

• Edit the object that contains the source graphic.•

• Create a new instance of the object that contains the source graphic.•

Symbol

Source Symbol

Embedded Symbol

Embed

Source Properties

Source Animations

Source Properties

Source Animations

Properties

Animations
can override

You can embed graphics from the Industrial Graphic Editor into other graphics.

When you embed a graphic, the animation links and scripts are inherited from the source graphic. You can only
change the animations and scripts in the source graphic and all changes are propagated to the embedded
graphic.

The embedded graphic appears with its original name appended by a number. The number is increased by one if
you embed the same graphic again.

If you embed graphics that have elements outside of the coordinates (0,0) and (2000,2000), the embedded
graphic clips these elements.

The name of the embedded graphic cannot be the same as a custom property of the graphic in which it is being
embedded.

The embedded graphic and the graphic in which it is being embedded cannot include elements that have the
same name.

To embed source graphics from the Industrial Graphic Editor
1. On the Industrial Graphic Editor Edit menu, click Embed Graphic Symbol. Your HMI's attribute/tag browser1.

appears.
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2. Select a source graphic.2.

3. Click OK. The pointer appears in paste mode.3.

4. Click on the canvas to place the graphic.4.

To embed source graphics contained in an object template
1. On the Industrial Graphic Editor Edit menu, click Embed Graphic Symbol. Your HMI's attribute/tag browser1.

appears.

2. Select the object template that contains the source graphic.2.

3. Select the graphic and click OK. The Create Instance dialog box appears.3.

4. Type a name for the new instance in the New Instance Name box and click OK. The new instance of the4.
object is created and the pointer appears in paste mode.

5. Click on the canvas to place the graphic.5.

To embed source graphics contained in an object instance
1. On the Industrial Graphic Editor Edit menu, click Embed Graphic Symbol. Your HMI's attribute/tag browser1.

appears.

2. Select the object instance that contains the source graphic.2.

3. Select the source graphic and click OK. The pointer appears in paste mode.3.

4. Click on the canvas to place the graphic.4.

Renaming Source Graphics and Hosting Objects
Generally, if you rename source graphics or their hosting objects, embedded graphics update their references to
the updated name of the renamed source graphic or hosting object.

However, if you are using relative references and you rename the contained name of the referenced object, the
references to the embedded graphic are broken.

You can identify embedded graphics that may cause a problem by clicking on the embedded graphics and
viewing the SymbolReference property from the Properties Editor. If the SymbolReference property contains
relative references such as me or myContainer, renaming the contained name of the referenced object causes
the reference to be broken.

Also, if any instance of the hosting object is checked out, when you change the contained name of the
referenced object, even after you check-in the instance:

• The change is not propagated to the instance.•

• Validating the object does not indicate an error.•

Editing the Embedded Graphic
After you embed a source graphic into another graphic, its animations are inherited from the source graphic. The
animation of the embedded graphic is controlled by the source graphic.

The embedded graphic itself has certain animations you can configure. The animations override the animations
of the source graphic for the embedded graphic. These are:

• Visibility•

© 2022 AVEVA Group plc and its subsidiaries. All rights reserved.
  

Page 164

AVEVA™ Industrial Graphic Editor User Guide 
Chapter 3 – Graphic Elements



• Blink•

• Location Horizontal•

• Location Vertical•

• Width•

• Height•

• Orientation•

• Disable•

Furthermore you can override the following animations if you change the TreatAsIcon property of the embedded
graphic to True:

• Tooltip•

• User Input•

• Slider Horizontal•

• Slider Vertical•

• Pushbutton•

• Action Scripts•

• Show Symbol•

• Hide Symbol•

To override the configured animations of an embedded graphic
1. Select the embedded graphic.1.

2. In the Properties Editor, change the value for the TreatAsIcon property to True.2.

Overriding Custom Properties of the Source Graphic
You can override the value and description of a custom property of the embedded graphic if the custom
property’s visibility is set to Public in the source graphic.

You cannot add, delete, or rename any custom properties of an embedded graphic or change the data type.
However, you can:

• Revert the value and description of the custom property to its default as defined in the source graphic.•

• Set the visibility of the custom property. This has an effect if the graphic containing the embedded graphic is•
embedded into another graphic.

To override the value and description of a custom property
1. Select the embedded graphic on the canvas.1.

2. On the Special menu, click Custom Properties. The Edit Custom Properties dialog box appears.2.

3. Select the custom property you want to override with a new value or description.3.

4. In the Default Value box, type a new value.4.

5. In the Description box, type a new description.5.
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To revert the value and description of a custom property
1. Select the embedded graphic on the canvas.1.

2. On the Special menu, click Custom Properties. The Edit Custom Properties dialog box appears.2.

3. Select the custom property you want to revert.3.

4. Click the Revert icon. The value and description of the selected custom property are reverted to the value4.
and description of the same custom property in the source graphic.

Restoring an Embedded Graphic to the Original Size of its Source Graphic
You can restore an embedded graphic to its original size as it is defined in the object or in the Industrial Graphic
Editor.

To restore an embedded graphic to its original size
1. Select the embedded graphic that you want to restore to its original size.1.

2. On the Edit menu, point to Embedded Symbol, and then click Symbol - Original Size. The embedded graphic2.
is restored to the original size of its source graphic.

Converting an Embedded Graphic to a Group
You can convert an embedded graphic to a group. A converted graphic is no longer associated with its source
graphic. All configuration of the embedded graphic is preserved.

If you convert an embedded graphic to a group:

• Scripts of the embedded graphic are not converted.•

• You can optionally move the custom properties to the group.•

• Relative references of the embedded graphic are no longer valid.•

To convert an embedded graphic to a group
1. Select the embedded graphic that you want to convert to a group.1.

2. On the Edit menu, point to Embedded Symbol, and then click Convert To Group. The embedded graphic is2.
converted to a group.

Detecting the Source Graphic of an Embedded Graphic
You can view the source of an embedded graphic by using the SymbolReference property.

To detect the source of an embedded graphic
1. Select the embedded graphic on the canvas.1.

2. In the Properties Editor, view the SymbolReference property to see what object or environment contains the2.
source and the name of the source graphic itself. This can be:

• Symbol:SymbolName.•

• Symbol:InstanceName.SymbolName•
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Editing the Source of an Embedded Graphic
You can edit the source of an embedded graphic by opening it in a new session of the Industrial Graphic Editor.

To edit the source of an embedded graphic
1. Select the embedded graphic.1.

2. On the Edit menu, point to Embedded Symbol, and then click Edit Symbol. The source of the embedded2.
graphic is opened in a new session of the Industrial Graphic Editor.

3. Edit the source graphic as needed and click Save and Close. The new session of the Industrial Graphic Editor3.
is closed and the Symbol Changed icon appears in the status bar.

4. Double-click the Symbol Changed icon. The change is reflected in the embedded graphic.4.

If you don't accept the change, the embedded graphic is updated the next time you open it in the Industrial
Graphic Editor.

Controlling Size Propagation of Embedded Graphics
You can control the way that size changes of the source graphic are propagated to its embedded instances, which
are embedded graphics. For example, a size change is:

• Resizing one of the elements in the source graphic so that the graphic boundary changes.•

• Adding elements to or removing elements from the source graphic so that the graphic’s boundary changes.•

This feature is called dynamic size change and can be enabled or disabled.

Setting the Anchor Point of a Source Graphic
You can set the position of the anchor point of a source graphic. The anchor point of a source graphic is by
default the center point of all elements on the canvas.

You can change the position of the anchor point:

• Numerically by typing the absolute or relative anchor point position values in the Properties Editor.•

• Graphically by dragging the anchor point on the canvas.•

To change the position of the anchor point numerically
1. Click on the canvas.1.

2. In the Properties Editor, type position values X,Y for:2.

• AbsoluteAnchor property, where the position is relative to the top left corner of the canvas 0,0.•

• RelativeAnchor property, where the position is relative to the center point of all elements on the canvas.•

The anchor point is changed accordingly. The AbsoluteAnchor and RelativeAnchor property values are
updated accordingly.

To change the position of the anchor point graphically
1. Click on the canvas.1.

2. In the Properties Editor, click the AbsoluteAnchor or RelativeAnchor property label. The anchor point of the2.
graphic is shown.
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3. Drag the anchor point to the new position. The AbsoluteAnchor and RelativeAnchor property values are3.
updated accordingly.

Showing or Hiding the Anchor Points of Embedded Graphics
You can show or hide the anchor points of embedded graphics. An anchor point shows the current absolute
anchor position of the embedded graphic on the canvas.

To show or hide the anchor point of an embedded graphic
• On the toolbar, click the Show/Hide Embedded Symbol Anchor Points icon. The anchor of the embedded•

graphic appears or disappears.

Enabling or Disabling Dynamic Size Change of Embedded Graphics
You can enable or disable the dynamic size change of embedded graphics. The anchor points of the embedded
instances are not changed by any size change to the source graphic.

If the source graphic size changes and the dynamic size change is enabled, the embedded graphic size adapts
accordingly. If the dynamic size change is disabled, the embedded graphic size does not change.

In both cases the anchor points of its embedded instances don't move on the canvas.

Source Symbol (Original) Source Symbol (Changed)

Embedded Symbol 
(Original)

Embedded Symbol 
(Propagated)

Embedded Symbol 
(Propagated)

Source Symbol
Changed

With 
Dynamic 

Size 
Propagation

Without Dynamic 
Size Propagation
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To enable or disable dynamic size change of an embedded graphic
1. Select the embedded graphic on the canvas.1.

2. On the toolbar, click the Enable/Disable Dynamic Size Change icon. The dynamic size change is enabled or2.
disabled.

Selecting Alternate Graphics and Instances
If your embedded graphic is contained in an object instance, you can:

• Use another graphic that is contained in the same object instance.•

• Use the same graphic that is contained in a different object instance, in which case the animation links in the•
graphic are redirected.

Selecting Alternate Graphics
You can select an alternate graphic of the same object instance to embed. The following properties are retained:

• Position and size•

• Animations applied to the embedded graphic•

• Override information (the TreatAsIcon property)•

You can only select alternate graphics for embedded graphics contained in object instances.

To select an alternate graphic
1. Select the embedded graphic on the canvas.1.

2. On the Edit menu, point to Embedded Symbol, and then click Select Alternate Symbol.Your HMI's2.
attribute/tag browser appears.

3. If available, select an alternate graphic that is contained in the same instance and click OK. The embedded3.
graphic is updated with the new alternate graphic.

Selecting Alternate Instances
You can select an alternate instance of the object that contains the same embedded graphic. When you select an
alternate graphic to embed, the following properties are retained:

• Position and size•

• Animations applied to the embedded graphic•

• Override information (the TreatAsIcon property)•

To select an alternate instance
1. Select the embedded graphic on the canvas.1.

2. On the Edit menu, point to Embedded Symbol, and then click Select Alternate Instance. Your HMI's2.
attribute/tag browser appears with a list of all instances that contain the same graphic.

3. Select an instance and click OK. All internal references of the embedded graphic update to point at the3.
alternate instance. The name of the embedded graphic updates to reflect that it is pointing at a different
instance.
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Detecting and Editing the Containing Object Instance
You can detect and edit the object instance that contains the embedded graphic.

To detect the object instance that contains the source graphic
1. Select the embedded graphic.1.

2. In the Properties Editor, locate the OwningObject property. Its value contains the name of the object that2.
contains the source graphic.

You can write to this property at run time to force the embedded graphic to point to a different object in its
references contained in animation links.

To edit the object that contains the source graphic
1. Select the embedded graphic.1.

2. On the Edit menu, point to Embedded Symbol, and then click Edit Instance. The object instance opens for2.
editing in the IDE.

3. Edit the instance as needed and save your changes.3.

Creating a New Instance of the Containing Object
You can create a new instance of the object that contains an embedded graphic. The following properties of the
graphic are retained:

• Position and size•

• Animations•

• Override information (the TreatAsIcon property)•

To create a new instance of the object that contains an embedded graphic
1. Select the embedded graphic.1.

2. On the Edit menu, point to Embedded Symbol, and then click New Instance. The Create Instance dialog box2.
appears.

3. Type a name for the new instance in the New Instance Name box and click OK. The new instance of the3.
object is created and the references and name of the embedded graphic are updated to point at it.
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Editing Graphic Properties

Editing Common Properties of Elements and Graphics
Editing the Name of an Element

For a detailed list of properties, see List of Element Properties.

Some properties are common to most types of elements, such as fill, line styles, and visibility. You can:

• Edit the name of an element.•

• Edit the fill properties of an element.•

• Edit the line properties of an element.•

• Edit the text properties of an element.•

• Set the style.•

• Set the transparency level of an element.•

• Adjusting colors and style for an element’s gradient style.•

• Enable and disable elements for run-time interaction.•

• Change the visibility of an element.•

• Change the tab order of an element.•

• Use the Format Painter to format elements.•

• Edit the general properties of a graphic.•

The name of an element uniquely identifies the element on the drawing surface.

When you draw a new element on the drawing surface, it is assigned a default name. You can then change its
name in the Properties Editor or the Elements List.

Element names are case-insensitive and unique within the same element hierarchy. It is possible to have two
elements with the same name if one is, for example, in a group and the other outside that group.

To change an element’s name in the Properties Editor
1. Select the element on the drawing surface.1.

2. In the Properties Editor, click the value for the Name box.2.

3. Type a new name and click Enter.3.
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To change an element’s name in the Elements List
1. Select the element in the Elements List.1.

2. Click the element in the Elements List again.2.

3. Type a new name and click Enter.3.

Editing the Fill Properties of an Element
You can configure the following fill properties for an element:

• Fill style as solid color, gradient, pattern or texture•

• Unfilled style•

• Fill orientation, relative to the element or to the screen•

• Fill behavior, which determines if the object is to be filled horizontally, vertically, or both•

• Horizontal fill direction•

• Vertical fill direction•

• Percent of horizontal fill•

• Percent of vertical fill•

Setting Fill Style
You can configure the fill style of one or more elements. You can do this to:

• Selected elements on the toolbar.•

• Style properties in the Properties Editor.•

• Nested style properties, such as just one color of a multi-colored gradient.•

To configure the fill style of an element with the toolbar
1. Select one or more elements you want to configure.1.

2. On the toolbar, click the down arrow to the right of the Fill Color icon. The fill style list appears.2.

3. Configure the fill color. Do any of the following:3.

• Click No Fill to configure an empty element.•

• Click a predefined solid color in the display.•

• Click More Solid Colors to open the style selection dialog box and select a solid color.•

• Click Color Picker to select a color from the screen.•

4. Configure the fill gradient, pattern, or texture. Do any of the following:4.

• Click a predefined gradient.•

• Click More Gradients to open the style selection dialog box and configure a gradient.•

• Click Patterns to open the style selection dialog box and select a pattern.•

• Click Textures to open the style selection dialog box and select a texture.•
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For more information about the style selection dialog box, see Setting Style.

To configure the fill style by setting style properties
1. Select one or more elements.1.

2. In the Properties Editor, locate the FillStyle property.2.

3. Click the browse button to open the style selection dialog box. For more information about the style3.
selection dialog box, see Setting Style.

To configure the fill style by setting gradient color style properties
1. Select one or more elements with gradient fill style.1.

2. In the Properties Editor, locate the Color1, Color2, and Color3 properties.2.

3. Click the browse button for any of these to set the selected gradient color from the style selection dialog3.
box. For more information, see Setting Style.

Setting Unfilled Style
You can configure an element’s unfilled style. The unfilled style of an element determines the element’s unfilled
portion at design time and run time.

To configure the unfilled style of an element
1. Select one or more elements.1.

2. In the Properties Editor, click UnfilledStyle.2.

3. Click the browse button in the UnfilledStyle line. The style selection dialog box appears.3.

4. Select a solid color, gradient, pattern, or texture. For more information about the style selection dialog box,4.
see Setting Style.

5. Click OK.5.

Setting Fill Orientation
You can configure an element’s fill orientation in the Properties Editor. The fill orientation property determines if
the fill style is relative to the screen or element.

• If relative to the screen, the gradient, pattern, or texture does not rotate with the element.•

• If relative to the element, the gradient, pattern, or texture rotates with the element.•

To configure an element’s fill orientation
1. Select one or more elements you want to configure.1.

2. In the Properties Editor, click FillOrientation.2.

3. From the list in the same line, click RelativeToScreen or RelativeToGraphic.3.

Setting Fill Behavior
You can set the fill behavior of an element. The fill can be:

• Horizontal.•
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• Vertical.•

• Both horizontal and vertical.•

To set an element’s fill behavior
1. Select one or more elements you want to configure.1.

2. In the Properties Editor, set the property FillBehavior to one of the following:2.

• Horizontal•

• Vertical•

• Both•

Setting Horizontal Fill Direction and Percentage
An element can fill:

• From left to right.•

• From right to left.•

You can also set the amount you want the element to be horizontally filled by as a percentage.

To set an element’s horizontal fill direction and percentage
1. Select one or more elements you want to configure.1.

2. In the Properties Editor, set the HorizontalDirection property to:2.

• Right to fill from left to right.•

• Left to fill from right to left.•

3. For the HorizontalPercentFill property, type a percentage (0 - 100) in the value box.3.

Setting Vertical Fill Direction and Percentage
An element can fill:

• From bottom to top.•

• From top to bottom.•

You can also set the amount you want the element to be vertically filled by as a percentage.

To set an element’s vertical fill direction and percentage
1. Select one or more elements you want to configure.1.

2. In the Properties Editor, set the VerticalDirection property to:2.

• Top to fill from bottom to top.•

• Bottom to fill from top to bottom.•

3. For the VerticalPercentFill property, type a percentage (0 - 100) in the value box.3.

Editing the Line Properties of an Element
You can set the line properties for any element that contains lines, such as:
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• Lines and polylines.•

• Rectangles, rounded rectangles, and ellipses.•

• Curves, closed curves, and polygons.•

• Arcs, pies, and chords.•

• Text boxes.•

You can set the:

• Start and end points for lines, arcs, and H/V lines.•

• Line weight, which is the thickness of a line.•

• Line pattern, which is the continuity of a line. For example, a continuous line, a dotted line, a dashed line, or•
a combination.

• Line style, which is the fill style of a line.•

• Shape and size of the end points of a line. For more information, see Setting Line End Shape and Size.•

You can also set the element’s line properties in the Line Format properties group in the Properties Editor.

Setting Start or End Points of a Line
After you draw a line or H/V line, you can change its start or end points in the Properties Editor.

To set the line or H/V line start or end point
1. Select a line or H/V line.1.

2. In the Properties Editor, type coordinate values X, Y for the Start or End properties.2.

Setting the Line Weight
You can set a line weight from 0 pixels to 255 pixels for any element that contains lines. You can set the line
weight using the Format menu, the toolbar, or the LineWeight property in the Properties Editor.

Large line weight settings can cause unexpected behavior, especially with curves and line end styles.

To set the line weight using the Format menu
1. Select one or more elements.1.

2. On the Format menu, click Line Weight.2.

3. To use a predefined line weight, select it from the list.3.

4. To use another line weight, click More Line Options. The Select Line Options dialog box appears. In the4.
Weight box, type a new line weight from 0 to 255 and then click OK.

Setting the Line Pattern
You can set the line pattern for any element that contains lines. The line pattern specifies the continuity of a line
(continuous, dotted, dashed) and not its fill properties.

To set the line pattern
1. Select one or more elements.1.

© 2022 AVEVA Group plc and its subsidiaries. All rights reserved.
  

Page 175

AVEVA™ Industrial Graphic Editor User Guide 
Chapter 4 – Editing Graphic Properties



2. On the Format menu, click Line Pattern.2.

3. To use a predefined line pattern, select it from the list.3.

4. To use another line pattern, click More Line Options. The Select Line Options dialog box appears. In the4.
Pattern list, select a pattern, and then click OK.

You can also set the line pattern by changing the LinePattern property in the Properties Editor.

Setting the Line Style
You can set the line style for any element that contains lines. Setting the line style is similar to setting the fill
style. You can also set the solid color, gradient, pattern, and texture for a line.

To set the line style
1. Select one or more elements.1.

2. On the toolbar, click the Line Color icon. The line style list appears.2.

3. Configure the line color. Do any of the following:3.

• Click a predefined solid color in the display.•

• Click More Solid Colors to open the style selection dialog box and select a solid color.•

• Click Color Picker to select a color from the screen.•

4. Configure the line gradient, pattern, or texture. Do any of the following:4.

• Click a predefined gradient.•

• Click More Gradients to open the style selection dialog box and configure a gradient.•

• Click Patterns to open the style selection dialog box and select a pattern.•

• Click Textures to open the style selection dialog box and select a texture.•

For more information about the style selection dialog box, see Setting Style.

You can also set the element’s line style in the Properties Editor. If you do this, you can configure the solid color,
gradient, pattern, or texture in the style selection dialog box. For more information, see Setting Style.

Setting the Text Properties of an Element
You can set the following for text, text box, and button elements:

• The text that appears•

• The format in which the text appears•

• The font of the text•

• The alignment of the text•

• The text style•

You can also substitute strings in text, text box, and button elements.
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Setting the Displayed Text
You can set the text of a text element, text box, or button in the canvas or by changing the Text property in the
Properties Editor.

To set the text to display
1. Select the text element, text box or button on the canvas.1.

2. On the Edit menu, click Edit Text. The selected element appears in edit mode.2.

3. Type a text string and press Enter.3.

Setting the Text Display Format
You can configure how values are shown for the text in a text box or button. For example, as a rounded float with
the format #.###.

You can format the text display for the:

• Text element and the button element in the same way as in the HMI or with the TextFormat property in the•
Properties Editor.

• Text box element only with the TextFormat property.•

To set the text display format
1. Select a text element, text box, or button.1.

2. In the Properties Editor, type a format for the TextFormat property.2.

Setting the Text Font
You can change the font style and font size of a text using:

• The Format menu.•

• The Font property in the Properties Editor.•

• Lists on the toolbar.•

To set the text font, font style, and size
1. Select a text element, a text box, or a button element on the canvas.1.

2. On the Format menu, click Fonts. The Font dialog box appears.2.

3. Set the font, font style, size, and effects.3.

4. Click OK.4.

Setting the Text Color
You can set the text color as a solid color, a gradient, a pattern, or a texture.

You can also change the text color in the Properties Editor with the TextColor property.

To set the text color
1. Select a text element, a text box, or a button element on the canvas.1.

2. Click the Text Color icon.2.
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3. Configure the text color. Do any of the following:3.

• Click a predefined solid color in the display.•

• Click More Solid Colors to open the style selection dialog box and select a solid color.•

• Click Color Picker to select a color from the screen.•

4. Configure the text gradient, pattern, or texture. Do any of the following:4.

• Click a predefined gradient.•

• Click More Gradients to open the style selection dialog box and configure a gradient.•

• Click Patterns to open the style selection dialog box and select a pattern.•

• Click Textures to open the style selection dialog box and select a texture.•

For more information about the style selection dialog box, see Setting Style.

Setting the Text Alignment
You can change the horizontal and vertical positioning of text within a text box element or button element.

You can also change the positioning for a text element. If the text is modified at design time or run time, the
alignment sets how the element boundary changes to fit around the modified text.

You can also set the text alignment in the Properties Editor by setting the Alignment property.

If the element is a text box or a button, then the text is aligned accordingly.

If the element is a text element and you then modify the text at design time or run time, the text is anchored to
the point of alignment.

• Text right alignments move additional text further over to the left.•

• Text left alignments move additional text to the right.•

• Changes in font size leave the point of alignment unchanged and modify the frame accordingly.•

To set the text alignment
1. Select a text element, text box element or button element on the canvas.1.

2. On the Format menu, point to Text Alignment, and then click the appropriate command:2.

Click this command To

Top Left Align the text at the top left frame handle.

Top Center Align the text at the top middle frame handle.

Top Right Align the text at the top right frame handle.

Middle Left Align the text at the middle left frame handle.

Middle Center Align the text in the middle of the element.

© 2022 AVEVA Group plc and its subsidiaries. All rights reserved.
  

Page 178

AVEVA™ Industrial Graphic Editor User Guide 
Chapter 4 – Editing Graphic Properties



Click this command To

Middle Right Align the text at the middle right frame handle.

Bottom Left Align the text at the bottom left frame handle.

Bottom Center Align the text at the bottom center frame
handle.

Bottom Right Align the text at the bottom right frame
handle.

Substituting Strings
You can search and replace strings of any element that have the Text property on your canvas. You can use the
basic mode to replace strings in a list.

You can also use advanced functions, such as find and replace, ignore, case-sensitivity, and wildcards.

You cannot substitute static strings that are used in an Radio Button Group, List Box or Combo Box.

If you substitute strings for a text element in an embedded graphic, that text element is not updated if you
change the source graphic's text. For example, an embedded graphic contains a text graphic with the string
"SomeTextHere". You substitute "SomeTextHere" with "MyText", and then change the source graphic text from
"SomeTextHere" to "NewText". The text in the embedded graphic will still show "MyText".

To substitute strings in a graphic by using the list
1. Select one or more elements.1.

2. Do one of the following:2.

• Press Ctrl + L.•

• On the Special menu, click Substitute Strings.•

The Substitute Strings dialog box appears.

3. In the New column, type the text to be replaced.3.

4. Click OK.4.

To substitute strings in a graphic by using advanced functions
1. Select one or more elements.1.

2. Do one of the following:2.

• Press Ctrl + E.•

• On the Special menu, click Substitute Strings.•

The Substitute Strings dialog box appears.

3. Click Find & Replace. The dialog box expands and shows advanced options.3.

4. Configure the search strings. Do any of the following:4.
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• To find specific strings in the list, type a string in the Find What box and click Find Next to find the next•
string.

• To replace a selected found string with another string, type a string in the Replace with box and click•
Replace.

• To replace multiple strings, type values in the Find What and Replace with boxes and click Replace all.•

5. Configure the search options. Do any of the following:5.

• If you want the search to be case-sensitive, click Match Case.•

• To find only entire words that match your search string, click Match Whole Word Only.•

• To use wildcards, click Use Wildcards. Use an asterisk (*) to search for any sequence of characters. Use a•
question mark (?) to search for strings with one variable character.

6. Click OK.6.

Setting Style
You can set the fill, line, and text style from various places in the Industrial Graphic Editor using the style
selection dialog box. The style selection dialog box is common to any element for which you can set a solid color,
gradient, pattern, or texture. You can also set the transparency of the style.

Because you can open the style selection dialog box from different places in the Industrial Graphic Editor, the
dialog box header can be different.

Also, not all tabs may be available. For example, for setting one color of a gradient in the Properties Editor, you
can only select a solid color from the style selection dialog box.

For information about working with legacy graphics, see Loading Graphics with Deprecated Features.

Setting a Solid Color
You can set a solid color using the Solid Color tab in the style selection dialog box. You can set a solid color from
the:

• Standard palette.•

• Color disc and bar.•

• Value input boxes.•

• Color picker.•

• Custom palette.•

You can also:

• Add the new color to the custom palette.•

• Remove a color from the custom palette.•

• Save the custom palette.•

• Load a custom palette.•
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Setting a Solid Color from the Standard Palette
You can set a solid color from the standard palette using the Solid Color tab in the style selection dialog box. The
standard palette is a set of 48 predefined colors you can use to quickly select a solid color.

To set a solid color from the Standard Palette
1. In the style selection dialog box, click the Solid Color tab.1.

2. In the Standard Palette area, click a color. The new color appears in the New color box on the right of the2.
dialog box.

3. Click OK.3.

Setting a Solid Color from the Color Disc and Bar
You can set a solid color using the color disc and bar on the Solid Color tab in the style selection dialog box. The
color disc and bar let you graphically select the color and the luminance (brightness).

To set a solid color from the color disc and bar
1. In the style selection dialog box, click the Solid Color tab.1.

2. Click on the color disk to select a color. The bar is updated and shows the selected color in varying degrees of2.
luminance (brightness).

3. Click on the bar to select a luminance (brightness). The new color appears in the New color box on the right3.
of the dialog box.

4. Click OK.4.

Setting a Solid Color with the Value Input Boxes
You can set a solid color by typing values that define the color, such as:

• Red component (0-255).•

• Green component (0-255).•

• Blue component (0-255).•

• Hue (0-255).•

• Saturation (0-255).•

• Luminance (0-255).•

To set a solid color with the value input boxes
1. In the style selection dialog box, click the Solid Color tab.1.
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2. In the Red, Green, Blue, Hue, Sat. and Lum. boxes, type respective values. The resulting color appears in the2.
New color box on the right of the dialog box and also on the color wheel and bar.

3. Click OK.3.

Setting a Solid Color with the Color Picker
You can set a solid color by using the color picker on the Solid Color tab in the style selection dialog box. The
color picker lets you select a color from anywhere on the screen, even outside the IDE application.

To set a solid color with the color picker
1. In the style selection dialog box, click the Solid Color tab.1.

2. Click the Color Picker button. The color picker pointer appears.2.

3. Select a color from anywhere on the screen by moving the mouse. As you move the mouse, the new color3.
appears in the New color box on the right of the dialog box.

4. Click the mouse to complete the color selection.4.

5. Click OK.5.

Setting a Solid Color from the Custom Palette
You can set a solid color from the custom palette on the Solid Color tab in the style selection dialog box. The
custom palette is a set of colors that you want to frequently use. You can save the custom palette to a .pal file or
load a custom palette from a .pal file.

To use colors from the custom palette, first add them. For more information, see Adding and Removing Colors in
the Custom Palette.

To set a solid color from the custom palette
1. In the style selection dialog box, click the Solid Color tab.1.

2. In the Custom Palette area, select a color. The new color appears in the New color box on the right of the2.
dialog box.

3. Click OK.3.

Adding and Removing Colors in the Custom Palette
You can add up to 36 solid colors to the custom palette. You can also remove any colors from the custom palette.

You cannot add a color that is already in the custom palette.

To add a solid color to the custom palette
1. In the style selection dialog box, click the Solid Color tab.1.

2. Add the color. Do any of the following:2.

• Select a solid color from the custom palette.•

• Select a solid color from the color disc and bar.•

• Type values for red, green, blue, hue, saturation, and luminance.•

• Select a solid color with the color picker.•

The new solid color appears in the New color box on the right of the dialog box.
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3. Click the add button above Custom Palette. The solid color is added to the Custom Palette area.3.

To remove a solid color from the custom palette
1. In the style selection dialog box, click the Solid Color tab.1.

2. In the Custom Palette area, select the solid color you want to remove.2.

3. Click the delete button above Custom Palette. The solid color is removed from the custom palette.3.

Saving and Loading the Custom Palette
You can save the current custom palette or load a previously saved custom palette. The custom palette is loaded
from or saved to a Windows Palette file (.pal).

After you save or load a custom palette, the .pal file is not connected to the graphic in any way.

To save a custom palette
1. In the style selection dialog box, click the Solid Color.1.

2. Click the Save Palette button. The Save Palette dialog box appears.2.

3. Browse to the location where you want to save the custom palette, type a name, and then click Save. The3.
custom palette is saved as a palette file.

To load a custom palette
1. In the style selection dialog box, click the Solid Color tab.1.

2. Click the Load Palette button.2.

3. If you currently have colors in the custom palette, a message appears. Click Yes to continue and overwrite3.
the current colors in the custom palette.

4. In the Load Palette dialog box, browse to the location of the palette file, select it, and then click Open. The4.
custom palette is loaded from the selected file.

Setting a Gradient
You can configure gradients by the:

• Number of colors - 1, 2 or 3.•

• Direction - horizontal, vertical, radial, or customized.•

• Variant - depending on your selection for the number of colors and direction.•

• Color distribution shape - triangular with options to configure the center and falloff.•

• Focus scales - width and height.•

You set a gradient on the Gradient tab in the style selection dialog box.

Setting the Number of Colors for a Gradient
You can set the number of colors you want to use in a gradient.

• If you use one color, the gradient is between this solid color and a specified shade of black to white.•

• If you use two colors, the gradient is between these two colors.•

• If you use three colors, the gradient is between these three colors in sequence.•
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To set a gradient using one color
1. In the style selection dialog box, click the Gradient tab.1.

2. In the Colors area, click One. A color selection box and a slider for the dark to light selection appears.2.

3. Click the color selection box to open the Select Solid Color 1 dialog box. Select a solid color and click OK. For3.
more information about this dialog box, see Setting a Solid Color.

4. Move the slider between Dark and Light. The new gradient appears in the New color box on the right of the4.
dialog box.

5. Click OK.5.

To set a gradient using two colors
1. In the style selection dialog box, click the Gradient tab.1.

2. In the Colors area, click Two. Two color selection boxes appear.2.

3. Click the Color 1 or Color 2 color field to select a color from the style selection dialog box. For more3.
information about this dialog box, see Setting a Solid Color.

The new gradient appears in the New color box on the right of the dialog box.

4. Click OK.4.

To set a gradient for three colors
1. In the style selection dialog box, click the Gradient tab.1.

2. In the Colors area, select Three. Three color selection boxes appear.2.

3. Click the Color 1, Color 2 or Color 3 color field to select a color from the style selection dialog box. For more3.
information about this dialog box, see Setting a Solid Color.

The new gradient appears in the New color box on the right of the dialog box.

4. Click OK.4.

Setting the Direction of the Gradient
You can configure the direction of the gradient to be one of the following:

• Horizontal - from side to side•

• Vertical - up and down•

• Radial - circular from the center outwards•

• Custom angle - across the element at a specified angle•

To set a horizontal gradient
1. In the style selection dialog box, click the Gradient tab.1.

2. In the Direction area, click Horizontal. The new gradient appears in the New color box on the right of the2.
dialog box.

3. Click OK.3.

To set a vertical gradient
1. In the style selection dialog box, click the Gradient tab.1.
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2. In the Direction area, click Vertical. The new gradient appears in the New color box on the right of the dialog2.
box.

3. Click OK.3.

To set a radial gradient
1. In the style selection dialog box, click the Gradient tab.1.

2. In the Direction area, click Radial.2.

3. Set the center location. Do any of the following:3.

• In the Horizontal and Vertical boxes, type values for the center location.•

• Click and drag the center point in the adjacent box.•

The new gradient appears in the New color box on the right of the dialog box.

4. Click OK.4.

To set the custom angle of a gradient
1. In the style selection dialog box, click the Gradient tab.1.

2. In the Direction area, click Custom.2.

3. Set the angle. Do any of the following:3.

• In the Angle text box, type a value for the angle.•

• Click and drag the angle bar in the adjacent box.•

The new gradient appears in the New color box on the right of the dialog box.

4. Click OK.4.

Changing the Variant of a Gradient
You can change the variant of a gradient. The variants are alternate gradients with the same colors you can
quickly select.

To change the variant of a gradient
1. In the style selection dialog box, click the Gradient tab.1.

2. In the Variants area, click on a variant gradient.2.

The new gradient appears in the New color box on the right of the dialog box.

3. Click OK.3.

Setting the Color Distribution Shape
You can configure the distribution shape of a triangle gradient with one or two colors.

• In a triangular distribution, the gradient from one color to the next rises and falls at the same rate.•

You can also configure the peak and the falloff.

• The peak specifies the offset of the gradient if it has one or two colors.•

• The falloff specifies the amplitude of the gradient if it has one or two colors.•

Additionally, you can configure the center point of a radial gradient if it is defined by three colors.
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To use a triangular gradient
1. In the style selection dialog box, click the Gradient tab.1.

2. In the Color Distribution Shape area, click Triangular. The new gradient appears in the New color box on the2.
right of the dialog box.

3. Click OK.3.

To set the peak of a gradient with one or two colors
1. In the style selection dialog box, click the Gradient tab.1.

2. In the Color Distribution Shape area, do one of the following:2.

• Use the Peak slider to specify the peak.•

• In the Peak box, type a value from 0 to 100.•

The new gradient appears in the New color box on the right of the dialog box.

3. Click OK.3.

To set the falloff of a gradient with one or two colors
1. In the style selection dialog box, click the Gradient tab.1.

2. In the Color Distribution Shape area, do one of the following:2.

• Use the Falloff slider to specify the peak.•

• In the Falloff box, type a value from 0 to 100.•

The new gradient appears in the New color box on the right of the dialog box.

3. Click OK.3.

To set the center point of a radial gradient with three colors
1. In the style selection dialog box, click the Gradient tab.1.

2. In the Color Distribution Shape area, do one of the following:2.

• Use the Center slider to specify the peak.•

• In the Center box, type a value from 0 to 100.•

The new gradient appears in the New color box on the right of the dialog box.

3. Click OK.3.

Setting the Focus Scales of a Gradient
You can set the focus scales of a radial gradient. The focus scales acts as a magnification of the gradient. You can
set the height and width of the focus scales.

Height Width Appearance

0 0
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Height Width Appearance

50 50

To set the height and width of the focus scales for a gradient
1. In the style selection dialog box, click the Gradient tab.1.

2. In the Focus Scales area, do one of the following:2.

• Move the Height & Width slider to specify the height and width.•

• In the text box, type the value for the height and width.•

The new gradient appears in the New color box on the right of the dialog box.

3. Click OK.3.

Setting a Pattern
You can set a pattern for an element. The following table describes the pattern options:

Pattern Options

Horizontal Simple, Light, Narrow, Dark, Dashed

Vertical Simple, Light, Narrow, Dark, Dashed

Percent 05, 10, 20, 25, 30, 40, 50, 60, 70, 75, 80, 90

Grid Small, Large, Dotted

Checker Board Small, Large

Diagonals Forward, Backward, Dashed Upward/Downward, Light/
Dark/Wide Upward/Downward

Diamond Dotted, Outlined, Solid

Cross Diagonal

Brick Horizontal, Diagonal

Confetti Small, Large

Others Zig Zag, Wave, Weave, Plaid, Divot, Shingle, Trellis, and
Sphere

Patterns consist of the foreground color and the background color that you can change.

To set a pattern
1. In the style selection dialog box, click the Pattern tab.1.

2. Select a pattern. The new pattern appears in the New color box on the right of the dialog box.2.
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3. If you want to change the foreground color of the pattern, click the Foreground color selection box. The style3.
selection dialog box appears. Select a solid color and click OK.

4. If you want to change the background color of the pattern, click the Background color selection box. The4.
style selection dialog box appears. Select a solid color and click OK.

For more information about setting a solid color, see Setting a Solid Color.

5. Click OK.5.

Setting a Texture
Textures are images you can use as styles for lines, fills and text. You can stretch the image or tile the image
across the entire element to be filled.

To set a texture
1. In the style selection dialog box, click the Textures tab.1.

2. Click Select Image. The Open dialog box appears. You can import the following image2.
formats: .BMP, .GIF, .JPG, .JPEG, .TIF, .TIFF, .PNG, .ICO, .EMF. Animated GIF images are not supported.

3. Browse to and select an image file and click Open. The new pattern appears in the New color box on the3.
right of the dialog box.

4. Configure the size mode. Do one of the following:4.

• Click Tile to create a pattern that repeats itself.•

• Click Stretch to enlarge (or shrink) the pattern across the selected element.•

5. Click OK.5.

Setting the Style to No Fill
You can set the style to "No Fill". For example if you set the fill style of a rectangle element to No Fill, the
background of the rectangle appears transparent.

To set the No Fill style
1. In the style selection dialog box, click the No Fill tab.1.

The No Fill style appears as a red cross-through line in the New color box on the right of the dialog box.

2. Click OK.2.

Setting the Transparency of a Style
You can set the transparency of a solid color, gradient, pattern, or texture.

To set the transparency of a style
1. Open the style selection dialog box.1.

2. At the bottom of the dialog box, do one of the following:2.

• Drag the Transparency slider handle left or right to change the transparency percentage.•
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• In the Transparency text box, type a percentage value.•

The new style appears in the New color box.

3. Click OK.3.

Setting the Transparency Level of an Element
You can set the transparency level of an element. Levels range from 0 percent (opaque) to 100 percent
(transparent).

Transparency of a group of elements behaves in a special way.

To set the transparency level of an element
1. Select one or more elements.1.

2. On the Format menu, click Transparency.2.

3. To use a predefined level, select it from the list.3.

4. To use a different level, click More Transparency Levels. The Select Transparency Level dialog box appears.4.
Type a transparency level in the Transparency text box or use the slider to select a transparency level.

5. Click OK.5.

You can also set the transparency level by changing the Transparency property in the Properties Editor.

Adjusting the Colors and Transparency of a Gradient
You can easily change the colors and transparency of an element with a gradient style.

For example, you can create pipes with a gradient style of different colors. You can change the pipe color, but still
keep the 3-D appearance.

You do this in the Properties Editor using the Color1, Color2, Color3, and Transparency sub-properties.

To tweak the colors and transparency of a gradient
1. Select the element for which you want to change colors or transparency.1.

2. In the Properties Editor, locate the appropriate style setting. This can be:2.

• FillColor•

• LineColor•

• TextColor•

• UnFillColor•

3. Click the + icon to expand the property. The Color1, Color2, Color3, and Transparency sub-properties are3.
shown.

4. Do one of the following:4.

• Click the color box of one of the color sub-properties.•

• Type a new value for the transparency and click Enter.•

5. Click the browse button. The style selection dialog box appears.5.
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6. Select a color from the style selection dialog box and click OK. The solid color is applied to the selected6.
element.

Loading Graphics with Deprecated Features
In recent versions of Microsoft’s rendering technologies, certain gradient features have been deprecated. To
accommodate and future proof graphics built using the Industrial Graphic Editor, the affected features have been
removed from the configuration environment. Graphics previously configured with deprecated features will
continue to render as expected.

Deprecated gradients are as follows:

• Point Based gradient direction•

• Bell gradient shape (1 or 2 color selection)•

• Radial gradient direction without locked focus•

When working with graphics that have been configured with deprecated gradients, the Gradient tab in the style
selection dialog box shows Point Based direction, Bell color distribution, and the Focus Scales lock option
disabled. You can choose an available option to enable other available options, and save your configuration to
update the graphic.

Enabling and Disabling Elements for Run-Time Interaction
You can enable or disable elements so that the run time user cannot use any interaction animations, such as:

• User input.•

• Horizontal and vertical sliders.•

• Pushbuttons.•

• Action scripts.•

• Showing and hiding graphics.•

Other animations such as horizontal fills and tooltips continue to work as expected.

To enable an element for run-time interaction
1. Select one or more elements you want to enable.1.

2. In the Properties Editor Runtime Behavior group, set the Enabled property to True.2.

To disable an element for run-time interaction
1. Select one or more elements you want to disable.1.

2. In the Properties Editor Runtime Behavior group, set the Enabled property to False.2.

Changing the Visibility of Elements
You can configure elements to be hidden or shown at run time.

The visibility of an element does not affect its animations. Even when an element is invisible, its animations
continue to be evaluated.
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To configure an element to be shown at run time
1. Select one or more elements you want to have shown at run time.1.

2. In the Properties Editor Runtime Behavior group, set the Visible property to True.2.

To configure an element to be hidden at run time
1. Select one or more elements you want to have hidden at run time.1.

2. In the Properties Editor Runtime Behavior group, set the Visible property to False.2.

Editing the Tab Order of an Element
You can configure the elements on the canvas so that at run time you can use the Tab key to put each element in
focus in a specified sequence. This sequence is called the tab order.

By default, when you place elements on the canvas, they have a tab order number of 0. Elements with the same
tab order number are placed into focus by tabbing at run time according to their z-order. This means they are
tabbed through at run time according to their position in the Elements List.

You can override the tab order by assigning a unique index number to the TabOrder property of each element.

Lower tab order numbers take precedence over higher tab order numbers. Change this value to determine the
tab order sequence.

Verify that the TabStop property of each element is set to true. When the TabStop property is set to true, you
can use the Tab key at run time to switch to the selected element.

To edit the element’s tab order
1. Select the element for which you want to set the tab order.1.

2. In the Properties Editor, set the TabStop property to True.2.

3. Type a unique value for the TabOrder property.3.
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Using the Format Painter to Format Elements
You can apply formatting of one element to other elements quickly by using the format painter. You can apply
the format of one element:

• One time to other elements.•

• In repetitive mode to other elements.•

When you use the format painter, it copies the following formats of the element if applicable to the target
elements:

• Font family, size, and style•

• Text style, alignment, and word wrap settings•

• Line style, weight, pattern, and ends•

• Transparency•

• Fill style, orientation, behavior, horizontal percent fill, and vertical percent fill•

• Unfilled style•

• Horizontal and vertical direction properties•

You cannot use the format painter for:

• The status element•

• An element that is part of a path•

• Groups of elements•

• Elements in different hierarchy groups•

To copy the format of an element one time
1. Select the element with the format you want to copy.1.

2. On the Edit menu, click Format Painter. The pointer appears as the format painter cursor.2.

3. Select the element you want to apply the format to. The format is applied to the clicked element.3.

To copy the format of an element in repetitive mode
1. Select the element with the format you want to copy.1.

2. On the toolbar, double-click the Format Painter icon. The pointer appears as the format painter cursor.2.

3. Click each element you want to apply the format to. The format is applied to the clicked element.3.
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4. Repeat Step 3 for any other elements you want to apply the format to.4.

5. When you are done, press the Esc key.5.

Editing the General Properties of a Graphic
You can configure the general properties of a graphic. The general properties determine the overall appearance
and behavior of the graphic. You can:

• Add a meaningful description to your graphic.•

• Enable anti-aliasing, or smoothing, for your graphic to improve its appearance. The anti-aliasing filter•
essentially blurs the elements slightly at the edges.

• Allow or prevent the opening of more than one graphic or display from a graphic. One example is a graphic•
with multiple Show Symbol animations. If this option is enabled, you can open more than one pop-up and
each pop-up is modeless.

To edit the description of a graphic
1. Click on the canvas so that no elements are selected.1.

2. In the Properties Editor, type a meaningful description for the Description property.2.

To use smoothing (anti-aliasing) for a graphic
1. Click on the canvas so that no elements are selected.1.

2. In the Properties Editor, select True for the Smoothing property.2.

To enable multiple pop-ups for a graphic
1. Click on the canvas so that no elements are selected.1.

2. In the Properties Editor, select True for the MultiplePopupsAllowed property.2.

Editing Graphic-Specific and Element-Specific Properties
About Graphic- and Element-Specific Properties

You can configure graphic-specific and element-specific properties. For properties that are common to all or
most elements, see Editing Common Properties of Elements and Graphics.

You can configure:

• General properties of a graphic.•

• Radius of rounded rectangles.•

• Shape and end appearance of lines and H/V lines.•

• Auto-sizing and word-wrapping in text boxes.•

• Image-specific properties.•

• Button-specific properties.•

• Control points and tension in curves.•

• Angles in pies, chords, and arcs.•
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• Status elements.•

• Windows common controls.•

Setting the Radius of Rounded Rectangles
You can specify the radius, in pixels, of the corners of rounded rectangles. The radius determines their
"roundness". You can:

• Enlarge or reduce the radius of the rounded rectangle on the fly. The easiest way to do this is with the•
keyboard.

• Set the radius of the rounded rectangle to a specific value using the Properties Editor.•

Rounded rectangles maintain their radius when their size is changed. If the graphic containing rounded
rectangles is embedded into a window and resized, the radius is not affected. This can have adverse affects on
the graphic representation of your graphic.

To enlarge the radius of a rounded rectangle
1. Select one or more rounded rectangles on the canvas.1.

2. Press and hold Shift and the + key on the number pad. The radius is enlarged, and the rounded rectangle2.
becomes more round.

To reduce the radius of a rounded rectangle
1. Select one or more rounded rectangles on the canvas.1.

2. Press and hold Shift and the minus (-) key on the number pad. The radius is reduced, and the rounded2.
rectangle becomes more rectangular.

To set the radius of a rounded rectangle exactly
1. Select one or more rounded rectangles on the canvas.1.

2. In the Properties Editor, change the value for Radius property and click Enter. The selected rounded2.
rectangles are updated accordingly.

Setting Line End Shape and Size
You can set the line end shape and size for any element that contains open lines such as lines, H/V lines,
polylines, curves, and arcs.
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For a line end, you can set the shape to be an arrowhead, diamond, circle, or square. You can set the size if the
line end shape is an arrowhead.

To set the line end shape
1. Select one or more elements.1.

2. On the Format menu, click Line Ends.2.

3. To use a predefined line end shape, select it from the list.3.

4. To use another line shape, click More Line Options. The Select Line Options dialog box appears.4.

5. Do the following:5.

a. In the Line Start list, click a shape for the start of the line.a.

b. In the Line End list, click a shape for the end of the line.b.

c. Click OK.c.

To set the size of the line arrowheads
1. Select one or more open line elements.1.

2. On the Format menu, click More Line Options. The Select Line Options dialog box appears.2.

3. Select a size on the Line Start Size list if the line starts with an arrowhead. Valid sizes are: XX Small, X Small,3.
Small, Medium Small, Medium, Medium Large, Large, X Large, XX Large.

4. Select a size on the Line End Size list if the line ends with a shape.4.

5. Click OK.5.

You can also set the line end shapes by changing the StartCap and EndCap properties in the Properties Editor.

Setting Auto Scaling and Word Wrapping for a Text Box
You can configure a text box to auto scale the text or to word wrap the text within the text box.

• For auto scaling, the text is resized to fit the text box.•

• For word wrapping, the text in a text box continues on the next line.•

To auto scale the text in a text box
1. Select one or more text boxes.1.

2. In the Properties Editor, set the AutoScale property to true.2.

To word wrap the text in a text box
1. Select one or more text boxes.1.

2. In the Properties Editor, set the WordWrap property to true.2.

Using Images
You can place images on the canvas. This is a two step process:

1. Draw a frame which specifies the target size of the image.1.

2. Import the image from an image file.2.
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After you place an image on the canvas, you can:

• Set the display mode (ImageStyle).•

• Set the image alignment (ImageAlignment).•

• Set the transparency color (HasTransparentColor, TransparentColor properties).•

• Open the image in an image editing application.•

• Select a different image for the image element.•

Placing an Image on the Canvas
You can place an image on the canvas. The image data is imported from an image file. You can import the
following image formats: .BMP, .GIF, .JPG, .JPEG, .TIF, .TIFF, .PNG, .ICO, .EMF.

You cannot use animated GIF images.

To place an image on the canvas
1. In the Tools panel, select the image icon.1.

2. Click the canvas where you want to place the image and drag the mouse to draw a rectangle that will contain2.
your image.

3. Release the mouse button. The Open dialog box appears.3.

4. Browse to and select an image file, and then click Open. The image is loaded into the image frame.4.

If the image frame is smaller than the image, the image is cropped to fit into the frame. If the image frame is
larger than the image, the image appears in its original size.

Setting the Image Display Mode
You can set the way the image appears on the canvas.

• In normal mode, the image is not stretched or tiled. You can resize the image frame with the resizing•
handles.

• In stretch mode, the image is stretched so that it fills its frame.•

• In tile mode, the image is repeated so that a tiled pattern that fills its frame is created.•

• In auto mode, the image frame is enlarged or reduced to the image size. The resizing handles are locked.•
When the image style of an image element is Auto, you cannot change its size.

To stretch an image to the image frame
1. Select the image element you want to stretch.1.

2. In the Properties Editor, select ImageStyle.2.

3. In the list, click Stretch. The image is stretched to the image frame.3.

To tile an image in an image frame
1. Select the image element you want to tile.1.

2. In the Properties Editor, select ImageStyle.2.

3. In the list, click Tile. The image is tiled to fill the image frame.3.
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To set an image frame size to its image size
1. Select the image element you want to adjust.1.

2. In the Properties Editor, select ImageStyle.2.

3. In the list, click Auto. The image frame is enlarged or reduced to the image size.3.

Setting the Image Alignment
The image alignment specifies where the image appears in an image frame. By default, images appear in the
center of the image frame. You can change this setting to one of the following:

• Top left, top center, or top right•

• Middle left, center, or middle right•

• Bottom left, bottom center, or bottom right•

You can also set the image alignment in the ImageAlignment property in the Properties Editor.

To set the image alignment
1. Select the image element with the image you want to align.1.

2. In the Properties Editor, select ImageAlignment.2.

3. In the list, click one of the following options: TopLeft, TopCenter, TopRight, MiddleLeft, Centers, MiddleRight,3.
BottomLeft, BottomCenter or BottomRight. The image is aligned accordingly in the image frame.

Setting the Image Color Transparency
You can use image color transparency to specify that a color within an image is partially or entirely transparent.
When you configure image transparency:

• Enable color transparency for images.•

• Specify the color that is to be transparent.•

Setting the image color transparency is different than setting the transparency of the image element, as it only
applies to one color. Image transparency applies to the entire image.

To enable image color transparency
1. Select the image element.1.

2. In the Properties Editor, select HasTransparentColor.2.

3. In the list, click True.3.

To set the transparency color for an image
1. Select the image element.1.

2. On the Edit menu, click Select Image Transparent Color. The pointer becomes a color picker.2.

3. Click the color you want to use as the transparency color. The image is updated with the new transparency3.
color.

You can also select a transparency color with the TransparentColor property in the Properties Editor. For more
information about setting the color, see Setting a Solid Color.
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Editing the Image
You can edit the image in an image element by opening it in an image editing application.

You can specify the image editor by changing the designer preferences. For more information, see Setting the
Image Editing Application.

To edit an image
1. Select the image element with the image you want to edit.1.

2. On the Edit menu, click Edit Image. The image is opened with the associated image editing application.2.

3. Make changes to the image as needed, save the image and close the image editing application. The image is3.
updated on the canvas.

Setting the Image Editing Application
You can specify the image editor that opens when you select an image for editing. You can select a currently
registered image editing application or add one.

To set the image editing application
1. On the Special menu, click Preferences. The Designer Preferences dialog box appears.1.

2. Select an image editor from the Image Editor list.2.

To add an image editing application
1. On the Special menu, click Preferences. The Designer Preferences dialog box appears.1.

2. In the Image Editor list, click Choose Custom Editor. The Select Image Editing Application dialog box2.
appears.

3. Browse to and select the executable file of the image editing application and click Open. The image editor is3.
added to the list.

Selecting a Different Image
You can change the current image of an image element by selecting a new image.

To select a different image
1. Select the image element with the image you want to change.1.

2. On the Edit menu, click Select Image. The Open dialog box appears.2.

3. Browse to and select an image file, and then click Open. The image is loaded into the image frame.3.

You can also select a different image by clicking the browse button in the Image property in the Properties
Editor .

Using Buttons
You can add a text caption or an image to buttons that belong to Industrial Graphics. If a button includes a text
caption, you can:

• Automatically scale the font size•

• Configure the text to wrap within the button•
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Automatically Scaling Text in Buttons
You can automatically scale text so that the font size is adapted to the button size.

To automatically scale text in buttons
1. Select the button element on the canvas.1.

2. In the Properties Editor, set the AutoScale property to True.2.

Wrapping Text in Buttons
You can wrap text in buttons.

To wrap text in buttons
1. Select the button element on the canvas.1.

2. In the Properties Editor, set the WordWrap property to True.2.

Configuring Buttons with Images
You can use buttons with an image in Industrial Graphics.

• The "up" image appears after a button is released and returns to the up position during run time•

• The "down" image appears after a button is pressed and locks in the down position during run time•

You can edit an up image or a down image after you assign it to a button.

To use a down image or up image on a button
1. Select the button element on the canvas.1.

2. In the Properties Editor, select Image in the property ButtonStyle list.2.

3. Click the browse button of the UpImage property and select an image in the Open dialog box. This is the3.
image that appears on the button by default and also when the button is released.

4. Click the browse button of the DownImage property and select an image in the Open dialog box. This image4.
appears after the button is clicked.

To edit an up image or a down image of a button
1. Right-click the button element on the canvas. The context menu appears.1.

2. Click Edit Button Image, then click one of the following:2.

• Edit Up Image•
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• Edit Down Image•

The up image or down image is opened in the default image editor.

3. Edit the image.3.

4. Save the image and close the image editor. The up image or down image is updated.4.

Editing Control Points
Control points determine the shapes of polylines, polygons, curves, and closed curves. To change the shape of
these elements after they have been placed on the canvas, you can:

• Move individual control points.•

• Add or remove control points.•

Moving Control Points
After you place a polyline, polygon, curve, or closed curve on the canvas, you can change its shape by editing its
control points.

To move the control points of a polyline, polygon, curve, or closed curve
1. Select the polyline, polygon, curve, or closed curve.1.

2. On the Edit menu, click Edit Control Points. The control points of the element are shown.2.

3. Click a control point you want to change and drag it to the new location. The element is updated accordingly.3.

4. Repeat the previous step for all control points you want to change.4.

Adding and Removing Control Points
You can add or remove control points from polylines, polygons, curves, and closed curves.

To add control points to a curve or closed curve
1. Select the curve or closed curve.1.

2. On the Edit menu, click Edit Control Points. The control points of the element are shown.2.

3. Press and hold the Shift key.3.

4. Move the mouse over the curve or closed curve at the point you want to add a control point. The pointer4.
appears as a pen with a plus graphic.

5. Click the curve or closed curve. The control point is added to the curve or closed curve.5.

6. Repeat the last step for any other control points you want to add.6.

7. When you are done, release the Shift key.7.

To delete control points from a curve or closed curve
1. Select the curve or closed curve.1.

2. On the Edit menu, click Edit Control Points. The control points of the element are shown.2.

3. Press and hold the Shift key.3.
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4. Move the mouse over the control point you want to remove. The pointer appears as a pen with a minus4.
graphic.

5. Click the control point. The control point is removed from the curve or closed curve.5.

6. Repeat the last step for any other control points you want to remove. We recommend that you have at least6.
two control points.

7. When you are done, release the Ctrl key.7.

Changing the Tension of Curves and Closed Curves
After you place a curve or a closed curve, you can change its tension. The tension specifies how tightly the curve
bends through the control points. Valid range are float values from 0 (tightly) to 2 (loosely).

You can also change the tension of a curve or closed curve by changing the value for the Tension property in the
Properties Editor.

To edit the tension of a curve or closed curve
1. Select the curve or closed curve.1.

2. In the Properties Editor, type a float value from 0 to 2 for the Tension property.2.

Changing Angles of Arcs, Pies and Chords
After you place an arc, pie, or chord, you can change the start and sweep angles of elements. You can change the
angles to any integer degree from 0 to 359. When you change the angles, you can press the Shift and Ctrl keys to
make the angle snap to multiples of 15 or 45 degrees.

You can also move the start angle and sweep angle at the same time. The object appears to be rotated around its
arc/pie/chord center point while keeping the same center point angle.

You can also change the start or sweep angle of an arc, pie or chord in the StartAngle or SweepAngle properties
in the Properties Editor. For more information, see Utilizing Sweep Angle Run-Time Properties.

To change the start or sweep angle of an arc, pie, or chord
1. Select the arc, pie, or chord.1.

2. On the Edit menu, click Edit Start and Sweep Angles. The start and sweep angle handles appear on the2.
selected element.

3. If you want to the angle to be multiples of 15 degrees, press and hold the SHIFT key.3.

4. If you want to the angle to be multiples of 45 degrees, press and hold the CTRL key.4.

5. Grab the start angle or the sweep angle handle and drag it to the new location. The element is updated5.
accordingly.

To change the start and sweep angles of an arc, pie, or chord together
1. Select the arc, pie, or chord.1.

2. On the Edit menu, click Edit Start and Sweep Angles. The start and sweep angle handles appear on the2.
selected element.

3. Select the start angle or the sweep angle handle and keep the mouse button down.3.

4. Press and hold the Alt key.4.
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5. If you want additionally either angles to be multiples of 15 degrees, press and hold the Shift key.5.

6. If you want additionally either angles to be multiples of 45 degrees, press and hold the Ctrl key.6.

7. Drag the mouse. The start angle and sweep angle are changed accordingly.7.

8. When you are done, release the mouse button and then any keys.8.

Utilizing Sweep Angle Run-Time Properties
The 2 and 3 point arc, pie, and chord graphic elements contain StartAngle and SweepAngle Appearance
properties. These properties can be assigned values in a client script that change during run time to show moving
sweep angle or start angle lines as part of arc, pie, and chord graphic elements.

Sweep angle run-time properties are well suited for showing a current value within a range of possible values.
For example, the movement of a chord sweep angle can show a pie chart with fill that indicates the current time
within a repetitive period. Or, the movement of an arc sweep angle can represent a pointer to the current value
within a range of possible values like a tachometer.

To configure sweep angle run-time properties
1. Place an arc, pie, or chord graphic object on the Industrial Graphic Editor canvas.1.

2. Select the graphic element to show its Properties attributes.2.

3. Assign StartAngle and SweepAngle properties as values of a client script that change based on run-time3.
events.

Monitoring and Showing Quality and Status
You can configure your graphic to show non-good status and quality of attributes or tags in different ways:

• A status element shows a specific icon depending on the quality and status of configured attributes, tags or•
elements.

• The text, fill, or line appearance of elements is overridden depending on the quality and status of the•
attributes and tags they reference.

• Elements are drawn with an outline depending on the quality and status of the attributes they reference.•

Quality and status elements might not be supported by all HMIs. Refer to "Working with the Industrial Graphic
Editor" in your HMI help for more information.

Using Status Elements
Status elements show a specified graphic depending on the quality and status of:

• Attributes and tags configured for specific animated elements.•

• One or more specified attributes or tags.•

You can assign status elements to an animation in three steps:

1. Draw the status element on the canvas.1.

2. Associate the status element with animated elements on the canvas and/or attributes that provide the2.
quality and status data to be monitored.

3. If needed, configure the appearance of the status element.3.
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Setting Number Formats by Regional Locales
The format of numbers varies by country. In the United States, a period represents the decimal point of an
analog number and a comma is the thousand separator. In other countries, the purpose of the characters may be
different. Germany uses a comma to represent the decimal point and a period to represent the thousand
separator.

Industrial graphic numeric values can display thousands and decimal separators that match the numeric format
of the country specified as the Home location of the computer running an HMI/SCADA application.

Numeric formatting by regional locale applies only to Industrial graphic number displays and input numbers
included as part of your applications.

Numeric formatting by regional locale can be applied to an application containing:

• User Input animation•

• Value Display animation•

• Tooltip animation•

• Windows Client Controls (RadioBox, ComboBox, and ListBox)•

• SecuredWrite dialog•

• VerifiedWrite dialog•

• SignedWrite dialog•

Design Time Considerations for Numeric Formatting
During design time, make the following preparations to show numbers in a regional locale:

• Enter numbers according to the the U.S. format in design time, e.g. #,###.##•

• Set the regional locale of the computer running an HMI/SCADA application.•

Enter Input Numbers in U.S. Format
The Industrial Graphic Editor enables you to specify a number format during design time using a format string for
Value Display animations.
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A Value Display animation includes a Text Format field. When Text Format is set to Format String, enter a text
string that represents the format of numbers shown during run time.

During design time, a numeric format string or numeric value follows the United States number format.

• The decimal point in a number is a period.•

• The thousand separator in a number is a comma.•
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In the example above, the design-time numeric format strings within the box at the left comply with the U.S.
number format. But during run time, User Input and Value Display animation show numbers in the correct
format of the country specified by the computer’s Regional setting.

Set the Regional Locale of the Computer Hosting the HMI/SCADA Application
To enable numeric formatting by regional locale, set the region of the computer running an HMI/SCADA
application to the country in which you want Industrial graphic numbers to be formatted.

The Region setting is accessible from the Windows Control Panel. If you want to display Industrial graphic
numbers in a non-U.S. format, select the Formats tab and select a country in the Format field.

Run-Time Considerations for Formatting Numbers
The following analog number format styles support numeric formatting by regional locale during run time:

• Custom•

• Real•

• FixedDecimal•

• Integer•

• Exponential•

During run time, numbers are entered in the format of the selected country.
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The following figure shows the analog number 123456.558857 formatted to the German regional locale during
run time by the different numeric format styles:

A thousand separator is not required when entering a number or specifying a format string. But, if a thousand
separator is used during run time, place it in the correct location in a specified number or with User Input
animation.

The thousand separator appears in the following numeric format styles:

• Real•

• Fixed Decimal•

• Integer•

• Custom configured as Real, Fixed Decimal, or Integer•

During run time, if your HMI/SCADA software provides software keypads, you can include comma, period, and
thin space keys to enter numbers in a User Input animation data entry field that match the format of the
computer’s regional locale. The following illustration shows a typical software keypad. The software keypad, if
supported by your HMI/SCADA software, might vary in appearance.
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Restrictions of Numeric Formatting by Regional Locale
There are several restrictions of numeric formatting by regional locale to consider for the visualization
applications you build with your HMI/SCADA software.

Numeric Strings Enclosed Within Quotation Marks
A numeric string enclosed within quotation marks cannot be converted to the number format of another
regional locale because of the ambiguity interpreting the thousand separator character.

Example:

"4000.654" in the U.S. regional setting is four thousand.

"4000.654" in the Germany regional setting is over four million.

A numeric string is not supported and cannot be converted to the number format of another regional locale.
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Numbers Passed as Script Parameters
Scripts containing the SignedWrite() function experience similar problems interpreting the thousand separator
character when a numeric string is passed as a parameter within quotation marks.

Example:

SignedWrite("AO1.PV1","8.456,56","",true,1,null);

The numeric value is enclosed within quotation marks as a string data type and the comma thousand separator
character is interpreted as a parameter delimiter. If the computer running a visualization application regional
locale is set to Germany, the script incorrectly writes 8.46 to an attribute.

Alternative Solution:

Use a custom property with an analog data type instead of a string.

SignedWrite("AO1.PV1",CP1,"",true,1,null);

where CP1=8.456,56 is set by the user at run time.

Double-byte Character Languages
Double-byte character languages like Chinese or Japanese provide narrow or wide character sets. The Windows
default setting is to show narrow characters in Chinese or Japanese languages. The decimal point and digital
grouping characters can be shown with a narrow double-byte character set. However, the comma or period
characters cannot be shown with a wide double-byte character set.

Using Windows Common Controls
You can add the following Windows common controls to your graphic:

• Radio button group•

• Check box•

• Edit box•

• Combo box•

• Calendar control•

• DateTime picker•

• List box•

You can place these Windows common controls as you would any other element by selecting them from the
Tools panel. You click on the canvas to position a common control and, with exception of the calendar control,
drag the rectangle to set of the control.

After placing the control on the canvas, you can then configure:

• Background color and text color (with exception of the DateTime Picker control).•

• Other control-specific properties in the Properties Editor.•

• Control-specific animations.•

• The common Value property in scripting to read from and write to the Windows common control at run•
time.
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Changing Background Color and Text Color of Windows Common Controls
You can change the background color and text color of all Windows common controls with exception of the
DateTime Picker control.

The background color and text color of the Windows common controls can be only solid colors, not gradients,
patterns, nor textures.

To set the background color of a Windows common control
1. Select the Windows common control.1.

2. In the Properties Editor, click the browse button of the Fill Color property. The Select Fill Color dialog box2.
appears.

3. Select a solid color and click OK. For more information, see Setting a Solid Color. The Windows common3.
control background color changes accordingly.

To set the text color of a Windows common control
1. Select the Windows common control.1.

2. In the Properties Editor, click the browse button of the TextColor property. The Select Text Color dialog box2.
appears.

3. Select a solid color and click OK. For more information, see Setting a Solid Color. The Windows common3.
control text color changes accordingly.

Reading and Writing the Selected Value at Run Time
You can use the Value property that is common to all Windows common controls. It is not visible in the
Properties Editor. You can use the value property in a script or other animation links.

The following table shows you the data type, a description on how the value property is used, and an example
for each Windows common control.

Control Data Type Description Example

Radio Button Group Boolean,
Integer, Real
or String

Reads the value of the
selected item, or selects
the item with that value if
it exists.

RadioButtonGroup1.Val
ue = "Mixing";

Check Box Boolean Sets or reads the checked
status.

CheckBox1.Value = 1;

Edit Box String Sets or reads the text
contents.

EditBox1.Value =
"Hello World";

Combo Box Integer Reads the value of the
selected item, or selects
the item with that value if
it exists.

ComboBox1.Value = 5;
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Control Data Type Description Example

Calendar Time Sets or reads the selected
date.

Calendar1.Value =
"11/15/2006 11:12:34
AM";

DateTime Picker Time Sets or reads the selected
date and time.

DateTimePicker1.Value
= "11/15/2006 2:55:12
PM";

List Box Integer Reads the value of the
selected item, or selects
the item with that value if
it exists.

ListBox1.Value =
"John Smith";

Configuring Radio Button Group Controls
You can use a Radio Button Group control element to exclusively select an option from a group of options at run
time.

You can set the:

• 3D appearance of buttons.•

• Layout of the radio button group options.•

You can also use properties that are specific to the Radio Button Group control in scripting. At run time you can
access the script to view and modify the Radio Button Group control.

Setting the 3D appearance of a Radio Button Group Control
You can set the 3D appearance of a radio button group control. This affects how the option circles appear.

Three-dimensional appearance

Flat appearance in same color as option text

To set the 3D appearance of a radio button group control
1. Select the radio button group control.1.

2. In the Properties Editor, select from the list for the ControlStyle property:2.

• Click ThreeD for a three-dimensional appearance.•

• Click Flat for a flat two-dimensional appearance in the same color as the option text.•

Setting the Layout of the Radio Button Group Options
You can set the layout of the radio button group options in a vertical or horizontal direction.
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To set the layout of the radio button group options
1. Select the radio button group control.1.

2. In the Properties Editor, select from the list for the Layout property:2.

• Click Vertical to arrange the options under each other.•

• Click Horizontal to arrange the options next to each other.•

You can set this option also in the radio button group animation dialog box.

Using Radio Button Group-Specific Properties at Run Time
You can use properties that are specific to the Radio Button Group control at run-time. These properties are:

• Count - returns the number of radio buttons in the Radio Button Group control.•

• SelectedValue - reads the value of the selected item, or selects the item with that value if it exists.•

These properties are available when you browse for a Radio Button Group control in your HMI's attribute/tag
browser.

Configuring Check Box Controls
You can use a Check Box control for users to reset a Boolean attribute during run time.

You can set the following properties of the Check Box control:

• Default state, checked or unchecked.•

• Caption text of the Check Box control button.•

• 3D appearance of the Check Box control button.•

Setting the Default State of a Check Box Control
You can set the default state of a check box control to be checked or unchecked.

To set the default state of a check box control
1. Select the Check Box control.1.

2. In the Properties Editor, select from the list for the Checked property:2.

• Click False to use an unchecked check box by default.•

• Click True to use a checked check box by default.•

Setting the Caption Text of a Check Box Control
You can set the caption text of a Check Box control.

To set the caption text of a Check Box control
1. Select the Check Box control.1.
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2. In the Properties Editor, type a text string in the Caption property value box.2.

Setting the 3D appearance of a Check Box Control
You can set the appearance of the check box within the control to be either flat or three-dimensional.

Three-dimensional appearance

Flat appearance in same color as caption text

To set the 3D appearance of a Check Box control
1. Select the check box control.1.

2. In the Properties Editor, select from the list for the ControlStyle property:2.

• Click ThreeD for a three-dimensional check box.•

• Click Flat for a flat two-dimensional check box in the same color as the caption text.•

Configuring Edit Box Controls
You can use an Edit Box control to create a box during run time in which users can enter text or view text.

You can configure the following properties of an Edit Box control:

• Set the default text.•

• Wrap text to the next line in the edit box at design time and run time.•

• Configure it so that the run-time text is read-only.•

Setting the Default Text in an Edit Box Control
You can set the default text that appears in an edit box control during run time.

To set the default text in an Edit Box control
1. Select the edit box control.1.

2. In the Properties Editor, type a text in the Text property. The text appears in the edit box control at design2.
time. At run time, it can be overwritten with the value of a configured attribute.

Configuring the Text to Wrap in an Edit Box Control
You can configure the edit box control to wrap text at design time and run time. This lets you view and type
strings in a more compact way.

To configure text-wrapping in an edit box control
1. Select the edit box control.1.

2. In the Properties Editor, select from the list for the Multiline property:2.

• Click True to enable text-wrapping at run time.•

• Click False to disable text-wrapping at run time.•
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Configuring the Text to be Read-Only in an Edit Box Control
You can configure the Edit Box control to only show text at run time and prevent the run-time user from writing
back to the associated attribute.

To configure the text to be read-only in an Edit Box control
1. Select the edit box control.1.

2. In the Properties Editor, set the ReadOnly property to True.2.

To enable writing back to the associated attribute at run time, you can set the ReadOnly property to False.

Configuring Combo Box Controls
You can use Combo Box controls to select an option from a foldable list.

You can configure:

• Drop-down type of combo box control.•

• Width of the drop-down list.•

• Integral height flag of the drop-down list to avoid clipping of the items in simple combo box controls.•

• Maximum number of items to appear in the drop-down list.•

You can also use properties that are specific to the Combo Box control in scripting. At run time, you can access
the script to view and modify the items in the Combo Box control.

Setting the Type of Combo Box Control
You can use one of the following combo box control types:

• Simple - no drop-down list, values can be entered•

• DropDown - has a drop-down list, values can be entered•

• DropdownList - has a drop-down list, values cannot be entered•

To set the type of Combo Box control
1. Select the combo box control.1.

2. In the Properties Editor, select from the list for the DropDownType property:2.

• Simple•

• DropDown•

• DropDownList•

Setting the Width of the Drop-Down List
You can set the width of the expanded drop-down list when the user clicks on it. This setting can be used to save
space of the folded combo box control at run time.

Typically you set the drop-down list width greater than the width of the combo box on the canvas.
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If you set the drop-down list width smaller than the combo box control width on the canvas, the drop-down list
is the same width as the combo box control.

To set the width of the combo box drop-down list
1. Select the combo box control.1.

2. In the Properties Editor, type a width value in the DropDownWidth property value box.2.

Avoiding Clipping of Items in the Simple Combo Box Control
You can avoid clipping of items in the simple combo box control list by setting the IntegralHeight property to
true. The combo box list height is then changed, so that no items appear clipped.

To avoid clipping of items in the drop-down list
1. Select the combo box control.1.

2. In the Properties Editor, select True as the value for the IntegralHeight property.2.

Setting the Maximum Number of Items to Appear in the Combo Box Drop-Down List
You can limit the number of items that appear at any given time in the combo box drop-down list.

To set the maximum number of items to appear in the drop-down list
1. Select the combo box control.1.

2. In the Properties Editor, type the maximum number as a value for the MaxDropDownItems property.2.

Using Combo Box-Specific Properties at Run Time
You can use properties that are specific to the Combo Box control at run time.

• The count property returns the number of items in a Combo Box control.•

• The NewIndex property returns the index of the last item added to the Combo Box list.•

These properties are available when you browse for a Combo Box control in your HMI's attribute/tag browser.
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Configuring Calendar Controls
You can use the Calendar control to select a date from one or more monthly calendar sheets.

You can:

• Set the number of calendar month sheets to be shown.•

• Set the first day of the week.•

• Show or hide today’s date on the bottom of the control.•

• Set the fill and text colors of the calendar title.•

• Set the text color for trailing dates.•

• Set the date value of the Calendar Control that is used as default at run time.•

Setting the Number of Calendar Month Sheets
You can set the number of calendar month sheets to be shown by specifying the number of month columns and
month rows. The number of columns and rows in the calendar control depends on the font size and the width of
the calendar control.

For example, you can show six months in a calendar control by specifying two columns and three rows.

To set the number of calendar month sheets
1. Select the Calendar control.1.

2. In the Properties Editor, configure the calendar properties:2.

• For the CalendarColumns property, specify the number of columns in the calendar control.•

• For the CalendarRows property, specify the number of rows in the calendar control.•

Setting the First Day of the Week
You can set the first day of the week for the calendar control. This is the day that appears on the most left
column of each calendar month sheet.
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You can set it to:

• The default as defined by the operating system.•

• Any day of the week.•

To set the first day of the week
1. Select the Calendar control.1.

2. In the Properties Editor, select from the list for the FirstDayOfWeek property:2.

• Click Default to use the operating system setting.•

• Click the day of the week.•

Showing or Hiding Today’s Date on a Calendar Control
You can show or hide today’s date on the bottom of a calendar control

To show or hide today’s date on the bottom of a calendar control
1. Select the Calendar control.1.

2. In the Properties Editor, set the ShowToday property to one of the following:2.

• True to show today’s date•

• False to hide today’s date•

Setting Title Fill Color and Text Color on a Calendar Control
You can set the title fill color and title text color on a calendar control.

Changing the title fill color also affects the:

• Color of the week days.•

• Fill color of the indication box of today’s date.•

When you change the title text color, this also affects the text color of the indication box of today’s date.

To change the title fill color of a Calendar control
1. Select the Calendar control.1.

2. In the Properties Editor, click the browse button for the TitleFillColor property. The Select FillColor dialog2.
box appears. For more information, see Setting Style.

3. Select a color and click OK. The title fill color is changed accordingly.3.

© 2022 AVEVA Group plc and its subsidiaries. All rights reserved.
  

Page 216

AVEVA™ Industrial Graphic Editor User Guide 
Chapter 4 – Editing Graphic Properties



To change the title fill color of a Calendar control
1. Select the Calendar control.1.

2. In the Properties Editor, click the browse button for the TitleTextColor property. The Select FillColor dialog2.
box appears. For more information, see Setting Style.

3. Select a color and click OK. The title text color is changed accordingly.3.

Setting the Text Color for Trailing Dates in a Calendar Control
You can set the text color for dates outside the month for any month sheet in a calendar control.

To set the text color for trailing dates
1. Select the Calendar control.1.

2. In the Properties Editor, click the browse button for the TrailingTextColor property. The Select Text Color2.
dialog box appears. For more information, see Setting Style.

3. Select a color and click OK. The text color of the trailing dates is changed accordingly.3.

Setting the Default Value of the Calendar Control
You can set the default value of the Calendar Control. The default value is a date that the control uses when it is
shown the first time.

To set the default value of the calendar control
1. Select the Calendar control.1.

2. In the Properties Editor, set the DefaultValue property to the date value you want to use as default at run2.
time.

Configuring DateTime Picker Controls
Use the DateTime Picker control to select a date or time.

You can configure the DateTime Picker control to show:

• A long format, such as Friday, August 11, 2008.•

• A short format, such as 8/11/2008.•

• Just the time, such as 9:16:36 PM.•

• A custom time format, such as 8/11/2008 9:16:36 PM.•

You can also set the default value of the DateTime Picker control.

To set the long date format
1. Select the DateTime Picker control.1.

2. In the Properties Editor, set the Format property to Long.2.

To set the short date format
1. Select the DateTime Picker control.1.

2. In the Properties Editor, set the Format property to Short.2.
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To set only time display
1. Select the DateTime Picker control.1.

2. In the Properties Editor, set the Format property to Time.2.

To set a custom date/time format
1. Select the DateTime Picker control.1.

2. In the Properties Editor, set the Format property to Custom.2.

3. Type the time format in the value box for the CustomFormat property. Use the following letters as3.
placeholders:

h The one or two-digit hour in 12-hour format.

hh The two-digit hour in 12-hour format. Single digit values are
preceded by a zero.

H The one or two-digit hour in 24-hour format.

HH The two-digit hour in 24-hour format. Single digit values are
preceded by a zero.

t The one-letter AM/PM abbreviation ("AM" is shown as "A").

tt The two-letter AM/PM abbreviation ("AM" is shown as "AM").

m The one or two-digit minute.

mm The two-digit minute. Single digit values are preceded by a
zero.

s The one or two-digit seconds.

ss The two-digit seconds. Single digit values are preceded by a
zero.

d The one or two-digit day.

dd The two-digit day. Single digit day values are preceded by a
zero.

ddd The three-character day-of-week abbreviation.

dddd The full day-of-week name.

M The one or two-digit month number.

MM The two-digit month number. Single digit values are preceded
by a zero.

MMM The three-character month abbreviation.

MMMM The full month name.

y The one-digit year (2001 is shown as "1").
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yy The last two digits of the year (2001 is shown as "01").

yyyy The full year (2001 is shown as "2001").

You can use any other characters, except "g" in the property. These characters then appear at design time and
run time in the control.

To set the default value in a DateTime Picker control
1. Select the DateTime Picker control.1.

2. In the Properties Editor, set the DefaultValue property to the date and time value you want to use as default2.
at run time.

Configuring List Box Controls
You can create a list box for users to select an option from a scrollable list during run time.

You can:

• Configure the list box to avoid clipping of its contained items. When you set the Integral Height flag, the list•
box control is resized so that no items are clipped.

• Specify if you want the control to be scrollable in horizontal direction at run time. This enables the user to•
see the full text if the item captions are wider than the control itself.

• Use properties that are specific to the List Box control in scripting. At run time you can access the script to•
view and modify the items in the List Box control.

Avoiding Clipping of Items in the List Box Control List
In the list of a List Box control, some items may appear vertically clipped. You can configure the List Box control
to avoid this clipping by setting the IntegralHeight property.

To avoid clipping of items in the List Box control
1. Select the list box control.1.

2. In the Properties Editor, select True as value for the IntegralHeight property.2.

Using a Horizontal Scroll Bar in a List Box Control
You can configure a horizontal scroll bar in a List Box Control so that at run time the user can scroll the list
horizontally to see items that are wider than the control.

To configure a horizontal scroll bar
1. Select the List Box control.1.

2. In the Properties Editor, select True as value for the HorizontalScrollbar property.2.

Using List Box-Specific Properties at Run Time
You can use properties that are specific to the List Box control at run time.

• The Count property returns the number of items in a List Box control.•

• The NewIndex property returns the index of the last item added to the List Box list.•

• The SelectedValue property reads the value of the selected item, or selects the item with that value if it•
exists.
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• The TopIndex property returns the index of the top most item in the list.•

These properties are available when you browse for a List Box control in your HMI's attribute/tag browser.

Using Custom Properties
About Custom Properties

You can configure and use custom properties to extend the functionality of symbols and use them in
combination with the HMI/SCADA software attributes or tags. You can use binding with custom properties to
dynamically change the reference of a custom property.

Symbol

Custom Property 1

Custom Property 2

Custom Property 3

Custom Property N

...

Data Type:
- Boolean
- Integer
- Float
- Double
- String
- Time
- Elapsed Time

Default Value:
- Value
- Reference (Element or Attribute)
- Expression

Description

Visibility:
- Public Custom Property
- Private Custom Property

You can associate custom properties with functionality you want exposed and that you want to be reusable. You
can also use custom properties to connect an embedded graphic to attributes and tags in your HMI/SCADA
software.

Managing Custom Properties
You manage all custom properties of a graphic using the Edit Custom Properties dialog box.

From the Custom Properties dialog box, you can:

• Add and delete custom properties.•

• Set the types and data types of custom properties.•

• Set the default values of custom properties.•

• Determine the visibility of each custom property.•

• Add a description for each custom property.•
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• Validate and clear custom properties.•

You can also:

• Rename custom properties.•

• Link custom properties to external sources.•

• Override custom properties with new values.•

• Revert custom property values to their default values.•

Adding and Deleting Custom Properties
You can add and delete custom properties from a graphic.

To add a custom property
1. Click the canvas to cancel any selected elements.1.

2. On the Special menu, click Custom Properties. The Edit Custom Properties dialog box appears.2.

3. Click the Add icon. A new line is added in the custom properties list.3.

4. Type a name for the new custom property and click Enter.4.

You can see the name of the graphic and the custom property in the header of the dialog box.

• If the graphic includes an embedded graphic, the name of the custom property cannot be the same as•
the name of the embedded graphic or of an element of the embedded graphic.

• If the graphic includes a script, the name of the custom property and a nested class property in the script•
cannot be the same.

5. Configure the custom property on the right side of the Edit Custom Properties dialog box. For more5.
information, see Configuring Custom Properties.

6. Click OK.6.

To delete a custom property
1. Click the canvas to cancel any selected elements.1.

2. On the Special menu, click Custom Properties. The Edit Custom Properties dialog box appears.2.

3. Select the custom property you want to delete and click the Remove icon. When a message appears3.
requesting confirmation to delete the custom property, click Yes. The custom property is removed from the
custom properties list.

4. Click OK.4.

Configuring Custom Properties
You can configure custom properties when you create them or at a later point of time.

To configure a custom property
1. Click the canvas of the graphic.1.

2. On the Special menu, click Custom Properties. The Edit Custom Properties dialog box appears.2.
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3. Select the custom property you want to edit. The configuration for the selected custom property appears at3.
the right of the dialog box.

The header of the configuration area shows the graphic name on the right, for example "Symbol_001," and it
shows the custom property name on the left, for example "MyCustomProperty." Its reference in a script would
be "Symbol_001.MyCustomProperty."

1. In the Data Type list, click the data type of the custom property. You can select one of the following:1.

Data Type Graphic

Boolean

Double

Elapsed Time

Float

Integer

String

Time

2. If you want to:2.

• Make the property read-only at design time and prevent further changes to it when the graphic is•
embedded into another graphic, click the Lock icon.

• Make the property read-only at run time and prevent its value being changed, click the Lock icon.•

3. In the Default Value box, type a literal value, reference, or expression or browse for a reference using the3.
Browse icon.

4. If the selected data type is String, Time or Elapsed Time, you can click the T icon or tag icon.4.

• Select the T icon to indicate that the default value is a static value.•

• Select the tag icon to indicate that the default value is a reference to a value.•

5. In the Visibility box, configure how the graphic is visible. Do one of the following:5.

• Click Public if you want the custom property to be visible and can be used in a source graphic if the•
graphic is embedded.

• Click Private if you want the custom property to be hidden and no reference be made to it outside of the•
defining graphic.

6. In the Description box, type a meaningful description for the custom property.6.
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Validating Custom Properties
You can validate custom properties to track down and avoid configuration errors.

To validate a custom property
1. Click on the canvas to cancel any selected elements.1.

2. On the Special menu, click Custom Properties. The Edit Custom Properties dialog box appears.2.

3. Select the custom property you want to validate and click the Validate icon. Required boxes are highlighted3.
by a red box, possible errors appear in the status area under the custom properties list.

Clearing the Configuration of Custom Properties
You can clear the configuration of custom properties. This resets the properties to their default values.

To clear the configuration of a custom property
1. In the Edit Custom Properties dialog box, select the custom property.1.

2. Click the Clear icon. The configured values are reset to their default values.2.

Renaming Custom Properties
You can rename custom properties.

To rename a custom property
1. In the Edit Custom Properties dialog box, select the custom property.1.

2. Click the custom property again. The custom property is in edit mode.2.

3. Type the new custom property name and click Enter. The custom property is renamed.3.

If the graphic includes an embedded graphic, the name of the custom property cannot be the same as the name
of the embedded graphic or of an element of the embedded graphic.

If the graphic includes a script, the name of the custom property and a nested class property in the script cannot
be the same.

Linking Custom Properties to External Sources
You can link custom properties of a graphic directly to external sources by:

• Configuring objects that point to external sources and then point the custom property at the corresponding•
attribute reference.

• Configuring a special reference syntax to your HMI/SCADA software in the Default Value box. When you•
embed the graphic into a window in your HMI/SCADA software, the referenced tags connect to the tags of
your HMI/SCADA software.

Overriding Custom Properties
You can override the custom property default values of embedded graphics within graphics in the Industrial
Graphic Editor or your HMI/SCADA software.

When you override the custom property, it appears bold in the custom property list.
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You can override the following custom property values:

• Default value•

• Visibility, but only from public to private, not private to public•

• Description•

• Locked state•

• String mode setting•

You cannot override the data type of a custom property.

Reverting to Original Custom Property Values
After you override a custom property value, you can revert to the original custom property value. This can be
done for overridden custom properties of embedded graphics in other graphics and in your HMI/SCADA
software.

To revert to the original custom property value
• In the Edit Custom Properties dialog box, click the Revert icon. The custom property value reverts to its•

original value.
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Element Styles

Understanding Element Styles
An Element Style defines a set of visual properties that determine the appearance of text, lines, graphic outlines,
and interior fill shown in Industrial Graphics. An Element Style that is applied to a graphic sets pre-configured
visual property values that take precedence over a graphic’s native visual properties.

Element Styles provide the means for developers to establish consistent visual standards in their applications. An
Element Style can define the same visual properties of text, lines, fill, and outlines for all symbols or graphics that
belong to an application.

Likewise, Element Styles can show the current status of an object represented by a symbol. For example, an
Element Style animation can be applied to a graphic when an object transitions to an alarm state.

 

Style Libraries
A typical Style Library includes a set of predefined Element Styles.

The predefined values of the Element Styles in this library can be changed. However, existing Element Styles
cannot be renamed or deleted. Also, new Element Styles cannot be added to the library.

Visual Properties Defined by Element Styles
The following table lists the visual properties of graphic elements defined in an Element Style.

Graphic Element Element Properties

Text • Font family•

• Font size•
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Graphic Element Element Properties

• Font style•

• Font color•

• Blink On/Off•

Fill • Fill color•

• Fill gradient•

• Fill pattern•

• Fill texture•

• Blink On/Off•

Line • Line pattern•

• Line weight•

• Line color•

• Blink On/Off•

Outline • Outline Show/Hide•

• Outline Pattern•

• Outline Weight•

• Outline Color•

• Blink On/Off•

An Element Style may not define every visual property. If a property value is not defined in an applied Element
Style, the element’s native style is used and can be changed. However, if an element’s property value is defined
in an applied Element Style, the element’s native properties are disabled and cannot be changed.

Element Styles in Animations
You can configure an element or a group of elements with Boolean or truth table animations that determine
whether Element Styles are applied based on evaluated conditions or expressions. See Configuring an Animation
Using Element Styles.

Property Style Order of Precedence
To understand the behavior of an element’s properties when an Element Style is applied, we recommend that
you understand the order of precedence for the levels at which property styles are applied.

Updating Element Styles at Application Run Time
You can update the Elements Styles applied to symbols or graphics included in a running application.

• Updating Element Styles from your HMI/SCADA development environment•
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When an application is deployed and updates were made to the applied Element Styles from the
development environment, those updates will be propagated to the graphic elements in a running
application without requiring your run-time viewer to be closed and re-opened.

• Importing an updated Graphic Style Library•

Importing an updated Graphic Style Library that includes different applied Element Styles will propagate
those changes to graphic elements in a running application without requiring your run-time viewer to be
closed and re-opened.

Managing Element Styles
You can import and export Style Libraries containing custom Element Styles from one application to another
remote application. This section describes the tasks to create a set of custom Element Styles that can be used in
other HMI/SCADA applications.

Importing and Exporting Element Style Libraries
You can import a application's Style Library to load its Element Styles into another application. You can also
modify Element Styles, and then export the Element Style Library as custom user-defined Element Styles.

Change the Visual Properties of an Element Style
You can modify the visual properties of any Element Style in the currently loaded Styles Library. You modify
properties by setting overrides on the Element Styles tab of the Configure Application Styles dialog box.

In the Element Style Overrides area, you can:

• Modify the appearance of text by setting overrides for the text font, text size, text style, text color, and•
blinking.

• Modify the appearance of graphic fill by setting overrides for fill color and blinking.•

• Override the appearance of the line pattern, weight, color, and blinking.•

• Override the appearance of the outline line pattern, weight, color, and blinking.•

• Preview the appearance of an Element Style.•

• Reset Element Style visual properties to their default values.•

To show the currently assigned Element Styles
1. On your HMI/SCADA product's menu bar, select the option that shows the Configure option.1.

2. Click Configure and click Application Style Library.2.

The Configure Application Styles dialog box appears.

3. Click the Element Styles tab.3.

The Element Styles tab includes the following fields:

• The Element Style Overrides grid lists the Element Styles included in the library. An X within grid cells•
indicates style properties that have been overridden.

• The Preview field shows the appearance of an element when the current Element Style is applied.•
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• The Reset to Default button returns all modified Element Styles to their default values.•

• The property tabs include related fields to set values for each property defined in the selected Element•
Style.

Overriding the Element Style Text Properties
You can modify an Element Style’s text visual properties by setting alternative values for text font, text color, text
style, and blink rate.

To change the appearance of text in an Element Style
1. Navigate to the Style Library configuration dialog.1.

The navigation path will differ according to your HMI/SCADA software. Typically, the path will be through
menu items to configure your project or application components.

2. Select the edit icon for an Element Style to show the Element Style Override window.2.

3. Click the Text tab.3.

4. To change the font, select Font Override, click the browse button, and select a font from the Font dialog box.4.

5. To override the font color:5.

a. Select Font Color Override.a.

b. Click the color box.b.

c. Select a color from the Select Font Color dialog box.c.

6. To override the text blink behavior:6.

a. Select Blink.a.

b. Select a blinking speed from the Speed list.b.

c. Click the color box to show the Select Blink Color dialog box.c.

d. Select the color, gradient, pattern, and texture for the blink style.d.

7. Click OK.7.

Overriding the Element Style Fill Properties
You can modify an Element Style’s fill visual properties by setting alternative values for fill color and blink rate.

To override the fill appearance of an Element Style
1. Navigate to the Style Library configuration dialog.1.

The navigation path will differ according to your HMI/SCADA software. Typically, the path will be through
menu items to configure your project or application components.

2. Select the edit icon for an Element Style to show the Element Style Override window.2.

3. Click the Fill tab.3.

4. To override the fill style:4.

a. Select Fill Color Override.a.

b. Click the color box.b.
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c. Select a style from the Select Fill Color dialog box.c.

5. To override the fill blink behavior:5.

a. Select Blink.a.

b. Select a blink speed from the Speed list.b.

c. Click the color box.c.

d. Select a style from the Select Fill Color dialog box.d.

6. Click OK.6.

Overriding the Element Style Line Properties
You can modify an Element Style’s line visual properties by setting alternative values for line color, line pattern,
and line weight

To override the line appearance of an Element Style
1. Navigate to the Style Library configuration dialog.1.

The navigation path will differ according to your HMI/SCADA software. Typically, the path will be through
menu items to configure your project or application components.

2. Select the edit icon for an Element Style to show the Element Style Override window.2.

3. Click the Line tab.3.

4. To override the line pattern, select Line Pattern Override and select a line pattern from the adjacent list.4.

5. To override line weight, select Line Weight Override and enter a new line weight in the adjacent box.5.

6. To override line color properties:6.

a. Select Line Color Override.a.

b. Click the color box.b.

c. Select a color style from the Select Line Color dialog box.c.

7. To override the line blink behavior:7.

a. Select Blink.a.

b. Select a blinking speed from the Speed list.b.

c. Click the color box.c.

d. Select a style from the Select Blink Color dialog box.d.

8. Click OK.8.

Overriding the Element Style Outline Properties
You can modify an Element Style’s outline visual properties by setting alternative values for text font, text color,
text style, and blink rate.

To override the outline appearance of an Element Style
1. Navigate to the Style Library configuration dialog.1.
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The navigation path will differ according to your HMI/SCADA software. Typically, the path will be through
menu items to configure your project or application components.

2. Select the edit icon for an Element Style to show the Element Style Override window.2.

3. Click the Outline tab.3.

4. Select Show Outline.4.

5. To set the line pattern, select Line Pattern and select a line pattern from the adjacent list.5.

6. To set the line weight, select Line Weight and type a line weight in the adjacent box.6.

7. To set the line style:7.

a. Click the color box next to Line Color.a.

b. Select a style from the Select Line Color dialog box.b.

8. To set the line blink behavior:8.

a. Select Blink.a.

b. Select a blinking speed from the Speed list.b.

c. Click the color box.c.

d. Select a blink style from the Select Blink Color dialog box.d.

Previewing an Element Style
The Preview area shows the appearance of an Element Style’s current assigned visual styles.

To preview an Element Style
1. Navigate to the Style Library configuration dialog.1.
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The navigation path will differ according to your HMI/SCADA software. Typically, the path will be through
menu items to configure your project or application components.

2. Select the Styles tab.2.

3. Select an Element Style to show the Element Style Overrides window.3.

The Preview field updates to show the appearance of the selected Element Style.

Resetting an Element Style to Default Values
You can reset an Element Style to its original default visual styles.

Resetting an Element Style resets visual styles to their original default styles, not to any previous override
settings.

To reset an Element Style
1. Navigate to the Style Library configuration dialog.1.

The navigation path will differ according to your HMI/SCADA software. Typically, the path will be through
menu items to configure your project or application components.

2. Select the Element Styles tab.2.

3. Select one or more Element Styles from the Element Style Overrides list.3.

4. Click Reset to Default. The selected Element Style properties are reset to their default styles.4.

Changing the Visual Properties of User-Defined Element Styles
The Style Library includes a set of 25 user-defined Element Styles. User-defined Element Styles appear towards
the bottom of the list of the Element Style Overrides field and are named User_Defined_01 to User_Defined_25.

All visual properties of user-defined Element Styles are initially set to default values. Visual properties can be
individually configured for each user-defined Element Style by setting overrides for text, fill, line, and outline as
other predefined Element Styles.

Applying Element Styles to Elements
You can apply Element Styles to one or more graphic elements. Unlike setting Element Style overrides that
change the appearance of an Element Style’s properties, applying an Element Style to a graphic element
overrides the element’s native properties.

Applying Element Styles to graphic elements can help standardize the appearance of those elements and show
the current state of an object represented by a symbol or graphic. For more information, see Change the Visual
Properties of an Element Style.

Using the Element Style List
The Industrial Graphic Editor menu bar contains an Element Style list to select an Element Style and apply it to a
selected element of a graphic.

To apply an Element Style to a graphic element
1. Open the graphic in the Industrial Graphic Editor.1.
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2. Select one or more elements from the graphic.2.

3. Select an Element Style from the Element Styles list to apply to the selected elements.3.

Using the Properties Grid
The Industrial Graphic Editor Properties view contains an Element Style Appearance item to select an Element
Style and apply it to a selected element of a graphic.

To apply an Element Style from the Properties Editor
1. Open the symbol or graphic in the Industrial Graphic Editor.1.

2. Select one or more elements from the graphic or symbol.2.

3. In the Appearance category of the Properties Editor, select an Element Style from the Element Style list.3.
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Using Format Painter
You can use the Industrial Graphic Editor’s Format Painter to copy an Element Style from one graphic element to
another.

To apply an Element Style using Format Painter
1. Open a graphic in the Industrial Graphic Editor.1.

2. Select the element with the Element Style you want to copy.2.

3. On the Edit menu, click Format Painter. The pointer appears as the Format Painter cursor.3.

4. Select the elements you want to apply the Element Style to. The Element Style is applied to the selected4.
elements.

Clearing an Element Style
When an Element Style is applied to an element, you cannot edit the element’s styles that are controlled by the
applied Element Style. However, you can clear the application of the Element Style so that all of the styles can be
edited.

To clear an Element Style
1. Select the element.1.

2. Select None in the Element Style list.2.

Selecting an Element Style as a Default for a Canvas
You can select an Element Style at the canvas level of the Industrial Graphic Editor. The selected Element Style is
applied to any graphic element or groups that you create on the canvas.

Applying Element Styles to Groups of Elements
You can apply an Element Style on a group of elements in the same way that you apply an Element Style to a
single graphic element. To enable group support for Element Styles, set the group’s run-time behavior to
TreatAsIcon.

Setting a Group’s Run-time Behavior to TreatAsIcon
To apply an Element Style to a graphic element group, set the group’s TreatAsIcon property to True. Otherwise,
the Element Style lists are disabled when an element group is selected.

To set a group’s TreatAsIcon property to true
1. Select the element group to which the Element Style will be applied.1.

2. On the Properties menu, click Run-time Behavior and click TreatAsIcon.2.

3. Select True from the drop-down list.3.
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Understanding Element Style Behavior with a Group of Elements
• The Element Style applied to a group has higher precedence than the property styles applied to individual•

graphic elements in the group.

• If the Element Style applied to a group of elements has undefined property styles, then the element•
continues to use its Element Style or element-level settings for undefined property styles.

• If the Element Style that is applied to a group of elements has defined property styles, then those property•
styles override the property styles defined at the element level for elements in the group.

• An Element Style cannot be applied to a nested element group.•

• If you add an element to a group that has a group-level Element Style applied, the group Element Style is•
applied to it.

Configuring an Animation Using Element Styles
You can configure an element or a group of elements with a:

• Boolean animation that applies Element Styles based on a binary True/False condition.•

• Truth table animation that applies Element Styles based on a range of possible values.•

• Bit State animation that applies Element Styles based on a bit state based conditions.•

The truth table animation that applies Element Styles:

• Associates expressions of any data type supported by Application Server or InTouch to an Element Style.•

• Defines as many conditions as required and applies a separate Element Style for each condition•

• Defines the conditions to apply an Element Style by specifying a comparison operator (=, >, >=, <, <=) and a•
breakpoint, which itself can be a value, an attribute reference, or an expression.

• Arranges conditions in the order that Element Styles are processed.•

Configuring a Boolean Animation Using Element Styles
You can configure an element or a group of elements with a Boolean animation that uses only two Element
Styles.

To configure an element or a group of elements with an Element Style that uses Boolean animation
1. Open the symbol or graphic in the Industrial Graphic Editor.1.

2. Select the element or element group.2.

3. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.3.

4. Click the Add icon and select Element Style. The Element Style animation is added to the Animation list and4.
the Element Style state selection panel appears.

5. Click the Boolean button. The Boolean Element Style configuration panel appears.5.

6. In the Boolean text box, enter a Boolean numeric value, attribute reference, or an expression.6.

7. Clear ElementStyle in the True, 1, On area or False, 0, Off area if you don't want a different Element Style for7.
the true or false condition than the default Element Style that is shown in the Element Style list.
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8. In the True, 1, On area, select the Element Style in the list to use when the expression is true.8.

9. In the False, 0, Off area, select the Element Style in the list to use when the expression is false.9.

10. Click OK.10.

Configuring a Truth Table Animation with Element Styles
You can configure an element or a group of elements with a Truth Table animation that can select multiple
Element Styles based on a set of evaluated values or expressions.

To configure an element or a group of elements with an Element Style that uses Truth Table
animation
1. Open the symbol or graphic in the IDE Industrial Graphic Editor.1.

2. Select the element or group.2.

3. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.3.

4. Click the Add icon and select Element Style. The Element Style animation is added to the Animation list and4.
the Element Style state selection panel appears.

5. Click the Truth Table button. The Truth Table Element Style configuration panel appears. The Element Style5.
that is applied to the element is shown in the Element Style list at the bottom of the panel.

6. In the Expression Or Reference area:6.

• Select the data type of the expression from the list.•

• Type a value, attribute reference or expression in the text box.•

7. If the data type of the expression is string or internationalized string, you can specify to ignore the case by7.
selecting Ignore Case.

8. In the Truth Table, select the Element Style check box and select the Element Style for one of the conditions8.
to be defined in the truth table.

9. In the Operator column, select a comparison operator.9.

10. In the Value or Expression column, type a value, attribute reference, or expression.10.

11. To add other conditions:11.

a. Click the Add icon. An additional condition is added to the truth table.a.

b. Select the Element Style check box, select the Element Style for the condition, select an operator, andb.
enter the condition value or expression.

12. After adding all truth table conditions, click OK.12.

Truth Table animation is typically used to set Element Styles for the different states of an object. For example,
you can set Truth Table conditions to show different Element Styles that represent the following alarm
conditions:

• When the attribute TankLevel_001.PV is 0 then no Element Style is applied.•

• When the attribute TankLevel_001.PV is less than 20, then the Element Style is Alarm_Minor_Dev.•

• When the attribute TankLevel_001.PV is greater than the attribute Standards.TankMax then the Element•
Style is Alarm_Major_Dev.
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Deleting a Condition from an Animation Truth Table
You can delete a condition from an animation Truth Table to remove the associated Element Style from the
animation.

To delete a condition from a Truth Table animation that uses Element Styles
1. Open the Edit Animations dialog box, Truth Table Element Style panel.1.

2. Select the condition you want to delete.2.

3. Click the Remove icon. The condition is removed.3.

Changing the Processing Order of Element Styles in a Truth Table Animation
You can change the processing order of Element Styles by moving the conditions up or down in the Truth Table
list. The Element Style at the top of the Truth Table list is processed first. The remaining Element Styles are
processed in order based on their position from the top of the list.

To change the processing order of Element Style conditions
1. Open the Edit Animations dialog box, Truth Table Element Style panel.1.

2. Select the condition you want to move up or down the condition list in order for it to be processed sooner or2.
later.

3. Click the:3.

• Arrow up icon to move the condition up in the truth table.•

• Arrow down icon to move the condition down in the truth table.•

Configuring a Bit State Animation with Element Styles
You can configure an element with a Bit State animation with Element Styles.

To configure an element with a bit state element style animation
1. Select the element.1.

2. On the Special menu, click Edit Animations. The Edit Animations dialog box appears.2.

3. Click the Add icon and select Element Style. The element style animation is added to the Animation list and3.
the Element Style state selection panel appears.

4. Click the Bit State button. The Bit State Element Style configuration panel appears.4.

5. In the Expression Or Reference area, type a value, attribute reference or expression in the text box. Only5.
integer values are allowed.

6. In the Bit State area, select the:6.

a. Element Style: Select the Element Style check box and select the Element Style from the drop down list.a.

b. Operator: Any or Allb.

c. Bitmask/Bitmatch: For more information, see Using the Bit Pattern Selector Dialog.c.

7. If no condition is selected from the Bit State table, the element will be displayed according to the definition7.
in the Element Element Style.
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8. To add/remove other conditions:8.

a. Click the Add icon. An additional condition is added to the table.a.

b. Click the Remove icon. The selected condition is removed from the table.b.

9. To reorder the condition use the up and down arrows.9.

10. After adding all the bit state conditions, click OK.10.
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Graphic Scripts

Adding and Maintaining Graphic Scripts
About Graphic Scripts

You can associate scripts to your graphics. Scripts can add animation to a graphic or its elements that can be
executed in run time.

If you configure scripts that affect more than element and graphic animation, the script processing may affect
performance.

You can:

• Configure the predefined scripts of a graphic.•

• Add named scripts to a graphic.•

• Edit existing named or predefined scripts in a graphic.•

• Rename named scripts in a graphic.•

• Remove named scripts from a graphic.•

• Substitute references in named or predefined scripts.•

• Use element methods in named or predefined scripts.•

The autocomplete feature is available in the Graphic Editor script editor.

Predefined and Named Scripts
Predefined graphic scripts run:

• One time when the graphic is shown or opened: On Show•

• Periodically while the graphic is showing: While Showing•

• One time when the graphic is hidden or closed: On Hide•

• Any combination of the above•

Named graphic scripts enable any number of scripts to run that are triggered by values or expressions during
runtime :

• Being true: While True•

• Being false: While False•
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• Transitioning from false to true: On True•

• Transitioning from true to false: On False•

• Change in value and/or quality: DataChange•

The name of named scripts can be up to 32 characters in length, contain at least one letter, and contain special
characters, such as #, $, and _.

Execution Order of Graphic Scripts
When the graphic is showing, the scripts run in the following order:

1. On Show script.1.

2. Named scripts, not necessarily in the order that they appear in the list.2.

Any named script that is triggered by the DataChange trigger type runs the first time when the reference is
subscribed to. This behavior is different than the DataChange trigger behavior of Application Server scripts and
can take considerable time in intermittent networks.

A named script will not run if the script is triggered by the DataChange trigger type and is bound to an HMI tag
whose quality is Initializing, or whose quality is Bad and category is not OK.

Graphic Script Time outs
To avoid infinite loops in a graphic script, a time-out limit can be set in which FOR loops complete execution. If a
script loop does not complete execution within the time-out limit, WindowViewer automatically terminates the
loop and writes a message to the Logger.

The time-out limit is checked only at the NEXT statement of the loop. Therefore, the first iteration of the loop is
always executed, even if it exceeds the time-out limit.

To change the time out for a graphic script
1. In WindowMaker, on the Special menu, point to Configure and click WindowViewer. The WindowViewer1.

Properties dialog box appears.

2. Click the Managed Application tab.2.

3. In the Script timeout (msec) box, type a time-out value in milliseconds. Valid values are from 1 to 360,000.3.

4. Click OK.4.

Security in Graphic Scripts
If the graphic script attempts to write to attributes or tags with Secured Write or Verified Write security
classification, the script execution stops and the authentication dialog box appears.

After you enter correct authentication information, the graphic script continues execution.

This feature applies only if Secured and Verified Writes are supported by your HMI/SCADA software application.

Error Handling
A graphic script does not run if it contains a syntax error. When the graphic is loaded, a message is written to the
Logger.
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Signature Security for Acknowledging Alarms
SignedAlarmAck() is a script function for Industrial Graphics to acknowledge one or more alarms on attributes or
tags that optionally require a signature depending on whether any of the indicated alarms falls within a
designated priority range. If so, the user performs an authentication of the operation to acknowledge the alarms.

For information about SignedAlarmAck() script function syntax, parameters, and to see script examples, see the
SignedAlarmAck().

This feature requires that your HMI/SCADA software supports SignedAlarmAcks.

SignedAlarmAck() Run-time Behavior
At run time, the SignedAlarmAck() function does the following:

1. The function checks whether a signature is required on the alarms to be acknowledged.1.

a. It checks if the parameter Signature_Reqd_for_Range is true.a.

b. If so, it checks if security is enabled on your HMI/SCADA project or application.b.

c. If so, it checks the Priority for each designated alarm and compares it against the indicated priorityc.
range. If any of the designated alarms falls within the priority range, a signature is required.

d. If none of the designated alarms falls within the priority range, but no one is logged in, a signature isd.
required.

e. If no alarm is waiting for an acknowledgement, the function will don'thing, but will return a valuee.
indicating that no alarms are waiting for acknowledgement.

2. If none of the indicated alarms requires a signature, the function displays a simple pop-up acknowledgement2.
dialog.

a. When the user clicks OK, the function writes the acknowledgement comment to the AckMsg attribute ofa.
each of the alarms identified in the Alarm_List parameter.

The system identifies the logged-on user, if any, as the one who acknowledged all of the alarms.

b. If the user has permission to acknowledged alarms, or the project or application is unsecured, the alarmsb.
are marked as having been acknowledged.

c. If the acknowledgement fails, there is no direct feedback to the user. The status of the alarms, however,c.
will show that they have not been acknowledged.

3. If any of the indicated alarms requires a signature and is waiting for an acknowledgement, the function3.
displays a pop-up acknowledgement dialog that requires a signature.

a. This dialog has edit fields for the user's credentials: name, password, and domain. By default, the usera.
displayed is the logged-in user, if any. Otherwise, it is blank. All of these fields can be edited.

If Smart Cards are not enabled, the mode buttons for selecting Smart Card or password authentication
are disabled.

b. The user enters the acknowledgement comment, if enabled, and the user’s credentials.b.

c. The function validates the user's credentials.c.

d. If the user credentials are invalid the function displays an error message.d.
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When the user clicks OK on the error message, the function re-displays the alarm authentication dialog,
and allows the user to try again.

When the dialog is re-displayed, it shows the same user's name, domain, and acknowledgement
comment as were entered, but the password or Smart Card PIN field is blank. The user may then re-try
the authentication or cancel.

e. If the user credentials are valid, the function writes the acknowledgement comment to the AckMsge.
attribute of each of the alarms identified in the Alarm_List parameter.

The system identifies the authorizing user as the one who acknowledged all of the alarms, including
those that don't require a signature.

If the user has permission to acknowledgement alarms, the alarms are marked as having been
acknowledged.

If the acknowledgement fails, there is no direct feedback to the user. The status of the alarms, however,
will show that they have not been acknowledged.

4. The function provides a return value, and writes an information message in the Logger if an error occurs or4.
the operation is canceled.

For information on run-time behavior and the sequence of executing script operations, see SignedWrite() Script
Execution Sequence at Run Time.

SignedAlarmAck() Scripting Tips
SignedAlarmAck() and Alarm Configuration

You can use the SignedAlarmAck() function only in client scripts supported by your HMI/SCADA software.

SignedAlarmAck() with OnShow and OnHide Scripts

We don't recommend using the SignedAlarmAck() function with OnShow and OnHide scripts. This can cause
issues with window functionality, including the window title bar, windows losing correct focus, and windows
opening on top of one another.

SignedAlarmAck() with While True Scripts

We don't recommend using the SignedAlarmAck() function in a While True script type. A signed alarm
acknowledgement requires user interaction. If you want to use a While True type script, set it to an execution
time of 30-seconds or longer to allow the user to enter the required information.

SignedAlarmAck() Applied Example
You can create a dashboard application to automate routine use of the SignedAlarmAck() function.

To configure signature required for alarm acknowledgement
1. Use the Industrial Graphic Editor to create a graphic. Embed the graphic elements you require, such as1.

buttons, Alarm Control, alarm acknowledgement and commenting configuration, and comment text boxes.
Examples are shown in the following illustration.

If you embed an Alarm Control, as shown in this example, enable Requires ACK Signature in the Runtime
Behavior animation to require a signature for alarm acknowledgement.

2. Add the SignedAlarmAck() script function as required. The following Industrial Graphic Editor detail shows2.
two buttons configured with action scripts:
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3. Configure the scripted functionality you require. Scripts for the buttons shown in the example, plus scripts3.
for other possible button functions, are as follows:

a. The alarm list and all other parameters are hard-coded into the script function.a.

The following example requests acknowledgement of three alarms. If the alarms are within the priority
range 1-500 an authentication signature will be required. The comment is disabled from the operator.

ReturnCode = SignedAlarmAck ("Tank1.TankLevel.Lo Tank1.TankLevel.Hi 
Tank1.TankLevel.HiHi", True, 1, 500, "Ack Tank Level", False, "Acknowledge 
Alarms", "Please Acknowledge the Tank Level Alarms");

b. The alarm list is passed as a parameter to the script from a string type Custom Property.b.

The following example is the same as example 4a above, except that the alarm list is a parameter
pointing to a string type Custom Property which has concatenated the names of the alarms.

ReturnCode = SignedAlarmAck (TankLevel_Alarm_List, True, 1, 500, "Ack Tank 
Level", False, "Acknowledge Alarms", "Please Acknowledge the Tank Level 
Alarms");

c. The alarm list is passed as a parameter to the script from an Attribute which is an array of strings.c.

The following example is the same as example 4a above, except that the alarm list is a parameter
pointing to a string type array Attribute which has each of the alarm names as an array element.

ReturnCode = SignedAlarmAck (DataUDO.StringArray[], True, 1, 500, "Ack Tank 
Level", False, "Acknowledge Alarms", "Please Acknowledge the Tank Level 
Alarms");

d. The alarm list is passed as a parameter to the script from an Attribute which is an array of strings. Alld.
other parameters are passed as script variables.

ReturnCode = SignedAlarmAck( DataUDO.StringArray[], EnableAckSig, 
FromPriority, ToPriority, Default_Ack_Comment, Comment_Is_Editable, 
Title_Bar_Caption, Message_Caption);

Configuring the Predefined Scripts of a Graphic
You can configure the predefined scripts of a graphic. The predefined scripts can consist of:

• A script that runs one time when the graphic opens (On Show).•
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• A script that runs periodically as long as the graphic is open (While Showing).•

• A script that runs one time when the graphic closes (On Hide).•

The Predefined Scripts animation cannot be deleted. It can contain scripts for each trigger type On Show, While
Showing and On Hide.

To configure the predefined scripts for a graphic
1. Open the graphic in the Industrial Graphic Editor.1.

2. On the Special menu, click Scripts. The Edit Scripts dialog box appears.2.

3. In the Trigger Type list, click:3.

• On Show to configure a script that runs one time when the graphic opens.•

If you create an OnShow script that uses a custom property bound to a tag, there is no guarantee that
the tag data is valid when the script runs. This could occur because of the asynchronous nature of data
subscriptions in HMI/SCADA software. We recommend that your script first tests the quality and status
of the tag value before it is used in the rest of the script.

When the On Show trigger type is selected, the field that appears to the right of the Type list becomes a
Data Timeout field. For more information about using this field, see Ensuring Proper OnShow Script
Execution.

• While Showing to configure a script that runs periodically while the graphic is open.•

• On Hide to configure a script that runs one time when the graphic closes.•

4. If you configured a While Showing script, type a time period in milliseconds in the Period box. This specifies4.
after how many milliseconds the action script is executed.

If you set the While Showing period too low, system performance may decrease.

5. Type your script in the main edit box. The script syntax is the same as the syntax of AutomationObject5.
scripting.

If the graphic includes a custom property, the name of the custom property and a nested class property in
the script cannot be the same.

6. Select external data using your HMI's browser or explorer.6.

7. When you are done, click OK. The script editor checks the syntax of the script and may inform you of invalid7.
syntax. Click:

• Yes to save changes even if the script contains errors.•

• No to cancel the changes and close the script dialog box.•

Ensuring Proper OnShow Script Execution
When an OnShow script includes external references to tags, it is possible that the data from these tags is not yet
available when the OnShow script runs. As a result, the script might not work properly.

To avoid this situation, you can enter a value in the Data Timeout field. For the duration of the data time-out
period, the system checks for the presence of the external reference data. After all external reference data is
present, the system executes the OnShow script.
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If the data time-out period expires before all external data is present, the OnShow script is executed. However,
the script might not work properly.

The default value in the Data Timeout field is:

• For new Industrial Graphics, 1,000 ms.•

• For some HMI symbols, 0 ms; that is, the presence of external reference data is not checked. Verify the•
behavior of your HMI/SCADA software.

The maximum data time-out value is 30,000 ms.

Some of the issues regarding OnShow scripts and the Data Timeout function:

• The Data Timeout function is not available for the other trigger script types. It would be rare for external•
reference data to not be available in time for those scripts.

• The execution of the OnShow script is not delayed if there is an invalid reference (that is, the reference's•
quality is Bad).

• Named scripts are blocked until the OnShow script has completed, so some could be missed. For example,•
the named script OnDataChange might not run for the first few updates.

• Delayed OnShow scripts within nested embedded graphics might run out of order for the different nested•
levels. If the outer-most level is delayed but the inner levels are not delayed and are executed immediately,
the order of execution will be changed.

Adding Named Scripts to a Graphic
You can add named scripts to a graphic. A named script runs:

• One time when the specified values, data or expressions change.•

• Periodically if the values or expressions meet a certain criterion, such as being true.•

Every named script can contain only one trigger type.

To add a named script to a graphic

1. Open the graphic in the Industrial Graphic Editor.1.

2. On the Special menu, click Scripts. The Edit Scripts dialog box appears.2.

3. Click the Add icon. A new entry is created in the Named Scripts list.3.

4. Type a name for the named script. The name appears on the right panel as header.4.

5. In the Expression box, do one of the following:5.

• Type an expression, value or reference.•

• Browse for a reference.•

The expression acts as data source for the script trigger.

6. In the Trigger list, click:6.

• WhileTrue to trigger the script periodically when the expression is true.•

• WhileFalse to trigger the script periodically when the expression is false.•

• OnTrue to trigger the script one time when the expression becomes true from false.•
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• OnFalse to trigger the script one time when the expression becomes false from true.•

• DataChange to trigger the script one time when the expression or its quality changes. Select the Quality•
Changes check box to trigger the script when the quality of the specified expression changes.

7. If you want to specify how often the script is run when the trigger condition is fulfilled, type a time delay in7.
milliseconds in the Trigger Period box.

8. If you want to specify by how much the evaluated value is expected to change before the script runs, type a8.
deadband value in the Deadband box.

9. Type your script in the main edit box.9.

10. Use the Script Function Browser and Attribute Browser to select external data.10.

11. Click OK. The script editor validates the syntax of the script and identifies any errors. Click:11.

• Yes to save changes even if the script contains errors.•

• No to cancel the changes and close the script dialog box.•

Editing Graphic Scripts
You can edit predefined and named graphic scripts.

To edit graphic scripts
1. Open the graphic in the Industrial Graphic Editor.1.

2. On the Special menu, click Scripts. The Edit Scripts dialog box appears.2.

3. Select the script from the list. The right pane shows the script configuration.3.

4. If you are editing a predefined script, select the script trigger from the TriggerType list:4.

• On Show if the action script you want to edit runs one time after the graphic opens.•

• While Showing if the action script you want to edit runs periodically while the graphic is open.•

• On Hide if the action script you want to edit runs one time when the graphic closes.•

5. Edit the action script in the script box.5.

6. Click OK.6.

Renaming Scripts in a Graphic
You can rename named scripts in a graphic. When you rename the named script, the functionality of the script
does not change.

To rename a named script
1. Open the graphic in the Industrial Graphic Editor.1.

2. On the Special menu, click Scripts. The Edit Scripts dialog box appears.2.

3. In the Named Scripts list, click the script you want to rename.3.

4. Click the script again. It appears in edit mode.4.

5. Enter a new name for the script and click Enter. The script is renamed.5.
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Removing Scripts from a Graphic
You can remove predefined or named scripts from a graphic.

To remove predefined scripts from a graphic
1. Open the graphic in the Industrial Graphic Editor.1.

2. On the Special menu, click Scripts. The Edit Scripts dialog box appears.2.

3. Select Predefined Scripts from the list.3.

4. In the Trigger type list, click:4.

• On Show if the action script you want to remove runs one time after the graphic opens.•

• While Showing if the action script you want to remove runs periodically while the graphic is open.•

• On Hide if the action script you want to remove runs one time after the graphic closes.•

5. Delete all the script content in the script box.5.

6. Click OK.6.

To remove named scripts from a graphic
1. Open the graphic in the Industrial Graphic Editor.1.

2. On the Special menu, click Scripts. The Edit Scripts dialog box appears.2.

3. Select the named script from the list.3.

4. Click the Remove icon. A message appears.4.

5. Click Yes. The script is removed.5.

Substituting Attribute References in Scripts
You can substitute attribute references in scripts in the same way as you would with attribute references in
elements. For more information, see Substituting References in Elements.

Example of Changing Element Properties using Scripts
You can change some properties of elements using scripting. This lets you configure additional run-time behavior
to your elements in addition to design-time animation of those elements.

When you write scripts for the graphic or for one of its elements, you can use your HMI's attribute/tag browser
to show and select a:

• Property of an element•

• Custom property of the graphic•

If a reference is not unique, the following order applies:

1. Dimensioned variable references1.

2. Graphic properties references2.

3. Custom property references3.

4. Object attribute references4.
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To select an element property or a graphic custom property
1. Open your HMI's attribute/tag browser. It shows the element names and the properties of the selected1.

element.

2. Select an element or graphic from the list. The right pane shows the accessible properties of the selected2.
element or graphic.

3. Select a property from the right pane and click OK. The reference appears in the script window.3.

Using Methods in Scripting
Some elements, such as the Edit Box, Combo Box and List Box controls, support methods in scripting. These
methods can be used to perform various functions on the elements themselves at run time.

You can see the properties and methods supported by any given element by opening your HMI's attribute/tag
browser and selecting the element.

You can use the methods of the:

• Edit Box control to save and load the text at run time to and from a file.•

• Combo Box and List Box controls to access and change the contents of their lists at run time.•

Configuring Edit Box Methods
You can use the methods of an Edit Box control to:

• Save the contained text at run time to a file.•

• Load text into the control from a file at run time.•

To save the contained text in an Edit Box control
• In an action script, use the following method:•

ControlName.SaveText(FileName);

where ControlName is the name of the Edit Box control and FileName is the name of the file in which to
save the contents of the control.

The text contained in the control at run time is saved to the specified file.

If you only specify a file name, the file is saved by default in the user folder of the operating system. For example:
c:\documents and settings\username.

To load text into an Edit Box control from a file
• In an action script, use the following method:•

ControlName.LoadText(FileName);

where ControlName is the name of the Edit Box control and FileName is the name of the file you want to
load the text from.

The text contained in the file is loaded into the run time contents of the Edit Box control.

If you only specify a file name, by default, the file is expected to be in the user folder of the operating system. For
example: c:\documents and settings\username.
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Configuring Combo Box and List Box Methods
The Combo Box and List Box controls have methods that you can use to access and change the items in the list at
run time. Typically, you configure an action script to access these methods.

You can:

• Add and insert items into the list.•

• Delete individual or all items from the list.•

• Find an item in the list.•

• Get the item caption based on a specified index.•

• Associate the items with values.•

• Load items from and save items to a file.•

Adding and Inserting Items into a List
You can add an individual item:

• To the end of the list.•

• Above the currently selected item.•

To add an item to a Combo Box or List Box list
• In an action script, use the following method:•

ControlName.AddItem("ItemCaption");

where ControlName is the name of the Combo Box or List Box control and ItemCaption is the new item
you want to add.

The item is added to the end of the list.

You can specify an additional parameter writeToSelectedItem in the .AddItem function for Combo Box
controls. If writeToSelectedItem is false, the newly added Item is not written to the reference configured in
the Combo box’s Selected Item Value. For example: Controlname.AddItem("ItemCaption", bool
writeToSelectedItem);

To insert an item in a Combo Box or List Box list
• In an action script, use the following method:•

Controlname.InsertItem("ItemCaption");

where ControlName is the name of the Combo Box or List Box control and ItemCaption is the new item you
want to insert.

The item is inserted above the currently selected item in the list.

Deleting Items from a List
You can delete:

• An individual item from a list.•

• The selected item from a list.•

• All items from a list.•
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If items cannot be deleted from a list at run time, no warning message is shown. Such items include Combo Box
and List Box controls configured with enums or arrays.

To delete an individual item from a Combo Box or List Box list
• In an action script, use the following method:•

ControlName.DeleteItem(Index);

where ControlName is the name of the Combo Box or List Box control and Index is the index of the item
you want to delete. The first item of the list has an index of 0.

The item at the specified index is deleted, subsequent items are moved up the list.

To delete the selected item from a Combo Box or List Box list
• In an action script, use the following method:•

ControlName.DeleteSelection();

where ControlName is the name of the Combo Box or List Box control.

The selected item is deleted, subsequent items are moved up the list.

To delete all items from a Combo Box or List Box list
• In an action script, use the following method:•

ControlName.Clear();

where ControlName is the name of the Combo Box or List Box control.

All items of the control are deleted.

Finding an Item in a List
You can find an item in a Combo Box or List Box list. You specify the item caption, and the method returns the
index number of the first item found. Otherwise, the method returns -1.

Finding an item in a Combo Box or List Box list
• In an action script, use the following method:•

Index = ControlName.FindItem("ItemCaption");

where ControlName is the name of the Combo Box or List Box control and ItemCaption is the caption of the
item you are looking for.

The index is set to -1 if the item is not found, otherwise it contains the index of the first found item. The first
item of the list has an index of 0.

Reading the Caption of a Selected Item in a List
You can read the caption of a selected item in a Combo Box or List Box list.

Reading the caption of a selected item in a Combo Box or List Box list
• In an action script, use the following method:•

Caption = ControlName.GetItem(Index);

where ControlName is the name of the Combo Box or List Box control. Index is the index of the item for
which you want to read the caption. The first item of the list has an index of 0.
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Caption contains the item caption of the specified index.

Associating Items with Values in a List
You can associate items with values in a Combo Box or List Box control. This is the same as using a secondary
index system to identify items in the list.

You can:

• Set item data, which associates an item with a value•

• Get item data, which returns the value that is associated with an item•

To set item data in a Combo Box or List Box list
• In an action script, use the following method:•

ControlName.SetItemData(Index,Value);

where ControlName is the name of the Combo Box or List Box control, Index is the index of the item that
you want to set and Value is the value you want to assign to the item. The first item of the list has an index of
0.

To get item data in a Combo Box or List Box list
• In an action script, use the following method:•

Value = ControlName.GetItemData(Index);

where ControlName is the name of the Combo Box or List Box control and Index is the index of the item
for which you want to get the value. The first item of the list has an index of 0.

Value contains the value that is assigned to the item.

Loading and Saving Item Lists
You can load and save all items in a list from and to a file.

To load the item list for a Combo Box or List Box control from a file
• In an action script, use the following method:•

ControlName.LoadList(FileName);

where ControlName is the name of the Combo Box or List Box control and FileName is the name of a file on
the local harddrive or on the network.

If you only specify a file name, the file is expected to be in the users folder. For example: c:\documents and
settings\username.

The list contained in the file is loaded and, if valid, the current list is overwritten.

To save the item list for a Combo Box or List Box control to a file
• In an action script, use the following method:•

Controlname.SaveList(FileName);

where ControlName is the name of the Combo Box or List Box control and FileName is the name of a file on
the local harddrive or on the network.

If you only specify a file name, the file is saved to the users folder. For example, c:\documents and
settings\username.
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The list is saved to the specified file.

Working with the Show/Hide Graphics Script Functions
About the Show/Hide Graphic Functions

The Show/Hide Graphic script functions enable you to write Industrial Graphics scripts to display a graphic as a
pop-up window and close the pop-up window.

The Show/Hide Graphics script functions are in addition to the Show/Hide Symbol animation feature, which
enables you to display a graphic as a pop-up window through graphic animation. The Show/Hide Symbol
animation feature remains unchanged. You can use Show/Hide Symbol animation and the Show/Hide Graphic
script functions together. For more information, see Run Time Behavior of the Show/Hide Graphic Functions.

Like the Show/Hide Symbol animation feature, you can control the properties of the graphic through the Show
Graphic feature. You can configure the script to specify:

• Which graphic will appear as the pop-up window.•

• Whether the window will have a title bar.•

• The initial position of the pop-up window.•

• Whether the window can be resized.•

• Whether the window will be modal or modeless.•

• The relative position of the pop-up window.•

• Passing the owning object to the graphic that you want to display.•

• Values of the custom properties of the graphic.•

You can use the HideSelf script function for Industrial Graphics to close the displayed graphic from within the
graphic's own script.

You can use the HideGraphic() script function to close any displayed graphic given its Identity.

The ShowGraphic(), HideGraphic(), and HideSelf() functions are available in managed or published HMI
applications only, if supported by your HMI.

Configuring the Show/Hide Graphic Script Functions
We recommend that you first include a script that contains the ShowGraphic function to display a graphic as a
pop-up window at run time. You can also include a script that contains the HideGraphic or HideSelf functions.
The HideGraphic script function allows you to close any Industrial Graphic, displayed through the ShowGraphic
script function. The HideSelf script function allows you to close the graphic, displayed by either the ShowGraphic
script function or the ShowSymbol animation.

The ShowGraphic function can be used in a symbol’s action script, named script and pre-defined script. Although
the system allows you to include it in a server script, such as Start Up, On Scan, Off Scan, Shut Down and Execute,
you will not be able to execute the function at run time.

The HideGraphic script function can be called from any Industrial Graphic being used in the HMI application.
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To include a script that contains the Show/Hide Graphic functions within a graphic animation action
script
1. Create a graphic or open an existing graphic.1.

2. Draw a graphic, and then double-click it to open the Edit Animations page.2.

3. Open the action script editor.3.

4. Click the Display Script Function Browser icon. The Script Function Browser appears.4.

5. In the Graphic Client list, click the required script function, and then click OK. The script is added to the5.
graphic script editor. If you add the ShowGraphic script function, the following code snippet is added:

Dim graphicInfo as aaGraphic.GraphicInfo;

graphicInfo.Identity = "<Identity>";

graphicInfo.GraphicName = "<SymbolName>";

ShowGraphic( graphicInfo );

6. Modify the script. The Identity and GraphicName are required properties and be specified.6.

a. You can use the Display Graphic Browser to set the value for the GraphicName property.a.

b. You can use the Display Automation Object Browser to set the OwningObject property.b.

For more information, see Using the Display Graphic Browser and Display Automation Object Browser.

For details on the scripts and samples, see Show/Hide Graphic Script Functions Guidelines.

Using the Display Graphic Browser and Display Automation Object Browser
You can use the Display Graphic Browser to select a graphic in the Graphic Toolbox, Instances, and Relative
References. You can select a graphic and insert it into the script editor.

You can use the Display Automation Object Browser to select an automation object and add it as an owning
object. The browser displays all automation objects in the application, arranged in a tree structure. The browser
also displays the object containment relationship. You can select an automation object and insert it into the
script editor.

The automation object that you have inserted will be placed within double quotes.

To select a graphic or reference name
1. On the script editor, click the Display Graphic Browser icon. Your HMI's attribute/tag browser appears.1.

2. Select the graphic, and then click OK. The graphic is added to the script editor.2.

To select an automation object as the owning object
1. On the script editor, click the Display Automation Object Browser icon. Your HMI's attribute/tag browser1.

appears.

2. Select the automation object, and then click OK. The automation object is added to the script editor.2.

Show/Hide Graphic Script Functions Guidelines
The following sections provide script tips and guidelines, followed by scripting scenarios:
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• Using the Show/Hide Script Parameters and Properties•

• Show/Hide Graphic Script Tips and Examples•

For information about script syntax and parameters along with basic script examples, see the Application Server
Scripting Guide.

Using the Show/Hide Script Parameters and Properties
The following sections provide guidelines for using the Show/Hide Graphic script parameters:

• Using the Identity Property in the ShowGraphic() Function•

• Height and Width Aspect Ratio•

• Incompatible GraphicInfo Properties•

Using the Identity Property in the ShowGraphic() Function
We recommend that the Identity be unique across the HMI application. If you want to add the HideGraphic
script function, use the same Identity as a parameter that you have used in the ShowGraphic script. The HideSelf
script function does not have any parameter.

The following table lists the various scenarios where you can use the Identity property with the
ShowGraphic() function and their results in run time:

Scenario Result in Run Time

You have executed two ShowGraphic scripts
for the same graphic using the same Identity.

The first pop-up window is closed and a new
one opens, displaying the same graphic.

You have executed two ShowGraphic scripts
for two different graphics, but using the
same Identity.

The first pop-up window displaying the first
graphic is closed and a new one opens,
displaying the second graphic.

You have executed two ShowGraphic scripts
for the same graphic, but using different
Identity properties.

Two pop-up windows are opened, displaying
the same graphic.

You have executed two ShowGraphic scripts
for two different graphics with different
Identity properties.

Two pop-up windows are opened, displaying
the two different graphics.

During configuration, the system validates only the syntax of the script. Validation of graphic and Identity
existence occurs only at run time.

Height and Width Aspect Ratio
In order to maintain aspect ratio, you can specify either the height or width of a pop-up window using the
CustomizedWidthHeight property. The system calculates the unspecified property based on the graphic's aspect
ratio.

If a pop-up window has a title bar, the system adjusts the size of the pop-up window so that the graphic retains
its aspect ratio.
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Example 1: Graphic is 100 x 100. If you specify height = 200, then the height of the content = 200 - 26 (title bar
height) = 174, and width of the content = 174. The same algorithm is applied to adjust the width, based on the
adjusted height.

Example 2: Graphic is 100 x 100. If you specify width = 200, then the width of the content = 200, and height of
the content = 200. The same algorithm is applied to adjust the width, based on the adjusted height. The height
of the container = 200 (height of the content) + 26 (height of the title bar) = 226.

If the pop-up window has a title bar, then the graphic is 100 x 100. If height = 200, then the height of the content
= 200, and width of the content = 200. The same algorithm is applied to adjust the width, based on the adjusted
height.

If the script contains the StretchWindowToScreenHeight property, but does not contain the Width property, the
system adjusts the width of the pop-up window.

If the script contains the StretchWindowToScreenWidth property, but does not contain the Height property, the
system adjusts the height of the pop-up window.

Incompatible GraphicInfo Properties
When you call ShowGraphic with an incompatible combination of GraphicInfo properties, you will see the
following warning message at run time:

ShowGraphic <Identity Name>. <Graphic name>.<script name> conflicting parameters used in
script: <Parameter1>, <Parameter2>

For example, the following incompatible properties result in a window with both Width and Height equal to 0:

graphicInfo.WindowRelativePosition = aaGraphic.WindowRelativePosition.WindowXY;

graphicInfo.RelativeTo = aaGraphic.RelativeTo.Desktop;

In this example, a WindowRelativePosition of WindowXY is incompatible with a size RelativeTo of Desktop.

The following table shows incompatible property combinations. Shaded cells indicate incompatible GraphicInfo
property combinations in addition to those specified in the Incompatible Properties column.

Window Relative
Position

Size:
Relative To

Incompatible
Properties Notes

Desktop Graphic X

Y

Width

Height

Desktop Desktop X

Y

Width

Height
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Window Relative
Position

Size:
Relative To

Incompatible
Properties Notes

Desktop CustomizedWidthHeig
ht

X

Y

ScalePercentage

Window Graphic X

Y

Width

Height

Window Desktop X

Y

Width

Height

RelativeTo to be
Window

Window CustomizedWidthHeig
ht

X

Y

ScalePercentage

ClientArea Graphic X

Y

Width

Height

ClientArea Desktop X

Y

Width

Height

RelativeTo to be
ClientArea

ClientArea CustomizedWidthHeig
ht

X

Y

ScalePercentage

ParentGraphic Graphic X

Y

Width

Height
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Window Relative
Position

Size:
Relative To

Incompatible
Properties Notes

ParentGraphic Desktop X

Y

Width

Height

RelativeTo to be
ParentGraphic

ParentGraphic CustomizedWidthHeig
ht

X

Y

ScalePercentage

ParentElement Graphic X

Y

Width

Height

ParentElement Desktop X

Y

Width

Height

ParentElement CustomizedWidthHeig
ht

X

Y

ScalePercentage

Mouse Graphic X

Y

Width

Height

StretchWindow
ToScreenWidth

StretchWindow
ToScreenHeight
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Window Relative
Position

Size:
Relative To

Incompatible
Properties Notes

Mouse Desktop X

Y

Width

Height
StretchWindow
ToScreenWidth

StretchWindow
ToScreenHeight

RelativeTo to be
Desktop

Mouse CustomizedWidthHeig
ht

X

Y

Width

Height
StretchWindow
ToScreenWidth

StretchWindow
ToScreenHeight

DesktopXY Graphic Width

Height

StretchWindow
ToScreenWidth

StretchWindow
ToScreenHeight

DesktopXY Desktop Width

Height

StretchWindow

ToScreenWidth

StretchWindow

ToScreenHeight

Conflicting
WindowRelative
Position and
RelativeTo
combination

DesktopXY CustomizedWidthHeig
ht

ScalePercentage

StretchWindow
ToScreenWidth

StretchWindow
ToScreenHeight
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Window Relative
Position

Size:
Relative To

Incompatible
Properties Notes

WindowXY Graphic Width

Height

StretchWindow
ToScreenWidth

StretchWindow
ToScreenHeight

WindowXY Desktop Width

Height

StretchWindow
ToScreenWidth

StretchWindow
ToScreenHeight

Conflicting
WindowRelative
Position and
RelativeTo
combination

WindowXY CustomizedWidthHeig
ht

ScalePercentage

StretchWindow
ToScreenWidth

StretchWindow
ToScreenHeight

ClientAreaXY Graphic Width

Height

StretchWindow
ToScreenWidth

StretchWindow
ToScreenHeight

ClientAreaXY Desktop Width

Height

StretchWindow
ToScreenWidth

StretchWindow
ToScreenHeight

Conflicting
WindowRelative
Position and
RelativeTo
combination

ClientAreaXY CustomizedWidthHeig
ht

ScalePercentage

StretchWindow
ToScreenWidth

StretchWindow
ToScreenHeight

© 2022 AVEVA Group plc and its subsidiaries. All rights reserved.
  

Page 258

AVEVA™ Industrial Graphic Editor User Guide 
Chapter 6 – Graphic Scripts



Run Time Behavior of the Show/Hide Graphic Functions
The Show/Hide Graphic script functions exhibit the following behavior:

• The graphic, configured with the ShowGraphic script function, behaves like a ShowSymbol animation pop-up•
window, rather than a typical HMI pop-up window.

• You can configure a graphic with both the ShowAnimation and ShowGraphic scripts together. If you execute•
the two scripts at run time, two pop-up windows open, displaying the same or different symbols. The two
pop-up windows are independent of each other.

• You can open, close, and manage the graphic from across symbols and across the entire HMI application.•

• Unlike ShowSymbol animation, there is no parent/child relationship between the window that launched the•
graphic and the graphic launched by the ShowGraphic() script function. For more information, see Closing a
Graphic.

• You cannot use the Close Window dialog box or similar dialog provided by your HMI/SCADA software at run•
time to close the pop-up windows displayed by the ShowGraphic script function. For more information, see
Closing a Graphic.

• Any graphic displayed by ShowGraphic script function or ShowSymbol animation always remains in front of•
HMI application run-time windows, except pop-up windows that might be supported by your HMI/SCADA
software. Even if you click a run-time HMI window, the window remains behind these graphics.

• If your HMI/SCADA software supports memory caching, enabling in-memory graphics caching in HMI run-•
time memory properties will keep ShowGraphic and ShowSymbol animation popup symbols cached in
memory. The system tracks the order in which graphics are closed in order to determine their age. If a user-
defined in-memory limit is exceeded, the system automatically removes the oldest popup symbols in the in-
memory graphics cache except those defined in high-priority windows. If you display a graphic with the
ShowGraphic script function or with ShowSymbol animation, the HMI run time will perform a memory
health check if supported by your HMI/SCADA software.

Behavior of ShowGraphic Windows with the Same Identity
ShowGraphic pop-up windows attempting to open a pop-up window with the same Identity exhibit the following
behavior with the predefined scripts OnHide, OnShow, and WhileShowing:

• A ShowGraphic function within an OnShow script will be blocked if a ShowGraphic pop-up window with the•
same Identity is already displayed.

• A ShowGraphic function within an WhileShowing script will be blocked if a ShowGraphic pop-up window•
with the same Identity is already displayed.

• A ShowGraphic function within an OnHide script will be blocked if a ShowGraphic pop-up window with the•
same Identity is already displayed.

No error or warning messages will appear in the logger when script execution is blocked as described.

With the Graphic Cache memory option enabled, calling ShowGraphic pop-up windows with same identity
name, if the graphic is modal to the modal graphic behind it, calling the ShowGraphic function cannot change
this symbol to be modeless to the current modal graphic. For more information, see Working with Modal
Windows.
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Closing a Graphic
You can close a graphic, displayed using the ShowGraphic script function, by executing the HideGraphic() or
HideSelf() script functions, by clicking the Close Window button of the graphic pop-up window if configured, or
by closing your HMI/SCADA software run time display. You cannot close the graphic by closing the HMI
configuration window or the graphic that launched the graphic.

Windows opened by the ShowGraphic() script function or ShowSymbol animation are loaded dynamically and
are not exposed at run time. You cannot close these windows using your HMI/SCADA software run-time Close
Window dialog box.

Show/Hide Graphic Script Tips and Examples
The Show/Hide Graphic script functions allow for a wide range of scripted uses. The following sections provide
in-context tips and examples of script applications:

• Using Predefined and Named Scripts•

• Working with Modal Windows•

• Using Hierarchical References and Containment Relationships•

• Scripting the Owning Object•

• Scripting Multiple Symbols•

Using Predefined and Named Scripts
You can use the Show/Hide Graphic script functions inside container scripts. Container scripts refers to
predefined scripts and named scripts. Predefined scripts include OnShow, WhileShowing, and OnHide. Named
scripts include WhileTrue, WhileFalse, OnTrue, OnFalse, and DataChange. For more information, see Predefined
and Named Scripts, Configuring the Predefined Scripts of a Graphic, and Adding Named Scripts to a Graphic.

Although you can use the Show/Hide Graphic script functions inside container scripts, you cannot use
ShowGraphic() in WhileTrue or periodic scripts such as WhileShowing.

Container Script Scenario
The following scenario illustrates the use of Show/Hide Graphic script functions inside a container script: You
want to automatically show a graphic upon closing the graphic already showing. This entails creating a
ShowGraphic script for one graphic, then creating a ShowGraphic script for a second graphic inside an OnHide
predefined script.

To execute the container script scenario
1. Create a graphic, such as a pump, called "symbol01" and another "symbol02".1.

2. Add a button named "Close" to symbol01 on the Industrial Graphic Editor canvas, and add an action script to2.
the button:

HideSelf();

3. Add a button named "Show Pump" in symbol02 on the Industrial Graphic Editor canvas and add an action3.
script to show the graphic, as in the following script example:

Dim graphicInfo as aaGraphic.GraphicInfo;

graphicInfo.Identity = "showpump_script001";
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graphicInfo.GraphicName = "symbol01";

graphicInfo.WindowType = aaGraphic.WindowType.Modeless;

graphicInfo.WindowRelativePosition = aaGraphic.WindowRelativePosition.Window;

graphicInfo.WindowLocation = aaGraphic.WindowLocation.Bottom;

ShowGraphic( graphicInfo);

4. Add an OnHide script in symbol01. In the script editor, add a ShowGraphic function for the second graphic,4.
symbol02, as in the following script example:

Dim graphicInfo as aaGraphic.GraphicInfo;

graphicInfo.Identity = "showpump_script001";

graphicInfo.GraphicName = "symbol02";

graphicInfo.WindowType = aaGraphic.WindowType.Modeless;

graphicInfo.WindowRelativePosition = aaGraphic.WindowRelativePosition.Window;

graphicInfo.WindowLocation = aaGraphic.WindowLocation.Bottom;

ShowGraphic( graphicInfo);

The ShowGraphic for your second graphic is now configured inside the predefined (container) script.

5. Go to run time and open the window containing the "show pump" button.5.

a. Click the "show pump" button. Symbol01 displays.a.

b. Click the "close button" on symbol01. Symbol02 now displays in place of symbol01.b.

In this scenario, you configure and demonstrate a ShowGraphic script inside a predefined script, and use it to
automatically display a second graphic upon closing the first.

By extension, you can configure more graphics the same way, accessing a sequence of graphics at run time with
only one button occupying your display. You can use other container scripts, such as OnShow and WhileShowing,
as well as named scripts in the same manner.

Working with Modal Windows
If you have opened a modal pop-up window using the ShowGraphic() script function, the system cannot execute
the rest of the script. Close the window to allow the system to execute the rest of the script.

If you have opened multiple modal pop-up windows, you cannot click or close the modal window stacked in the
middle of the modal chain. The system will maintain the modal chain to allow pending or unprocessed scripts to
process before the graphic can close. Attempts to close a window beneath a modal window are blocked.

The following examples 1 and 2 illustrate modal window behavior using the ShowGraphic() function.

The following example 3 illustrates a specific scenario of working with modal windows with the same identity
name using the ShowGraphic() function while the Graphic Cache memory feature is enabled.

Example 1: Modeless Symbol1 (S1) opens modeless Symbol2 (S2) using a ShowGraphic() script function.
Modeless graphic S2 opens modal Symbol3 (S3) using a ShowGraphic script function. In this scenario:

• S2 cannot complete its script and close (HideSelf) until S3 closes.•

• You cannot close S2 using the close window button.•
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• You cannot close S2 using a HideGraphic (S2) script function from another window until the modal graphic S3•
closes and the S2 script completes.

• You cannot close S2 using a ShowGraphic (S2) script function with the same Identity until the modal graphic•
S3 closes and the S2 script completes.

• You can close S1 using a HideGraphic (S1) script function from another window because the subsequent•
graphic S2 is modeless.

Example 2: Modeless Symbol1 (S1) opens modal Symbol2 (S2) using a ShowGraphic() script function. Modal
graphic S2 opens modal Symbol3 (S3) using a ShowGraphic script function. In this scenario:

• S1 cannot complete its script and close (HideSelf) until S2 closes.•

• S2 cannot complete its script and close (HideSelf) until S3 closes.•

• You cannot close S1 or S2 using the close window buttons.•

• You cannot close S2 using a HideGraphic (S2) script function from another window until the modal graphic S3•
closes.

• You cannot close S1 using a HideGraphic (S1) script function from another window until the modal graphic S2•
closes.

• You cannot close S2 using a ShowGraphic (S2) script function with the same Identity until the modal graphic•
S3 closes.

• You cannot close S1 using a ShowGraphic (S1) script function with the same Identity until the modal graphic•
S2 closes.

• You can close S3 using a HideGraphic script function from another window, or by using the close window•
button if enabled.

Although you can close a graphic by opening another graphic with the same Identity, effectively replacing the
original graphic, we recommend that you don't use the same Identity as a graphic opened with ShowGraphic in a
modal dialog.

Example 3: With the Graphic Cache memory feature enabled, a ShowSymbol (SS) has a button to show graphic
Symbol1 (S1) (modal), and another button to show graphic Symbol1 (S1) (modeless). S1 is configured to open
Symbol2 (S2) with the ShowGraphic() function. In this scenario:

• Click show graphic button S1(modeless) to open pop-up S1. Click the ShowGraphic() button in S1 to open•
pop-up S2 with title "Graphic01".

• User can enter input into S2.•

• With the pop-up open, click the show graphic button S1(modal). Pop-up S1 will open. Click the•
ShowGraphic() button in S1. Pop-up S2 will open with the title "Graphic01". The already open Graphic01
pop-up window will be replaced.

• With the Graphic Cache memory feature enabled, S1 cannot change from being modal to SS to being•
modeless to SS.

• User cannot enter input to S2.•

• Alternatively, close S2 opened from modeless S1, then open modal S1, and click the ShowGraphic() button to•
open S2, "Graphic01".

• User can enter input to S2.•
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For more information about example 3, see Behavior of ShowGraphic Windows with the Same Identity.

Using Hierarchical References and Containment Relationships
Placing one or more AutomationObjects within another AutomationObject results in a collection of
AutomationObjects organized in a hierarchy that matches the application model, allows for better naming and
manipulation, and for more precise scripting.

Using hierarchical references in scripts makes use of the fully qualified name of a contained object, including the
container object's TagName.

The following table provides generic examples of using hierarchical references and containment
relationships in scripts.

Without Hierarchical References With Hierarchical References

GraphicName = 
"MyContainer.Contained
ObjectHierachyName.Symbol
Name";

GraphicName = 
MyContainer.Tagname + 
".ContainedObjectHierachy
Name.SymbolName";
GraphicName = me.Container 
+ ".ContainedObjectHierarchy
Name.SymbolName";

GraphicName = 
"MyPlaform.SymbolName";

GraphicName = 
MyPlaform.Tagname + 
".SymbolName";

GraphicName = 
"MyEngine.SymbolName";

GraphicName = 
MyEngine.Tagname + 
".SymbolName";

GraphicName = 
"MyArea.SymbolName";

GraphicName = 
MyArea.Tagname + 
".SymbolName";

An example of a HierarchicalName is a valve object with a contained name of "Inlet" within a reactor named
"Reactor1". The valve object would have "Reactor1.Inlet" as the HierarchicalName.

The valve object would also have a unique TagName distinct from its HierarchicalName, such as "Valve101".

Another example of a HierarchicalName is a level transmitter with the TagName "TIC101" placed within a
container object called "Reactor1" and given the name" Level" within that container. This results in the
HierarchicalName "Reactor1.Level".

Scripting the Owning Object
The owning object in a ShowGraphic script function resolves only relative references. Any absolute reference is
not affected by the owning object. The owning object is independent of the graphic definition. The relative
reference is resolved by the object that hosts the script. For example, where GraphicName = "me.S1" or
"Obj1.S1", and OwningObject = "Obj2", the owning object resolves only the relative reference in the graphic S1.

Consider a scenario where there are two automation object instances, "Reactor_001" and "Reactor_002" in a
user application. Both instances have four user-defined attributes, int1, int2, real1 and real2, and the graphic S1.

The graphic (Reactor_001.S1) has the following UDA references:
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• Me.int1 (relative reference)•

• Me.real1 (relative reference)•

• Reactor_001.int2 (absolute reference)•

• Reactor_001.real2 (absolute reference)•

If you configure Reactor_001.S1 with the ShowGraphic script ("me.S1" or "Reactor_001.S1", OwningObject =
"Reactor_002") and execute the script at run time, the system displays Reactor_001.S1, though the relative
reference within this graphic points to Reator_002 object.

In such a case:

• The graphic always opens from only the host automation object instance, here "Reactor_001".•

• The GraphicName property can be set to relative reference, absolute reference or the Graphic Toolbox•
graphic name. If a relative reference is used in the GraphicName property, then the graphic will always open
from only the host automation object instance, here "Reactor_001". If an absolute reference or Graphic
Toolbox graphic name is used in the GraphicName property such as "Reactor_001.S1" or "S1", then the
system will search for such graphic by its name.

• The relative references for Me.int1, Me.real1 is redirected to Reactor_002.•

• The absolute references for Reactor_001.int2 and Reactor_001.real2 come from Reactor_001 only, and are•
not redirected to Reactor_002.

Relative references (such as me.int1) used in custom property override on embedded symbols would resolve to
the owning object of the embedded graphic. Whereas the relative references used in container scripts would
resolve to the owning object of the graphic where the script is configured.

The following examples illustrate a couple of scenarios where you may need to use the ShowGraphic function to
work with owning objects.

Assigning Custom Property Values of a Graphic
Custom properties of a graphic can be set to values when a graphic is shown by ShowGraphic() containing the
CustomProperties property.

The parameters of CustomProperties are the custom property name, assigned value, and the IsConstant Boolean
flag that indicates if the custom property value is a constant. Any parameter that has default value in the
GraphicInfo is optional. If no input value is specified for these parameters, the default values are used at run
time. Any parameter except the Enum data type can be a constant, reference, or expression. When you use the
Object Browser to select and automatically insert an object in the script, the script editor adds double quotes
around the object name. If you add the object name manually, be sure to enclose it in double quotes.

These parameters are specified as an array of values using the CustomPropertyValuePair[] array. The array index
starts at 1.

If an attribute name is not enclosed in double quotes while assigning it to a custom property with the
CustomPropertyValuePair[] array, the quality of the attribute will not be picked up by the custom property.

Use a script similar to the following to assign values to a symbol’s custom properties. In this example, "i1" is
string Identity and the graphic "S1" contains custom properties CP1 and CP2. When S1 is shown during run time,
CP1 is assigned a constant value of 20 and CP2 is assigned the current value of the reference Pump.PV.Tagname.
Dim graphicInfo as aaGraphic.GraphicInfo;
Dim cpValues [2] as aaGraphic.CustomPropertyValuePair;
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cpValues[1] = new
aaGraphic.CustomPropertyValuePair("CP1", 20, true);
cpValues[2] = new
aaGraphic.CustomPropertyValuePair("CP2", "Pump.PV.TagName", false);
graphicInfo.Identity = "i1";
graphicInfo.GraphicName = "S1";
graphicInfo.OwningObject = "UserDefined_001";
graphicInfo.WindowTitle = "Graphic01";
graphicInfo.Resizable = false;
graphicInfo.CustomProperties=cpValues;
ShowGraphic( graphicInfo );

Scripting Multiple Symbols
You can use the ShowGraphic script function to launch multiple windows from the same interface element, like a
pushbutton. The following examples illustrate scenarios, where you may need to use the Show Graphic function
to work with multiple symbols.

Multiple Symbols Scenario 1
You need to open several graphics using the same interface element, such as a pushbutton.

You can use the following script for the purpose:
Dim graphicInfo as aaGraphic.GraphicInfo;
graphicInfo.Identity = "i1";
graphicInfo.GraphicName = "AnalogHiLo";
graphicInfo.HasTitleBar = true;
graphicInfo.WindowTitle = "Analog Meter 1";
graphicInfo.Resizable = true;
graphicInfo.WindowLocation = aaGraphic.WindowLocation.Leftside;
graphicInfo.WindowType = aaGraphic.WindowType.Modeless;
ShowGraphic( graphicInfo );
graphicInfo.Identity = "i2";
graphicInfo.GraphicName = "AnalogHiLo";
graphicInfo.HasTitleBar = true;
graphicInfo.WindowTitle = "Analog Meter 2";
graphicInfo.Resizable = true;
graphicInfo.WindowLocation = aaGraphic.WindowLocation.Center;
graphicInfo.WindowType = aaGraphic.WindowType.Modeless;
ShowGraphic( graphicInfo );
graphicInfo.Identity = "i3";
graphicInfo.GraphicName = "AnalogHiLo";
graphicInfo.HasTitleBar = true;
graphicInfo.WindowTitle = "Analog Meter 3";
graphicInfo.Resizable = true;
graphicInfo.WindowLocation = aaGraphic.WindowLocation.Rightside;
graphicInfo.WindowType = aaGraphic.WindowType.Modal;
ShowGraphic( graphicInfo );

If you want to open multiple pop-up windows, only the last pop-up window can be modal. All other pop-up
windows can be modeless. If any other pop-up window is modal, then the script will be blocked after the first
modal pop-up window is opened. For more information, see Working with Modal Windows.

At run time, click the ShowGraphicMultipleSymbols pushbutton to open all the symbols:
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Multiple Symbols Scenario 2
You want to open several graphics using the same interface element, such as a pushbutton. You also want to
select the graphic position and the graphic name using interface elements, like combo boxes. You can configure a
combo box on the Edit Animations page. The combo box values can be used as index values for the window
location parameter. At run time, you can dynamically select the values for the window location using this combo
box.

You can use the following script for the purpose:
dim popup as aaGraphic.GraphicInfo;
dim MyInt as Integer;
popup.GraphicName = SelectedSymbol.Value;
IF SelectedPosition.Value == 2 THEN
   popup.Identity = "Top Left";
   popup.WindowTitle = "Top Left Corner";
ENDIF;
IF SelectedPosition.Value == 4 THEN
   popup.Identity = "TopRight";
   popup.WindowTitle = "Top Right Corner";
ENDIF;
IF SelectedPosition.Value == 9 THEN
   popup.Identity = "BottomLeft";
    popup.WindowTitle = "Bottom Left Corner";
ENDIF;
IF SelectedPosition.Value == 11 THEN
   popup.Identity "BottomRight";
   popup.WindowTitle = "Bottom Right Corner";
ENDIF;
popup.RelativeTo = aaGraphic.RelativeTo.CustomizedWidthHeight;
popup.width = 300;
popup.height = 300;
MyInt = StringToIntg( SelectedPosition.Value );
popup.WindowLocation = MyInt;
ShowGraphic( popup );
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In the script, popup.WindowLocation = MyInt substitutes the explicit reference with the integer index.
SelectedSymbol is the combo box for dynamically selecting the graphic at run time and SelectedPosition is the
combo box for dynamically selecting the window location.

At run time, click the ShowGraphic pushbutton to open all the symbols. You can select the graphic in the Select a
graphic list. You can also select the location of the graphic in the Select a position list.

Multiple Graphics Scenario 3
You want the Graphics in relative position with the graphic.

You can use the following script for the purpose:
Dim graphicInfo as aaGraphic.GraphicInfo;
graphicInfo.Identity = "i1";
graphicInfo.GraphicName = "S1";
graphicInfo.RelativeTo= aaGraphic.RelativeTo.Graphic;
ShowGraphic(graphicInfo);

Multiple Graphics Scenario 4
You want the graphic in relative position with the window.

You can use the following script for the purpose:
Dim graphicInfo as aaGraphic.GraphicInfo;
graphicInfo.Identity = "i1";
graphicInfo.GraphicName = "S1";
graphicInfo.RelativeTo= aaGraphic.RelativeTo.Window;
ShowGraphic(graphicInfo);
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Using Client Controls

About Client Controls
Provided your HMI/SCADA software supports specific client controls, you can perform the following functions:

• Import and embed client controls into a graphic.•

• View and edit the properties of the client control.•

• Bind the properties of the client control with attributes and element references.•

• Configure scripts for client control.•

• Animate client controls.•

• Export a client control.•

• Configure a client control with security.•

• Verify that dynamically loaded assemblies are included with the primary client control assembly when an•
application is deployed

• View additional client control information such as the files the client control uses and what objects and•
graphics are using the client control.

For information on language switching for client controls, see Switching Languages for Graphic Elements.

Client controls give you functionality contained in .NET controls you can use in graphics. To use this functionality:

• Import the .DLL file that contains one or more client controls. The client control is imported into the Graphic•
Toolbox.

• Browse and embed one or more of the client controls into a new or existing graphic. The client controls•
appear as elements.

• View and edit the exposed client control properties.•

• Bind the client control properties to attributes, graphic custom properties or tags. Do this using data binding•
animation.

• Configure scripts for client control. Do this using the animation.•

You can then use the graphic containing the embedded client control in your HMI/SCADA software.
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Organizing Client Controls
You can organize the client controls within the Graphic Toolbox the same way as you would with Industrial
Graphics. You can:

• Rename client controls.•

• Move client controls in and out of Graphic Toolsets.•

• Delete client controls.•

For more information, see Organizing Graphics and Importing and Exporting Graphics.

Embedding Client Controls
You can embed an installed client control into a graphic as you would embed a graphic within another graphic.

We recommend that you not overlap client controls with other elements on the canvas. Otherwise, the client
controls may not work correctly.

To embed a client control into an Industrial graphic
1. On the Edit menu, click Embed Graphic Symbol. Your HMI's attribute/tag browser appears.1.

2. Browse to the location that contains the client control.2.

3. Select a client control from the right panel and click OK. The pointer changes to paste mode.3.

4. Click on the canvas where you want to embed the client control. The client control is placed onto the canvas.4.

Viewing and Changing the Properties of Client Controls
When you embed a client control into a graphic, the native properties of the client control are imported into the
Properties Editor in the Misc group.

Also the element container of the client control has properties such as:

• Name•

• X, Y, Width, Height, AbsoluteOrigin, RelativeOrigin, and Locked•

• FillColor•

• TextColor and Font•

• Enabled, TabOrder, TabStop, and Visible•

The element container properties override the native properties of the client control.

You can view and change the properties of the control in the Properties Editor.

To view or change the properties of a client control
1. Select the embedded client control on the canvas.1.

2. In the Properties Editor, locate a:2.

• Container property in the property categories Graphic, Appearance, Fill Style, Text Style or Runtime•
Behavior.
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• Native property in the Misc property category.•

3. View or change the located property.3.

To reset a client control back to its original size
• On the Edit menu, click Control - Original Size. The AutoSize property is set to False.•

Binding Client Control Properties to Attributes or Element
References

You can bind the properties of an embedded client control to attributes or element references. This lets you use
attributes and element references as source and consumer of data for the client control properties. You do this
with the Data Binding animation.

The Data Binding table contains the following information:

• Name - name of the client control property•

• Type - the .NET data type of the property•

• Value - the default value of the client control property•

• Direction - indicates if the property is read/write or just read-only•

read/write property

read-only property

write-only property
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• Reference - the attribute or element reference the property is bound to•

You cannot remove the Data Binding animation.

To bind a client control property with an attribute or element reference
1. Double-click the embedded client control on the canvas. The Edit Animations dialog box appears and the1.

Data Binding animation is selected by default.

2. Locate the client control property that you want to bind with an attribute or element reference.2.

3. Double-click the Reference box.3.

4. Do one of the following:4.

• Type an attribute or element reference.•

• Browse for an attribute or element reference by clicking the Browse button.•

5. Repeat above for any other properties you want to bind.5.

6. Click OK.6.

Configuring Client Control Event Scripts
You can configure a script that is executed when a client control event occurs. You do this using the Event
animation.

To configure a script for a client control event
1. Double-click the embedded client control on the canvas. The Edit Animations dialog box appears.1.

2. In the animation list, click Event. The right panel shows the configuration.2.

3. In the Event list, select the event for which you want to execute a script. The Parameters list shows for the3.
selected event:

• Type: the data type of each parameter.•

• Name: the name of each parameter.•

4. In the script area, write the event script.4.

5. If you want to insert an event parameter in your script, click the Select Event Parameter icon. Select the5.
parameter. The parameter name is inserted into the script at the cursor position.

6. If you want to configure scripts for other, select the event from the Event list. The script area is cleared and6.
you can write the script for the newly selected event.

7. When you are done, save and close.7.

Animating Client Controls
Every client control has these animation types:

• Data binding animations determine which attributes and element references can read and write to the client•
control.

• Event animations assign scripts to individual client control.•
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You can add the following animations that correspond to the supported client control container properties.

• Visibility•

• Fill Style•

• Text Style•

• Location Horizontal•

• Location Vertical•

• Width•

• Height•

• Tooltip•

• Disable•

If you configure these animations, the resulting behavior and appearance overrides the behavior and appearance
given by the native properties of the client control.

To add animation to embedded client controls
1. Double-click the embedded client control on the canvas. The Edit Animations dialog box appears.1.

2. Add animations as you would with any other element.2.

Including Dynamically Loaded Assemblies with the Client Control
When the primary client control assembly is imported into the HMI/SCADA project or application during an
application’s deployment, the system identifies all statically-linked dependent assemblies and imports them into
the HMI/SCADA application as well. However, if the client control contains dynamically loaded assemblies, these
assemblies are not automatically loaded in the HMI/SCADA application or project.

There are two methods for ensuring that the client control’s dynamically loaded assemblies are included in the
galaxy when the primary assembly is imported:

• By including the list of dynamically loaded assemblies in an XML manifest resource that is embedded in the•
primary assembly. The advantage of this method is that the required configuration information is packaged
with the assembly, so no any other packing mechanism is required.

• By including the list of dynamically loaded assemblies in an external XML configuration file that is stored in•
the same directory as the primary assembly.

Both methods can be used simultaneously to provide redundancy, in the event that one of the dynamically
loaded assembly lists is missing a required assembly.

Requirements for Both Inclusion Methods
• Store all dynamically loaded assemblies, as well as all non-system static dependencies of these dynamically•

loaded assemblies, in the same directory as the primary assembly.

• If a dynamically loaded assembly is loading another assembly dynamically, then include the other assembly•
as a dynamically loaded assembly of the primary assembly. This is a requirement because the system will not
search recursively for static or dynamic dependencies.
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Sample XML for a Dynamically Loaded Assembly List
A sample list of dynamically loaded assemblies in XML format is shown below. The XML list format is the same
for an embedded manifest resource or an external configuration file.
<?xml version="1.0" encoding="utf-8"?>
<Root>
<DependentFiles>
<DependentFile>
<FileName>DynDepAsm1.dll</FileName>
</DependentFile>
<DependentFile>
<FileName>DynDepAsm2.dll</FileName>
</DependentFile>
<DependentFile>
<FileName>DynDepAsm3.dll</FileName>
</DependentFile>
</DependentFiles>
</Root>

XML Schema for the Dynamically Loaded Assembly List
The following XML schema is applicable for the dynamically loaded assembly XML list whether the list is provided
as an embedded manifest resource or an external configuration file.
<?xml version="1.0" encoding="utf-8"?>
<xs:schema attributeFormDefault="unqualified" elementFormDefault="qualified" 
xmlns:xs="http://www.w3.org/2001/XMLSchema">

<xs:element name="Root">
<xs:complexType>

<xs:sequence>
<xs:element minOccurs="1" maxOccurs="1" name="DependentFiles">

<xs:complexType>
<xs:sequence>

<xs:element minOccurs="1" maxOccurs="unbounded" name="DependentFile">
<xs:complexType>
<xs:sequence>
<xs:element minOccurs="1" maxOccurs="1" name="FileName" type="xs:string"/>
</xs:sequence>
</xs:complexType>
</xs:element>

</xs:sequence>
</xs:complexType>

</xs:element>
</xs:sequence>

</xs:complexType>
</xs:element>

</xs:schema>

Embedding the XML Manifest Resource in the Primary Assembly
To embed the XML manifest resource in the primary assembly
1. In Visual Studio, add the XML list file to the client control assembly project. Any file name can be used, with1.

the extension .aaCFG.

2. Change the Build Action property value to Embedded Resource.2.

After compilation, the XML will be available in the assembly as an embedded manifest resource file.
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During the client control import operation, the system will read any embedded XML manifest resources with the
extension .aaCFG. The system will then import any listed assemblies that are stored in the same location as the
primary assembly.

Including the XML Manifest Resource in an External Configuration File
To include the XML manifest resource in an external configuration file
1. Create the XML list file using the same root name as the primary assembly but with the extension .aaCFG.1.

For example, if the primary assembly name is MyControl.dll, then the configuration file name would be
MyControl.aaCFG.

2. Store the file in the same directory as the primary assembly.2.

During the client control import operation, the system will look for a file that has the same root name as the
primary assembly but with the extension .aaCFG and in the directory in which the primary assembly is stored. If
this file is found and an embedded XML manifest resource exists, the system will consolidate the two lists to
eliminate duplicate entries. The system will then import any listed assemblies that are stored in the same
location as the primary assembly.

Preventing Dynamically Loaded Assembly Import Issues
Refer to the following guidelines to prevent issues with importing the dynamically loaded assemblies.

• Verify that the XML is valid. Invalid XML in the embedded manifest resource or the configuration file will•
result in the entire client control import operation for the selected primary assembly to be canceled.

• Include all assemblies on which the dynamically loaded assemblies are directly or indirectly dependent, in•
the same directory as the primary assembly and included in the XML list. If the system is unable to locate
and load any of the direct or indirect dependencies, the entire client control import operation for the
selected primary assembly will fail.

• If a dynamically loaded assembly is going to load another assembly dynamically, check that the other•
assembly is included in the XML list. If any such assemblies are not included in the primary assembly’s
manifest resource or configuration file, the import operation will succeed. However, these indirectly loaded
assemblies will not be imported, which can result in the client control not behaving correctly during
execution.
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Working with Symbol Wizards

Introduction
The Industrial Graphic Editor includes the Symbol Wizard Editor, which can be used to create reusable
configurable graphics called Symbol Wizards. For example, a single pump symbol can be created with the Symbol
Wizard Editor that includes different visual pump configurations based on the orientation of inlet and outlet
pipes. Another example of a Symbol Wizard is the Situational Awareness Library pump graphic. Situational
Awareness Library graphics are designed using the Symbol Wizard Editor. However, they are protected graphics
and their design cannot be changed. But, you can select Wizard Options from the Symbol Wizard Editor to select
the configurations that are incorporated into each graphic’s design.

 

Incorporating multiple configurations in a single graphic reduces the number of graphics needed to develop an
application.

Understanding the Symbol Wizard Editor
After enabling the Symbol Wizard Editor, the Industrial Graphic Editor window updates to show Symbol Wizard
Editor panes at the left of the window.
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• Beneath the Tools pane, separate tabbed panes show the graphic elements, custom properties, and named•
scripts that belong to a graphic.

• The tabbed Options pane shows a hierarchical list of Choice Groups, Choices, and Options that define•
graphic configurations.

The Options pane includes buttons to add, delete, and reorder Choice Groups, Choices, and Options.

• The tabbed Layers view includes a list of defined graphic layers. Beneath each layer, separate folders contain•
the graphic’s elements, custom properties, and named scripts associated with the layer. A graphic's
elements, custom properties, and named scripts are assigned to graphic layers by dragging them to
corresponding folders in the Layers view.

Understanding Choice Groups and Choices
The Symbol Wizard Editor Options pane includes buttons to create Choice Groups, Choices, and Options.

• A Choice Group represents a unique property of a graphic and appears as the top level property node in the•
Options view.

• A Choice represents a possible value or attribute of a Choice Group property. Choices are indented beneath•
the associated Choice Group node in the Options view. Choices are mutually exclusive and only one choice
can be selected from a Choice Group for a single configuration of a graphic.

An item shown in the Options view list can be moved by selecting it, and then clicking the Up or Down
arrow. If no Choice is specified as the default value for a Choice Group, the first Choice added to the Choice
Group is always the default value.

In the example of a centrifugal pump graphic, one possible Choice Group is Orientation for the different
configurations of inlet and outlet pipes. The Left, Right, Bottom, and Top choices appear as the associated Choice
attributes of the Orientation Choice Group.

Understanding Symbol Wizard Layers
Symbol Wizard layers associate graphic elements, custom properties, and named scripts to a unique graphic
configuration defined by a rule. When the rule is True, the layer’s graphic elements, custom properties, and
named scripts are part of the Symbol Wizard’s configuration.
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In the example of a centrifugal pump graphic, a rule determines the orientation of the pump’s inlet and outlet
pipes. When the rule for the Right configuration is True, the Right layer containing the inlet and outlet pipes is
part of the graphic’s configuration.

The blade housing does not belong to a layer because it is common to all pump graphic configurations. Graphic
elements of a graphic that don't belong to a layer appear in all graphic configurations. As a result, the pump’s
blade housing appears in the Left, Right, Top, and Bottom configurations of the pump by default.

Likewise, adding graphic elements, custom properties, and named scripts to a layer without a rule results in
these elements appearing in all graphic configurations. Each layer has a defined rule that specifies a True
condition when the set of graphic elements, custom properties, and named scripts are part of a graphic
configuration.

Associating graphic elements, named scripts, and custom properties to graphic layers involves working with the
Symbol Wizard Editor Layers pane shown to the left of the graphic canvas.

Defining Graphic Configuration Rules
A rule defines an expression that determines if a given choice or option and its associated graphic layer is visible
or hidden based on the evaluation of the rule to true or false.

Rules can consist of a single expression or compound expressions using Boolean keywords or operator
characters:

Boolean Keywords AND, OR, NOT

Operator Characters • Period (.)•

A period concatenates a Choice Group to a Choice in a hierarchical
expression.

• Pipe (|)•

A pipe evaluates to a Boolean OR.

• Ampersand (&)•

An ampersand evaluates to a Boolean AND.

• Exclamation point (!)•

An exclamation point evaluates to a Boolean NOT.
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• Parentheses ( )•

A compound expression enclosed within parentheses is evaluated before
other expressions in a rule

Any other unlisted keywords or operator characters in a rule are treated as part of the references.

• Include blank spaces around the Boolean keyword within the Compound expressions.•

ConditionA OR ConditionB

• Compound expressions that include an operator character that evaluates to a Boolean condition don't•
require blank spaces.

ConditionA|ConditionB

• Reference the property attribute by its hierarchal Choice Group name.•

ChoiceGroup.Choice

• Rules cannot reference a Choice Group alone. Rule expressions references Choices within a Choice Group.•

ChoiceGroup.Choice.

• When an Option is renamed, the name change is updated in all referenced rule expressions.•

• An Option or a Choice can be deleted only if no graphics are associated with their default layers.•

Examples of Graphic Configuration Rules
The following examples explain how rules specify the layers that belong to a Symbol Wizard configuration.

• Orientation.Left&HasTach.True•

When this rule is True, the Symbol Wizard’s configuration includes a layer containing a pair of pipes with the
inlet pipe oriented to the left and a tachometer.

• Orientation.Left AND HasTach.True•

This rule is the same as the preceding rule except that a Boolean keyword is used rather than an operator
character. There are blank spaces before and after the Boolean keyword in the rule.

• Orientation.Right&HasTach.False•

When this rule is True, the Symbol Wizard’s configuration includes a layer containing a pair of pipes with the
inlet pipe oriented to the right and a layer that does not include a tachometer.

• (Orientation.Top&HasTach.True)|(Orientation.Bottom&HasTach.True)•

When this rule is True, the Symbol Wizard’s configuration includes two layers containing pipes with inlet pipe
oriented at the top or the bottom. Both pipe layers include a tachometer. The selected option of the
Orientation Wizard Option determines which pipe layer appears in the configuration.

For more practical examples of creating rules, see Symbol Wizard Tips and Examples.

Designing a Symbol Wizard
The process of creating and implementing a Symbol Wizard has two workflows:
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• The first workflow, referred to as a designer workflow, uses the Symbol Wizard Editor to create Symbol•
Wizards containing multiple configurations.

• The second workflow, referred to as a consumer workflow, embeds a Symbol Wizard and then configures it•
for use in an application.

Creating Graphic Choice Groups, Choices, and Options
The following list summarizes the tasks that need to be completed in a designer workflow to create a Symbol
Wizard containing multiple configurations.

• Define a graphic’s Choice Groups, their Choices, and Options•

• Assign rules to Choice Groups, Choices, and Options•

• Associate graphic elements, custom properties, and named scripts to graphic layers•

• Verify each graphic configuration with Symbol Wizard Preview•

After planning the possible configurations for a graphic, Designers will know the properties and the possible
attributes associated with each configuration. Designers create Choice Groups, Choices, and Options to define a
graphic’s properties and attributes.

Situational Awareness Library symbols have predefined Choice Groups, Choices, and Options.

To create graphic choice groups, choices, and options
1. In the IDE, create a copy of a graphic in the Industrial Graphic Editor for which you want to create multiple1.

configurations.

You can also build an entirely unique symbol from scratch and create multiple configurations of it with
Symbol Wizard.

2. Check out and open the copied graphic in the Industrial Graphic Editor’s canvas drawing area.2.

3. Click the Symbol Wizard icon shown on the Industrial Graphic Editor menu bar.3.

You can also show Symbol Wizard by pressing Alt+W or selecting it as an option from the View menu.

The Industrial Graphic Editor updates to show the Symbol Wizard Editor’s tabbed panes at the left of the
window.

4. Click the Options tab.4.

5. Click Add Choice Group to create a Choice Group.5.

A Choice Group folder appears in the Options window.

6. Rename the Choice Group to assign an easily identifiable name of a property used in a graphic configuration.6.

Creating a Choice Group automatically sets it to rename mode. You can also manually rename a Choice
Group by right-clicking the Choice Group and selecting Rename from the menu.

7. Repeat steps 5-6 to create as many Choice Groups as needed to define all properties of a graphics that7.
determine its configurations.

8. Select a Choice Group folder and click Add Choice to add a choice beneath the select Choice Group.8.

9. Rename the Choice to assign an easily identifiable name of a property attribute used in a graphic9.
configuration.
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10. Repeat steps 8-9 to assign all possible Choice attributes to the Choice Groups.10.

11. Click Add Option to add an Option, which appears in the window at the same hierarchical level as Choice11.
Groups.

12. Right-click the Option and select Rename to assign a name.12.

13. Repeat steps 11-12 to create as many Options needed to define a graphic’s configurations.13.

Assigning Graphic Configuration Rules
In a designer workflow, you can specify rules for a graphic's defined Choices and Options. We recommend that
the Choice Groups not be included in graphic configuration rules.

These rules determine the graphic elements, custom properties, and scripts that belong to a graphic
configuration. For more information about rule syntax, see Defining Graphic Configuration Rules.

To define graphic configuration rules
1. Show the selected graphic in the Industrial Graphic Editor with the Symbol Wizard enabled.1.

2. Select a Choice from the Options view.2.

The Properties view updates to show Option Properties fields. The Name field shows the name of the
Choice you selected from the Options view. The Rule field is blank.

3. If necessary, enter a rule for the Choice.3.

Not all Choices require rules. Specify only those rules necessary to create graphic configurations. Choices
without rules are always visible.

4. Repeat steps 2-3 to specify rules for the remaining Choices of the graphic.4.

5. Select an Option from the Options view.5.

The Name field of the Option Properties view updates to show the name of the Option you selected from
the Options view.

6. Enter a rule for the Option that defines the conditions to show or hide the Choice Groups and Choices in a6.
configuration.

7. Enter True or False in the Default Value field to set the Option as part of the graphic’s default configuration7.
or not.

8. In the Description field, enter a description of the Option.8.

The description appears when the Consumer embeds the graphic and clicks the option to configure it.

9. Repeat steps 5-8 to specify rules and optional default values for the remaining Options of the graphic.9.

Updating Graphic Layers
A Symbol Wizard automatically creates a set of default layers that match the hierarchical set of Choices and
Options defined for a graphic. Each Choice layer has an assigned default rule containing the expression
ChoiceGroup.Choice that defines an attribute of a graphic’s property.

The default rule for an Option layer is simply the name of the Option itself. Renaming an Option automatically
renames any layer rules that reference the Option.
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In a designer workflow, you can update layers by adding layers to or deleting layers from the set of default layers.
Also, layers can be renamed and the default rule assigned to a layer can be changed.

Updating graphic layers may not be necessary if the default set of layers created for Choices and Options can
create all graphic configurations.

If a graphic layer is renamed, it loses the link to the Option. When the Option name is updated, the layer name
will not get updated with changed Option name.

To add or delete a graphic layer
1. Show the selected graphic in the Industrial Graphic Editor with the Symbol Wizard selected.1.

2. Click the Layers tab to show the list of layers.2.

3. To add a layer, do the following:3.

a. Click the Add Layer icon above the Layers list.a.

You can also add a layer by right-clicking within the layers listand selecting Add.

The new layer appears at the bottom of the list with an assigned default name.

b. Click the new layer to select it.b.

c. Rename the new layer.c.

Creating a layer automatically sets it to rename mode. You can also rename a layer by right-clicking the
layer and selecting Rename from the menu.

4. To delete a layer, do the following:4.

a. Click the layer within the list to be deleted.a.

b. Delete the layer by clicking the Delete Layer icon above the Layers list or right clicking the layer andb.
selecting Delete.

To update a layer rule
1. Show the selected graphic in the Industrial Graphic Editor with the Symbol Wizard selected.1.

2. Click the Layers tab to show the list of layers.2.

3. Select the layer whose rule needs to be updated.3.

The Layer Properties view appears and shows the rule assigned to the selected layer Choice or Option.

4. Click within the Rule field to select it.4.

5. Update the rule.5.

6. Click Save to save the changes to the layer rule.6.

Associating Configuration Elements to Graphic Layers
The basic workflow to associate graphic elements, custom properties, or named scripts to a graphic layer consists
of these general steps:
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1. Select a graphic layer from the Layers view.1.

2. Select items from the tabbed Elements, Named Scripts, and Custom Properties views to associate with the2.
selected layer.

Multiple graphic elements, custom properties, or named scripts can be selected using the Shift key to select
a range of listed items or the Ctrl key to select individual items from a list.

3. Drag and drop the selected graphic elements, custom properties, or scripts into the Layers view.3.

Configuration elements can be associated with a graphic layer by two methods:

• Active layer method: Select the check box to the left of the layer name. Then, drag and drop the•
configuration element anywhere within the Layers view. The configuration element is automatically
associated to the correct folder of the active layer.

• Direct folder method: Select a layer and expand it to show the folders for the different types of configuration•
elements. Then, drag and drop the configuration element directly on the folder that matches the type of
configuration element.

Associating Graphic Elements to Graphic Layers
Graphic elements show the visual properties of a graphic. In a designer workflow, associate graphic elements to
the defined layers of a graphic.

To associate graphic elements to graphic layers
1. Show the symbol with the Symbol Wizard Editor selected.1.

2. Click the Elements tab to show the graphic elements that belong to the graphic.2.

3. Click the Layers tab.3.

4. Activate a layer from the Layers view by selecting the check box next to the layer.4.

If you prefer to add graphic elements directly to a layer’s Graphic Elements folder with the direct folder
method, simply click the layer name from the list to select it.

5. Click the box to the left of the check box to expand the layer view and show the Graphic Elements folder.5.

6. In the Elements view, click the graphic element to associate with the active graphic layer.6.

You can also select the symbol element group by clicking it on the displayed graphic.

7. Drag the graphic element from the Elements view and drop it anywhere within the Layers view.7.

If you are using the direct folder method, drop the graphic element directly on the selected layer’s Graphic
Elements folder.

The selected element appears beneath the active layer’s Graphic Elements folder.

8. Repeat steps 6-7 to select all element groups that belong to the graphic layer.8.

You can also select multiple graphic elements from the Elements view and drop them as a set.

9. Repeat steps 4-8 to select all elements for the different layers of a graphic.9.

The Show/Hide icon appears to the left of the Graphic Elements folder in the Layers view. Clicking the icon
shows or hides the graphic elements in a layer’s Graphic Elements folder on the graphic itself.
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10. Click the Show/Hide icon to verify the graphic elements associated to a layer are correct for the graphic10.
configuration.

11. Save your changes to the graphic.11.

Using Shortcut Menu Commands to Edit Graphic Layer Graphic Elements
The Symbol Wizard Editor provides a set of shortcut menu commands to add graphic elements to graphic layers
or remove them from layers. Using shortcut commands makes it easier to add or remove graphic elements when
a complex Symbol Wizard contains many graphic elements and layers.

Adding Graphic Elements to Active Symbol Layers

Adding graphic elements to an active layer involves selecting an active layer, selecting one or more graphic
elements, and then using the Add To Active Layers shortcut command.

All graphic elements to be created for all Symbol Wizard configurations before adding them to graphic layers.

To add graphic elements to graphic layers
1. Show the graphic with the Symbol Wizard Editor selected.1.

2. From the Layers pane, select the check box next to the graphic layer to make it active.2.

If you want to add a graphic element to multiple layers, select the check box next to each layer.

3. Select the graphic element to be added from the displayed Symbol Wizard.3.

The graphic element can also be selected from the Elements pane.

4. Show the Symbol Wizard shortcut commands by right-clicking the selected graphic element on the graphic or4.
right-clicking the graphic element name from the Elements pane.

5. Click Add to Active Layers.5.

6. Verify the graphic element has been added to the active layers.6.

Removing Graphic Elements from Graphic Layers
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Removing graphic elements from graphic layers follows a similar sequence of steps as adding graphic elements to
layers. The Symbol Wizard shortcut menu includes separate commands to remove graphic elements from all
layers or only from a selected layer.

To remove graphic elements from graphic layers
1. Show the graphic with the Symbol Wizard Editor selected.1.

2. From the Layers pane, select the check box next to the graphic layer that contains the graphic element to be2.
removed.

Selecting a layer is not necessary if you will remove the graphic element from all layers. Also, if a layer is not
selected, the Remove From Layer command lists the layers that include the selected graphic element.

3. Select the graphic element to remove from the displayed Symbol Wizard.3.

The graphic element can also be selected from the Elements pane.

4. Show the Symbol Wizard shortcut commands by right-clicking the selected graphic element on the graphic or4.
right-clicking the graphic element name in the Elements pane.

5. Click the option you want: Remove From All Layers or Remove From Layer.5.

If a layer has not been selected, the Remove From Layer command lists the layers that include the selected
graphic element. Click the layer to remove the graphic element from.

6. Verify the graphic element has been removed from the selected layers.6.

Associating Custom Properties to Graphic Layers
Associating custom properties to a graphic layer uses a procedure similar to associating graphic elements.
Selected custom properties are dragged and dropped on the Custom Properties folder to associate them to a
graphic layer. You can associate custom properties to layers with the active layer or directory folder methods.

To associate custom properties to graphic layers
1. Open the selected graphic in the Industrial Graphic Editor with the Symbol Wizard selected.1.

2. Click the Custom Properties grid to show the locally defined custom properties of the graphic.2.

Custom properties of embedded graphics are not listed.

3. Click the Layers tab.3.

4. Select the check box next to the layer that you want to associate a custom property with.4.

5. Click the box to the left of the check box to expand the layer view and show the Custom Properties folder.5.

6. Click a custom property in the Custom Properties view that belongs to the selected graphic layer.6.

7. Drag the custom property from the Custom Properties view and drop it on the Custom Properties folder.7.

The selected custom property appears beneath the Custom Properties folder.

8. Repeat steps 6-7 to select all custom properties that belong to the graphic layer.8.

9. Repeat steps 4-7 to select the remaining custom properties for the different layers of a graphic.9.
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10. Save your changes to the graphic.10.

Associating Named Scripts to Graphic Layers
Associating named scripts to a graphic layer uses a similar procedure to associate graphic elements or custom
properties. You can associate named scripts to layers with the active layer or directory folder methods.

To associate named scripts to graphic layers
1. Show the selected graphic in the Industrial Graphic Editor with the Symbol Wizard selected.1.

2. Click the Named Scripts tab to show the scripts associated with the graphic.2.

3. Click the Layers tab.3.

4. Select a layer from the Layers view by selecting the check box next to the layer.4.

5. Click the box to the left of the check box to expand the layer view and show the Named Scripts folder.5.

6. Click a script in the Named Scripts view that belongs to the selected graphic layer.6.

7. Drag the script from the Named Scripts view and drop it on the Named Scripts folder7.

The selected script appears beneath the Named Scripts folder.

8. Repeat steps 6-7 to select all scripts that belong to the graphic layer.8.

9. Repeat steps 4-7 to select the remaining scripts for the different layers of a graphic.9.

10. Save your changes to the graphic.10.

Verifying Graphic Configurations
After creating the different configurations of a graphic, you can use the Symbol Wizard Preview to verify each
configuration works as designed. Also, you can validate the graphic to identify any invalid references to other
objects or values.

To verify graphic configurations
1. Open the graphic created with Symbol Wizard in the Industrial Graphic Editor.1.

2. Click Symbol Wizard Preview shown on the menu bar of the Industrial Graphic Editor.2.

You can also open the Symbol Wizard Preview as a View menu option or by pressing Alt+P.

The Industrial Graphic Editor shows the Wizard Options view with a set of drop-down lists to select different
graphic property attributes and options. Select the default graphic configuration.
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3. Select the different combinations of property values and view options from Wizard Options fields.3.

4. Verify the graphic that appears is correct for the selected combination of values.4.

5. Click the Validation icon to see if the graphic contains any invalid references.5.

The Validation view lists any invalid references within the graphic that need to be corrected.

Invalid references also include references to properties or elements in hidden graphic layers.

Using Symbol Wizards in an Application
Symbol Wizards are stored in a library just like standard Industrial Graphics. When you select a graphic and
embed it into an HMI/SCADA application, the graphic’s default configuration is selected.

In a consumer workflow, you can change a Symbol Wizard’s configuration by changing the values assigned to the
graphic’s properties from the Symbol Wizard’s Wizard Options section of the Properties view. After selecting a
graphic configuration and changing any properties, save the graphic.

The Symbol Wizard appears as the configuration you have selected . A Symbol Wizard’s configuration cannot be
changed during application run time.

Embedding Symbol Wizards
In a consumer workflow, you embed Symbol Wizards from the Industrial Graphic Editor. Embedding a Symbol
Wizard is similar to embedding a standard Industrial Graphic.
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A Symbol Wizard appears with its default configuration when it is embedded. The Consumer can select another
configuration by changing the configuration values shown in the Wizard Options section of the Properties view.

To embed a graphic
1. Create a new graphic or add a graphic to your HMI application.1.

2. Open the symbol to show the Industrial Graphic Editor.2.

3. On the Edit menu, click Embed Graphic.3.

You can also click the Embed Graphic icon from the menu bar.

Your HMI's attribute/tag browser appears.

4. Locate the folder containing the Symbol Wizard.4.

5. Click the graphic to select it and click OK.5.

6. Position the pointer at the location where the Symbol Wizard needs to be placed.6.

7. Click once to embed the Symbol Wizard.7.

An embedded Symbol Wizard appears with handles on the Industrial Graphic Editor canvas to show that it is
selected.

8. Select the graphic’s configuration by selecting values for the various options shown in the Wizard Options8.
view.

9. Rename the graphic.9.
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10. Right-click on the graphic and select Custom Properties from the menu.10.

The Edit Custom Properties dialog box appears with the set of custom properties defined for the Symbol
Wizard.

11. Configure the custom properties with the required references for the application.11.

12. Press [F10] to show the Edit Scripts dialog box.12.

13. Verify if any changes need to be made to the graphic’s named scripts to run within the application.13.

14. Save the changes made to the graphic.14.

Symbol Wizard Tips and Examples
This section describes a practical example of creating a Symbol Wizard. The example explains how to modify a
centrifugal pump graphic to create a Symbol Wizard with Wizard Options that represent different orientations of
inlet and outlet pumps for a tank farm application. The Symbol Wizard also includes a Wizard Option to show or
hide a pump tachometer.

Creating Visual Configurations of an Industrial Graphic
Complete the following tasks to create a Symbol Wizard:

• Plan the different configurations of a graphic and select a default configuration that represents the base•
Symbol Wizard.

• Identify the graphic elements needed to create each graphic configuration.•

• Add graphic elements, named scripts, and custom properties for each configuration.•

• Create graphic layers to group graphic elements, named scripts, and custom properties•

• Specify rules to select the layers needed to create each Symbol Wizard configuration•

Planning Symbol Wizard Configurations
The first step in creating a Symbol Wizard is to identify the different configurations that have to be included in a
symbol. In the example of a centrifugal pump, a Symbol Wizard represents a pump that has the inlet pipe at the
left, right, top, or bottom of the pump’s central housing. Also, the Symbol Wizard needs to be able to show or
hide a tachometer for each orientation of the centrifugal pump.
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After identifying all of the different configurations of a Symbol Wizard, identify the unique properties of each
configuration. The example of a centrifugal pump includes two properties: inlet pipe orientation and whether a
tachometer is shown with a pump or not.

The next step is to identify the properties and associated attributes for each configuration of the symbol.

Symbol Configuration Configuration Properties and Attributes

Orientation=Left

HasTach=False

Orientation=Left

HasTach=True

Orientation=Right

HasTach=False

Orientation=Right

HasTach=True

Orientation=Top

HasTach=False

Orientation=Top

HasTach=True
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Symbol Configuration Configuration Properties and Attributes

Orientation=Bottom

HasTach=False

Orientation=Bottom

HasTach=True

Using the Symbol Wizard Editor, create the Choice Groups and Choices needed to represent all properties and
attributes of a Symbol Wizard.

In the example of a centrifugal pump, the Choice Groups are Orientation and HasTach. The Orientation Choice
Group includes Left, Right, Top, and Bottom Choices, which are the possible attributes of a pump’s inlet pipe. The
HasTach Choice Group includes Boolean True or False Choices that indicate whether a configuration includes a
tachometer or not.

Initially, the top listed Choice is the default for a Choice Group. To assign another listed Choice as the default
value for the Choice Group, assign the Choice in the Default Value field of the Option Properties pane.

If the desired base configuration of a centrifugal pump has the inlet pipe to the right and includes a tachometer,
then Right is assigned as the default Orientation Choice and True is assigned as the default HasTach Choice.

Planning Tips

• Always decide the different configurations to be incorporated into a Symbol Wizard as the first step.•

• Identify those properties that define a symbol’s configurations. These properties will be specified as the•
Choice Groups when building configurations with the Symbol Wizard Editor.
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Identify all attributes of each property that define a symbol's configurations. These attributes will be the child
Choices of the parent Choice Groups.

Select a default Symbol Wizard configuration at the planning stage to identify the symbol elements, named
scripts, and custom properties that you want to include in the base configuration.

Identify Graphic Elements
Graphic elements are the graphics, named scripts, custom properties, and animations included with each
configuration of a Symbol Wizard. The first step is to identify the graphic elements that need to be created for
each Symbol Wizard configuration.

The following table shows the graphic elements needed to create a Symbol Wizard of a centrifugal
pump.

Graphic
Configuration

Configuration Properties
and Attributes Required Graphic Elements

Orientation=Left

HasTach=False

Graphic elements:

• InletLeft•

• OutletRight•

Orientation=Left

HasTach=True

Graphic elements:

• InletLeft•

• OutletRight•

• MeterLeft•

Orientation=Right

HasTach=False

Graphic elements:

• InletRight•

• OutleftLeft•

Orientation=Right

HasTach=True

Graphic elements:

• InletRight•

• OutleftLeft•

• MeterRight•

Orientation=Top

HasTach=False

Graphic elements:

• InletTop•

• OutletBottom•
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Graphic
Configuration

Configuration Properties
and Attributes Required Graphic Elements

Orientation=Top

HasTach=True

Graphic elements:

• InletTop•

• OutletBottom•

• MeterTop•

Orientation=Bottom

HasTach=False

Graphic elements:

• InletBottom•

• OutletTop•

Orientation=Bottom

HasTach=True

Graphic elements:

• InletBottom•

• OutletTop•

• MeterTop•

Identification Tips

• Assign short descriptive names to graphic elements. Default names are created for layers by concatenating•
Choice Group and Choice names. Shorter names reduce the number of Option and Layer rules that will
extend beyond the borders of Rule field of the Symbol Wizard Editor.

• Use a standard naming convention for the graphic elements of a Symbol Wizard. Using a standard naming•
convention groups similar functional graphic elements together in the list shown in the Elements pane. This
makes it easier to find graphic elements when a Symbol Wizard contains many graphic elements. Also, the
names of layers appear in alphabetic order.

Build a Visual Representation of a Symbol Wizard
The major steps to add the necessary graphic elements to a Symbol Wizard consist of the following:

1. Check out and open an instance of a graphic from the Industrial Graphic Editor in the Industrial Graphic1.
Editor, or create a new graphic.

2. Create the graphic elements required for each Symbol Wizard configuration by doing one of the following:2.

• Embed other graphics from the Industrial Graphic Editor into the symbol.•

• Duplicate graphic elements from the symbol and edit them as necessary for each Symbol Wizard•
configuration.
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In the example of the centrifugal pump Symbol Wizard, a meter has been embedded into centrifugal
pump graphic and then duplicated for the different configuration positions. The inlet and outlet pipes
are created by duplicating the graphic pipe elements from the centrifugal pump graphic.

3. Rename each graphic element to easily associate it with a Symbol Wizard configuration.3.

4. Position the graphic elements to accurately represent the different visual representations of each4.
configuration of a Symbol Wizard.

Visualization Tips

• If the same graphic element will be placed at different positions within a Symbol Wizard based on different•
configurations, create a copy of the graphic element for each position. Each graphic element can be placed
into a separate layer, making it easier to specify rules to show the element at the desired position.

• If a graphic element included in a specific Symbol Wizard configuration consists of two or more elements,•
group the elements together. Grouping related elements makes it easier to assign graphics to Symbol Wizard
layers.
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Assign Graphic Elements, Named Scripts, and Custom Properties to Graphic
Layers
By default, the Layers pane shows a layer for each Choice Group/Choice combination listed in the Options pane.
In the example of a centrifugal pump Symbol Wizard, there are unique layers for each orientation of the inlet
pipe of the pump graphic. Inlet and outlet graphic element pairs are added to each Orientation layer.

 

Layers need to be added for the left, right, and top positions of the tachometer when the HasTach Choice Group
is True. Copies of the embedded tachometer graphic are added to the TachLeft, TachRight, and TachTop layers,
which map to the different positions of the tachometer shown in the pump Symbol Wizard. The TachFalse layer
does not contain any graphic elements because it selects the Symbol Wizard configurations without a
tachometer.

Layer Tips

• Use the Active Layer method to quickly drag and drop elements, scripts, and custom properties to a layer•
folder. Selected elements can be dropped anywhere within the Layers view and automatically placed in the
correct folder of the active layer.

• If not created by default, create an empty layer without graphic elements for a Choice Group with Boolean•
True/False Choices. This makes it easier to write layer rules to hide graphic elements when a Choice Group is
False.

• After adding graphic elements to a layer, toggle the Show/Hide icon on and off to verify the correct graphic•
elements have been added to the layer.

• Toggle the Expand All/Collapse All button above the Layers pane to show or hide all of the folders beneath•
each layer.

Specify Rules to select Graphic Layers
A default rule is assigned to each layer based on the Choice Group Choice pair. In the example of the centrifugal
pump Symbol Wizard, the Orientation Choice Group layer rules map directly to Wizard Options choices.
Selecting an Orientation option displays the graphic elements of the selected layer in the pump’s configuration.

  

Modify the default layer rules to show or hide the tachometer. In the case of the Left or Right pump orientation,
we recommend that the layer rules select the appropriate Orientation layer and tachometer layers. The TachLeft
and TachRight layer rules include an AND statement that selects the tachometer and the Symbol Wizard’s pipe
orientation:
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TachLeft: Orientation.Left&HasTach.True

TachRight: Orientation.Right&HasTach.True

The layer rule to select the Top and Bottom Orientation configurations with a tachometer is more complex
because the position of the tachometer is the same in both orientations. The TachTop layer rule includes
separate Top and Bottom compound expressions joined with an OR statement.

(Orientation.Top&HasTach.True)|(Orientation.Bottom&HasTach.True)

Using Symbol Wizard Preview, verify each set of layer rules defines only a single unique Symbol
Wizard configuration. Rule errors become apparent when a Symbol Wizard includes elements from
other configurations, or elements are missing.

Symbol Wizard
Configuration

Wizard Options and Corresponding Active
Configuration Layer Rules

Orientation.Left&HasTach.False

Orientation.Left&HasTach.True

Orientation.Right&HasTach.False

Orientation.Right&HasTach.True
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Symbol Wizard
Configuration

Wizard Options and Corresponding Active
Configuration Layer Rules

Orientation.Top&HasTach.False

(Orientation.Top&HasTach.True)|(Orientation.Bottom&HasTach.True)

Orientation.Bottom&HasTach.False

(Orientation.Top&HasTach.True)|(Orientation.Bottom&HasTach.True)

Rule Tips

• Symbol Wizard rules are evaluated simultaneously. Place parentheses around compound expressions, which•
are evaluated before other operators outside of parentheses in a rule.

• Rules cannot reference a Choice Group alone. Always write rule expressions that reference Choices within a•
Choice Group in a hierarchical manner: ChoiceGroup.Choice.

• Use operator characters (&, |, !) rather than Boolean keywords (AND, OR, and NOT) to save space when•
writing rules. Using operator characters reduces the likelihood that a long rule will extend beyond the
borders of the Rule field.
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Switching Languages for Graphic
Elements

About Language Switching for Industrial Graphics
This section describes how to switch the language shown for industrial graphics, the effects of different language
settings on an individual industrial graphic, and language switching behaviors for certain features, such as
embedded graphics, custom properties, and string substitution.

The language settings of the IDE control which languages are available to graphics. You cannot add a language at
the graphic level. Languages are only added at the HMI/SCADA product level using the IDE.

Using the Industrial Graphic Editor, you select which of the IDE-configured languages you want to show for your
graphic. By default, text for the graphic is shown in the default language and font for the IDE.

You export text for translation using the IDE.

Selecting a Language for a Graphic
When you select a language for a graphic, all graphic elements show the translated text associated with the
selected language, if it is available. You can switch languages even if you open the graphic in read-only mode.

You can only select that are currently configured for the IDE.

The current Element Style assigned to a text font does not change when you switch to a different language.

To select the language for a graphic
1. Open the graphic in the Industrial Graphic Editor.1.

2. In the Languages panel, select the language from the list.2.

Removing a Language from a Graphic
If you remove a language from the IDE, the language is still available for a graphic until you specifically remove it.

You cannot remove a language from a graphic if the language is configured at the HMI/SCADA product level.

To remove the language for a graphic
1. Open the graphic in the Industrial Graphic Editor.1.
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2. On the Special menu, point to Configure and then click Locales. The Configure Languages dialog box2.
appears.

3. Select the language to remove and click Remove.3.

4. Click OK.4.

Creating Elements When Multiple Languages are Defined for an
HMI/SCADA Application

Select the default language for your HMI/SCADA product before you create a new graphic element. You cannot
create an element if you have a secondary language selected in the Industrial Graphic Editor. This includes:

• Duplicating an element•

• Pasting an element•

• Embedding a graphic•

• Grouping or ungrouping elements•

• Combining paths•

• Breaking paths•

• Import an InTouch SmartSymbol•

• Convert a graphic to a group•

Moving Graphics to Applications with Different Language Settings
If you import a graphic into another HMI/SCADA application, any translation that already exists for the graphic is
retained. However, only languages that are configured for the new application are available for use.

If you open a graphic that does not contain the default language of your HMI/SCADA product, then the default
language is added to the list of languages for that graphic and is set as the new default language. The text strings
from the last saved default language of that graphic are transferred over to the new default language of the
graphic.

For example, if a graphic only has the French language configured and is opened in another application where
English is the default language, the French strings are transferred over to the English language when the graphic
is opened, and English is made the default language for the graphic. The French language still exists for the
graphic, but it will no longer be the default language.

If a previously imported graphic has English and French configured with French as the default language and the
graphic is opened in another application with English as the default language, the default language for the
graphic is set to English.

If you open a graphic in read-only mode, no changes are made to the graphic's language settings to reflect the
language settings of your HMI/SCADA product.

We recommend that you validate templates and instances that have graphics after migrating them to another
application and before exporting localizations.
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How Fonts are Applied at Design Time
When you create a graphic element that supports visible text, it is created in the default language of your HMI/
SCADA product. The font used is the last font persisted in the editor. However, if you provide a specific
translation for an element in a secondary language, the configured font for the language is applied to the
element.

For example:

1. You configure three languages: English (Default, Font = Arial), French (Font = Courier New) and German (Font1.
= Times New Roman).

2. You open a graphic S1 in the English language. The editor default is Arial. You create a textbox in English. It is2.
created with the Arial font.

3. You switch to German and translate the text. The font changes to Times New Roman, which is the font3.
configured for German. The original font size and style remains the same.

4. You switch to French. The font is Arial because the text in French is not translated yet.4.

Language Switching for Embedded Graphics
When you embed a graphic into another graphic, any translations are also loaded for the embedded graphic.
Switching the language for a graphic also switches the language for all embedded graphics.

For example, a graphic G1 contains a text graphic with the text "English String." English is the default language.
The text is set to "French String" for the French language. The following steps describe language switching for the
embedded graphic:

1. You embed the graphic G1 into the graphic G2.1.

You see the text showing the "English String."

2. You switch the language to French in the editor of G2.2.

The text in the embedded graphic G1 switches to "French String."

If you convert an embedded graphic to a group, any translations defined for the embedded graphic are migrated
to the new elements created in the graphic. If the embedded graphic supports languages that are not defined in
the base graphic, those translations are removed during the conversion.

If you open a graphic containing one or more embedded graphics and the current language of the Industrial
Graphic Editor is not available in the embedded graphics, then the embedded graphic uses the configured
default language, if available. If the configured default language configured in your application, is not available,
then the embedded graphics use the last saved default language of that graphic.

For example:

1. You create graphic S1 with French and German languages. The default language for your HMI/SCADA1.
application is German.

2. You embed G1 inside G2 and then save and close G2.2.

3. You change the default application language to French.3.

4. You add English as another language.4.
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If you open the graphic G2 in the English language, then the graphic G1 is shown using the French text. This is
because French is the default language configured in the application.

Embedded graphics support translations for custom properties. For more information on translating custom
properties, see Translating String Custom Properties.

Embedded graphics also support translations for string substitutions. For more information on translation and
string substitutions, see String Substitutions and Language Switching.

String Substitutions and Language Switching
You can substitute strings for textual elements within a graphic. For general information about string
substitution, see Substituting Strings.

If you perform a first-time string substitution on an embedded graphic in the primary language, that substitution
is shown in the secondary languages. You can then perform a substitution in the secondary language to create a
string substitution specific to the secondary language.

If you perform a first-time string substitution on an embedded graphic in a secondary language, the substitution
is also applied to the primary language, because the translated string that previously existed for the primary
language is no longer valid. Because the primary language value is changed in the graphic, this string applies to
all secondary languages configured. You can then perform a second substitution in the primary language, which
will apply to all secondary languages except the ones that have had a specific substitution set.

If you perform a string substitution in a secondary language with an existing string substitution in the primary
language, the new substitution is applied to the secondary language only.

The following design time and run-time rules are applied during a language switch to properly update an
embedded graphic with the current substitutions for the language:

1. Apply the string substitutions from the default language.1.

2. Apply the string substitutions from the secondary language, if switching to a secondary language.2.

For example, an embedded graphic contains a text graphic with the text "English String." English is the default
language. The following steps describe how changing the language affects string substitution for the embedded
graphic:

1. While editing in the default language, you select an embedded graphic and open the string substitution1.
dialog box.

2. You can see the old column with a value of "English String."2.

3. You replace the "English String" with "New English String."3.

4. You close the string substitution dialog box.4.

5. You switch to the French language.5.

6. You open the string substitution dialog box and see the string "New English String" in the old column.6.

7. You now replace the "New English String" with "New French String."7.

8. You close the string substitution dialog box.8.

9. You switch to the German language.9.

10. You open the string substitution dialog box and see the string "New English String" in the old column.10.
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11. You now replace the "New English String" with "New German String."11.

12. You close the string substitution dialog box.12.

13. You switch to the French language.13.

14. You open the string substitution dialog box and see the string "New French String" in the old column.14.

If you select an alternate graphic, the string substitutions made on the initial graphic are reapplied to the new
graphic across all languages.

The behavior of client control string substitutions are the same as the embedded graphics.

Translating String Custom Properties
You can translate custom properties that are defined as static strings.

If the custom property is configured with a reference, then that reference applies across all languages in the
graphic. If you change that reference in any language to a static string, that string is set for all languages, and you
can provide specific translations in the other languages.

For example, you create a custom property CP1 of type string with a default value of "Hello." You can now
translate this custom property. You switch to another language in the editor and modify the default value of CP1
to UD1.str1 (changed from string to reference). Now CP1 cannot be translated. If you go back and change CP1
from a reference to a string, you can translate it again. The value you place in the default value is the value
shown for all other languages if you don't specify a different string in that language.

When the custom property dialog box opens, it shows the appropriate translated values for the constant string
custom properties, as determined by the translation precedence rules. For more information on these rules, see
Precedence Rules for Showing the Language and Font.

Translation Support for Client Controls with Satellite Assemblies
A satellite assembly is a .NET Framework assembly that contains resources specific to a given language. You can
place the resources for different languages in different assemblies, and the correct assembly is loaded into
memory if the run-time user views the application in that language.

If you import a client control with satellite assemblies, then the satellite assemblies are also imported.

The translation support for client controls with satellite assemblies is as follows:

Scenario Behavior of Client Control

Design Time - Industrial
Graphic Editor

The Industrial Graphic Editor only supports English. The
application locale has no effect on how the client controls are
shown.

Application Design Time The localized version of the application determines how the
client controls are shown.
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Scenario Behavior of Client Control

Application Run Time The localized version of the application determines how the
client controls are shown during runtime. The application locale
has no effect on how the client controls are shown.

When you export text for translation, the base font information for client controls is not included. You need to
use satellite assemblies to control this information.

Translation Support for Client Controls
Client controls included in the Industrial Graphic Editor, such as the Alarm Control, support the following types of
translation:

• Client controls with satellite assemblies work similar to other types of client controls.•

• Client controls support translated string substitutions. For more information on translated string•
substitution, see Switching Languages and String Substitutions at Run Time.

The number and type of strings used by the client control is specific to the control.

When you export text for translation, the base font information for client controls is not included. You need to
use satellite assemblies to control this information.

Importing InTouch SmartSymbols that Have Translated Data
You can import InTouch SmartSymbols having translated data into the Industrial Graphic Editor. All the language
data in a SmartSymbol is imported into the Industrial Graphic, including:

• Configured languages.•

• Translated content for graphic elements (text and font)•

• Translated animation links.•

After you import, you can view the language data in the Industrial Graphic Editor at design time or your HMI/
SCADA product's run time interface.

For example, you import a SmartSymbol with language data for French and German. After the import, the French
and German languages are added to the Industrial Graphic, if they don't already exist.

The language switching behavior at run time matches the behavior of the original SmartSymbol. Any variation in
the default font usage at run time between Industrial Graphics and native graphics is resolved during the
SmartSymbol import. During the import, elements that have translations but not a translated font are detected
and their font set to the font configured in your application

Support for Empty Strings
You cannot substitute an empty string in the primary locale. Use space characters. When you set an empty string
for a primary locale, the empty string is propagated to all other locales that don't have translations.
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Performing a first time substitution of an empty string in a secondary locale puts a space character in the primary
and the current locale. The remaining locales will match the primary value if they don't already have a specific
value.

If a primary locale contains an empty string, it will be exported for translation.

If you substitute an empty string for a secondary locale, the element shows as empty. However, if you switch to
the primary locale and then back to the secondary locale, the element shows the primary string substitution
again.

Language Switching Example
The following table describes the effects of language switching on the various parts of the system. In this
example:

• The application is configured with two languages: English and French.•

• The default language is English.•

• There are several graphics, some of which contain partial or mismatched language configurations compared•
to to your HMI/SCADA product's configured languages.

Action

Effect on the
Languages
Configured for the
Graphic

Effect on Elements
that contain English
Translations

Effect on Elements
that contain French
Translations

You open a new graphic. English language is
added to the
graphic.

None None

You open an existing graphic
that only has English
defined.

None None None

You open an existing graphic
that only has the French
language defined.

English language is
added to the
graphic.

French strings are
transferred into the
English language.

French strings are
marked as specific
translations for
French.

You open an existing graphic
that only has the German
language defined.

English language is
added to the
graphic.

German strings are
transferred into the
English language.
German strings are
marked as specific
translations for
German.

None

You change a text string in
the English language.

None New string is set for
the English language.

None
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Action

Effect on the
Languages
Configured for the
Graphic

Effect on Elements
that contain English
Translations

Effect on Elements
that contain French
Translations

You switch to the French
language for the first time in
a graphic that only had the
English language.

French language is
added to the
graphic.

None The default language
strings are shown
unless a specific
French translation
exists.

You change a string while
viewing the French
language.

None None The new string is set
as the specific
translation for the
French language and
used for display.

You create a new text
element in a graphic that has
English only while viewing
the English language.

None The new element's
string value is saved for
translation.

None

You delete an element with
translations in English and
French.

None English translations are
removed.

French translations
are removed.

You copy animations from an
element.

None English animation
translation strings are
put into the clipboard.

French animation
translation strings are
put into the clipboard.

You paste animations to an
element.

None English animation
translation strings are
put into the
destination
animations.

French animation
translation strings are
put into the
destination
animations.

You clear animations for an
element.

None English animation
strings are removed.

French animation
strings are removed.

You copy and paste elements
from a German-only graphic
into a graphic containing
English and French.

None German strings are
placed in the English
language.

None
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Action

Effect on the
Languages
Configured for the
Graphic

Effect on Elements
that contain English
Translations

Effect on Elements
that contain French
Translations

You copy and paste elements
from an English and German
graphic into a symbol
containing English and
French.

None English strings from
the source graphic are
copied during the
paste. The German
strings are dropped.

None

You export the French
language, having never
switched to the French
language.

The French
language is added
to the graphic for
the purposes of the
export. The
language is not
saved back to the
graphic during the
export.

English strings are
exported in the
"Phrase" XML attribute
field.

If specific strings exist
for French, they are
exported in the
"Translation" XML
field.

You import the French
language.

The French
language is added.

None Any translations
provided in the import
are marked as specific
translations for the
French language. If
the translation is
empty, the default
language value is
shown.

You convert a graphic to a
group.

Same logic as
copy/paste.

Same logic as copy/
paste.

Same logic as copy/
paste.

You delete the German
language.

German is
removed.

None None

Overriding Translated Strings for Industrial Graphics
After you embed a graphic into an application, you can override the translations for:

• Strings on the substitutable graphic elements within the Industrial Graphic.•

• String type custom properties on the graphic.•

To translate these overrides, export and import the strings.
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Language Switching at Run Time
At run time, languages can be switched by selecting the language from the Special menu. The list of languages
shown is based on the languages configured for your HMI/SCADA product.
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Exporting and Importing Industrial
Graphics Programmatically

The set of GraphicAccess application programming interfaces (API) allow users to export graphics to an XML file
programmatically. Use the same set of APIs to create an Industrial Graphic in another galaxy or to overwrite an
existing graphic(s) by importing the graphic definition from an XML file. The APIs can also be used to export the
configured references or GPI for a graphic and importing multiple XML files from a folder location.

Before using the set of GraphicAccess APIs, you must use the GRAccess Toolkit to log in and connect to an Galaxy
repository. For more information about logging in and connecting to a Galaxy repository, see the GRAccess
Toolkit API Help.

The APIs are available through the following interfaces:

• IGraphicAccess – Export and import an Industrial Graphic•

• IGraphicAccess2 – Export the substitutable strings and configured references for an Industrial Graphic•

• IGraphicAccess3 – Export the GPI of an Industrial Graphic•

• IGraphicAccess4 – Import Industrial Graphics from a folder location•

About Programmatic Graphic Export and Import
The GraphicAccess programmatic API exports or imports an extensive set of properties of an Industrial graphic.
For standard Industrial Graphics, an exported or imported graphic can contain the following:

• Custom properties•

• Configured References•

• Graphic elements•

• Connector lines•

• Graphic groups•

• Graphic animations•

• Element styles•

• Named scripts•

• Predefined scripts•
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• Overridden text strings•

• Numeric format styles•

• DataStatus elements•

• Trend Pen•

• Alarm Client•

• Trend Client•

In addition to the properties of a standard Industrial graphic, an exported or imported Symbol Wizard can
contain the following:

• Wizard Options•

• Choice groups•

• Choices•

• Layers•

• Rules•

Implementing the IGraphicAccess API
The GraphicAccess API is implemented by the ArchestrA.Visualization.GraphicAccess.dll file, located in:
\Program Files (x86)\ArchestrA\Framework\Bin

IGraphicAccess is used to export an Industrial Graphic to an XML file, or to import an XML file into a Galaxy as an
Industrial Graphic. IGalaxy points to the Galaxy where the import/export operation is performed.
public interface IGraphicAccess
{

/// <summary>Export an Industrial Graphic to XML file</summary>
/// <param name="galaxy">IGalaxy obtained from GRAccess</param>
/// <param name="graphicName">The graphic name</param>
/// <param name="xmlFilePath">The XML file path</param>
/// <returns>Result of the method</returns>
IGraphicAccessResult ExportGraphicToXml(IGalaxy galaxy, string graphicName, string 

xmlFilePath);
/// <summary>Import the XML file and generate an Industrial Graphic</summary>
/// <param name="galaxy">IGalaxy obtained from GRAccess</param>
/// <param name="graphicName">The graphic name</param>
/// <param name="xmlFilePath">The XML file path</param>
/// <param name="bOverWrite">Flag which indicates if existing graphic should be 

overwritten</param>
/// <returns>Result of the method</returns>
IGraphicAccessResult ImportGraphicFromXml(IGalaxy galaxy, string graphicName, 

string xmlFilePath, bool bOverWrite);
void ValidateSymboltoExport(IGalaxy galaxy, string graphicName);

}
public interface IGraphicAccessResult : ICommandResult
{

XMLOperations.StatusCode Status { get; }
}
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If the Galaxy has security enforced, you must first log in to the Galaxy Repository with proper credentials. Also,
the Can Export Graphics and Can Import Graphics Galaxy role permissions must be set active before attempting
an import or export operation.

You can set the Can Export Graphics and Can Import Graphics Galaxy role permissions from the IDE Configure
Security dialog box. For more information about setting Galaxy permissions, see the Application Server Help.

GraphicAccess Interface Methods
The IGraphicAccess interface includes separate graphic export and import methods.

ExportGraphicToXml Method

Exports an Industrial Graphic to an XML file. Galaxy, graphic name, and the XML file path are passed as
parameters to the ExportGraphicToXml function.

Syntax
IGraphicAccessResult ExportGraphicToXml(IGalaxy galaxy, string graphicName, string 
xmlFilePath);

Parameters

galaxy
IGalaxy obtained from GRAccess, returns the galaxy containing the graphic to export.

graphicName
Name of the graphic to export.

xmlFilePath
Directory folder to place the XML file containing the exported graphic.

ImportGraphicFromXml Method

Imports a graphic from an existing XML file. Galaxy, graphic name, the XML file path, and an overwrite flag are
passed as parameters to the ImportGraphicfromXml function.

Syntax
IGraphicAccessResult ImportGraphicFromXml(IGalaxy galaxy, string graphicName, string 
xmlFilePath, bool bOverWrite);

Parameters

galaxy
IGalaxy obtained from GRAccess, returns the galaxy where the graphic will be imported.

graphicName
Name of the graphic to import.

xmlFilePath
Directory folder location of the XML file.

bOverWrite
Boolean flag that indicates if an existing graphic can be overwritten by an imported graphic with the same name.

ValidateSymboltoExport Method

Validates the graphic before exporting it to an XML file. For more information, see Validate Objects in Application
Server Help.

Syntax
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void ValidateSymboltoExport(IGalaxy galaxy, string graphicName);

Parameters

galaxy
IGalaxy obtained from GRAccess, returns the galaxy that contains the graphic that requires validation.

graphicName
Name of the graphic to validate.

After an import or export operation is complete, the results are set to IGraphicAccessResult which is derived
from ICommandResult. A message appears and indicates if the operation succeeded or failed. For detailed
information about the ICommandResult interface, see the GRAccess Toolkit API User's Guide.

A succeeded message only means the import or export operation finished successfully. It does not indicate the
quality of the exported XML file or the imported graphic. Check the SMC log file for any warning or error
messages after each export or import operation.

About Programmatic String and Reference Export and Import
The GraphicAccess2 API exports all of a graphic's substitutable strings to a specified XML file, regardless of
whether some of the strings have been overridden. All graphic strings that appear from a Ctrl+L or Substitute
Strings operation from within the Graphic Editor will be exported, allowing for bulk editing of the graphic strings.

The GraphicAccess2 API can also be used to export a list of configured references for a selected object. The list is
exported to a XML string. The API will export the following configured references:

• Mx references•

• InTouch tags, including those configured from the argument of attribute•

Example: attribute("InTouch:zhmi-abc")

• Custom properties configured with animation links•

• Client scripts•

• Custom property overrides•

• Client controls•

• All applicable references configured within an embedded graphic, regardless of the number of times it is•
embedded

Implementing the IGraphicAccess2 API
The GraphicAccess2 API is implemented by the ArchestrA.Visualization.GraphicAccess.dll file, located in:
\Program Files (x86)\ArchestrA\Framework\Bin

IGraphicAccess2 is used to export all of a graphic's substitutable strings to a specified XML file, regardless of
whether some of the strings have been overridden.

The GraphicAccess2 API can also be used to export a list of configured references for a selected graphic to an
XML string.

IGraphicAccess2 passes galaxy, graphicName, the XML file path, and substitute strings as parameters.
public interface IGraphicAccess2 : IGraphicAccess
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{
/// <summary>Export an Industrial Graphic to XML file</summary>
/// <param name="galaxy">IGalaxy obtained from GRAccess</param>
/// <param name="graphicName">The graphic name</param>
/// <param name="xmlFilePath">The XML file path</param>
/// <param name="bExportSubstituteStrings">Option to export SubstituteStrings</

param>
/// <returns>Result of the method</returns>
IGraphicAccessResult ExportGraphicToXml(IGalaxy galaxy, string graphicName, string 

xmlFilePath, bool bExportSubstituteStrings);
/// <summary>Get references configured on an Industrial Graphic</summary>
/// <param name="galaxy">IGalaxy obtained from GRAccess</param>
/// <param name="graphicName">The graphic name</param>
/// <param name="sConfiguredReferencesXML">Returns all the references in XML 

format</param>
/// <returns>Result of the method</returns>
IGraphicAccessResult GetConfiguredReferences(IGalaxy galaxy, string graphicName, 

out string sConfiguredReferencesXML);
}

If the Galaxy has security enforced, you must first log in to the Galaxy Repository with proper credentials. Also,
the Can Export Graphics and Can Import Graphics Galaxy role permissions must be set active before attempting
an import or export operation.

You can set the Can Export Graphics and Can Import Graphics Galaxy role permissions from the IDE Configure
Security dialog box. For more information about setting Galaxy permissions, see the Application Server Help.

GraphicAccess2 Interface Methods
The GraphicAccess2 interface uses separate methods to export substitutable strings and configured references
for an Industrial Graphic.

ExportGraphicToXml Method

Exports all substitutable strings in an Industrial Graphic to an XML file. Galaxy, graphic name, the XML file path
and Export Substitute Strings option are the parameters for the ExportGraphictoXML function. This API will not
export empty strings and strings used in invisible graphics.

Syntax
IGraphicAccessResult ExportGraphicToXml(IGalaxy galaxy, string graphicName, string 
xmlFilePath, bool bExportSubstituteStrings);

Parameters

galaxy
IGalaxy obtained from the GRAccess and returns the galaxy.

graphicName
Name of the graphic to export.

xmlFilePath
Directory folder to place the XML file containing the exported graphic.

bExportSubstituteStrings
When set 'True' will include the substitute string from graphic in the export XML file.

GetConfiguredReferences Method
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Exports all of the configured references within an Industrial Graphic to an XML file.

Syntax
IGraphicAccessResult GetConfiguredReferences(IGalaxy galaxy, string graphicName, out 
string sConfiguredReferencesXML);

Parameters

galaxy
IGalaxy obtained from the GRAccess and returns galaxy containing the graphic object.

graphicName
Name of the graphic with references to export.

sConfiguredReferencesXML
The configured references for the graphic will be returned to this parameter in a string.

About Programmatic GPI Export
The IGraphicAccess3 API exports the Graphics Performance Index (GPI) rating for a graphic and related details to
a specified XML file. The details are as follows:

Item Relevance Example

Description Component type Number of Trend Pens

Count Number of items comprising the component type 3

Impact Score Call up time in milliseconds for the component type 2.9

Implementing the IGraphicAccess3 API
The IGraphicAccess3 API is implemented by the ArchestrA.Visualization.GraphicAccess.dll, located in:
\Program Files (x86)\ArchestrA\Framework\Bin

The IGraphicAccess3 API is used to export the Graphics Performance Index (GPI) of the Industrial Graphic.

IGraphicAccess3 passes galaxy, graphicName and the XML file path as parameters.
public interface IGraphicAccess3 : IGraphicAccess2
{

/// <summary>Get GPI XML of an Industrial Graphic</summary>
/// <param name="galaxy">IGalaxy obtained from GRAccess</param>
///<param name="graphicName">The graphic name</param>
///<param name="sGPIXML">Returns GPI details in XML format</param>
/// <returns>Result of the method</returns
ICommandResult GetGPI (IGalaxy galaxy, string graphicName, out string sGPIXML);

}

GraphicAccess3 Interface Methods
GetGPI Method

Exports the GPI of a graphic to an XML file.
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Syntax
ICommandResult GetGPI (IGalaxy galaxy, string graphicName, out string sGPIXML);

Parameters

galaxy
IGalaxy obtained from the GRAccess and returns the galaxy.

graphicName
Name of the graphic for which the GPI is needed.

sGPIXML
The GPI information (XML) for the graphic will be returned to this parameter in a string.

About Programmatic Import from a Folder Location
The GraphicAccess4 programmatic API and can import Industrial Graphics from multiple XML files available in a
folder.

Implementing the IGraphicAccess4 API
The GraphicAccess4 API is implemented by the ArchestrA.Visualization.GraphicAccess.dll file, located in:
\Program Files (x86)\ArchestrA\Framework\Bin

IGraphicAccess4 is used to import graphic XML files. IGalaxy points to a Galaxy where the import
operation is performed.
public interface IGraphicAccess4 : IGraphicAccess3
{

/// <summary>Import the XML files from the folder and generate Industrial 
Graphics</summary>

/// <param name="galaxy">IGalaxy obtained from GRAccess</param>
/// <param name="strFolderPath">The folder/directory path where graphic XML files 

are present</param>
/// <param name="bOverWrite">Flag which indicates if existing graphic should be 

overwritten</param>
/// <param name="opNotifier">Returns the status of the import operation to the 

calling function (client)</param>
/// <param name="cancelToken">Sets the token which indicates if the operation 

needs to be canceled during import</param>
/// <returns>Result of the method</returns>
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Task<IGraphicAccessResult> ImportGraphics(IGalaxy galaxy, string strFolderPath, 
bool bOverWrite, IGraphicOperationStatus opNotifier = null, CancellationToken cancelToken 
= default);
}

The IGraphicAccess4 uses the IGraphicOperationStatus callback interface to determine if the operation is in
progress, cancelled or completed.
namespace ArchestrA.Visualization.GraphicAccess
{

public interface IGraphicOperationStatus
{

void OnOperationProgressMessage(string message);
void OnOperationComplete();
void OnOperationCancel();

}
}

GraphicAccess4 Interface Methods
ImportGraphics Method

Imports graphics from existing XML files available in a folder. Galaxy, folder path, an overwrite flag, progress of
the operation and a token to determine if the operation is cancelled are passed as parameters to the
ImportGraphics function.

Syntax
Task<IGraphicAccessResult> ImportGraphics(IGalaxy galaxy, string strFolderPath, bool 
bOverWrite, IGraphicOperationStatus opNotifier = null, CancellationToken cancelToken = 
default);

Parameters

galaxy
Points to a galaxy to which graphics will be imported or where the API will be run.

strFolderPath
Directory folder location of the XML files.

bOverWrite
Boolean flag that indicates if an existing graphic can be overwritten by an imported graphic with the same name.

opNotifier
Returns the status of the import operation to the calling function (client)

cancelToken
Calling function (Client) can set this token to cancel the import graphics operation. For more information on
CancellationToken, see the MSDN help.

After the import operation is complete, the results are set to Task<IGraphicAccessResult> which is derived from
ICommandResult. A message appears and indicates if the operation succeeded or failed. For detailed information
about the ICommandResult interface, see the GRAccess Toolkit API Help.

A succeeded message only means the import operation finished successfully. It does not indicate the quality of
the exported XML file or the imported graphic. Check the SMC log file for any warning or error messages after
each import operation.
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Importing Industrial Graphics from XML Files
The ImportGraphicFromXml method imports an XML file and creates a graphic in the root folder of the Industrial
Graphic Toolbox. A graphic container instance is created and loads the graphic definition from the provided XML
file. The container then uses its binary serialization to save the binary definition to a blob. A new graphic is
created with GraphicAccess API and the graphic blob is set to the Galaxy attribute "_VisualElementDefinition".

An XML schema file aaGraphics.xsd is located in the ...\ArchestrA\Framework\Bin folder. The Industrial Graphic
library uses this schema file to validate the provided XML file before importing it and creating an Industrial
graphic. If an invalid graphic name is specified or the XML file does not validate against the schema file, the
import operation stops immediately without further processing.

Exporting Industrial Graphics to XML Files
During an export operation, the graphic definition is retrieved from Galaxy attribute "_VisualElementDefinition"
of the graphic with the specified name. A graphic container instance is created for the exported graphic
definition. XML serialization in the graphic container is used to create the graphic’s XML file at the specified
folder path.

Exporting and Importing Overridden Text Strings
The ArchestrA programmatic API supports overridden text strings in graphics. Typically, a string substitution is
performed on a text string from the Industrial Graphic Editor before exporting the graphic with the
programmatic API. The exported XML file shows the content of overridden and substituted text strings as
elements and attributes of the SubstitutedStrings element.

When a graphic is imported using the programmatic API, the graphic shows the text string assigned to the New
attribute of the XML file’s String element. Users can substitute text strings before importing a graphic by editing
the contents of the String element in the exported XML file.

Exporting Overridden Text Strings
After exporting a graphic, the XML file’s String element specifies the original string and the new substituted
string with the Old and New attributes. The ElementID attribute specifies the specific text element to be
overridden.
<SubstituteStrings>
   <String Old="TextBox1" New="TextBox2" ElementID="A.Text1"/>
<SubstituteStrings>

In this example, the TextBox1 text string was overridden by the new substituted text string TextBox2. The string
substitution occurred in symbol B that substituted the text of the text element in symbol A.

Text strings can be overridden within symbols that are embedded within other symbols. Consider an example
that shows symbol A embedded in symbol B, which is embedded in symbol C. Two string substitutions are made
to a single text element.
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The export XML file’s SubstituteStrings element shows the text string override information.
<SubstituteStrings>
   <String Old="TextBox2" New="TextBox3" ElementID="B.A.Text1"/>
<SubstituteStrings>

Notice the Old and New attributes show the text strings of the most recent string substitution before symbol C
was exported. Also, the ElementID attribute indicates symbol A containing text element Text1 is embedded in
symbol B in the form ElementID="B.A.Text1".

The programmatic API can export an embedded symbol containing multiple text elements with the same text
string that is overridden by different string substitutions. Consider an example that shows symbol A embedded in
symbol B. Two string substitutions are made to a single text string in two text elements of embedded symbol A.

The export XML file’s SubstituteStrings element shows the text string override information with a String element
for each text override.
<SubstituteStrings>
   <String Old="TextBox1" New="TextBox2" ElementID="B.A.Text1"/>
   <String Old="TextBox1" New="TextBox3" ElementID="B.A.Text2"/>
<SubstituteStrings>

Importing Overridden Text Strings
An exported symbol’s text strings can be overridden by editing the SubstituteString elements of the export XML
file before importing the symbol.
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The following illustration shows symbol A embedded in symbol B. Symbol A contains three text elements with
text strings. The TextBox1 text string of the Text1 element was overridden to Textbox11. Then, symbol B was
exported using the programmatic API.

The expected SubstituteStrings element in the export XML file should be similar to the following:
<SubstituteStrings>
   <String Old="TextBox1" New="TextBox11" ElementID="A.Text1"/>
</SubstituteStrings>

The user edits the export XML file and adds an entry to override a text string without using an ElementID
attribute to identify the text element.
<SubstituteStrings>
   <String Old="TextBox1" New="TextBox11" ElementID="A.Text1"/>
   <String Old="TextBox2" New="TextBox22">
</SubstituteStrings>

After importing the symbol, the text strings for the Text2 and Text3 elements are overridden to TextBox22.
Without an ElementID to identify the text element, the string override replaces all text strings that match the
text string specified by the Old attribute.

If the symbol was exported again using the programmatic API, the exported XML file shows that ElementID
attributes have been added to each String element.
<SubstituteStrings>
 <String Old="TextBox1" New="TextBox11" ElementID="A.Text1"/>
 <String Old="TextBox2" New="TextBox22" ElementID="A.Text2"/>

<String Old="TextBox2" New="TextBox22" ElementID="A.Text3"/>
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</SubstituteStrings>
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List of Element Properties

Alphabetical List of Properties
This section shows you the properties of elements, the canvas, element groups, and embedded graphics.

Each property has a purpose, a category it belongs to, where it is used if it can be used in scripting at run time,
and where to find more information on how to use it.

The first part of this section contains an alphabetical list of all properties, the second part shows a table for each
category of properties.

The following table contains a list of properties used by the:

• Elements.•

• Canvas.•

• Element groups.•

• Embedded graphics.•

Asterisk (*) marks properties that are specific to only one type of element or the canvas, a group or an
embedded graphic.

Property Purpose, category, usage and further information

AbsoluteAnchor* Purpose: Defines the absolute anchor point of the source graphic. By
default, this is the center point of all elements on the canvas but can
be changed.

Category: Appearance

Used by: Canvas

Can be read by script at run time: No

Info: Size Propagation and Anchor Points
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Property Purpose, category, usage and further information

AbsoluteOrigin Purpose: Defines an X, Y location relative to the top, left (0, 0) origin of
the graphic or window.

Category: Appearance

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Line, H/V
Line, Polyline, Curve, 2 Point Arc, 3 Point Arc, Button, Text, Text Box,
Image, Status, Embedded Symbol, Group, Path, Radio Button Group,
Check Box, Edit Box, Combo Box, Calendar, DateTime Picker, List Box.

Can be read by script at run time: No

Info: Changing Points of Origin in the Properties Editor

Alignment Purpose: Controls the location of the text relative to the bounding
rectangle of the element.

Category: Text Style

Used by: Button, Text, Text Box

Can be read by script at run time: No

Info: Setting the Text Alignment

AnchorFixedTo Purpose: Determines if the anchor point is fixed to the canvas when
you resize, delete, or add elements (Absolute), or if the anchor point is
recalculated relative to the element sizes and positions (Relative).

Category: Appearance

Used by: Embedded Symbol, Canvas

Can be read by script at run time: No

Info: Size Propagation and Anchor Points

AnchorPoint* Purpose: Defines the anchor X, Y location of the embedded graphic.

Category: Appearance

Used by: Embedded Symbol

Can be read by script at run time: No

Info: Size Propagation and Anchor Points
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Property Purpose, category, usage and further information

Angle Purpose: Defines the current angle of rotation of the element. 0 is
always the top of the element relative to the canvas. Angle is always
determined relative to the top of the element and rotates in a
clockwise direction.

Category: Appearance

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Line, H/V
Line, Polyline, Curve, 2 Point Arc, 3 Point Arc, Button, Text, Text Box,
Image, Status, Group, Embedded Symbol

Can be read by script at run time: Yes

Info: Rotating Elements by Changing the Angle Property

AutoScale Purpose: If this property is set to True then the text is stretched
horizontally and vertically (larger or smaller) to fit the bounding
rectangle.

Category: Appearance

Used by: Button, Text Box

Can be read by script at run time: Yes

Info: Setting Auto Scaling and Word Wrapping for a Text Box

ButtonStyle* Purpose: Determines if the button appears as a standard button or as
an image.

Category: Appearance

Used by: Button

Can be read by script at run time: No

Info: Configuring Buttons with Images

CalendarColumns* Purpose: Defines the number of columns the calendar object has.

Category: Appearance

Used by: Calendar

Can be read by script at run time: No

Info: Setting the Number of Calendar Month Sheets

CalendarRows* Purpose: Defines the number of rows the calendar object has.

Category: Appearance

Used by: Calendar

Can be read by script at run time: No

Info: Setting the Number of Calendar Month Sheets
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Property Purpose, category, usage and further information

Caption* Purpose: Defines the text shown on the Check Box at design time and
at run time when the caption property is not bound to a reference in
the checkbox animation panel.

Category: Text Style

Used by: Check Box

Can be read by script at run time: No

Info: Setting the Caption Text of a Check Box Control

Checked* Purpose: Sets or gets the value of check box. This is the initial value of
the check box when the control is not connected to a reference and is
overridden at run time with value of reference.

Category: Appearance

Used by: Check Box

Can be read by script at run time: Yes

Info: Setting the Default State of a Check Box Control

.Color1 Purpose: Color1 is a sub-property of a FillColor, UnfilledColor,
LineColor or TextColor property. It is used to change the first color of
the fill, unfill, line or text style if applicable.

Category: Depends on its source property

Used by: Depends on its source property

Can be read by script at run time: No

Info: Enabling and Disabling Elements for Run-Time Interaction

.Color2 Purpose: Color2 is a sub-property of a FillColor, UnfilledColor,
LineColor or TextColor property. It is used to change the second color
of the fill, unfill, line or text style if applicable.

Category: Depends on its source property

Used by: Depends on its source property

Can be read by script at run time: No

Info: Enabling and Disabling Elements for Run-Time Interaction
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.Color3 Purpose: Color3 is a sub-property of a FillColor, UnfilledColor,
LineColor or TextColor property. It is used to change the third color of
the fill, unfill, line or text style if applicable.

Category: Depends on its source property

Used by: Depends on its source property

Can be read by script at run time: No

Info: Enabling and Disabling Elements for Run-Time Interaction

ControlStyle Purpose: Defines the control style as Flat or 3D.

Category: Appearance

Used by: Radio Button Group, Check Box

Can be read by script at run time: No

Info: Setting the Layout of the Radio Button Group Options and Setting
the 3D appearance of a Check Box Control

Count Purpose: Indicates how many items there are in a list.

Category: not available at design time

Used by: Radio Button Group, Combo Box, List Box

Can be read by script at run time: Yes

Info: Using Radio Button Group-Specific Properties at Run Time, Using
Combo Box-Specific Properties at Run Time and Using List Box-Specific
Properties at Run Time

CustomFormat* Purpose: Defines the format to be used in the DateTime Picker control
for input of a date or time.***inappropriateUI***

Category: Appearance

Used by: DateTime Picker

Can be read by script at run time: No

Info: Configuring DateTime Picker Controls

CustomProperties Purpose: The collection of CustomProperties defined by the graphic.

Category: Custom Properties

Used by: Canvas, Embedded Symbol

Can be read by script at run time: No

Info: Using Custom Properties
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Description* Purpose: Contains a meaningful description of the graphic.

Category: Graphic

Used by: Canvas

Can be read by script at run time: No

Info: Setting the Radius of Rounded Rectangles

DefaultValue Purpose: The default time value to use for the control.

Category: Appearance

Used by: Calendar, DateTime Picker

Can be read by script at run time: No

Info: Setting the Default Value of the Calendar Control and Configuring
DateTime Picker Controls

DownImage* Purpose: Defines the image that is rendered in the button element
when it is clicked or held down.

Category: Appearance

Used by: Button

Can be read by script at run time: No

Info: Configuring Buttons with Images

DropDownType* Purpose: Defines the type of combo box: simple, drop-down or drop-
down list.

Category: Appearance

Used by: Combo Box

Can be read by script at run time: No

Info: Setting the Type of Combo Box Control

DropDownWidth* Purpose: Defines the width of the drop-down list.

Category: Appearance

Used by: Combo Box

Can be read by script at run time: No

Info: Setting the Width of the Drop-Down List
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DynamicSizeChange* Purpose: Determines if the embedded graphic propagates the size
changes from the source graphic.

Category: Appearance

Used by: Embedded Symbol

Can be read by script at run time: No

Info: Enabling or Disabling Dynamic Size Change of Embedded
Graphics

Enabled Purpose: When set to True enables the element at run time and allows
the user to interact with it. If the property is set to False the user
cannot use the mouse or keyboard to interact with the element. Data
changes as a result of an animation or script still execute.

Category: Runtime Behavior

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Line, H/V
Line, Polyline, Curve, 2 Point Arc, 3 Point Arc, Button, Text, Text Box,
Image, Radio Button Group, Check Box, Edit Box, Combo Box, Calendar,
DateTime Picker, List Box, Group, Path, Embedded Symbol

Can be read by script at run time: Yes

Info: Enabling and Disabling Elements for Run-Time Interaction

End Purpose: Defines the end of a line or H/V line as X, Y location.

Category: Appearance

Used by: Line, H/V Line

Can be read by script at run time: No

Info: Setting Start or End Points of a Line

EndCap Purpose: Defines the cap used at the end of the line of an open
element.

Category: Line Style

Used by: Line, H/V Line, Polyline, Curve, 2 Point Arc, 3 Point Arc

Can be read by script at run time: No

Info: Setting Line End Shape and Size
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FillBehavior Purpose: Determines how the Fill (Horizontal, Vertical or Both) can be
applied to the element.

Category: Fill Style

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Button,
Text Box, Path

Can be read by script at run time: No

Info: Setting Fill Behavior

FillColor Purpose: Defines the fill style used for the filled portion of the
element.

Category: Fill Style

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Button,
Text Box, Radio Button Group, Check Box, Edit Box, Combo Box,
Calendar, List Box, Path

Can be read by script at run time: No

Info: Setting Fill Style and Changing Background Color and Text Color of
Windows Common Controls

FillOrientation Purpose: Determines the orientation of the fill when the element
orientation is any value other than 0.

Category: Fill Style

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Button,
Text Box, Path

Can be read by script at run time: No

Info: Setting Fill Orientation

FirstDayOfWeek* Purpose: Defines the first day of the week used for the display of the
columns in the calendar.

Category: Appearance

Used by: Calendar

Can be read by script at run time: No

Info: Setting the First Day of the Week
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Font Purpose: Defines the basic text font as defined by the operating
system.

Category: Text Style

Used by: Button, Text, Text Box, Radio Button Group, Check Box, Edit
Box, Combo Box, Calendar, DateTime Picker, List Box

Can be read by script at run time: No

Info: Setting the Text Font

Format* Purpose: Defines the format of the reference values. This is only
available for array mode.

Category: Appearance

Used by: DateTime Picker

Can be read by script at run time: No

Info: Configuring DateTime Picker Controls

HasTransparentColor* Purpose: Indicates whether or not the image applies a transparent
color. If True the image is rendered transparent wherever a color in the
image matches the TransparentColor property.

Category: Appearance

Used by: Image

Can be read by script at run time: Yes

Info: Setting the Image Color Transparency

Height Purpose: Defines the height of the element.

Category: Appearance

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Line, H/V
Line, Polyline, Curve, 2 Point Arc, 3 Point Arc, Button, Text, Text Box,
Image, Status, Radio Button Group, Check Box, Edit Box, Combo Box,
Calendar, DateTime Picker, List Box, Group, Path, Embedded Symbol

Can be read by script at run time: Yes

Info: Resizing Elements by Changing Size Properties
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HorizontalDirection Purpose: Determines the horizontal direction of the fill for the
element. Can be "Right" or "Left".

Category: Fill Style

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Button,
Text Box, Path

Can be read by script at run time: No

Info: Setting Horizontal Fill Direction and Percentage

HorizontalPercentFill Purpose: Determines the percentage of horizontal fill for the element.

Category: Fill Style

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Button,
Text Box, Path

Can be read by script at run time: Yes

Info: Setting Horizontal Fill Direction and Percentage

HorizontalScrollbar Purpose: Determines if a horizontal scroll bar appears on a list box
control to allow the user to scroll the list box items horizontally.

Category: Appearance

Used by: List Box

Can be read by script at run time: No

Info: Using a Horizontal Scroll Bar in a List Box Control

Image* Purpose: Defines the image that is rendered in the element. Any image
format supported by the application can be used.

Category: Appearance

Used by: Image

Can be read by script at run time: No

Info: Selecting a Different Image

ImageAlignment* Purpose: Controls the location of the image relative to the bounding
rectangle of the graphic. This property is only applicable when the
ImageStyle is set to Normal.

Category: Appearance

Used by: Image

Can be read by script at run time: No

Info: Setting the Image Alignment
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ImageStyle Purpose: Defines how the image is rendered relative to its bounding
rectangle.

Category: Appearance

Used by: Button, Image

Can be read by script at run time: No

Info: Setting the Image Display Mode

IntegralHeight Purpose: Determines if the List Box size is an integral multiple of the
Font Size so that a finite number of items fit in it without being
clipped.

Category: Appearance

Used by: Combo Box, List Box

Can be read by script at run time: No

Info: Avoiding Clipping of Items in the Simple Combo Box Control

Language Purpose: Defines the current language of the graphic.

Category: Runtime Behavior

Used by: Embedded Symbol

Can be read by script at run time: Yes

Info: Selecting a Language for a Graphic.

LanguageID Purpose: Defines the current language ID of the graphic.

Category: Runtime Behavior

Used by: Embedded Symbol

Can be read by script at run time: Yes

Info: Selecting a Language for a Graphic.

Layout* Purpose: Defines the way the radio buttons are arranged in the group
(Horizontal or Vertical).

Category: Appearance

Used by: Radio Button Group

Can be read by script at run time: No

Info: Setting the Layout of the Radio Button Group Options
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LineColor Purpose: Defines the color and affects of the line or border.

Category: Line Style

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Line, H/V
Line, Polyline, Curve, 2 Point Arc, 3 Point Arc, Text Box, Path

Can be read by script at run time: No

Info: Setting the Line Style

LinePattern Purpose: Defines the pattern of the line or border.

Category: Line Style

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Line, H/V
Line, Polyline, Curve, 2 Point Arc, 3 Point Arc, Text Box, Path

Can be read by script at run time: No

Info: Setting the Line Pattern

LineWeight Purpose: Determines the weight of the element’s line or border. A
value of 0 means that there is no line or border.

Category: Line Style

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Line, H/V
Line, Polyline, Curve, 2 Point Arc, 3 Point Arc, Text Box, Path

Can be read by script at run time: Yes

Info: Setting the Line Weight

Locked Purpose: Locks or unlocks the element’s size, position, orientation and
origin. Other properties that can have an affect on element size,
position, orientation and origin are also locked. These are element-
specific.

Category: Appearance

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Line, H/V
Line, Polyline, Curve, 2 Point Arc, 3 Point Arc, Button, Text, Text Box,
Image, Status, Radio Button Group, Check Box, Edit Box, Combo Box,
Calendar, DateTime Picker, List Box, Group, Path, Embedded Symbol

Can be read by script at run time: Yes

Info: Locking and Unlocking Elements
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MaxDropDownItems* Purpose: Defines the maximum number of items the drop-down list
shows.

Category: Appearance

Used by: Combo Box

Can be read by script at run time: No

Info: Setting the Maximum Number of Items to Appear in the Combo
Box Drop-Down List

Multiline* Purpose: Determines if the control shows several lines of text that
automatically wrap up when reaching the right border of the control.

Category: Appearance

Used by: Edit Box

Can be read by script at run time: No

Info: Configuring the Text to Wrap in an Edit Box Control

MultiplePopupsAllowed* Purpose: If False, ShowSymbol animations only show within a single
dialog window no matter how many animations are invoked and
regardless of how the animations are configured. If True, ShowSymbol
animations show in separate dialog windows.

Category: Runtime Behavior

Used by: Canvas

Can be read by script at run time: No

Info: Setting the Radius of Rounded Rectangles

Name Purpose: Gives the element a meaningful unique name.

Category: Graphic

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Line, H/V
Line, Polyline, Curve, 2 Point Arc, 3 Point Arc, Button, Text, Text Box,
Image, Status, Radio Button Group, Check Box, Edit Box, Combo Box,
Calendar, DateTime Picker, List Box, Embedded Symbol, Path

Can be read by script at run time: No

Info: Setting the Radius of Rounded Rectangles
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NewIndex Purpose: Returns the index of the last value added to the list. This is
provided for migration of HMI application windows common controls.

Category: not available at design time

Used by: Combo Box, List Box

Can be read by script at run time: Yes

Info: Using Combo Box-Specific Properties at Run Time and Using List
Box-Specific Properties at Run Time

OwningObject* Purpose: Used as the object reference to replace all "Me." references
in expressions and scripts. Everywhere there is a "Me." reference this
object reference is used instead. The object name can be set either
using a tag or hierarchical name of an AutomationObject.

Category: Runtime Behavior

Used by: Embedded Symbol

Can be read by script at run time: Yes

Info: Detecting and Editing the Containing Object Instance

Radius* Purpose: Defines the radius of the corners of the Rounded Rectangle.

Category: Appearance

Used by: Rounded Rectangle

Can be read by script at run time: Yes

Info: Setting the Radius of Rounded Rectangles

ReadOnly* Purpose: Determines if the user can type data into the edit box.

Category: Appearance

Used by: Edit Box

Can be read by script at run time: No

Info: Configuring the Text to be Read-Only in an Edit Box Control

RelativeAnchor* Purpose: Relative anchor point of the source graphic. By default, this is
0,0.

Category: Appearance

Used by: Canvas

Can be read by script at run time: No

Info: Size Propagation and Anchor Points
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RelativeOrigin Purpose: Defines the relative origin as X, Y location. The location is
relative to the center point of the element (0, 0).

Category: Appearance

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Line, H/V
Line, Polyline, Curve, 2 Point Arc, 3 Point Arc, Button, Text, Text Box,
Image, Status, Group, Path, Embedded Symbol

Can be read by script at run time: No

Info: Changing Points of Origin in the Properties Editor

Scripts* Purpose: Defines a collection of scripts configured for the graphic.

Category: Runtime Behavior

Used by: Canvas

Can be read by script at run time: No

Info: Adding and Maintaining Graphic Scripts

SelectedValue Purpose: Reads the value of the selected item, or selects the item with
that value if it exists.

Category: not available at design time

Used by: Radio Button Group, List Box

Can be read by script at run time: Yes

Info: Using Radio Button Group-Specific Properties at Run Time and
Using List Box-Specific Properties at Run Time

ShowToday* Purpose: Determines if today's date is shown on the calendar control.

Category: Appearance

Used by: Calendar

Can be read by script at run time: No

Info: Showing or Hiding Today’s Date on a Calendar Control

Smoothing* Purpose: When False the graphics are rendered normally, when True
graphics are rendered with anti-aliasing which produces a smoother
appearing graphic.

Category: Appearance

Used by: Canvas

Can be read by script at run time: No

Info: Setting the Radius of Rounded Rectangles
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Start Purpose: Defines the start of a line or H/V line as X, Y location.

Category: Appearance

Used by: Line, H/V Line

Can be read by script at run time: No

Info: Setting Start or End Points of a Line

StartAngle Purpose: Defines the starting angle of an Arc, Pie or Chord. 0 is always
the top of the graphic relative to its orientation. A positive number is
clockwise from 0 and a negative number is counter clockwise from 0. If
a negative number is used to set the property it is automatically
converted to a positive value.

Category: Appearance

Used by: 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, 2 Point
Arc, 3 Point Arc

Can be read by script at run time: Yes

Info: Changing Angles of Arcs, Pies and Chords

StartCap Purpose: Defines the cap used at the start of the line of an open
graphic.

Category: Line Style

Used by: Line, H/V Line, Polyline, Curve, 2 Point Arc, 3 Point Arc

Can be read by script at run time: No

Info: Setting Line End Shape and Size

SweepAngle Purpose: Defines the ending angle of the Arc, Pie or Chord. This angle
is always measured from the start angle.

Category: Appearance

Used by: 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, 2 Point
Arc, 3 Point Arc

Can be read by script at run time: Yes

Info: Changing Angles of Arcs, Pies and Chords
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SymbolReference* Purpose: Contains the exact location that the embedded graphic is
linked to. This can help the user in locating the original definition for
editing purposes.

This property is always disabled.

Category: Runtime Behavior

Used by: Embedded Symbol

Can be read by script at run time: No

Info: Detecting the Source Graphic of an Embedded Graphic

TabOrder Purpose: Defines the tab order for the element. The tab order is only
used when navigating by the keyboard. This property is valid only
when the TabStop property is set to true.

Category: Runtime Behavior

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Line, H/V
Line, Polyline, Curve, 2 Point Arc, 3 Point Arc, Button, Text, Text Box,
Image, Radio Button Group, Check Box, Edit Box, Combo Box, Calendar,
DateTime Picker, List Box, Group, Path, Embedded Symbol

Can be read by script at run time: No

Info: Editing the Tab Order of an Element

TabStop Purpose: Determines if the element can be navigated to and can
receive focus at run time.

Category: Runtime Behavior

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Line, H/V
Line, Polyline, Curve, 2 Point Arc, 3 Point Arc, Button, Text, Text Box,
Image, Radio Button Group, Check Box, Edit Box, Combo Box, Calendar,
DateTime Picker, List Box, Group, Path, Embedded Symbol

Can be read by script at run time: No

Info: Editing the Tab Order of an Element

Tension Purpose: Specifies how tightly the curve bends through the control
points of the curve.

Category: Appearance

Used by: Closed Curve, Curve

Can be read by script at run time: Yes

Info: Changing the Tension of Curves and Closed Curves
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Text Purpose: Defines the unicode text that is shown by the element.

Category: Appearance

Used by: Button, Text, Text Box, Edit Box

Can be read by script at run time: Yes

Info: Setting the Displayed Text

TextColor Purpose: Defines the color and affects applied to the text.

Category: Text Style

Used by: Button, Text, Text Box, Radio Button Group, Check Box, Edit
Box, Combo Box, Calendar

Can be read by script at run time: No

Info: Setting the Text Color and Changing Background Color and Text
Color of Windows Common Controls

TextFormat Purpose: Defines the formatting string that is applied to the text when
it is shown.

Category: Appearance

Used by: Button, Text, Text Box

Can be read by script at run time: Yes

Info: Setting the Text Display Format

TitleFillColor* Purpose: Determines the background solid color in the title bar of the
calendar control.

Category: Fill Style

Used by: Calendar

Can be read by script at run time: No

Info: Setting Title Fill Color and Text Color on a Calendar Control

TitleTextColor* Purpose: Determines the text solid color in the title bar of the calendar
control.

Category: Text Style

Used by: Calendar

Can be read by script at run time: No

Info: Setting Title Fill Color and Text Color on a Calendar Control
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TopIndex* Purpose: Returns the index of the top most item in the list. This is
provided for migration of HMI application windows common controls.

Category: not available at design time

Used by: List Box

Can be read by script at run time: Yes

Info: Using List Box-Specific Properties at Run Time

TrailingTextColor* Purpose: Determines the text solid color of the text for the trailing
days. The trailing days are days outside the current month.

Category: Text Style

Used by: Calendar

Can be read by script at run time: No

Info: Setting the Text Color for Trailing Dates in a Calendar Control

Transparency Purpose: Defines the transparency of the element. A value of 0 means
fully opaque and a value of 100 means fully transparent.

Category: Appearance

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Line, H/V
Line, Polyline, Curve, 2 Point Arc, 3 Point Arc, Button, Text, Text Box,
Image, Group, Path, Embedded Symbol

Can be read by script at run time: Yes

Info: Setting the Transparency Level of an Element

.Transparency Purpose: Transparency is a sub-property of a FillColor, UnfilledColor,
LineColor or TextColor property. It is used to change the transparency
of the fill, unfill, line or text style if applicable. The transparency acts in
addition to the transparency of the element.

Category: Depends on its source property

Used by: Depends on its source property

Can be read by script at run time: No

Info: Enabling and Disabling Elements for Run-Time Interaction
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TransparentColor* Purpose: Defines the RGB color value that is used as the transparent
color.

Category: Appearance

Used by: Image

Can be read by script at run time: No

Info: Setting the Image Color Transparency

TreatAsIcon Purpose: If this property is set to False, the animations defined on the
graphics within the group or embedded graphic take precedence over
an animation defined on the group or embedded graphic. If there are
no animations or the user clicked on an area of the group or
embedded graphic that does not have an animation, then the group or
embedded graphic animation executes.

If the property is set to True, only the animation on the group or
embedded graphic is executed. The interactive animations within the
group or embedded graphic never execute.

Category: Runtime Behavior

Used by: Group, Embedded Symbol

Can be read by script at run time: Yes

Info: Editing the Embedded Graphic

UnFilledColor Purpose: Determines the element's unfilled area appearance.

Category: Fill Style

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Button,
Text Box, Path

Can be read by script at run time: No

Info: Setting Unfilled Style

UpImage* Purpose: Defines the image that is used in the button element when it
is un-clicked or released.

Category: Appearance

Used by: Button

Can be read by script at run time: No

Info: Configuring Buttons with Images
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Value Purpose: Reads the value of the selected item, or selects the item with
that value if it exists. Its data type depends on the control.

Category: not available at design time

Used by: Radio Button Group, Check Box, Edit Box, Combo Box,
Calendar, DateTime Picker, List Box

Can be read by script at run time: Yes

Info: Reading and Writing the Selected Value at Run Time

VerticalDirection Purpose: Defines the vertical direction of the fill. Can be "Top" or
"Bottom".

Category: Fill Style

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Button,
Text Box, Path

Can be read by script at run time: No

Info: Setting Vertical Fill Direction and Percentage

VerticalPercentFill Purpose: Determines the percentage of vertical fill for the element.

Category: Fill Style

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Button,
Text Box, Path

Can be read by script at run time: Yes

Info: Setting Vertical Fill Direction and Percentage

Visible Purpose: Determines the visibility of the element. This property is
configured at design time and used only at runtime. At design time all
elements are visible irrespective of this setting.

Category: Runtime Behavior

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Line, H/V
Line, Polyline, Curve, 2 Point Arc, 3 Point Arc, Button, Text, Text Box,
Image, Radio Button Group, Check Box, Edit Box, Combo Box, Calendar,
DateTime Picker, List Box, Group, Path, Embedded Symbol

Can be read by script at run time: Yes

Info: Changing the Visibility of Elements
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Width Purpose: Defines the width of the element.

Category: Appearance

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Line, H/V
Line, Polyline, Curve, 2 Point Arc, 3 Point Arc, Button, Text, Text Box,
Image, Status, Radio Button Group, Check Box, Edit Box, Combo Box,
Calendar, DateTime Picker, List Box, Group, Path, Embedded Symbol

Can be read by script at run time: Yes

Info: Resizing Elements by Changing Size Properties

WordWrap Purpose: When set to True, the text in the button or text box is
formatted to fit as much text on a single line within the horizontal
bounding area of the element and then continued to the next line. This
continues as long as there is vertical space.

Category: Appearance

Used by: Button, Text Box

Can be read by script at run time: Yes

Info: Wrapping Text in Buttons

X Purpose: Defines the left position of the element.

Category: Appearance

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Line, H/V
Line, Polyline, Curve, 2 Point Arc, 3 Point Arc, Button, Text, Text Box,
Image, Status, Radio Button Group, Check Box, Edit Box, Combo Box,
Calendar, DateTime Picker, List Box, Group, Path, Embedded Symbol

Can be read by script at run time: Yes

Info: Moving Elements

Y Purpose: Defines the top position of the element.

Category: Appearance

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Line, H/V
Line, Polyline, Curve, 2 Point Arc, 3 Point Arc, Button, Text, Text Box,
Image, Status, Radio Button Group, Check Box, Edit Box, Combo Box,
Calendar, DateTime Picker, List Box, Group, Path, Embedded Symbol

Can be read by script at run time: Yes

Info: Moving Elements
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List by Functional Area
Each property of the elements, the canvas, element groups and embedded objects belongs to one of the
following property categories:

• Graphic•

• Appearance•

• Fill Style•

• Line Style•

• Text Style•

• Runtime Behavior•

• Custom Properties•

Graphic Category Properties
The following table contains a list of properties in the Graphic property category used by the:

• Elements.•

• Canvas.•

• Element groups.•

• Embedded graphics.•

It shows their purpose, where they are used and where to find more information on how to use them.

An asterisk (*) identifies properties that are specific to only one type of element or the canvas, a group or an
embedded graphic.

Property Purpose, category, usage and further information

Description* Purpose: Contains a meaningful description of the graphic.

Category: Graphic

Used by: Canvas

Can be read by script at run time: No

Info: Setting the Radius of Rounded Rectangles
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Property Purpose, category, usage and further information

Name Purpose: Gives the element a meaningful unique name.

Category: Graphic

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Line, H/V
Line, Polyline, Curve, 2 Point Arc, 3 Point Arc, Button, Text, Text Box,
Image, Status, Radio Button Group, Check Box, Edit Box, Combo Box,
Calendar, DateTime Picker, List Box, Embedded Symbol, Path

Can be read by script at run time: No

Info: Setting the Radius of Rounded Rectangles

Appearance Category Properties
The following table contains a list of properties in the Appearance property category used by the:

• Elements.•

• Canvas.•

• Element groups.•

• Embedded graphics.•

It shows their purpose, where they are used and where to find more information on how to use them.

Asterisk (*) marks properties that are specific to only one type of element or the canvas, a group or an
embedded graphic.

Property Purpose, category, usage and further information

AbsoluteAnchor* Purpose: Defines the absolute anchor point of the source graphic. By
default, this is the center point of all elements on the canvas but can
be changed.

Category: Appearance

Used by: Canvas

Can be read by script at run time: No

Info: Size Propagation and Anchor Points
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Property Purpose, category, usage and further information

AnchorFixedTo Purpose: Determines if the anchor point is fixed to the canvas when
you resize, delete, or add elements (Absolute), or if the anchor point is
recalculated relative to the element sizes and positions (Relative).

Category: Appearance

Used by: Embedded Symbol, Canvas

Can be read by script at run time: No

Info: Size Propagation and Anchor Points

AbsoluteOrigin Purpose: Defines an X, Y location relative to the top, left (0, 0) origin of
the graphic or window.

Category: Appearance

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Line, H/V
Line, Polyline, Curve, 2 Point Arc, 3 Point Arc, Button, Text, Text Box,
Image, Status, Embedded Symbol, Group, Path, Radio Button Group,
Check Box, Edit Box, Combo Box, Calendar, DateTime Picker, List Box.

Can be read by script at run time: No

Info: Changing Points of Origin in the Properties Editor

AnchorPoint* Purpose: Defines the anchor X, Y location of the embedded graphic.

Category: Appearance

Used by: Embedded Symbol

Can be read by script at run time: No

Info: Size Propagation and Anchor Points

Angle Purpose: Defines the current angle of rotation of the element. 0 is
always the top of the element relative to the canvas. Angle is always
determined relative to the top of the element and rotates in a
clockwise direction.

Category: Appearance

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Line, H/V
Line, Polyline, Curve, 2 Point Arc, 3 Point Arc, Button, Text, Text Box,
Image, Status, Group, Embedded Symbol

Can be read by script at run time: Yes

Info: Rotating Elements by Changing the Angle Property
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Property Purpose, category, usage and further information

AutoScale Purpose: If this property is set to True then the text is stretched
horizontally and vertically (larger or smaller) to fit the bounding
rectangle.

Category: Appearance

Used by: Button, Text Box

Can be read by script at run time: Yes

Info: Setting Auto Scaling and Word Wrapping for a Text Box

ButtonStyle* Purpose: Determines if the button appears as a standard button or as
an image.

Category: Appearance

Used by: Button

Can be read by script at run time: No

Info: Configuring Buttons with Images

CalendarColumns* Purpose: Defines the number of columns the calendar object has.

Category: Appearance

Used by: Calendar

Can be read by script at run time: No

Info: Setting the Number of Calendar Month Sheets

CalendarRows* Purpose: Defines the number of rows the calendar object has.

Category: Appearance

Used by: Calendar

Can be read by script at run time: No

Info: Setting the Number of Calendar Month Sheets

Checked* Purpose: Sets or gets the value of check box. This is the initial value of
the check box when the control is not connected to a reference and is
overridden at run time with value of reference.

Category: Appearance

Used by: Check Box

Can be read by script at run time: Yes

Info: Setting the Default State of a Check Box Control

© 2022 AVEVA Group plc and its subsidiaries. All rights reserved.
  

Page 344

AVEVA™ Industrial Graphic Editor User Guide 
Appendix A – List of Element Properties



Property Purpose, category, usage and further information

ControlStyle Purpose: Defines the control style as Flat or 3D.

Category: Appearance

Used by: Radio Button Group, Check Box

Can be read by script at run time: No

Info: Setting the Layout of the Radio Button Group Options and Setting
the 3D appearance of a Check Box Control

CustomFormat* Purpose: Defines the format to be used in the DateTime Picker control
for input of a date or time.

Category: Appearance

Used by: DateTime Picker

Can be read by script at run time: No

Info: Configuring DateTime Picker Controls

DefaultValue Purpose: The default time value to use for the control.

Category: Appearance

Used by: Calendar, DateTime Picker

Can be read by script at run time: No

Info: Setting the Default Value of the Calendar Control and Configuring
DateTime Picker Controls

DownImage* Purpose: Defines the image that is rendered in the button element
when it is clicked or held down.

Category: Appearance

Used by: Button

Can be read by script at run time: No

Info: Configuring Buttons with Images

DropDownType* Purpose: Defines the type of combo box: simple, drop-down or drop-
down list.

Category: Appearance

Used by: Combo Box

Can be read by script at run time: No

Info: Setting the Type of Combo Box Control
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Property Purpose, category, usage and further information

DropDownWidth* Purpose: Defines the width of the drop-down list.

Category: Appearance

Used by: Combo Box

Can be read by script at run time: No

Info: Setting the Width of the Drop-Down List

DynamicSizeChange* Purpose: Determines if the embedded graphic propagates the size
changes from the source graphic.

Category: Appearance

Used by: Embedded Symbol

Can be read by script at run time: No

Info: Enabling or Disabling Dynamic Size Change of Embedded
Graphics

End Purpose: Defines the end of a line or H/V line as X, Y location.

Category: Appearance

Used by: Line, H/V Line

Can be read by script at run time: No

Info: Setting Start or End Points of a Line

FirstDayOfWeek* Purpose: Defines the first day of the week used for the display of the
columns in the calendar.

Category: Appearance

Used by: Calendar

Can be read by script at run time: No

Info: Setting the First Day of the Week

Format* Purpose: Defines the format of the reference values. This is only
available for array mode.

Category: Appearance

Used by: DateTime Picker

Can be read by script at run time: No

Info: Configuring DateTime Picker Controls
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Property Purpose, category, usage and further information

HasTransparentColor* Purpose: Indicates whether or not the image applies a transparent
color. If True the image is rendered transparent wherever a color in the
image matches the TransparentColor property.

Category: Appearance

Used by: Image

Can be read by script at run time: Yes

Info: Setting the Image Color Transparency

Height Purpose: Defines the height of the element.

Category: Appearance

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Line, H/V
Line, Polyline, Curve, 2 Point Arc, 3 Point Arc, Button, Text, Text Box,
Image, Status, Radio Button Group, Check Box, Edit Box, Combo Box,
Calendar, DateTime Picker, List Box, Group, Path, Embedded Symbol

Can be read by script at run time: Yes

Info: Resizing Elements by Changing Size Properties

HorizontalScrollbar Purpose: Determines if a horizontal scroll bar appears on a list box
control to allow the user to scroll the list box items horizontally.

Category: Appearance

Used by: List Box

Can be read by script at run time: No

Info: Using a Horizontal Scroll Bar in a List Box Control

Image* Purpose: Defines the image that is rendered in the element. Any image
format supported by the application can be used.

Category: Appearance

Used by: Image

Can be read by script at run time: No

Info: Selecting a Different Image
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Property Purpose, category, usage and further information

ImageAlignment* Purpose: Controls the location of the image relative to the bounding
rectangle of the graphic. This property is only applicable when the
ImageStyle is set to Normal.

Category: Appearance

Used by: Image

Can be read by script at run time: No

Info: Setting the Image Alignment

ImageStyle Purpose: Defines how the image is rendered relative to its bounding
rectangle.

Category: Appearance

Used by: Button, Image

Can be read by script at run time: No

Info: Setting the Image Display Mode

IntegralHeight Purpose: Determines if the List Box size is an integral multiple of the
Font Size so that a finite number of items fit in it without being
clipped.

Category: Appearance

Used by: Combo Box, List Box

Can be read by script at run time: No

Info: Avoiding Clipping of Items in the Simple Combo Box Control

Layout* Purpose: Defines the way the radio buttons are arranged in the group
(Horizontal or Vertical).

Category: Appearance

Used by: Radio Button Group

Can be read by script at run time: No

Info: Setting the Layout of the Radio Button Group Options

© 2022 AVEVA Group plc and its subsidiaries. All rights reserved.
  

Page 348

AVEVA™ Industrial Graphic Editor User Guide 
Appendix A – List of Element Properties



Property Purpose, category, usage and further information

Locked Purpose: Locks or unlocks the element’s size, position, orientation and
origin. Other properties that can have an affect on element size,
position, orientation and origin are also locked. These are element-
specific.

Category: Appearance

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Line, H/V
Line, Polyline, Curve, 2 Point Arc, 3 Point Arc, Button, Text, Text Box,
Image, Status, Radio Button Group, Check Box, Edit Box, Combo Box,
Calendar, DateTime Picker, List Box, Group, Path, Embedded Symbol

Can be read by script at run time: Yes

Info: Locking and Unlocking Elements

MaxDropDownItems* Purpose: Defines the maximum number of items the drop-down list
shows.

Category: Appearance

Used by: Combo Box

Can be read by script at run time: No

Info: Setting the Maximum Number of Items to Appear in the Combo
Box Drop-Down List

Multiline* Purpose: Determines if the control shows several lines of text that
automatically wrap up when reaching the right border of the control.

Category: Appearance

Used by: Edit Box

Can be read by script at run time: No

Info: Configuring the Text to Wrap in an Edit Box Control

Radius* Purpose: Defines the radius of the corners of the Rounded Rectangle.

Category: Appearance

Used by: Rounded Rectangle

Can be read by script at run time: Yes

Info: Setting the Radius of Rounded Rectangles
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Property Purpose, category, usage and further information

ReadOnly* Purpose: Determines if the user can type data into the edit box.

Category: Appearance

Used by: Edit Box

Can be read by script at run time: No

Info: Configuring the Text to be Read-Only in an Edit Box Control

RelativeAnchor* Purpose: Relative anchor point of the source graphic. By default, this is
0,0.

Category: Appearance

Used by: Canvas

Can be read by script at run time: No

Info: Size Propagation and Anchor Points

RelativeOrigin Purpose: Defines the relative origin as X, Y location. The location is
relative to the center point of the element (0, 0).

Category: Appearance

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Line, H/V
Line, Polyline, Curve, 2 Point Arc, 3 Point Arc, Button, Text, Text Box,
Image, Status, Group, Path, Embedded Symbol

Can be read by script at run time: No

Info: Changing Points of Origin in the Properties Editor

ShowToday* Purpose: Determines if today's date is shown on the calendar control.

Category: Appearance

Used by: Calendar

Can be read by script at run time: No

Info: Showing or Hiding Today’s Date on a Calendar Control

Smoothing* Purpose: When False the graphics are rendered normally, when True
graphics are rendered with anti-aliasing which produces a smoother
appearing graphic.

Category: Appearance

Used by: Canvas

Can be read by script at run time: No

Info: Setting the Radius of Rounded Rectangles
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Property Purpose, category, usage and further information

Start Purpose: Defines the start of a line or H/V line as X, Y location.

Category: Appearance

Used by: Line, H/V Line

Can be read by script at run time: No

Info: Setting Start or End Points of a Line

StartAngle Purpose: Defines the starting angle of an Arc, Pie or Chord. 0 is always
the top of the graphic relative to its orientation. A positive number is
clockwise from 0 and a negative number is counter clockwise from 0. If
a negative number is used to set the property it is automatically
converted to a positive value.

Category: Appearance

Used by: 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, 2 Point
Arc, 3 Point Arc

Can be read by script at run time: Yes

Info: Changing Angles of Arcs, Pies and Chords

SweepAngle Purpose: Defines the ending angle of the Arc, Pie or Chord. This angle
is always measured from the start angle.

Category: Appearance

Used by: 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, 2 Point
Arc, 3 Point Arc

Can be read by script at run time: Yes

Info: Changing Angles of Arcs, Pies and Chords

Tension Purpose: Specifies how tightly the curve bends through the control
points of the curve.

Category: Appearance

Used by: Closed Curve, Curve

Can be read by script at run time: Yes

Info: Changing the Tension of Curves and Closed Curves

Text Purpose: Defines the unicode text that is shown by the element.

Category: Appearance

Used by: Button, Text, Text Box, Edit Box

Can be read by script at run time: Yes

Info: Setting the Displayed Text
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Property Purpose, category, usage and further information

TextFormat Purpose: Defines the formatting string that is applied to the text when
it is shown.

Category: Appearance

Used by: Button, Text, Text Box

Can be read by script at run time: Yes

Info: Setting the Text Display Format

Transparency Purpose: Defines the transparency. A value of 0 means fully opaque
and a value of 100 means fully transparent.

Category: Appearance

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Line, H/V
Line, Polyline, Curve, 2 Point Arc, 3 Point Arc, Button, Text, Text Box,
Image, Group, Path, Embedded Symbol

Can be read by script at run time: Yes

Info: Setting the Transparency Level of an Element

TransparentColor* Purpose: Defines the RGB color value that is used as the transparent
color.

Category: Appearance

Used by: Image

Can be read by script at run time: No

Info: Setting the Image Color Transparency

UpImage* Purpose: Defines the image that is used in the button element when it
is un-clicked or released.

Category: Appearance

Used by: Button

Can be read by script at run time: No

Info: Configuring Buttons with Images

Width Purpose: Defines the width of the element.

Category: Appearance

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Line, H/V
Line, Polyline, Curve, 2 Point Arc, 3 Point Arc, Button, Text, Text Box,
Image, Status, Radio Button Group, Check Box, Edit Box, Combo Box,
Calendar, DateTime Picker, List Box, Group, Path, Embedded Symbol

Can be read by script at run time: Yes
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Property Purpose, category, usage and further information

Info: Resizing Elements by Changing Size Properties

WordWrap Purpose: When set to True, the text in the button or text box is
formatted to fit as much text on a single line within the horizontal
bounding area of the element and then continued to the next line. This
continues as long as there is vertical space.

Category: Appearance

Used by: Button, Text Box

Can be read by script at run time: Yes

Info: Wrapping Text in Buttons

X Purpose: Defines the left position of the element.

Category: Appearance

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Line, H/V
Line, Polyline, Curve, 2 Point Arc, 3 Point Arc, Button, Text, Text Box,
Image, Status, Radio Button Group, Check Box, Edit Box, Combo Box,
Calendar, DateTime Picker, List Box, Group, Path, Embedded Symbol

Can be read by script at run time: Yes

Info: Moving Elements

Y Purpose: Defines the top position of the element.

Category: Appearance

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Line, H/V
Line, Polyline, Curve, 2 Point Arc, 3 Point Arc, Button, Text, Text Box,
Image, Status, Radio Button Group, Check Box, Edit Box, Combo Box,
Calendar, DateTime Picker, List Box, Group, Path, Embedded Symbol

Can be read by script at run time: Yes

Info: Moving Elements
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Fill Style Group Properties
The following table contains a list of properties in the Fill Style property category used by the:

• Elements.•

• Canvas.•

• Element groups.•

• Embedded graphics.•

It describes their purpose, where they are used and where to find more information on how to use them.

An asterisk (*) identifies properties that apply to only one type of element or the canvas, a group or an
embedded graphic.

Property Purpose, category, usage and further information

FillBehavior Purpose: Determines how the Fill (Horizontal, Vertical or Both) can be
applied to the element.

Category: Fill Style

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Button,
Text Box, Path

Can be read by script at run time: No

Info: Setting Fill Behavior

FillColor Purpose: Defines the fill style used for the filled portion of the
element.

Category: Fill Style

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Button,
Text Box, Radio Button Group, Check Box, Edit Box, Combo Box,
Calendar, List Box, Path

Can be read by script at run time: No

Info: Setting Fill Style and Changing Background Color and Text Color of
Windows Common Controls

FillOrientation Purpose: Determines the orientation of the fill when the element
orientation is any value other than 0.

Category: Fill Style

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Button,
Text Box, Path

Can be read by script at run time: No

Info: Setting Fill Orientation
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Property Purpose, category, usage and further information

HorizontalDirection Purpose: Determines the horizontal direction of the fill for the
element. Can be "Right" or "Left".

Category: Fill Style

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Button,
Text Box, Path

Can be read by script at run time: No

Info: Setting Horizontal Fill Direction and Percentage

HorizontalPercentFill Purpose: Determines the percentage of horizontal fill for the element.

Category: Fill Style

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Button,
Text Box, Path

Can be read by script at run time: Yes

Info: Setting Horizontal Fill Direction and Percentage

TitleFillColor* Purpose: Determines the background solid color in the title bar of the
calendar control.

Category: Fill Style

Used by: Calendar

Can be read by script at run time: No

Info: Setting Title Fill Color and Text Color on a Calendar Control

UnFilledColor Purpose: Determines the element's unfilled area appearance.

Category: Fill Style

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Button,
Text Box, Path

Can be read by script at run time: No

Info: Setting Unfilled Style
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Property Purpose, category, usage and further information

VerticalDirection Purpose: Defines the vertical direction of the fill. Can be "Top" or
"Bottom".

Category: Fill Style

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Button,
Text Box, Path

Can be read by script at run time: No

Info: Setting Vertical Fill Direction and Percentage

VerticalPercentFill Purpose: Determines the percentage of vertical fill for the element.

Category: Fill Style

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Button,
Text Box, Path

Can be read by script at run time: Yes

Info: Setting Vertical Fill Direction and Percentage

Line Style Group Properties
The following table contains a list of properties in the Line Style property category used by the:

• Elements.•

• Canvas.•

• Element groups.•

• Embedded graphics.•

It shows their purpose, where they are used and where to find more information on how to use them.

Asterisk (*) marks properties that are specific to only one type of element or the canvas, a group or an
embedded graphic.

Property Purpose, category, usage and further information

EndCap Purpose: Defines the cap used at the end of the line of an open
element.

Category: Line Style

Used by: Line, H/V Line, Polyline, Curve, 2 Point Arc, 3 Point Arc

Can be read by script at run time: No

Info: Setting Line End Shape and Size
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Property Purpose, category, usage and further information

LineColor Purpose: Defines the color and affects of the line or border.

Category: Line Style

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Line, H/V
Line, Polyline, Curve, 2 Point Arc, 3 Point Arc, Text Box, Path

Can be read by script at run time: No

Info: Setting the Line Style

LinePattern Purpose: Defines the pattern of the line or border.

Category: Line Style

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Line, H/V
Line, Polyline, Curve, 2 Point Arc, 3 Point Arc, Text Box, Path

Can be read by script at run time: No

Info: Setting the Line Pattern

LineWeight Purpose: Determines the weight of the element’s line or border. A
value of 0 means that there is no line or border.

Category: Line Style

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Line, H/V
Line, Polyline, Curve, 2 Point Arc, 3 Point Arc, Text Box, Path

Can be read by script at run time: Yes

Info: Setting the Line Weight

StartCap Purpose: Defines the cap used at the start of the line of an open
graphic.

Category: Line Style

Used by: Line, H/V Line, Polyline, Curve, 2 Point Arc, 3 Point Arc

Can be read by script at run time: No

Info: Setting Line End Shape and Size

Text Style Group Properties
The following table contains a list of properties in the Text Style property category used by the:

• Elements.•

• Canvas.•

• Element groups.•
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• Embedded graphics.•

It shows their purpose, where they are used and where to find more information on how to use them.

An asterisk (*) indicates properties that are specific to only one type of element or the canvas, a group
or an embedded graphic.

Property Purpose, category, usage and further information

Alignment Purpose: Controls the location of the text relative to the bounding
rectangle of the element.

Category: Text Style

Used by: Button, Text, Text Box

Can be read by script at run time: No

Info: Setting the Text Alignment

Caption* Purpose: Defines the text shown on the Check Box at design time and
at run time when the caption property is not bound to a reference in
the checkbox animation panel.

Category: Text Style

Used by: Check Box

Can be read by script at run time: No

Info: Setting the Caption Text of a Check Box Control

Font Purpose: Defines the basic text font as defined by the operating
system.

Category: Text Style

Used by: Button, Text, Text Box, Radio Button Group, Check Box, Edit
Box, Combo Box, Calendar, DateTime Picker, List Box

Can be read by script at run time: No

Info: Setting the Text Font

TextColor Purpose: Defines the color and affects applied to the text.

Category: Text Style

Used by: Button, Text, Text Box, Radio Button Group, Check Box, Edit
Box, Combo Box, Calendar

Can be read by script at run time: No

Info: Setting the Text Color and Changing Background Color and Text
Color of Windows Common Controls
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Property Purpose, category, usage and further information

TitleTextColor* Purpose: Determines the text solid color in the title bar of the calendar
control.

Category: Text Style

Used by: Calendar

Can be read by script at run time: No

Info: Setting Title Fill Color and Text Color on a Calendar Control

TrailingTextColor* Purpose: Determines the text solid color of the text for the trailing
days. The trailing days are days outside the current month.

Category: Text Style

Used by: Calendar

Can be read by script at run time: No

Info: Setting the Text Color for Trailing Dates in a Calendar Control

Runtime Behavior Group Properties
The following table contains a list of properties in the Runtime Behavior property category used by the:

• Elements.•

• Canvas.•

• Element groups.•

• Embedded graphics.•

The table shows the purpose of Runtime Behavior properties, where they are used, and where to find more
information on how to use them.

Asterisk (*) marks properties that are specific to only one type of element or the canvas, a group or an
embedded graphic.

Property Purpose, category, usage and further information

Enabled Purpose: When set to True enables the element at run time and allows
the user to interact with it. If the property is set to False the user
cannot use the mouse or keyboard to interact with the element. Data
changes as a result of an animation or script still execute.

Category: Runtime Behavior

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Line, H/V
Line, Polyline, Curve, 2 Point Arc, 3 Point Arc, Button, Text, Text Box,
Image, Radio Button Group, Check Box, Edit Box, Combo Box, Calendar,
DateTime Picker, List Box, Group, Path, Embedded Symbol

Can be read by script at run time: Yes
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Property Purpose, category, usage and further information

Info: Enabling and Disabling Elements for Run-Time Interaction

Language Purpose: Defines the current language of the graphic.

Category: Runtime Behavior

Used by: Embedded Symbol

Can be read by script at run time: Yes

Info: Selecting a Language for a Graphic.

LanguageID Purpose: Defines the current language ID of the graphic.

Category: Runtime Behavior

Used by: Embedded Symbol

Can be read by script at run time: Yes

Info: Selecting a Language for a Graphic.

MultiplePopupsAllowed* Purpose: If False, ShowSymbol animations only show within a single
dialog window no matter how many animations are invoked and
regardless of how the animations are configured. If True, ShowSymbol
animations show in separate dialog windows.

Category: Runtime Behavior

Used by: Canvas

Can be read by script at run time: No

Info: Setting the Radius of Rounded Rectangles

OwningObject* Purpose: Used as the object reference to replace all "Me." references
in expressions and scripts. Everywhere there is a "Me." reference this
object reference is used instead. The object name can be set either
using a tag or hierarchical name of an AutomationObject.

Category: Runtime Behavior

Used by: Embedded Symbol

Can be read by script at run time: Yes

Info: Detecting and Editing the Containing Object Instance
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Property Purpose, category, usage and further information

Scripts* Purpose: Defines a collection of scripts configured for the graphic.

Category: Runtime Behavior

Used by: Canvas

Can be read by script at run time: No

Info: Adding and Maintaining Graphic Scripts

SymbolReference* Purpose: Contains the exact location that the Embedded Symbol is
linked to. This can help the user in locating the original definition for
editing purposes.

This property is always disabled.

Category: Runtime Behavior

Used by: Embedded Symbol

Can be read by script at run time: No

Info: Detecting the Source Graphic of an Embedded Graphic

TabOrder Purpose: Defines the tab order for the element. The tab order is only
used when navigating by the keyboard. This property is valid only
when the TabStop property is set to true.

Category: Runtime Behavior

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Line, H/V
Line, Polyline, Curve, 2 Point Arc, 3 Point Arc, Button, Text, Text Box,
Image, Radio Button Group, Check Box, Edit Box, Combo Box, Calendar,
DateTime Picker, List Box, Group, Path, Embedded Symbol

Can be read by script at run time: No

Info: Editing the Tab Order of an Element

TabStop Purpose: Determines if the element can be navigated to and can
receive focus at run time.

Category: Runtime Behavior

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Line, H/V
Line, Polyline, Curve, 2 Point Arc, 3 Point Arc, Button, Text, Text Box,
Image, Radio Button Group, Check Box, Edit Box, Combo Box, Calendar,
DateTime Picker, List Box, Group, Path, Embedded Symbol

Can be read by script at run time: No

Info: Editing the Tab Order of an Element
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Property Purpose, category, usage and further information

TreatAsIcon Purpose: If this property is set to False, the animations defined on the
graphics within the group or embedded graphic take precedence over
an animation defined on the group or embedded graphic. If there are
no animations or the user clicked on an area of the group or
embedded graphic that does not have an animation, then the group or
embedded graphic animation executes.

If the property is set to True, only the animation on the group or
embedded graphic is executed. The interactive animations within the
group or embedded graphic never execute.

Category: Runtime Behavior

Used by: Group, Embedded Symbol

Can be read by script at run time: Yes

Info: Editing the Embedded Graphic

Visible Purpose: Determines the visibility of the element. This property is
configured at design time and used only at runtime. At design time all
elements are visible irrespective of this setting.

Category: Runtime Behavior

Used by: Rectangle, Rounded Rectangle, Ellipse, Polygon, Closed
Curve, 2 Point Pie, 3 Point Pie, 2 Point Chord, 3 Point Chord, Line, H/V
Line, Polyline, Curve, 2 Point Arc, 3 Point Arc, Button, Text, Text Box,
Image, Radio Button Group, Check Box, Edit Box, Combo Box, Calendar,
DateTime Picker, List Box, Group, Path, Embedded Symbol

Can be read by script at run time: Yes

Info: Changing the Visibility of Elements

Custom Properties Group Properties
The following table contains a list of properties in the Custom Properties property category used by the:

• Elements.•

• Canvas.•

• Element groups.•

• Embedded graphics.•

It shows their purpose, where they are used and where to find more information on how to use them.

The Custom Properties group contains also any other custom property you define.
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Property Purpose, category, usage and further information

CustomProperties Purpose: The collection of CustomProperties defined by the graphic.

Category: Custom Properties

Used by: Canvas, Embedded Symbol

Can be read by script at run time: No

Info: Using Custom Properties

Order of Precedence for Property Styles
The order of precedence for property styles from high to low is:

1. Quality and Status1.

2. Element Style Animation2.

3. Style Animations3.

4. Group-level Element Style4.

5. Element-level Element Style5.

6. Local element-level style6.
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Windows Common Control List Methods

Overview of Windows Common Control List Methods
You can use the methods of the Windows common controls to manipulate the controls at run time by using them
in scripting.

The following table contains a list of methods you can use in scripting to:

• Load and save the contents of the Edit Box control from and to a file.•

• Manipulate items in the lists of the List Box control and Combo Box control.•

• Manipulate items in the lists of the List Box control and Combo Box control.•

Method Purpose, syntax and information

AddItem Purpose: Add an item (coerced to String) to the list. If the list is sorted,
then the new item is inserted at the right position and selected. If the list
is unsorted, the item is added to the bottom of the list.

Used by: Combo Box, List Box

This function does not work when using an Enum or Array to populate the
List Box.

Syntax: ControlName.AddItem(CaptionString);

Info: Adding and Inserting Items into a List

Clear Purpose: Removes all items from the List. If the list is bound, it clears the
bound reference (array or enum).

This function does not work when using an Enum or Array to populate the
List Box.

Used by: Combo Box, List Box

Syntax: ControlName.Clear();

Info: Deleting Items from a List
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Method Purpose, syntax and information

DeleteItem Purpose: Accepts an index as a parameter and removes that item from
the list. The first item in the list has an index of 0.

Used by: Combo Box, List Box

Syntax: ControlName.DeleteItem(Index);

Info: Deleting Items from a List

DeleteSelection Purpose: Delete the currently selected item from the list.

Used by: Combo Box, List Box

Syntax: ControlName.DeleteSelection();

Info: Deleting Items from a List

FindItem Purpose: Accepts a string as a parameter and returns the index of the first
item that matches the string. The first item in the list has an index of 0.

Used by: Combo Box, List Box

Syntax: ControlName.FindItem(SearchString);

Info: Finding an Item in a List

GetItem Purpose: Returns the item associated with an index supplied as a
parameter to this function. The first item in the list has an index of 0.

Used by: Combo Box, List Box

Syntax: ItemCaption = ControlName.GetItem(Index);

Info: Reading the Caption of a Selected Item in a List

InsertItem Purpose: Inserts the supplied string after the current selection in the List.
Does not work if list is sorted.

Used by: Combo Box, List Box

Syntax: ControlName.InsertItem(String);

Info: Adding and Inserting Items into a List

SetItemData Purpose: Associates a value with an item in the list which index is
provided to the function. The first item in the list has an index of 0.

This function only works when UseValuesAsItems is set to false. It does
not work when using an Enum or Array to populate the List Box control.

Used by: Combo Box, List Box

Syntax: ControlName.SetItemData(Index,Value);

Info: Associating Items with Values in a List

© 2022 AVEVA Group plc and its subsidiaries. All rights reserved.
  

Page 365

AVEVA™ Industrial Graphic Editor User Guide 
Appendix B – Windows Common Control List Methods



Method Purpose, syntax and information

GetItemData Purpose: Returns the value associated with the item in the list which
index is supplied to the function. The first item in the list has an index of 0.

This function only works when UseValuesAsItems is set to false. It does
not work when using an Enum or Array to populate the List Box control.

Used by: Combo Box, List Box

Syntax: Value = ControlName.GetItemData(Index);

Info: Associating Items with Values in a List

LoadList Purpose: Loads a list of strings from a file which name is passed as
parameter to the function. The default location for files is the users folder,
for example: c:\documents and settings\username.

The LoadList method does not work when using an Enum or Array to
populate the List Box control.

Used by: Combo Box, List Box

Syntax: ControlName.LoadList(FileName);

Info: Loading and Saving Item Lists

LoadText Purpose: Loads a text from a file into the Edit Box control. The default
location for files is the users folder, for example: c:\documents and
settings\username.

Used by: Edit Box

Syntax: ControlName.LoadText(FileName);

Info: Configuring Edit Box Methods

SaveList Purpose: Save a list to a file which name is passed as parameter to the
function. The default location for files is the users folder, for example:
c:\documents and settings\username.

Used by: Combo Box, List Box

Syntax: ControlName.SaveList(FileName);

Info: Loading and Saving Item Lists

SaveText Purpose: Saves the current text in the Edit Box control to a file. The
default location for files is the users folder, for example: c:\documents and
settings\username.

Used by: Edit Box

Syntax: ControlName.SaveText(FileName);

Info: Configuring Edit Box Methods
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QuickScript References

Script Functions
This section describes the script functions available in the HMI/SCADA development environment. The function
documentation is organized into a set of folders that represents the same organization of the functions in the
Script Function Browser.

Also provided are additional references for standard QuickScript .NET variables, control structures, and
operators.

Other Microsoft .NET script functions, are not documented. Refer to Microsoft .NET documentation for
descriptions of the functions.

Graphic Client Functions
Use graphic client functions to hide and show symbols, open and close popup windows, log in and log off users,
or to query custom properties contained in a symbol.

GetCPQuality()
Returns the Quality value of a custom property. This function is available within any Industrial Graphics client
script, but may not be supported by your HMI. For more information, consult your HMI documentation.

Syntax
Int          GetCPQuality(String name)

Where String name is the name of the custom property whose quality is to be retrieved.

This script function takes the name of a custom property on the symbol. This argument is of type string and it
can be a reference or a constant.

If the custom property is type constant, GOOD is the quality always returned.

For use with custom properties only. It does not apply to HMI tags.

Return Value
The GetCPQuality() script function returns a value 0-255 of type Integer, as per the OPC quality standard. 192 is
GOOD.

Example
cp2 = GetCPQuality("cp1");

Where cp1 and cp2 are custom properties and the data type of cp2 is Integer.

© 2022 AVEVA Group plc and its subsidiaries. All rights reserved.
  

Page 367

Appendix C



GetCPTimeStamp()
Returns the time stamp of a custom property. This function is available within any Industrial Graphics client
script.

Syntax
DateTime GetCPTimeStamp(String name)

Where String name is the name of the custom property whose time stamp is to be retrieved.

This script function takes the name of a custom property on the symbol. This argument is of type string and it
can be a reference or a constant.

For use with custom properties only. It does not apply to HMI tags.

Return Value
The GetCPTimeStamp() script function returns the time stamp of the custom property’s current value of type
DateTime. If the custom property value is a constant, then the return value is the time the value was created.

Example
cp2 = GetCPTimeStamp("cp1");

Where cp1 and cp2 are custom properties and the data type of cp2 is DateTime.

HideGraphic()
Closes an open graphic pop-up window shown in the ShowGraphic() script with the given identity name.

The HideGraphic() function has been extended to close HMI Windows identified with a given identity name. This
function is available within any Industrial Graphics client script.

Category
Graphic Client

Syntax
HideGraphic(string identity);

Parameter
Identity

The unique name of the instance that shows the graphic.

Examples
HideGraphic("i1");

Where "i1" is string Identity.

HideGraphic("<HMIName>:Window1");

Where "<HMIName>1" is the string identity.

See Also
ShowGraphic(), HideSelf()
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HideSelf()
Closes the displayed graphic or layout for which this script is configured. This script function is available within
any Industrial Graphics client script.

Category
Graphic Client

Syntax
HideSelf();

Remarks
For an Industrial Graphics script, call the script function within the symbol to hide the popup.

Example
HideSelf();

See Also
ShowGraphic(), HideGraphic()

ShowGraphic()
Shows a graphic within a pop-up window. The ShowGraphic() function has been extended to call InTouch HMI
Windows. This function is available within any Industrial Graphics client script.

Category
Graphic Client

Syntax
Show a graphic within a pop-up window
Dim graphicInfo as aaGraphic.GraphicInfo;
graphicInfo.Identity = "<Identity>";
graphicInfo.GraphicName = "<SymbolName>";
ShowGraphic( graphicInfo );

Call an HMI window
Dim graphicInfo as aaGraphic.GraphicInfo;
graphicInfo0.Identity = "<<HMIName>:WindowName>";
ShowGraphic( graphicInfo );

Parameter
GraphicInfo

Data Type
aaGraphic.GraphicInfo

Examples
Show graphic within a pop-up window
ShowGraphic (graphicInfo);

Show an HMI window
Dim graphicInfo0 as aaGraphic.GraphicInfo;
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graphicInfo0.Identity = "<HMIName>:Window1";
ShowGraphic( graphicInfo0 );

aaGraphic.GraphicInfo Properties
Any string properties can be a concatenation of strings and/or custom properties.

Identity

A unique name that identifies which instance has opened the graphic.

Data Type
String

Additional Information
Mandatory
The same Identity is used in the HideGraphic() script function to close the pop-up window.

Valid Range
The name cannot contain more than 329 characters.
The name has to contain at least one letter.
Valid characters are alphanumeric and special characters ($, #, _).

Example
graphicInfo.Identity = "i1";

GraphicName

The name of the graphic to show.

Data Type
String

Valid Range
The name cannot contain more than 329 characters.
The name has to contain at least one letter.
Valid characters are alphanumeric and special characters ($, #, _).

Additional Information
Mandatory
Browse using your HMI/SCADA application browser, such as the Display Galaxy Browser or equivalent in
your HMI/SCADA software, or directly type the graphic name.
The application name can come from:

• Graphic Toolbox, for example:•
"Symbol_001"

• Instances, absolute or hierarchical, for example:•
"Userdefined_001.Symbol1", "Userdefined_001.Pump_001.S1"

• Relative reference, for example:•
"Me.Symbol_001"

Use an absolute name to specify the symbol name and owning object if you are using an Object Wizard
with Symbol Wizard custom property selections. This allows the correct symbol configuration to be
shown for the instance. See Owning Object, below, for more information.

If you type any invalid character or exceed the character limit, the system shows a warning message at
run time. There is no validation at design time.
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The graphic name can be a concatenation of constant strings and reference strings. For
example:"Pump_001" + ".Symbol_001"; cp1 + ".Symbol_001", where the value of cp1 =
"Pump_001"; or Obj1.Str1 + ".Symbol_001", where the value of Obj.Str1 =
"Pump_001".

Examples

Graphic Toolbox Reference
graphicInfo.GraphicName = "S1";

Absolute Reference
graphicInfo.GraphicName = "OwningObjectName.SymbolName";

OwningObject

The owning object of the graphic shown by the ShowGraphic() script function.

Data Type
String

Default Value
Empty

Additional Information
Optional
Can be a concatenation of constant strings and reference strings.
Can be browsed using the Display Automation Object Browser, or you can type the name of the owning
object.

The OwningObject property sets references for the graphic, but is not associated with the GraphicName property
if the symbol is part of an Object Wizard. Therefore, if you are scripting a symbol with an owning object, specify
the owning object name as part of the GraphicName property, for example, UserDefined_001.Pump_001.

Example
graphicInfo.OwningObject = "UserDefined_001";

HasTitleBar

Determines if the graphic is shown with a title bar.

Data Type
Boolean

Default Value
True

Example
graphicInfo.HasTitleBar = false;

WindowTitle

Specifies the title shown in the window title bar.

Data Type
String

Default Value
Empty

Valid Range
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Limit 1024 characters

Additional Information
Can be a constant string, a reference, or an expression.
If you change the owning object for an AutomationObject graphic, the window title is updated accordingly.
If the WindowTitle parameter is empty, the value of the Identity parameter is shown on the title bar.

Example
graphicInfo.WindowTitle = "Graphic01";

WindowType

Specifies whether window type is modal or modeless.

Data Type
Enum

Default Value
Modeless

Valid Range
0, 1

Enumerations

WindowType Integer

Modal 0

Modeless 1

Examples
graphicInfo.WindowType = aaGraphic.WindowType.<windowtype>;
graphicInfo.WindowType = 1;

HasCloseButton

Determines if the pop-up window has a close button.

Data Type
Boolean

Default Value
True

Example
graphicInfo.HasCloseButton = false;

Resizable

Determines if the pop-up window is resizable.

Data Type
Boolean

Default Value
False

Example
graphicInfo.Resizable = true;
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WindowLocation

Specifies the location of the pop-up window.

Data Type
Enum

Default Value
Center

Valid Range
One of 0–12

Enumerations

WindowLocation Integer

Center 0

Above 1

TopLeftCorner 2

Top 3

TopRightCorner 4

LeftOf 5

LeftSide 6

RightSide 7

RightOf 8

BottomLeftCorner 9

Bottom 10

BottomRightCorner 11

Below 12

Additional Information
If you have selected Desktop as the window relative position, Above, LeftOf, RightOf, and Below are invalid.
For more information about the behavior of the WindowLocation parameter, see "Working with the Show/
Hide Graphics Script Functions," in the Creating and Managing Industrial Graphics User Guide.

Examples
graphicInfo.WindowLocation = aaGraphic.WindowLocation.<WindowLocation>;
graphicInfo.WindowLocation = 1;

WindowRelativePosition

Specifies the relative position of the pop-up window.

Data Type
Enum
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Default Value
Desktop

Valid Range
One of 0–8

Enumerations

WindowRelativePosition Integer

Desktop 0

Window 1

ClientArea 2

ParentGraphic 3

ParentElement 4

Mouse 5

DesktopXY 6

WindowXY 7

ClientAreaXY 8

Examples
graphicInfo.WindowRelativePosition = 
aaGraphic.WindowRelativePosition.<WindowRelativePosition>;
graphicInfo.WindowRelativePosition = 1;

RelativeTo

Specifies the size of the pop-up window relative to the graphic, desktop, or customized width and height.

Data Type
Enum

Default Value
Graphic

Valid Range
One of 0–2

Enumerations

RelativeTo Integer

Graphic 0

DeskTop 1

CustomizedWidthHeight 2

Additional Information
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If you enter aaGraphic.RelativeTo.CustomizedWidthHeight, you can include the values of the height and
width in the script. Otherwise, the default values are used.

Examples
graphicInfo.RelativeTo = aaGraphic.RelativeTo.<RelativeTo>;
graphicInfo.RelativeTo = 1;

X

The horizontal position of the pop-up window.

Data Type
Integer

Default Value
0

Valid Range
-2,147,483,648 through 2,147,483,647

Additional Information
If X is beyond the integer range, an overflow message appears in the Logger at run time.
This parameter is applicable only if the value of the WindowRelativePosition parameter is DesktopXY,
WindowXY, or ClientAreaXY.
Unlike the ShowSymbol animation, there is no boundary for this value.

Examples
graphicInfo.X = 100;

Y

Specifies the vertical position of the pop-up window.

Data Type
Integer

Default Value
0

Valid Range
-2,147,483,648 through 2,147,483,647

Additional Information
If Y is beyond integer range, a proper overflow message will appear in the Logger at run time.
This value is applicable only if WindowRelativePosition is DesktopXY, WindowXY, or ClientAreaXY.

Unlike the ShowSymbol animation, there is no boundary for this value.

Examples
graphicInfo.Y = 100;

Width

Specifies the width of the pop-up window.

Data Type
Integer

Default Value
100
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Valid Range
0–10000

Additional Information
Applicable only if RelativeTo is CustomizedWidthHeight
You can specify either the height or the width of the pop-up window. The system calculates the other, based
on the aspect ratio of the symbol.
If you enter an out-of-boundary value, the system shows an "Out of range" message at run time. If the value
> 10000, it is set at 10000. If the value < 0, it is set at 0.

Examples
graphicInfo.width = 500;

Height

Specifies the height of the pop-up window.

Data Type
Integer

Default Value
100

Valid Range
0–10000

Additional Information
Applicable only if RelativeTo is the value of the CustomizedWidthHeight parameter.
You can specify either the height or the width of the pop-up window. The system calculates the other, based
on the aspect ratio of the symbol.
If you enter an out-of-boundary value, the system shows an "Out of range" message at run time. If the value
> 10000, it is set at 10000. If the value < 0, it is set at 0.

Examples
graphicInfo.height = 500;

TopMost

Sets a value that indicates whether the ShowGraphic appears in the top most z-order window. A ShowGraphic
whose Topmost property is set to true appears above all windows whose TopMost properties are set to false
(same as Windows Task Manager).

Data Type
Boolean

Default Value
False

Additional Information
ShowGraphic windows whose Topmost properties are set to true appear above all windows whose Topmost
properties are set to false. In a group of windows that have the Topmost property set to true, the active
window is the topmost window.

Don't create scripts that launch a non-TopMost Modal dialog from a TopMost dialog. Users will not be able to
interact with the View if the Modal dialog is completely hidden by any TopMost window.

Example
graphicInfo.TopMost = true;
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ScalePercentage

Sets the scaling percentage of the pop-up window and the graphic it contains.

Data Type
Integer

Default Value
100

Valid Range
0–1000

Additional Information
If you enter an out-of-boundary value, the system shows an "Out of range" message at run time. If the value
> 1000, it is set at 1000. If the value < 0, it is set at 0.

Examples
graphicInfo.ScalePercentage = 150;

KeepOnMonitor

Specifies that a pop-up window appears entirely within the boundaries of an application window.

Data Type
Boolean

Default Value
True

Example
graphicInfo.KeepOnMonitor = true;

StretchGraphicToFitWindowSize

Determines if the graphic is scaled to the current size of the pop-up window.

Data Type
Boolean

Default Value
True

Additional Information
Applicable only if the value of the ScalePercentage parameter is greater than 100.

Examples
graphicInfo.StretchGraphicToFitWindowSize = false;

StretchWindowToScreenWidth

Determines if the pop-up window is scaled to the same width as the screen.

Data Type
Boolean

Default Value
False

Additional Information
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Applicable only if the WindowRelativePosition parameter is Desktop, Window, Client Area, ParentGraphic, or
ParentElement.

Examples
graphicInfo.StretchWindowToScreenWidth = true;

StretchWindowToScreenHeight

Determines if the pop-up window is scaled to the same height as the screen.

Data Type
Boolean

Default Value
False

Additional Information
Applicable only if the WindowRelativePosition parameter is Desktop, Window, Client Area, ParentGraphic, or
ParentElement.

Examples
graphicInfo.StretchWindowToScreenHeight = true;

CustomProperties

Sets the custom properties of the symbol being shown.

Data Type
CustomPropertyValuePair[] array

Additional Information
The first three parameters are custom property name, value, and IsConstant.
Both custom property and the value can be a constant string, reference, or concatenation of strings.
If the parameter IsConstant = True, the value is treated as a constant. Otherwise, the value is treated as a
reference.
The array index starts at 1.

Examples
Dim cpValues [4] as aaGraphic.CustomPropertyValuePair;
cpValues[1] = new aaGraphic.CustomPropertyValuePair("CP1", 20, true);
cpValues[2] = new aaGraphic.CustomPropertyValuePair("CP2", Pump.PV.TagName, true);
cpValues[3] = new aaGraphic.CustomPropertyValuePair("CP3", "CP"+var1, CP2 + "001" + 
".Speed", true);
cpValues[4] = new aaGraphic.CustomPropertyValuePair("CP3", "<HMIName>:Tag1", false);
graphicInfo.CustomProperties = cpValues;

Remarks
Any parameter that has default value in the GraphicInfo is optional. If no input value specified for these
parameters, the default values are used at run time. Any parameter except the Enum data type can be a
constant, reference, or expression.

For more information, see "Working with the Show/Hide Graphics Script Functions" in the Industrial Graphic
Editor User Guide.

Examples for ShowGraphic
Basic script example:
Dim graphicInfo as aaGraphic.GraphicInfo;
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graphicInfo.Identity = "Script_001";
graphicInfo.GraphicName = "Symbol_001";
ShowGraphic( graphicInfo );

Advanced script example:
Dim graphicInfo as aaGraphic.GraphicInfo;
Dim cpValues [2] as aaGraphic.CustomPropertyValuePair;
cpValues[1] = new aaGraphic.CustomPropertyValuePair("CP1", 20, true);
cpValues[2] = new aaGraphic.CustomPropertyValuePair("CP2", "Pump.PV.TagName", false);
graphicInfo.Identity = "i1";
graphicInfo.GraphicName = "S1";
graphicInfo.OwningObject = "UserDefined_001";
graphicInfo.WindowTitle = "Graphic01";
graphicInfo.Resizable = false;
graphicInfo.CustomProperties=cpValues;
ShowGraphic( graphicInfo );

Where "i1" is string Identity and the symbol "S1" contains custom property CP1 and CP2.

See Also
HideSelf()

Math Functions
Use math functions to return the answer to the specified mathematical expression.

In QuickScript, all mathematical operations are calculated internally as double, regardless of the operand data
type. Following standard mathematical rules, the result is always rounded in division operations to maintain
accuracy. Rounding only occurs on the end result, not intermediate values, and the quotient will match the
target data type. This is the standard methodology for SCADA and DCS systems, and provides the data integrity,
precision retention, time stamps, and overall data quality propagation and aggregation needed for these
systems.

If you want to round at each step instead of only at the final result, you can leverage the support built
into QuickScript for .NET libraries and utilize the System.Math.Floor and System.Math.Round methods
to explicitly round the intermediate steps. As an example, consider the following script:
dim dividend as integer;
dim divisor as integer;
dim quotient as integer;
dim remainder as integer;
dividend = 8;
divisor = 3;
LogMessage("Value of dividend = " + dividend);
LogMessage("Value of divisor = " + divisor);
quotient = dividend/divisor;
LogMessage("Value of quotient = " + quotient);
remainder = dividend mod divisor;
LogMessage ("Value of remainder = " + remainder);
dividend = divisor*quotient +remainder;
LogMessage ("Value of dividend = " + dividend);

The result is: 8 / 3 = 3
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If, instead, you want to drop the remainder (not rounding the final result to the nearest integer), you
could add a call to the Math.Floor method and use the following:
dim dividend as integer;
dim divisor as integer;
dim quotient as integer;
dim remainder as integer;
dividend = 8;
divisor = 3;
LogMessage("Value of dividend = " + dividend);
LogMessage("Value of divisor = " + divisor);
// *** Add call to Math.Floor. This drops the remainder rather than rounding the internal 
Double result to integer
quotient = System.Math.Floor(dividend/divisor);

LogMessage("Value of quotient = " + quotient);
remainder = dividend mod divisor;
LogMessage ("Value of remainder = " + remainder);
dividend = divisor*quotient +remainder;
LogMessage ("Value of dividend = " + dividend);

The result is: 8 / 3 = 2 (remainder 2)

Abs()
Returns the absolute value (unsigned equivalent) of a specified number.

Category
Math

Syntax
Result = Abs( Number );

Parameter
Number

Any number or numeric attribute.

Examples
Abs(14); ' returns 14
Abs(-7.5); ' returns 7.5

ArcCos()
Returns an angle between 0 and 180 degrees whose cosine is equal to the number specified.

Category
Math

Syntax
Result = ArcCos( Number );

Parameter
Number

Any number or numeric attribute with a value between -1 and 1 (inclusive).
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Examples
ArcCos(1); ' returns 0
ArcCos(-1); ' returns 180

See Also
Cos(), Sin(), Tan(), ArcSin(), ArcTan()

ArcSin()
Returns an angle between -90 and 90 degrees whose sine is equal to the number specified.

Category
Math

Syntax
Result = ArcSin( Number );

Parameter
Number

Any number or numeric attribute with a value between -1 and 1 (inclusive).

Examples
ArcSin(1); ' returns 90
ArcSin(-1); ' returns -90

See Also
Cos(), Sin(), Tan(), ArcCos(), ArcTan()

ArcTan()
Returns an angle between -90 and 90 degrees whose tangent is equal to the number specified.

Category
Math

Syntax
Result = ArcTan( Number );

Parameter
Number

Any number or numeric attribute.

Examples
ArcTan(1); ' returns 45
ArcTan(0); ' returns 0

See Also
Cos(), Sin(), Tan(), ArcCos(), ArcSin()

Cos()
Returns the cosine of an angle in degrees.
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Category
Math

Syntax
Result = Cos( Number );

Parameter
Number

Any number or numeric attribute.

Examples
Cos(90); ' returns 0
Cos(0); ' returns 1

This example shows how to use the function in a math equation:
Wave = 50 * Cos(6 * Now().Second);

See Also
Sin(), Tan(), ArcCos(), ArcSin(), ArcTan()

Exp()
Returns the result of the exponent e raised to a power.

Category
Math

Syntax
Result = Exp( Number );

Parameter
Number

Any number or numeric attribute.

Example
Exp(1); ' returns 2.718...

Int()
Returns the next integer less than or equal to a specified number.

Category
Math

Syntax
IntegerResult = Int( Number );

Parameter
Number

Any number or numeric attribute.
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Remarks
When handling negative real (float) numbers, this function returns the integer farthest from zero.

Examples
Int(4.7); ' returns 4
Int(-4.7); ' returns -5

Log()
Returns the natural log (base e) of a number.

Category
Math

Syntax
RealResult = Log( Number );

Parameter
Number

Any number or numeric attribute.

Remarks
Natural log of 0 is undefined.

Examples
Log(100); ' returns 4.605...
Log(1); ' returns 0

See Also
LogN(), Log10()

Log10()
Returns the base 10 log of a number.

Category
Math

Syntax
Result = Log10( Number );

Parameter
Number

Any number or numeric attribute.

Example
Log10(100); ' returns 2

See Also
Log(), LogN()

© 2022 AVEVA Group plc and its subsidiaries. All rights reserved.
  

Page 383

AVEVA™ Industrial Graphic Editor User Guide 
Appendix C – QuickScript References



LogN()
Returns the values of the logarithm of x to base n.

Category
Math

Syntax
Result = LogN( Number, Base );

Parameters
Number

Any number or numeric attribute.

Base
Integer to set log base. You could also specify an integer attribute.

Remarks
Base 1 is undefined.

Examples
LogN(8, 3); ' returns 1.89279
LogN(3, 7); ' returns 0.564

See Also
Log(), Log10()

Pi()
Returns the value of Pi.

Category
Math

Syntax
RealResult = Pi();

Example
Pi(); ' returns 3.1415926

Round()
Rounds a real number to a specified precision and returns the result.

Category
Math

Syntax
RealResult = Round( Number, Precision );

Parameters
Number

Any number or numeric attribute.
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Precision
Sets the precision to which the number is rounded. This value can be any number or a numeric attribute.

Examples
Round(4.3, 1); ' returns 4
Round(4.3, .01); ' returns 4.30
Round(4.5, 1); ' returns 5
Round(-4.5, 1); ' returns -4
Round(106, 5); ' returns 105
Round(43.7, .5); ' returns 43.5

See Also
Trunc()

Sgn()
Determines the sign of a value (whether it is positive, zero, or negative) and returns the result.

Category
Math

Syntax
IntegerResult = Sgn( Number );

Parameter
Number

Any number or numeric attribute.

Return Value
If the input number is positive, the result is 1. Negative numbers return a -1, and 0 returns a 0.

Examples
Sgn(425); ' returns 1;
Sgn(0); ' returns 0;
Sgn(-37.3); ' returns -1;

Sin()
Returns the sine of an angle in degrees.

Category
Math

Syntax
Result = Sin( Number );

Parameter
Number

Angle in degrees. Any number or numeric attribute.

Examples
Sin(90); ' returns 1;
Sin(0); ' returns 0;
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This example shows how to use the function in a math expression:
wave = 100 * Sin (6 * Now().Second);

See Also
Cos(), Tan(), ArcCos(), ArcSin(), ArcTan()

Sqrt()
Returns the square root of a number.

Category
Math

Syntax
RealResult = Sqrt( Number );

Parameter
Number

Any number or numeric attribute.

Example
This example takes the value of me.PV and returns the square root as the value of x:
x=Sqrt(me.PV);

Tan()
Returns the tangent of an angle given in degrees.

Category
Math

Syntax
Result = Tan( Number );

Parameter
Number

The angle in degrees. Any number or numeric attribute.

Examples
Tan(45); ' returns 1;
Tan(0); ' returns 0;

This example shows how to use the function in a math expression:
Wave = 10 + 50 * Tan(6 * Now().Second);

See Also
Cos(), Sin(), ArcCos(), ArcSin(), ArcTan()

Trunc()
Truncates a real (floating point) number by simply eliminating the portion to the right of the decimal point,
including the decimal point, and returns the result.
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Category
Math

Syntax
NumericResult = Trunc( Number );

Parameter
Number

Any number or numeric attribute.

Remarks
This function accomplishes the same result as placing the contents of a float type attribute into an integer type
attribute.

Examples
Trunc(4.3); ' returns 4;
Trunc(-4.3); ' returns -4;

See Also
Round()

Miscellaneous Functions
Functions in the miscellaneous group perform a variety of purposes, such as logging data or querying attributes.

DateTimeGMT()
Returns a number representing the number of days and fractions of days since January 1, 1970, in Coordinated
Universal Time (UTC), regardless of the local time zone.

Category
Miscellaneous

Syntax
Result=DateTimeGMT();

Parameters
None

Example
MessageTag = StringFromTime(DateTimeGMT() * 86400.0, 3);

IsBad()
Returns a Boolean value indicating if the quality of the specified attribute is Bad.

Category
Miscellaneous

Syntax
BooleanResult = IsBad( Attribute1, Attribute2, … );
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Parameter(s)
Attribute1, Attribute2, ...AttributeN

Names of one or more attributes for which you want to determine Bad quality. You can include a variable-
length list of attributes.

Return Value
If any of the specified attributes has Bad quality, then true is returned. Otherwise, false is returned.

Examples
IsBad(TIC101.PV);
IsBad(TIC101.PV, PIC102.PV);

See Also
IsGood(), IsInitializing(), IsUncertain(), IsUsable()

IsGood()
Returns a Boolean value indicating if the quality of the specified attribute is Good.

Category
Miscellaneous

Syntax
BooleanResult = IsGood( Attribute1, Attribute2, … );

Parameter(s)
Attribute1, Attribute2, and so on

Name of the attribute(s) for which you want to determine Good quality. You can include a variable-length list
of attributes.

Return Value
If all of the specified attributes have Good quality, then true is returned. Otherwise, false is returned.

Examples
IsGood(TIC101.PV);
IsGood(TIC101.PV, PIC102.PV);

See Also
IsBad(), IsInitializing(), IsUncertain(), IsUsable()

IsInitializing()
Returns a Boolean value indicating if the quality of the specified attribute is Initializing.

Category
Miscellaneous

Syntax
BooleanResult = IsInitializing( Attribute1, Attribute2, … );

© 2022 AVEVA Group plc and its subsidiaries. All rights reserved.
  

Page 388

AVEVA™ Industrial Graphic Editor User Guide 
Appendix C – QuickScript References



Parameter(s)
Attribute1, Attribute2, and so on

Name of the attribute(s) for which to determine Initializing quality. You can include a variable-length list of
attributes.

Return Value
If any of the specified attributes has Initializing quality, then true is returned. Otherwise, false is returned.

Examples
IsInitializing(TIC101.PV);
IsInitializing(TIC101.PV, PIC102.PV);

See Also
IsBad(), IsGood(), IsUncertain(), IsUsable()

IsUncertain()
Returns a Boolean value indicating if the quality of the specified attribute is Uncertain.

Category
Miscellaneous

Syntax
BooleanResult = IsUncertain( Attribute1, Attribute2, … );

Parameter(s)
Attribute1, Attribute2, and so on

Name of the attribute(s) to determine Uncertain quality. You can include a variable-length list of attributes.

Return Value
If all of the specified attributes have Uncertain quality, then true is returned. Otherwise, false is returned.

Examples
IsUncertain(TIC101.PV);
IsUncertain(TIC101.PV, PIC102.PV);

See Also
IsBad(), IsGood(), IsInitializing(), IsUsable()

IsUsable()
Returns a Boolean value indicating if the specified attribute is usable for calculations.

Category
Miscellaneous

Syntax
BooleanResult = IsUsable( Attribute1, Attribute2, … );

Parameter(s)
Attribute1, Attribute2, ...AttributeN
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Name of one or more attributes for which you want to determine unusable quality. You can include a
variable-length list of attributes.

Return Value
If all of the specified attributes have either Good or Uncertain quality, then true is returned. Otherwise, false is
returned.

Remarks
The attributes having Good or Uncertain quality qualifies as usable. In addition, each float or double attribute
cannot be a NaN (not a number).

Examples
IsUsable(TIC101.PV);
IsUsable(TIC101.PV, PIC102.PV);

See Also
IsBad(), IsGood(), IsInitializing(), IsUncertain()

LogCustom()
Writes a user-defined custom flag message in the Log Viewer.

Category
Miscellaneous

Syntax
LogCustom( CustomFlag, msg );

Parameter
CustomFlag

Creates a new log flag based on the first parameter string. The first call creates the custom flag.

msg
The message to write to the Log Viewer. Actual string or a string attribute.

Remarks
The log flag is disabled by default.

The message is always logged under the component "ObjectName.ScriptName". For example,
"WinPlatform_001.script1: msg", which identifies what object and what script within the object logged the error.

LogCustom() is similar to LogMessage(), but displays the message in the custom log flag when Log Custom is
enabled.

The parameter help tooltip and Function Browser sample parameter list will show "LogCustom( CustomFlag,
msg )" rather than "LogCustom( CustomFlag, Message )". "Message" is a reserved keyword.

Example
LogCustom(EditBox1.text, "User-defined message.";

This statement writes to the Log Viewer as follows:
10/24/2005 12:49:14 PM ScriptRuntime
<ObjectName.ScriptName>: <LogFlag EditBox1> User-defined message.
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LogDataChangeEvent()
Logs an application change event to the application Historian.

The LogDataChangeEvent() function works only in object scripts, not in symbol scripts.

Category
Miscellaneous

Syntax
LogDataChangeEvent(AttributeName, Description, OldValue, NewValue, TimeStamp);

Parameters
AttributeName

Attribute name as a tag name.

Description
Description of the object.

OldValue
Old value of the attribute.

NewValue
New value of the attribute.

TimeStamp
The time stamp associated with the logged event. The timestamp can be UTC or local time. The TimeStamp
parameter is optional. The timestamp of the logged event defaults to Now() if a TimeStamp parameter is not
included.

Remarks
A symbol script still compiles if the LogDataChangeEvent() function is included. However, a warning message is
written to the log at run time that the function is inoperable.

Example
This example logs an event when a pump starts or stops with a timestamp of the current time when the event
occurred.
LogDataChangeEvent(TC104.pumpstate, "Pump04", OldState, NewState);

LogError()
Writes a user-defined error message in the Log Viewer with a red error log flag.

Category
Miscellaneous

Syntax
LogError( msg );

Parameter
msg

The message to write to the Log Viewer. Actual string or a string attribute.

© 2022 AVEVA Group plc and its subsidiaries. All rights reserved.
  

Page 391

AVEVA™ Industrial Graphic Editor User Guide 
Appendix C – QuickScript References



Remarks
The log flag is enabled by default.

The message is always logged under the component "ObjectName.ScriptName". For example,
"WinPlatform_001.script1: msg", which identifies what object and what script within the object logged the error.

LogError() is similar to LogMessage(), but displays the message in red.

The parameter help tooltip and Function Browser sample parameter list will show "LogError( msg )" rather than
"LogError( Message )". "Message" is a reserved keyword.

Example
LogError("User-defined error message.");

This statement writes to the Log Viewer as follows:
10/24/2005 12:49:14 PM ScriptRuntime
<ObjectName.ScriptName>: User-defined error message.

LogMessage()
Writes a user-defined message to the Log Viewer.

Category
Miscellaneous

Syntax
LogMessage( msg );

Parameter
msg

The message to write to the Log Viewer. Actual string or a string attribute.

Remarks
This is a very powerful function for troubleshooting scripting. By strategically placing LogMessage() functions in
your scripts, you can determine the order of script execution, performance of scripts, and identify the value of
attributes both before they are changed and after they are affected by the script.

Each message posted to the Log Viewer is stamped with the exact date and time. The message always begins
with the component "Tagname.ScriptName" so you can tell what object and what script within the object posted
the message to the log.

Examples
LogMessage("Report Script is Running");

The above statement writes the following to the Log Viewer:
10/24/2005 12:49:14 PM ScriptRuntime <Tagname.ScriptName>:Report Script is Running.
MyTag=MyTag + 10;
LogMessage("The Value of MyTag is " + Text(MyTag, "#"));

LogTrace()
Writes a user-defined trace message in the Log Viewer.
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Category
Miscellaneous

Syntax
LogTrace( msg );

Parameter
msg

The message to write to the Log Viewer. Actual string or a string attribute.

Remarks
The log flag is disabled by default.

The message is always logged under the component "ObjectName.ScriptName". For example,
"WinPlatform_001.script1: msg", which identifies what object and what script within the object logged the error.

LogTrace() is similar to LogMessage(), but displays the message as Trace when Log Trace is enabled.

The parameter help tooltip and Function Browser sample parameter list will show "LogTrace( msg )" rather than
"LogTrace( Message )". "Message" is a reserved keyword.

Example
LogTrace("User-defined trace message.");

This statement writes to the Log Viewer as follows:
10/24/2005 12:49:14 PM ScriptRuntime
<ObjectName.ScriptName>: User-defined trace message.

LogWarning()
Writes a user-defined error message in the Log Viewer with a yellow warning log flag.

Category
Miscellaneous

Syntax
LogWarning( msg );

Parameter
msg

The message to write to the Log Viewer. Actual string or a string attribute.

Remarks
The log flag is disabled by default.

The message is always logged under the component "ObjectName.ScriptName". For example,
"WinPlatform_001.script1: msg", which identifies what object and what script within the object logged the error.

LogWarning() is similar to LogMessage(), but displays the message as a yellow warning message.

The parameter help tooltip and Function Browser sample parameter list will show "LogWarning( msg )" rather
than "LogWarning( Message )". "Message" is a reserved keyword.

Example
LogWarning("User-defined warning message.")
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This statement writes to the Log Viewer as follows:
10/24/2005 12:49:14 PM ScriptRuntime
<ObjectName.ScriptName>: User-defined warning message.

SendKeys()
Sends keystrokes to an application. To the receiving application, the keys appear to be entered from the
keyboard. You can use SendKeys() within a script to enter data or send commands to an application. Most
keyboard keys can be used in a SendKeys() statement. Each key is represented by one or more characters, such
as A for the letter A or {ENTER} for the Enter key.

Category
Miscellaneous

Syntax
SendKeys( KeySequence );

Parameter
KeySequence

Any key sequence or a string attribute.

Remarks
To specify more than one key, concatenate the codes for each character. For example, to specify the dollar sign
($) key followed by a (b), enter $b.

The following lists the valid send key codes for unique keyboard keys:

Key Code

BACKSPACE {BACKSPACE}or {BS}

BREAK {BREAK}

CAPSLOCK {CAPSLOCK}

DELETE {DELETE} or {DEL}

DOWN {DOWN}

END {END}

ENTER {ENTER} or tilde (~ )

ESCAPE {ESCAPE} or {ESC}

F1...F12 {F1}...{F12}

HOME {HOME}

INSERT {INSERT}

LEFT {LEFT}

NUMLOCK {NUMLOCK}
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Key Code

PAGE DOWN {PGDN}

PAGE UP {PGUP}

PRTSC {PRTSC}

RIGHT {RIGHT}

TAB {TAB}

UP {UP}

HOME {HOME}

Special keys (SHIFT, CTRL, and ALT) have their own key codes:

Key Code

SHIFT + (plus)

CTRL ^ (caret)

ALT % (percent)

Enhancements to the Microsoft Hardware Abstraction Layer in Windows prevents the SendKeys() function from
operating on some computers.

Examples
To use two special keys together, use a second set of parentheses. The following statement holds down the CTRL
key while pressing the ALT key, followed by p:
SendKeys ("^(%(p))");

Commands can be preceded by the ActivateApp() command to direct the keystrokes to the proper application.

The following statement gives the computer focus to Calculator and sends the key combination 1234:
ActivateApp("Calculator");
SendKeys("^(1234)");

SetBad()
Sets the quality of an attribute to Bad.

Category
Miscellaneous

Syntax
SetBad( Attribute );

Parameter
Attribute

The attribute for which you want to set the quality to Bad.

© 2022 AVEVA Group plc and its subsidiaries. All rights reserved.
  

Page 395

AVEVA™ Industrial Graphic Editor User Guide 
Appendix C – QuickScript References



Remarks
The specified attribute needs be within the object to which the script is attached.

Example
SetBad(me.PV);

See Also
SetGood(), SetInitializing(), SetUncertain()

SetGood()
Sets the quality of an attribute to Good.

Category
Miscellaneous

Syntax
SetGood( Attribute );

Parameter
Attribute

The attribute for which you want to set the quality to Good.

Remarks
The specified attribute needs to be within the object to which the script is attached.

Example
SetGood(me.PV);

See Also
SetBad(), SetInitializing(), SetUncertain()

SetInitializing()
Sets the quality of an attribute to Initializing.

Category
Miscellaneous

Syntax
SetInitializing( Attribute );

Parameter
Attribute

The attribute for which you want to set the quality to Initializing.

Remarks
The specified attribute needs to be within the object to which the script is attached.
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Example
SetInitializing(me.PV);

See Also
SetBad(), SetGood(), SetUncertain()

SetUncertain()
Sets the quality of an attribute to Uncertain.

Category
Miscellaneous

Syntax
SetUncertain( Attribute );

Parameter
Attribute

The attribute for which you want to set the quality to Uncertain.

Remarks
The specified attribute needs to be within the object to which the script is attached.

Example
SetUncertain(me.PV);

See Also
SetBad(), SetGood(), SetInitializing()

SignedWrite()
Performs a write to an AutomationObject attribute that has a Secured Write or Verified Write security
classification.

Category
Miscellaneous

Syntax
int SignedWrite(string Attribute,
object Value,
string ReasonDescription,
Bool Comment_Is_Editable,
Enum Comment_Enforcement,
string[] Predefined_Comment_List
);

Brackets [ ] indicate an array.

Parameters
Attribute

The attribute to be updated.
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Data Type
String

Additional Information
Can be a constant string, a reference, or an expression.
Supports bound and nested bound references.
For detailed examples of Attribute parameter uses, see the topic Examples of Using the Attribute Parameter
in the SignedWrite() Function under "Managing Symbols" in the Creating and Managing Industrial Graphics
User Guide.

Examples
Example 1:

"UserDefined_001.temp"
Example 2:

"Pump15" + ".valve4"

Example 3:

With UDO_7 containing two string attributes, namestrA and namestrB set to the values "Tank1" and "Tank5"
respectively, the following script writes to Tank1.Level or Tank5.Level according to whether strselect is "A" or "B":

Dim strselect As String;
Dim x As Indirect;
{ logic to set strselect to "A" or "B" }
x.BindTo ("UDO_7.namestr" + strselect);
SignedWrite(x + ".Level", 243, "Set " + x + " Level", true, 0, null);

Value

The value to be written.

Data Type
Object

Valid Range
Has to match data type of the attribute being updated.

Additional Information
Can be a constant value, a reference, an expression, or NULL if nothing is to be entered.

ReasonDescription

Text that explains the purpose of the target attribute and the impact of changing it.

Data Type
String

Valid Range
Maximum of 256 characters.

Additional Information
Can be a constant string, a reference, or an expression.
The ReasonDescription is passed to the indicated Attribute as part of the write operation. The object also
includes the user’s write comment, if any. A Field Attribute description is used for the ReasonDescription
parameter only if the attribute is a Field Attribute and it has a description (is not null). Otherwise, the Short
Description for the corresponding ApplicationObject is used for the ReasonDescription parameter.

Comment_is _Editable
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Indicates whether user can edit the write comment.

Data Type
Bool

Additional Information
Can be a constant value, a reference, or an expression.
If set to True: The comment text box is enabled with exceptions. If Comment_Is_Editable is true and if the
Comment_ Enforcement parameter is PredefinedOnly, the comment text box is disabled. At run time, the
user can only select a comment from the predefined comment list.
If the Comment_ Enforcement parameter is not PredefinedOnly, the comment list and box are enabled. You
can select a comment from the comment list and modify it in the comment box.
If the predefined list is empty, the comment list is not shown in the dialog box.
If set to False: The predefined comment list does not appear in the Secured Write or Verified Write dialog
boxes. The editable comment text box is disabled.

Comment_Enforcement

Contains choices of Optional, Mandatory and PredefinedOnly.

Data Type
Enum

Enumerations
Optional = 0
The run-time user can enter a comment or leave it blank.
Mandatory = 1
The run-time user has to add a comment, either by selecting from the comment list or by entering a
comment in the comment box.
PredefinedOnly = 2
The run-time user can select a comment from the comment list only. The comment text box is disabled.

Additional Information
Can be a constant, a reference, or an expression.

Predefined_Comment_List

An array of strings that can be used as predefined comments.

Data Type
String[]

Valid Range
Maximum of 20 comments, each with a maximum of 200 characters.

Additional Information
The array can be empty (number of elements is 0).
Can be a constant, a reference, an expression, or NULL if empty. Can reference an attribute that contains an
array of strings.
If no predefined comment is entered, the predefined comment list is disabled at run time.
If Comment_Is_Editable is False, the predefined comment is still placed in the editable comment text box,
but the user cannot modify it at run time.

Return Values
Return values indicate success or failure status. A non-zero value indicates type of failure.
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0 The function returns a value of 0 (meaning success) if the
following are all true:

• The function parameters were valid.•

• The write operation was successfully placed on the queue•
for Secured and Verified Writes.

• If the user cancels the operation, a message is written to the•
Logger indicating user cancellation.

1 The function failed due to any error that is not covered by the
other specified return values. This includes any error that is not
covered by the other specified return values. If there is a failure,
a specific message is logged in the Logger.

2 One or more parameters were not coerced to the appropriate
data type at run time.

Example: Parameter is a reference with Boolean as the expected
data type. At run time, reference is to a String data type that
cannot be coerced to True or False. The function returns this
value and writes a message to the Logger.

3 The attribute parameter was not valid at run time.

• Attribute string was null, empty, or contained no attribute•
reference.

• Attribute string contained an item that was not a valid•
attribute reference.

• Attribute string contained an attribute reference that did•
not exist.

• Attribute string contained an attribute reference that was•
not of the Secured Write or Verified Write security
classification.

The function writes a message to the Logger identifying the
error and the invalid attribute string.

4 The Comment_Enforcement parameter value was out of the
range of valid enumerators.

Remarks
The SignedWrite() function is supported only for client scripting and not for object scripting.

A return value of 0 does not indicate whether the attribute was updated, only that the function placed an entry
on the queue to write to the attribute. The operator may decide to cancel the operation after the Secured Write
or Verified write dialog box is presented. In this case the attribute is not updated and a message is placed in the
Logger indicating that the user canceled the operation. Even if the user enters valid credentials and clicks OK, the
attribute still might not have been updated because of inadequate permission or data coercion problems.
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The SignedWrite() function supports the custom property passed as the first parameter with opened and closed
quotation marks, "".

If you configure the custom property CP as shown in the following script, the function attempts to resolve CP and
determine if it has a reference. If it has a reference, then the reference is retrieved and the write is performed on
the reference.
SignedWrite("CP", value, reason, editable, enforcement, null);

For more information about using the SignedWrite() function, see the topic Working with the SignedWrite()
Function for Secured and Verified Writes under "Managing Symbols" in the Creating and Managing Industrial
Graphics User Guide.

Examples
SignedWrite ("UserDefined_001.temp", 185, "This will change the oven temperature", true, 
1, null);

The following example shows the user an array of predefined comments:
Dim n as Integer;
n = SignedWrite("UserDefined_001.temp", 185, "This will change the oven temperature", 
true, 1, UserDefined_001.OvenCommentArray[ ]);

where UserDefined_001.OvenCommentArray is an attribute containing an array of strings.

WriteStatus()
Returns the enumerated write status of the last write to the specified attribute.

Category
Miscellaneous

Syntax
Result = WriteStatus( Attribute );

Parameter
Attribute

The attribute for which you want to return write status.

Return Value
The return statuses are:

• MxStatusOk•

• MxStatusPending•

• MxStatusWarning•

• MxStatusCommunicationError•

• MxStatusConfigurationError•

• MxStatusOperationalError•

• MxStatusSecurityError•

• MxStatusSoftwareError•

• MxStatusOtherError•
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Remarks
If the attribute has never been written to, this function returns MxStatusOk. This function always returns
MxStatusOk for attributes that do not support a calculated (non-Good) quality.

Example
WriteStatus(TIC101.SP);

String Functions
Use string functions to work with character strings and string values.

DText()
Returns one of two possible strings, depending on the value of the Discrete parameter.

Category
String

Syntax
StringResult = DText( Discrete, OnMsg, OffMsg );

Parameters
Discrete

A Boolean value or Boolean attribute.

OnMsg
The message that is shown when the value of Discrete equals true.

OffMsg
The message shown when Discrete equals false.

Example
StringResult = DText(me.temp > 150, "Too hot", "Just right");

StringASCII()
Returns the ASCII value of the first character in a specified string.

Category
String

Syntax
IntegerResult = StringASCII( Char );

Parameter
Char

Alphanumeric character or string or string attribute.

Remarks
When this function is processed, only the single character is tested or affected. If the string provided to
StringASCII contains more than one character, only the first character of the string is tested.
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Examples
StringASCII("A"); ' returns 65;
StringASCII("A Mixer is Running"); ' returns 65;
StringASCII("a mixer is running"); ' returns 97;

See Also
StringChar(), StringFromIntg(), StringFromReal(), StringFromTime(), StringInString(), StringLeft(), StringLen(),
StringLower(), StringMid(), StringReplace(), StringRight(), StringSpace(), StringTest(), StringToIntg(),
StringToReal(), StringTrim(), StringUpper(), Text()

StringChar()
Returns the character corresponding to a specified ASCII code.

Category
String

Syntax
StringResult = StringChar( ASCII );

Parameter
ASCII

ASCII code or an integer attribute.

Remarks
Use the StringChar function to add ASCII characters not normally represented on the keyboard to a string
attribute.

This function is also useful for SQL commands. The where expression sometimes requires double quotation
marks around string values, so use StringChar(34).

Example
In this example, a [Carriage Return (13)] and [Line Feed (10)] are added to the end of StringAttribute and passed
to ControlString. Inserting characters out of the normal 32-126 range of displayable ASCII characters can be very
useful for creating control codes for external devices such as printers or modems.
ControlString = StringAttribute+StringChar(13)+StringChar(10);

StringCompare()
Compares a string value with another string.

Category
String

Syntax
StringCompare( Text1, Text2 );

Parameters
Text1

First string in the comparison.

Text2
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Second string in the comparison.

Return Value
The return value is zero if the strings are identical, -1 if Text1’s value is less than Text2, or 1 if Text1’s value is
greater than Text2.

Example
Result = StringCompare ("Text1","Text2"); (or)
Result = StringCompare (MText1,MText2);
Where Result is an Integer or Real tag and MText1 and MText2 are Memory Message tags.

See Also
StringASCII(), StringChar(), StringFromIntg(), StringFromReal(), StringFromTime(), StringFromTimeLocal(),
StringInString(), StringLeft(), StringLen(), StringLower(), StringMid(), StringReplace(), StringRight(), StringSpace(),
StringTest(), StringToIntg(), StringToReal(), StringTrim(), StringUpper(), Text()

StringCompareNoCase()
Compares a string value with another string and ignores the case.

Category
String

Syntax
SStringCompareNoCase( Text1, Text2 );

Parameters
Text1

First string in the comparison.

Text2
Second string in the comparison.

Return Value
The return value is zero if the strings are identical (ignoring case), -1 if Text1’s value is less than Text2 (ignoring
case), or 1 if Text1’s value is greater than Text2 (ignoring case).

Example
Result = StringCompareNoCase ("Text1","TEXT1"); (or)
Result = StringCompareNoCase (MText1,MText2);
Where Result is an Integer or Real tag and MText1 and MText2 are Memory Message tags.

See Also
StringASCII(), StringChar(), StringFromIntg(), StringFromReal(), StringFromTime(), StringFromTimeLocal(),
StringInString(), StringLeft(), StringLen(), StringLower(), StringMid(), StringReplace(), StringRight(), StringSpace(),
StringTest(), StringToIntg(), StringToReal(), StringTrim(), StringUpper(), Text()

StringFromGMTTimeToLocal()
Converts a time value (in seconds since Jan-01-1970) to a particular string representation. This is the same as
StringFromTime().
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Category
String

Syntax
MessageResult=StringFromGMTTimeToLocal(SecsSince1-1-70,StringType);

Parameters
SecsSince1-1-70

Is converted to the StringType specified and the result is stored in MessageResult.

StringType
Determines the display method:

1 = Displays the date in the same format set from the windows control Panel. (Similar to that displayed for
$DateString.)

2 = Displays the time in the same format set from the Windows control Panel. (Similar to that displayed for
$TimeString.)

3 = Displays a 24-character string indicating both the date and time: "Wed Jan 02 02:03:55 1993"

4 = Displays the short form for the day of the week: "Wed"

5 = Displays the long form for the day of the week: "Wednesday"

Remarks
Any adjustments necessary due to Daylight Savings Time are automatically applied to the return result.
Therefore, it is not necessary to make any manual adjustments to the input value to convert to DST.

Example
This example assumes that the time zone on the local node is Pacific Standard Time (UTC-0800). The UTC time
passed to the function is 12:00:00 AM on Friday, 1/2/1970. Since PST is 8 hours behind UTC, the function will
return the following results:
StringFromGMTTimeToLocal(86400, 1); ' returns "1/1/1970"
StringFromGMTTimeToLocal(86400, 2); ' returns "04:00:00 PM"
StringFromGMTTimeToLocal(86400, 3); ' returns "Thu Jan 01 16:00:00 1970"
StringFromGMTTimeToLocal(86400, 4); ' returns "Thu"
StringFromGMTTimeToLocal(86400, 5); ' returns "Thursday"

See Also
StringASCII(), StringChar(), StringFromIntg(), StringFromReal(), StringFromTime(), StringFromTimeLocal(),
StringInString(), StringLeft(), StringLen(), StringLower(), StringMid(), StringReplace(), StringRight(), StringSpace(),
StringTest(), StringToIntg(), StringToReal(), StringTrim(), StringUpper(), Text()

StringFromIntg()
Converts an integer value into its string representation in another base and returns the result.

Category
String

Syntax
SringResult = StringFromIntg( Number, numberBase );
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Parameters
Number

Number to convert. Any number or an integer attribute.

numberBase
Base to use in conversion. Any number or an integer attribute.

Examples
StringFromIntg(26, 2); ' returns "11010"
StringFromIntg(26, 8); ' returns "32"
StringFromIntg(26, 16); ' returns "1A"

See Also
StringASCII(), StringChar(), StringFromReal(), StringFromTime(), StringInString(), StringLeft(), StringLen(),
StringLower(), StringMid(), StringReplace(), StringRight(), StringSpace(), StringTest(), StringToIntg(),
StringToReal(), StringTrim(), StringUpper(), Text()

StringFromReal()
Converts a real value into its string representation, either as a floating-point number or in exponential notation,
and returns the result.

Category
String

Syntax
StringResult = StringFromReal( Number, Precision, Type );

Parameters
Number

Converted to the Precision and Type specified. Any number or a float attribute.

Precision
Specifies how many decimal places is shown. Any number or an integer attribute.

Type
A string value that determines the display method. Possible values are:

f = Display in floating-point notation.

e = Display in exponential notation with a lowercase "e."

E = Display in exponential notation with an uppercase "E" followed by a plus sign and at least three exponential
digits.

Examples
StringFromReal(263.355, 2,"f"); ' returns "263.36";
StringFromReal(263.355, 2,"e"); ' returns "2.63e2";
StringFromReal(263.355, 2,"E"); ' returns "2.63 E+002";

See Also
StringASCII(), StringChar(), StringFromIntg(), StringFromTime(), StringInString(), StringLeft(), StringLen(),
StringLower(), StringMid(), StringReplace(), StringRight(), StringSpace(), StringTest(), StringToIntg(),
StringToReal(), StringTrim(), StringUpper(), Text()
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StringFromTime()
Converts a time value (in seconds since January 1, 1970) into a particular string representation and returns the
result.

Category
String

Syntax
StringResult = StringFromTime( SecsSince1-1-70, StringType );

Parameters
SecsSince1-1-70

Converted to the StringType specified.

StringType
Determines the display method. Possible values are:

1 = Shows the date in the same format set from the Windows Control Panel.

2 = Shows the time in the same format set from the Windows Control Panel.

3 = Shows a 24-character string indicating both the date and time: "Wed Jan 02 02:03:55 1993"

4 = Shows the short form for a day of the week: "Wed"

5 = Shows the long form for a day of the week: "Wednesday"

Remarks
The time value is UTC equivalent: number of elapsed seconds since January 1, 1970 GMT. The value returned
reflects the local time.

Examples
StringFromTime(86400, 1); ' returns "1/2/1970"
StringFromTime(86400, 2); ' returns "12:00:00 AM"
StringFromTime(86400, 3); ' returns "Fri Jan 02 00:00:00 1970"
StringFromTime(86400, 4); ' returns "Fri"
StringFromTime(86400, 5); ' returns "Friday"

See Also
StringASCII(), StringChar(), StringFromIntg(), StringFromReal(), StringFromTime(), StringInString(), StringLeft(),
StringLen(), StringLower(), StringMid(), StringReplace(), StringRight(), StringSpace(), StringTest(), StringToIntg(),
StringToReal(), StringTrim(), StringUpper(), Text()

StringFromTimeLocal()
Converts a time value (in seconds since Jan-01-1970) into a particular string representation. The value returned
also represents local time.

Category
String

Syntax
MessageResult=StringFromTimeLocal(SecsSince1-1-70,
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StringType);

Parameters
SecsSince1-1-70

Is converted to the StringType specified and the result is stored in MessageResult.

StringType
Determines the display method:

1 = Displays the date in the same format set from the windows control Panel. (Similar to that displayed for
$DateString.)

2 = Displays the time in the same format set from the Windows control Panel. (Similar to that displayed for
$TimeString.)

3 = Displays a 24-character string indicating both the date and time: "Wed Jan 02 02:03:55 1993"

4 = Displays the short form for the day of the week: "Wed"

5 = Displays the long form for the day of the week: "Wednesday"

Remarks
Any adjustments necessary due to Daylight Savings Time will automatically be applied to the return result.
Therefore, it is not necessary to make any manual adjustments for DST to the input value.

Example
StringFromTimeLocal (86400, 1); ' returns "1/2/1970"
StringFromTimeLocal (86400, 2); ' returns "12:00:00 AM"
StringFromTimeLocal (86400, 3); ' returns "Fri Jan 02 00:00:00 1970"
StringFromTimeLocal (86400, 4); ' returns "Fri"
StringFromTimeLocal (86400, 5); ' returns "Friday"

See Also
StringASCII(), StringChar(), StringFromIntg(), StringFromReal(), StringFromTime(), StringInString(), StringLeft(),
StringLen(), StringLower(), StringMid(), StringReplace(), StringRight(), StringSpace(), StringTest(), StringToIntg(),
StringToReal(), StringTrim(), StringUpper(), Text()

StringInString()
Returns the position in a string of text where a specified string first occurs.

Category
String

Syntax
IntegerResult = StringInString( Text, SearchFor, StartPos, CaseSens );

Parameters
Text

The string that is searched. Actual string or a string attribute.

SearchFor
The string to be searched for. Actual string or a string attribute.

StartPos
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Determines the position in the text where the search begins. Any number or an integer attribute.

CaseSens
Determines whether the search is case-sensitive.
0 = Not case-sensitive
1 = Case-sensitive
Any number or an integer attribute.

Remarks
If multiple occurrences of SearchFor are found, the location of the first is returned.

Examples
StringInString("The mixer is running", "mix", 1, 0) ' returns 5;
StringInString("Today is Thursday", "day", 1, 0) ' returns 3;
StringInString("Today is Thursday", "day", 10, 0) ' returns 15;
StringInString("Today is Veteran's Day", "Day", 1, 1) ' returns 20;
StringInString("Today is Veteran's Day", "Night", 1, 1) ' returns 0;

See Also
StringASCII(), StringChar(), StringFromIntg(), StringFromReal(), StringFromTime(), StringLeft(), StringLen(),
StringLower(), StringMid(), StringReplace(), StringRight(), StringSpace(), StringTest(), StringToIntg(),
StringToReal(), StringTrim(), StringUpper(), Text()

StringLeft()
Returns a specified number of characters in a string value, starting with the leftmost string character.

Category
String

Syntax
StringResult = StringLeft( Text, Chars );

Parameters
Text

Actual string or a string attribute.

Chars
Number of characters to return or an integer attribute.

Remarks
If Chars is set to 0, the entire string is returned.

Examples
StringLeft("The Control Pump is On", 3) ' returns "The";
StringLeft("Pump 01 is On", 4) ' returns "Pump";
StringLeft("Pump 01 is On", 96) ' returns "Pump 01 is On";
StringLeft("The Control Pump is On", 0) ' returns "The Control Pump is On";

See Also
StringASCII(), StringChar(), StringFromIntg(), StringFromReal(), StringFromTime(), StringInString(), StringLen(),
StringLower(), StringMid(), StringReplace(), StringRight(), StringSpace(), StringTest(), StringToIntg(),
StringToReal(), StringTrim(), StringUpper(), Text()

© 2022 AVEVA Group plc and its subsidiaries. All rights reserved.
  

Page 409

AVEVA™ Industrial Graphic Editor User Guide 
Appendix C – QuickScript References



StringLen()
Returns the number of characters in a string.

Category
String

Syntax
IntegerResult = StringLen( Text );

Parameter
Text

Actual string or a string attribute.

Remarks
All the characters in the string attribute are counted, including blank spaces and those not normally shown on
the screen.

Examples
StringLen("Twelve percent") ' returns 14;
StringLen("12%") ' returns 3;
StringLen("The end." + StringChar(13)) ' returns 9;

The carriage return character is ASCII 13.

See Also
StringASCII(), StringChar(), StringFromIntg(), StringFromReal(), StringFromTime(), StringInString(), StringLeft(),
StringLower(), StringMid(), StringReplace(), StringRight(), StringSpace(), StringTest(), StringToIntg(),
StringToReal(), StringTrim(), StringUpper(), Text()

StringLower()
Converts all uppercase characters in text string to lowercase and returns the result.

Category
String

Syntax
StringResult = StringLower( Text );

Parameter
Text

String to be converted to lowercase. Actual string or a string attribute.

Remarks
Lowercase characters, symbols, numbers, and other special characters are not affected.

Examples
StringLower("TURBINE") ' returns "turbine";
StringLower("22.2 Is The Value") ' returns "22.2 is the value";
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See Also
StringASCII(), StringChar(), StringFromIntg(), StringFromReal(), StringFromTime(), StringInString(), StringLeft(),
StringLen(), StringMid(), StringReplace(), StringRight(), StringSpace(), StringTest(), StringToIntg(), StringToReal(),
StringTrim(), StringUpper(), Text()

StringMid()
Extracts a specific number of characters from a starting point within a string and returns the extracted character
string as the result.

Category
String

Syntax
StringResult = StringMid( Text, StartChar, Chars );

Parameters
Text

Actual string or a string attribute to extract a range of characters.

StartChar
The position of the first character within the string to extract. Any number or an integer attribute.

Chars
The number of characters within the string to return. Any number or an integer attribute.

Remarks
This function is slightly different than the StringLeft() function and StringRight() function in that it allows you to
specify both the start and end of the string that is to be extracted.

Examples
StringMid("The Furnace is Overheating",5,7);  ' returns "Furnace";
StringMid("The Furnace is Overheating",13,3);  ' returns "is ";
StringMid("The Furnace is Overheating",16,50); ' returns "Overheating"

See Also
StringASCII(), StringChar(), StringFromIntg(), StringFromReal(), StringFromTime(), StringInString(), StringLeft(),
StringLen(), StringLower(), StringReplace(), StringRight(), StringSpace(), StringTest(), StringToIntg(), StringToReal(),
StringTrim(), StringUpper(), Text()

StringReplace()
Replaces or changes specific parts of a provided string and returns the result.

Category
String

Syntax
StringResult = StringReplace( Text, SearchFor, ReplaceWith, CaseSens, NumToReplace, 
MatchWholeWords );
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Parameters
Text

The string in which characters, words, or phrases will be replaced. Actual string or a string attribute.

SearchFor
The string to search for and replace. Actual string or a string attribute.

ReplaceWith
The replacement string. Actual string or a string attribute.

CaseSens
Determines whether the search is case-sensitive. (0=no and 1=yes) Any number or an integer attribute.

NumToReplace
Determines the number of occurrences to replace. Any number or an integer attribute. To indicate all
occurrences, set this value to -1.

MatchWholeWords
Determines whether the function limits its replacement to whole words. (0=no and 1=yes) Any number or an
integer attribute. If MatchWholeWords is turned on (set to 1) and the SearchFor is set to "and", the "and" in
"handle" are not replaced. If the MatchWholeWords is turned off (set to 0), it is replaced.

Remarks
Use this function to replace characters, words, or phrases within a string.

The StringReplace() function does not recognize special characters, such as @ # $ % & * ( ). It reads them as
delimiters. For example, if the function StringReplace() (abc#,abc#,1234,0,1,1) is processed, there is no
replacement. The # sign is read as a delimiter instead of a character.

Examples
StringReplace("In From Within","In","Out",0,1,0) ' returns "Out From Within" (replaces 
only the first one);
StringReplace("In From Within","In","Out",0,-1,0) ' returns "Out From without" (replaces 
all occurrences);
StringReplace("In From Within","In","Out",1,-1,0) ' returns "Out From Within" (replaces 
all that match case);
StringReplace("In From Within","In","Out",0,-1,1) ' returns "Out From Within" (replaces 
all that are whole words);

See Also
StringASCII(), StringChar(), StringFromIntg(), StringFromReal(), StringFromTime(), StringInString(), StringLeft(),
StringLen(), StringLower(), StringMid(), StringRight(), StringSpace(), StringTest(), StringToIntg(), StringToReal(),
StringTrim(), StringUpper(), Text()

StringRight()
Returns the specified number of characters starting at the right-most character of text.

Category
String

Syntax
StringResult = StringRight( Text, Chars );

© 2022 AVEVA Group plc and its subsidiaries. All rights reserved.
  

Page 412

AVEVA™ Industrial Graphic Editor User Guide 
Appendix C – QuickScript References



Parameters
Text

Actual string or a string attribute.

Chars
The number of characters to return or an integer attribute.

Remarks
If Chars is set to 0, the entire string is returned.

Examples
StringRight("The Pump is On", 2) ' returns "On";
StringRight("The Pump is On", 5) ' returns "is On";
StringRight("The Pump is On", 87) ' returns "The Pump is On";
StringRight("The Pump is On", 0) ' returns "The Pump is On";

See Also
StringASCII(), StringChar(), StringFromIntg(), StringFromReal(), StringFromTime(), StringInString(), StringLeft(),
StringLen(), StringLower(), StringMid(), StringReplace(), StringSpace(), StringTest(), StringToIntg(), StringToReal(),
StringTrim(), StringUpper(), Text()

StringSpace()
Generates a string of spaces either within a string attribute or within an expression and returns the result.

Category
String

Syntax
StringResult = StringSpace( NumSpaces );

Parameter
NumSpaces

Number of spaces to return. Any number or an integer attribute.

Examples
All spaces are represented by the "×" character:
StringSpace(4) ' returns "××××";
"Pump" + StringSpace(1) + "Station" ' returns "Pump×Station";

See Also
StringASCII(), StringChar(), StringFromIntg(), StringFromReal(), StringFromTime(), StringInString(), StringLeft(),
StringLen(), StringLower(), StringMid(), StringReplace(), StringRight(), StringTest(), StringToIntg(), StringToReal(),
StringTrim(), StringUpper(), Text()

StringTest()
Tests the first character of text to determine whether it is of a certain type and returns the result.

Category
String
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Syntax
DiscreteResult = StringTest( Text, TestType );

Parameters
Text

String that function acts on. Actual string or a string attribute.

TestType
Determines the type of test. Possible values are:

1 = Alphanumeric character ('A-Z', 'a-z' and '0-9')

2 = Numeric character ('0- 9')

3 = Alphabetic character ('A-Z' and 'a-z')

4 = Uppercase character ('A-Z')

5 = Lowercase character ('a'-'z')

6 = Punctuation character (0x21-0x2F)

7 = ASCII characters (0x00 - 0x7F)

8 = Hexadecimal characters ('A-F' or 'a-f' or '0-9')

9 = Printable character (0x20-0x7E)

10 = Control character (0x00-0x1F or 0x7F)

11 = White Space characters (0x09-0x0D or 0x20)

Remarks
StringTest() function returns true to DiscreteResult if the first character in Text is of the type specified by
TestType. Otherwise, false is returned. If the StringTest() function contains more than one character, only the first
character of the attribute is tested.

Examples
StringTest("ACB123",1) ' returns 1;
StringTest("ABC123",5) ' returns 0;

See Also
StringASCII(), StringChar(), StringFromIntg(), StringFromReal(), StringFromTime(), StringInString(), StringLeft(),
StringLen(), StringLower(), StringMid(), StringReplace(), StringRight(), StringSpace(), StringToIntg(), StringToReal(),
StringTrim(), StringUpper(), Text()

StringToIntg()
Converts the numeric value of a string to an integer value and returns the result.

Category
String

Syntax
IntegerResult = StringToIntg( Text );
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Parameter
Text

String that function acts on. Actual string or a string attribute.

Remarks
When this statement is evaluated, the system reads the first character of the string for a numeric value. If the
first character is other than a number, the string's value is equated to zero (0). Blank spaces are ignored. If the
first character is a number, the system continues to read the subsequent characters until a non-numeric value is
detected.

Examples
StringToIntg("ABCD"); ' returns 0;
StringToIntg("22.2 is the Value"); ' returns 22  (since integers are whole numbers);
StringToIntg("The Value is 22"); ' returns 0;

See Also
StringASCII(), StringChar(), StringFromIntg(), StringFromReal(), StringFromTime(), StringInString(), StringLeft(),
StringLen(), StringLower(), StringMid(), StringReplace(), StringRight(), StringSpace(), StringTest(), StringToReal(),
StringTrim(), StringUpper(), Text()

StringToReal()
Converts the numeric value of a string to a real (floating point) value and returns the result.

Category
String

Syntax
RealResult = StringToReal( Text );

Parameter
Text

String that function acts on. Actual string or a string attribute.

Remarks
When this statement is evaluated, the system reads the first character of the string for a numeric value. If the
first character is other than a number (blank spaces are ignored), the string's value is equated to zero (0). If the
first character is found to be a number, the system continues to read the subsequent characters until a non-
numeric value is encountered.

Examples
StringToReal("ABCD"); ' returns 0;
StringToReal("22.261 is the value"); ' returns 22.261;
StringToReal("The Value is 2"); ' returns 0;

See Also
StringASCII(), StringChar(), StringFromIntg(), StringFromReal(), StringFromTime(), StringInString(), StringLeft(),
StringLen(), StringLower(), StringMid(), StringReplace(), StringRight(), StringSpace(), StringTest(), StringToIntg(),
StringTrim(), StringUpper(), Text()
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StringTrim()
Removes unwanted spaces from text and returns the result.

Category
String

Syntax
StringResult = StringTrim( Text, TrimType );

Parameter
Text

String that is trimmed of spaces. Actual string or a string attribute.

TrimType
Determines how the string is trimmed. Possible values are:

1 = Remove leading spaces to the left of the first non-space character

2 = Remove trailing spaces to the right of the last non-space character

3 = Remove all spaces except for single spaces between words

Remarks
The text is searched for white-spaces (ASCII 0x09-0x0D or 0x20) that are to be removed. TrimType determines
the method used by the function:

Examples
All spaces are represented by the "×" character.
StringTrim("×××××This×is×a××test×××××", 1) ' returns "This×is×a××test×××××";
StringTrim("×××××This×is×a××test×××××", 2) ' returns "×××××This×is×a××test";
StringTrim("×××××This×is×a××test×××××", 3) ' returns "This×is×a×test";

The StringReplace() function can remove ALL spaces from a specified a string attribute. Simply replace all the
space characters with a "null."

See Also
StringASCII(), StringChar(), StringFromIntg(), StringFromReal(), StringFromTime(), StringInString(), StringLeft(),
StringLen(), StringLower(), StringMid(), StringReplace(), StringRight(), StringSpace(), StringTest(), StringToIntg(),
StringToReal(), StringUpper(), Text()

StringUpper()
Converts all lowercase text characters to uppercase and returns the result.

Category
String

Syntax
StringResult = StringUpper( Text );

Parameter
Text
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String to be converted to uppercase. Actual string or a string attribute.

Remarks
Uppercase characters, symbols, numbers, and other special characters are not affected.

Examples
StringUpper("abcd"); ' returns "ABCD";
StringUpper("22.2 is the value"); ' returns "22.2 IS THE VALUE";

See Also
StringASCII(), StringChar(), StringFromIntg(), StringFromReal(), StringFromTime(), StringInString(), StringLeft(),
StringLen(), StringLower(), StringMid(), StringReplace(), StringRight(), StringSpace(), StringTest(), StringToIntg(),
StringToReal(), StringTrim(), Text()

Text()
Converts a number to text based on a specified format.

Category
String

Syntax
StringResult = Text( Number, Format );

Parameters
Number

Any number or numeric attribute.

Format
Format to use in conversion. Actual string or a string attribute.

Examples
Text(66,"#.00"); ' returns 66.00;
Text(22.269,"#.00"); ' returns 22.27;
Text(9.999,"#.00"); ' returns 10.00;

The following example shows how to use this function within another function:
LogMessage("The current value of FreezerRoomTemp is:" + Text (FreezerRoomTemp, "#.#"));

In the following example, MessageTag is set to "One=1 Two=2".
MessageTag = "One + " + Text(1,"#") + StringChar(32) +  "Two +" + Text(2,"#");

See Also
StringFromIntg(), StringToIntg(), StringFromReal(), StringToReal()

System Functions
Use system functions to interact with the operating system or other core system functions, such as ActiveX
objects.

CreateObject()
Creates an ActiveX (COM) object.
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Category
System

Syntax
ObjectResult = CreateObject( ProgID );

Parameter
ProgID

The program ID (as a string) of the object to be created.

Example
CreateObject("ADODB.Connection");

Now()
Returns the current time.

Category
System

Syntax
TimeValue = Now();

Remarks
The return value can be formatted using .NET functions.

QuickScript .NET Variables
Declare the QuickScript .NET variables before they can be used in QuickScript .NET scripts. Variables can be used
on both the left and right side of statements and expressions.

Local variables or attributes can be used together in the same script. Variables declared within the script body
lose their value after the script is executed. Those declared in the script body cannot be accessed by other
scripts.

Variables declared in the Declarations area maintain their values throughout the lifetime of the object that the
script is associated with.

Declare each variable in the script by a separate DIM statement followed by a semicolon. Enter DIM
statements in the Declarations area of the Script tab page. The DIM statement syntax is as follows:
DIM <variable_name> [ ( <upper_bound> 
[, <upper_bound >[, < upper_bound >]] ) ]  
[ AS <data_type> ];

where:

DIM Required keyword.
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<variable_name> Name that begins with a letter (A-Z or a-z) and whose remaining characters
can be any combination of letters (A-Z or a-z), digits (0-9) and underscores
(_). The variable name is limited to 255 Unicode characters.

<upper_bound> Reference to the upper bound (a number between 1 and 2,147,483,647,
inclusive) of an array dimension. Three dimensions are supported in a DIM
statement, each being nested in the syntax structure. After the upper bound
is specified, it is fixed after the declaration. A statement similar to Visual
Basic’s ReDim is not supported.

The lower bound of each array dimension is always 1.

AS Optional keyword for declaring the variable’s datatype.

<data_type> Any one of the following 11 datatypes: Boolean, Discrete, Integer,
ElapsedTime, Float, Real, Double, String, Message, Time or Object.

Data_type can also be a .Net data_type like System.Xml.XmlDocument or a
type defined in an imported script library

If you omit the AS clause from the DIM statement, the variable, by default, is
declared as an Integer datatype. For example:

DIM LocVar1;

is equivalent to:

DIM LocVar1 AS Integer;

In contrast to attribute names, variable names must not contain dots. Variable names and the data type
identifiers are not case sensitive. If there is a naming conflict between a declared variable and another named
entity in the script (for example, attribute name, alias or name of an object leveraged by the script), the variable
name takes precedence over the other named entities. If the variable name is the same as an alias name, a
warning message appears when the script is validated to indicate that the alias is ignored.

The syntax for specifying the entire array is "[ ]" for both local array variables and for attribute references. For
example, to assign an attribute array to a local array, the syntax is:

locarr[] = tag.attr[];

DIM statements can be located anywhere in the script body, but they have to precede the first referencing script
statement or expression. If a local variable is referenced before the DIM statement, script validation done when
you save the object containing the script prompts you to define it.

The validation mentioned above occurs only when you save the object containing the script. This is not the script
syntax validation done when you click the Validate Script button.

Don't cascade DIM statements. For example, the following examples are invalid:
DIM LocVar1 AS Integer, LocVar2 AS Real;
DIM LocVar3, LocVar4, LocVar5, AS Message;
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To declare multiple variables, enter separate DIM statements for each variable.

When used on the right side of an equation, declared local variables always cause expressions on the left side to
have Good quality. For example :
dim x as integer;
dim y as integer;
x = 5;
y = 5;
me.attr = 5;
me.attr = x;
me.attr = x+y;

In each case of me.attr, quality is Good.

When you use a variable in an expression to the right of the operator, its Quality is treated as Good for the
purpose of data quality propagation.

You can use null to indicate that there is no object currently assigned to a variable. Using null has the same
meaning as the keyword "null" in C# or "nothing" in Visual Basic. Assigning null to a variable makes the variable
eligible for garbage collection. You may not use a variable whose value is null. If you do, the script terminates and
an error message appears in the logger. You may, however, test a variable for null. For example:
IF myvar == null THEN ...

It is not possible to pass attributes as parameters for system objects. To work around this issue, use a local
variable as an intermediary or explicitly convert the attribute to a string using an appropriate function call when
calling the system object.

Numbers and Strings
Allowed format for integer constants in decimal format is as follows:
IntegerConst =  0 or [sign] <non-zero_digit> <digit>*;

where:
sign :: = + | -
non-zero_digit ::= 1-9
digit ::= 0-9

For example, an integer constant is a zero or consists of an optional sign followed by one or more digits. Leading
zeros are not allowed. Integer constants outside the range –2147483648 to 2147483647 cause an overflow error.

Prepending either 0x or 0X causes a literal integer constant to be interpreted as hexadecimal notation. The +/-
sign is supported.

The acceptable float for integers in hexadecimal is as follows:
IntegerHexConst = [<sign>] <0><x (or X)> <hexdigit>*

where:

sign ::= + or -

hexdigit ::= 0-9, A-F, a-f (only eight hexdigits [32-bits] are allowed)

Allowed format for floats is as follows:
FloatConst ::= [<sign>] <digit>* .<digit>+ [<exponent>;]

or
             [<sign>] <digit>+ [.<digit>* [<exponent>]];
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where:
sign ::= + or -
digit ::= 0-9 (can be one or more decimal digits)
exponent = e (or E) followed by a sign and then digit(s)

Float constants are applicable as values for variables of type float, real, or double. For example, float constants
don't take the number of bytes into account. Script validation detects an overflow when a float, real, or double
variable has been assigned a float constant that exceeds the maximum value.

If no digits appear before the period (.), at least one has to appear after it. If neither an exponent part nor the
period appears, a period is assumed to follow the last digit in the string.

If an attribute reference exists that has a format similar to a float constant with an exponent (such as "5E3"),
then use the Attribute qualifier, as follows:
Attribute("5E3")

Strings have to be surrounded by double quotation marks. They are referred to as quoted strings. The double-
double quote indicates a single double-quote in the string. For example, the string:
Joe said, "Look at that."

can be represented in QuickScript .NET as:
"Joe said, ""Look at that."""

QuickScript .NET Control Structures
QuickScript .NET provides five primary control structures in the scripting environment:

• IF … THEN … ELSEIF … ELSE … ENDIF•

• FOR … TO … STEP … NEXT Loop•

• FOR EACH … IN … NEXT•

• TRY ... CATCH•

• WHILE Loop•

IF … THEN … ELSEIF … ELSE … ENDIF
IF-THEN-ELSE-ENDIF conditionally executes various instructions based on the state of an expression. The syntax is
as follows:
IF <Boolean_expression> THEN
    [statements];
[ { ELSEIF
    [statements] } ];
[ ELSE
    [statements] ];
ENDIF;

Where Boolean_expression is an expression that can be evaluated as a Boolean.

Depending on the data type returned by the expression, the expression is evaluated to constitute a
True or False state according to the following table:

© 2022 AVEVA Group plc and its subsidiaries. All rights reserved.
  

Page 421

AVEVA™ Industrial Graphic Editor User Guide 
Appendix C – QuickScript References



Data Type Mapping

Boolean, Discrete Directly used (no mapping needed).

Integer Value = 0 evaluated as False.
Value != 0 evaluated as True.

Float, Real Value = 0 evaluated as False.
Value != 0 evaluated as True.

Double Value = 0 evaluated as False.
Value != 0 evaluated as True.

String, Message Cannot be mapped. Using an expression that results in a string type as the
Boolean_expression results in a script validation error.

Time Cannot be mapped. Using an expression that results in a time type as the
Boolean_expression results in a script validation error.

ElapsedTime Cannot be mapped. Using an expression that results in an elapsed time
type as the Boolean_expression results in a script validation error.

Object Using an expression that results in an object type. Validates, but at run
time, the object is converted to a Boolean. If the type cannot be converted
to a Boolean, a run-time exception is raised.

The first block of statements is executed if Boolean_expression evaluates to True. Optionally, a second block of
statements can be defined after the keyword ELSE. This block is executed if the Boolean_expression evaluates to
False.

To help decide between multiple alternatives, an optional ELSEIF clause can be used as often as
needed. The ELSEIF clause mimics switch statements offered by other programming languages. For
example:
IF value == 0 Then
          Message = "Value is zero";
     ELSEIF value > 0 Then
          Message = "Value is positive";     ELSEIF value < 0 Then
          Message = "Value is negative";
     ELSE
          {Default. Should never occur in this example};
ENDIF;

The following approach nests a second IF compound statement within a previous one and requires an
additional ENDIF:
IF (X1 == 1) THEN
           X1 = 5;
  { ELSEIF <X1 == 2> THEN
           X1 = 10;
    ELSEIF X1 == 3 THEN
           X1 = 20 ;
    ELSEIF X1 == 4 THEN
           X1 = 30 };
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        IF X1 == 99 THEN
           X1 = 0;
        ENDIF;
ENDIF;

See Sample Scripts for more ideas about using this type of control structure.

IF … THEN … ELSEIF … ELSE … ENDIF and Attribute Quality
When an attribute value is copied to another attribute of the same type, the attribute’s quality is also copied.
This can be especially relevant when working with I/O attributes. For example, the following two statements
copy both value and quality:
me.Attr2 = me.Attr1;
me.Attr2.value = me.Attr1.value;

If only the value needs to be copied and the attribute has the quality BAD, you can use a temporary variable to
hold the value. For example:
Dim temp as Integer;
temp = me.Attr1;
me.Attr2 = temp;

If there is a comparison such as Attr1 <> Attr2 and one of the attributes has the quality BAD, then the statements
within the IF control block are not executed. For example, assuming Attr1 has the quality BAD:
if me.Attr1<> me.Attr2 then

  me.Attr2 =  me.Attr1;
endif;

In this script, the statement me.Attr2 = me.Attr1 is not executed because Attr1 has the quality BAD and
comparing a BAD quality value with a good quality value is not defined/not possible.

The recommended approach is to first verify the quality of Attr1, as shown in the following example:
if(IsBad(me.Attr1)) then
LogMessage("Attr1 quality is bad, its value is not copied to Attr2");
else
  if me.Attr1<> me.Attr2 then
      me.AttrA2 =  me.Attr1;
  endif;
endif;

An alternative method of verifying quality is to use the "==" operator:
if Me.Attr1 == TRUE then

Or, you can add the "value" property to the simplified IF THEN statement:
if Me.Attr1.value then

Your scripts will execute correctly if you verify the data quality using any of the above methods.

FOR … TO … STEP … NEXT Loop
FOR-NEXT performs a function (or set of functions) within a script several times during a single execution of a
script. The general format of the FOR-NEXT loop is as follows:
FOR <analog_var> = <start_expression> TO <end_expression> [STEP <change_expression>];
         [statements];
         [EXIT FOR;];
         [statements];
NEXT;
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Where:

• analog_var is a variable of type Integer, Float, Real, or Double.•

• start_expression is a valid expression to initialize analog_var to a value for execution of the loop.•

• end_expression is a valid expression. If analog_var is greater than end_expression, execution of the script•
jumps to the statement immediately following the NEXT statement.

This holds true if loop is incrementing up, otherwise, if loop is decrementing, loop termination occurs if
analog_var is less than end_expression.

• change_expression is an expression that defines the increment or decrement value of analog_var after•
execution of the NEXT statement. The change_expression can be either positive or negative.

• If change_expression is positive, start_expression has to be less than or equal to end_expression or the•
statements in the loop don't execute.

• If change_expression is negative, start_expression has to be greater than or equal to end_expression for•
the body of the loop to be executed.

• If STEP is not set, then change_expression defaults to 1 for increasing increments, and defaults to -1 for•
decreasing increments.

Exit the loop from within the body of the loop with the EXIT FOR statement.

The FOR loop is executed as follows:

1. analog_var is set equal to start_expression.1.

2. If change_expression is positive, the system tests to see if analog_var is greater than end_expression. If so,2.
the loop exits. If change_expression is negative, the system tests to see if analog_var is less than
end_expression. If so, program execution exits the loop.

3. The statements in the body of the loop are executed. The loop can potentially be exited via the EXIT FOR3.
statement.

4. analog_var is incremented by 1,-1, or by change_expression if it is specified.4.

5. Steps 2 through 4 are repeated.5.

FOR-NEXT loops can be nested. The number of levels of nesting possible depends on memory and resource
availability.

FOR EACH … IN … NEXT
FOR EACH loops can be used only with collections exposed by OLE Automation servers. A FOR-EACH loop
performs a function (or set of functions) within a script several times during a single execution of a script. The
general format of the FOR-EACH loop is as follows:
FOR EACH <object_variable> IN <collection_object >
   [statements];
   [EXIT FOR;];
   [statements];
NEXT;

Where:

• object_variable is a dimmed variable.•

• collection_object is a variable holding a collection object.•
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As in the case of the FOR … TO loop, it is possible to exit the execution of the loop through the statement EXIT
FOR from within the loop.

TRY ... CATCH
TRY ... CATCH provides a way to handle some or all possible errors that may occur in a given block of code, while
still running rather than terminating the program. The TRY part of the code is known as the try block. Deal with
any exceptions in the CATCH part of the code, known as the catch block.

The general format for TRY ... CATCH is as follows:
TRY

[try statements] ’guarded section
CATCH

[catch statements]
ENDTRY

Where:

tryStatements

Statement(s) where an error can occur. Can be a compound statement. The tryStatement is a guarded section.

catchStatements

Statement(s) to handle errors occurring in the associated Try block. Can be a compound statement.

Statements inside the Catch block may reference the reserved ERROR variable, which is a .NET System.Exception
thrown from the Try block. The statements in the Catch block run only if an exception is thrown from the Try
block.

TRY ... CATCH is executed as follows:

1. Run-time error handling starts with TRY. Put code that might result in an error in the try block.1.

2. If no run-time error occurs, the script will run as usual. Catch block statements will be ignored.2.

3. If a run-time error occurs, the rest of the try block does not execute.3.

4. When a run-time error occurs, the program immediately jumps to the CATCH statement and executes the4.
catch block.

The simplest kind of exception handling is to stop the program, write out the exception message, and
continue the program.

The error variable is not a string, but a .NET object of System.Exception. This means you can determine the
type of exception, even with a simple CATCH statement. Call the GetType() method to determine the
exception type, and then perform the operation you want, similar to executing multiple catch blocks.

Example:
dim command = new System.Data.SqlClient.SqlCommand;
dim reader as System.Data.SqlClient.SqlDataReader;
command.Connection = new System.Data.SqlClient.SqlConnection;
try

command.Connection.ConnectionString = "Integrated Security=SSPI";
command.CommandText="select * from sys.databases";
command.Connection.Open();
reader = command.ExecuteReader();
while reader.Read()
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me.name = reader.GetString(0);
LogMessage(me.name);

endWhile;
catch

LogMessage(error);
endtry;
if reader <> null and not reader.IsClosed then

reader.Close();
endif;
if command.Connection.State == System.Data.ConnectionState.Open then

command.Connection.Close();
endif;

WHILE Loop
WHILE loop performs a function or set of functions within a script several times during a single execution of a
script while a condition is true. The general format of the WHILE loop is as follows:
WHILE <Boolean_expression>
        [statements]
        [EXIT WHILE;]
        [statements]
ENDWHILE;

Where: Boolean_expression is an expression that can be evaluated as a Boolean as defined in the description of
IF…THEN statements.

It is possible to exit the loop from the body of the loop through the EXIT WHILE statement.

The WHILE loop is executed as follows:

1. The script evaluates whether the Boolean_expression is true or not. If not, program execution exits the loop1.
and continues after the ENDWHILE statement.

2. The statements in the body of the loop are executed. The loop can be exited through the EXIT WHILE2.
statement.

3. Steps 1 through 2 are repeated.3.

WHILE loops can be nested. The number of levels of nesting possible depends on memory and resource
availability.

QuickScript .NET Operators
The following QuickScript .NET operators require a single operand:

Operator Short Description

~ Complement

- Negation

NOT Logical NOT

The following QuickScript .NET operators require two operands:
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Operator Short Description

+ Addition and concatenation

- Subtraction

& Bitwise AND

* Multiplication

** Power

/ Division

^ Exclusive OR

| Inclusive OR

< Less than

<= Less than or equal to

<> Not equal to

= Assignment

== Equivalency (is equivalent to); not supported for entire array
compares. Compare the arrays one element at a time using ==.

> Greater than

>= Greater than or equal to

AND Logical AND

MOD Modulo

OR Logical OR

SHL Left shift

SHR Right shift

The following table shows the precedence of QuickScript .NET operators:

Precedence Operator

1 (highest) ( )

2 - (negation), NOT, ~

3 **

4 *, /, MOD

5 +, - (subtraction)
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Precedence Operator

6 SHL, SHR

7 <, >, <=, >=

8 ==, <>

9 &

10 ^

11 |

12 =

13 AND

14 (lowest) OR

The arguments of the listed operators can be numbers or attribute values. Putting parentheses around an
argument is optional. Operator names are not case-sensitive.

Parentheses ( )
Parentheses specify the correct order of evaluation for the operator(s). They can also make a complex expression
easier to read. Operator(s) in parentheses are evaluated first, preempting the other rules of precedence that
apply in the absence of parentheses. If the precedence is in question or needs to be overridden, use
parentheses.

In the example below, parentheses add B and C together before multiplying by D:
( B + C ) * D;

Negation ( - )
Negation is an operator that acts on a single component. It converts a positive integer or real number into a
negative number.

Complement ( ~ )
This operator yields the one's complement of a 32-bit integer. It converts each zero-bit to a one-bit and each
one-bit to a zero-bit. The one's complement operator is an operator that acts on a single component, and it
accepts an integer operand.

Power ( ** )
The Power operator returns the result of a number (the base) raised to the power of a second number (the
power). The base and the power can be any real or integer numbers, subject to the following restrictions:

• A zero base and a negative power are invalid.•

Example: "0 ** - 2" and "0 ** -2.5"

• A negative base and a fractional power are invalid.•

© 2022 AVEVA Group plc and its subsidiaries. All rights reserved.
  

Page 428

AVEVA™ Industrial Graphic Editor User Guide 
Appendix C – QuickScript References



Example: "-2 ** 2.5" and "-2 ** -2.5"

• Invalid operands yield a zero result.•

The result of the operation cannot be so large or so small that it cannot be represented as a real number.
Example:
1 ** 1 = 1.0
3 ** 2 = 9.0
10 ** 5 = 100,000.0

Multiplication ( * ), Division ( / ), Addition ( + ),Subtraction ( - )
These binary operators perform basic mathematical operations. The plus (+) can also concatenate String
datatypes.

For example, in the data change script below, each time the value of "Number" changes, "Setpoint" changes as
well:
Number=1;
Setpoint.Name = "Setpoint" + Text(Number, "#" );

Where: The result is "Setpoint1."

Modulo (MOD)
MOD is a binary operator that divides an integer quantity to its left by an integer quantity to its right. The
remainder of the quotient is the result of the MOD operation. Example:
97 MOD 8 yields 1
63 MOD 5 yields 3

Shift Left (SHL), Shift Right (SHR)
SHL and SHR are binary operators that use only integer operands. The binary content of the 32-bit word
referenced by the quantity to the left of the operator is shifted (right or left) by the number of bit positions
specified in the quantity to the right of the operator.

Bits shifted out of the word are lost. Bit positions vacated by the shift are zero-filled. The shift is an unsigned
shift.

Bitwise AND ( & )
A bitwise binary operator compares 32-bit integer words with each other, bit for bit. Typically, this operator
masks a set of bits. The operation in this example "masks out" (sets to zero) the upper 24 bits of the 32-bit word.
For example:
result = name & 0xff;

Exclusive OR (^) and Inclusive OR ( | )
The ORs are bitwise logical operators compare 32-bit integer words to each other, bit for bit. The Exclusive OR
compare the status of bits in corresponding locations. If the corresponding bits are the same, a zero is the result.
If the corresponding bits differ, a one is the result. Example:
0 ^ 0 yields 0
0 ^ 1 yields 1
1 ^ 0 yields 1
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1 ^ 1 yields 0

The Inclusive OR examines the corresponding bits for a one condition. If either bit is a one, the result is a one.
Only when both corresponding bits are zeros is the result a zero. For example:
0 | 0 yields 0
0 | 1 yields 1
1 | 0 yields 1
1 | 1 yields 1

Assignment ( = )
Assignment is a binary operator which accepts integer, real, or any type of operand. Each statement can contain
only one assignment operator. Only one name can be on the left side of the assignment operator.

Read the equal sign (=) of the assignment operator as "is assigned to" or "is set to."

Don't confuse the equal sign with the equivalency sign (==) used in comparisons.

Comparisons ( <, >, <=, >=, ==, <> )
Comparisons in IF-THEN-ELSE statements execute various instructions based on the state of an expression.

AND, OR, and NOT
These operators work only on discrete attributes. If these operators are used on integers or real numbers, they
are converted as follows:

• Real to Discrete: If real is 0.0, discrete is 0, otherwise discrete is 1.•

• Integer to Discrete: If integer is 0, discrete is 0, otherwise discrete is 1.•

If the statement is: "Disc1 = Real1 AND Real2;" and Real1 is 23.7 and Real2 is 0.0, Disc1 has 0 assigned to
it, since Real1 is converted to 1 and Real2 is converted to 0.

When assigning the floating-point result of a mathematical operation to an integer, the value is rounded to the
nearest integer instead of truncating it. This means that an operation like IntAttr = 32/60 results in IntAttr
having a value of 1, not 0. If truncation is needed, use the Trunc() function.
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